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About this Guide

This section describes the purpose of the ArcSight Administrator’s Guide. It also lists other 
documents available for ArcSight ESM and briefly describes the information contained in 
those documents.

The ArcSight Administrator’s Guide provides you information about configuring and running 
your ArcSight ESM system. This guide assumes that you have successfully installed your 
ArcSight ESM system.

Information about ArcSight ESM system components, supported platforms, deployment 
scenarios, and how to install the components is covered in the ArcSight Installation and 
Configuration Guide.

Related Documentation
The complete ArcSight documentation set includes guides and Online Help listed in the 
following table. All guides are available in PDF format.

You can access the guides in these ways:

From the ArcSight Manager doc directory.

From the ArcSight Customer Support web site at https://support.arcsight.com.

From the ArcSight Console online Help (click Help | Browse Arcsight 
Documentation).

You can access the ArcSight ESM Online Help from the Help option in ArcSight Console 
(click Help | Help Contents).

“Related Documentation” on page xv

“Feedback” on page xviii

Document Title Description

ESM 101: Concepts for 
ArcSight™ ESM

ESM 101 introduces the underlying concepts 
behind how ArcSight ESM works, and provides a 
roadmap to the tools available in ESM depending 
on your role in security operations.

ArcSight™ ESM Release Notes Describes new product features, latest updates, 
known product issues and work-arounds, and 
technical support information.
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About this Guide
ArcSight™ ESM Installation and 
Configuration Guide

This Guide.

ArcSight™ ESM Administrator's 
Guide

Describes how to configure ArcSight and its 
network interfaces, and maintain ArcSight for 
ongoing operations.

ArcSight™ ESM Reviewer’s 
Guide

Introduces major new features in the current 
version of ArcSight ESM, including task walk-
throughs and usage guidance. The same 
information is highlighted in the “What’s New” 
Console Help topics.

ArcSight™ ESM User’s Guide

ArcSight™ ESM Reference Guide

Describes how to use the ArcSight Console. These 
are printable versions of the online Help topics and 
glossary. 

ArcSight™ ESM Web User’s 
Guide

Provides user and reference information from the 
ArcSight Web online Help system.

ArcSight™ SmartConnector 
Configuration Guides

Provides vendor-specific instructions for how to 
install individual SmartConnectors and configure 
their associated devices.

ArcSight™ SmartConnector 
Configuration Guide for ArcSight 
Forwarding Connector

This guide provides information for installing an 
ArcSight Forwarding Connector for event collection 
from an ArcSight ESM Manager installation.

ArcSight FlexConnector 
Configuration Guide

Describes how to design, create, and install 
custom SmartConnectors.

ArcSight ESM Upgrade Guides Provide detailed instructions about how to plan for 
and execute upgrades from prior releases to the 
latest version of ESM.

ArcSight™ ESM Release Notes Describes new product features, latest updates, 
known product issues and work-arounds, and 
technical support information.

Document Title Description
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About this Guide
Notes, Tips, and Cautions

Text Conventions
The following table lists the syntax conventions used in this guide.

Represents a Note.

Notes provide additional information about a feature or procedure that might 
help the user make decisions, or inform users about outcomes they can 
expect. 

Represents a Tip.

Tips provide helpful suggestions and best practices about how to get 
optimum results from a feature or procedure. 

Represents a Caution.

Cautions provide information that when ignored may cause system damage, 
data loss, or bodily injury. 

Text Description and Example

Bold Bold is used to indicate an on-screen element that a user 
should click. Always use this character format rather than 
manually bolding the item with the format | style menu or 
“bold” button.

• Enter a value and click OK. 

Code As described before, the code character tag is used for code 
elements discussed in-line in a paragraph.

• If the name of your active list entries text file is 
“AdministrativeUsers.txt,” the script would look like 
this:

Emphasis or BookName Italics indicates emphasis or a book name:

• Do not perform this procedure until you have backed up 
your data.

• For more information, see the ArcSight Administrator’s 
Guide.

menu > submenu Right angle brackets are used to indicate steps in a 
command sequence and online Help topic sequences.

• menu > submenu > submenu

For example:

• Authoring > Rules > Rule Actions > Updating 
Session Lists

| tab | subtab Vertical bars are used to separate multilevel editor-tab 
sequences.

• tab | subtab | subtab

/ Forward slash / Forward slashes are used to separate resource URI strings 
and other file paths.

• All Reports/System Reports/Asset/All Assets
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About this Guide
Feedback
To submit feedback regarding ArcSight ESM or documentation, go to ArcSight’s Customer 
Support web site at https://support.arcsight.com

<variable> A text string enclosed in angular brackets is a variable for 
which you need to supply a value. (The bracketed text may 
also be in italics to emphasize that it is a variable.)

Example: 

In --nsp_password=<password>, <password> is a variable 
for which you supply a value.

{parameter1 | 
parameter2 | 
parameter3}

Curly brackets enclose multiple parameters, at least one of 
which you must provide. 

Example: 

{--user_id_seq=<user_id> | --
user_login=<user_login}

In the above example, either supply the user ID of a user 
or his/her login name.

[optional_parameter] Square brackets enclose parameters, variables, or values 
that are optional. 

Example: 

[--cli_restrict=1]

Text Description and Example
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Chapter 1

Basic Administration Tasks

This chapter describes the various tasks that you can perform to effectively manage an 
ArcSight ESM installation, performing additional configuration and maintenance operations 
for ArcSight Manager and the ArcSight Database. 

The following topics are covered here:

Running ArcSight ESM
Unless ArcSight ESM is configured to run as a service, you run ArcSight Manager, Console, 
and SmartConnectors using the Start menu. For Linux and Solaris, you need to start the 
ArcSight Manager from a command or console window, or set up ArcSight Manager as a 
daemon. The remainder of this section provides more information about command line 
options you can use to start up, shut down, configure, or reconfigure ESM components. In 
addition, it provides information about setting up ArcSight Manager as a daemon (on Unix 
platforms) or as a service (on Windows), if you didn’t originally configure ArcSight Manager 
that way.

Starting the ArcSight Manager
To start up ArcSight Manager from the command line, if it’s not configured to run either as 
a daemon or a service:

1 Open a command window or terminal box.

2 Change directories to the ArcSight Manager <ARCSIGHT_HOME>\bin directory:

3 Type in the following line and press Enter.

arcsight manager

“Running ArcSight ESM” on page 1

“Starting the ArcSight Manager” on page 1

“Starting the ArcSight Console” on page 2

“Starting ArcSight SmartConnectors” on page 3

“Stopping the ArcSight Manager” on page 4

“Reconnecting to the ArcSight Manager” on page 4

“Configuring ArcSight Manager or ArcSight Web as a Service” on page 4

“Reducing Impact of Anti-Virus Scanning” on page 6
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1 Basic Administration Tasks
When you start up, the ArcSight Manager will display a stream of messages in the 
command window or terminal box to reflect its status. The command window or terminal 
box will say Ready when the Manager has started successfully. If you are starting the 
Manager as a service, you can monitor whether or not it has successfully loaded by viewing 
the server.std.log file, located in <ARCSIGHT_HOME>\logs\default on Windows. 
On Unix systems, you could use the command:

cd ARCSIGHT_HOME;tail -f logs/default/server.std.log

On Windows systems, you can use a “tail” equivalent tool to run the same command, such 
as those available from http://www.cygwin.com, which provides Unix environments and 
tools for Windows. 

ArcSight Manager Decoupled Process Execution
On UNIX-based systems, ArcSight Manager uses decoupled process execution to perform 
specific tasks, for example to compile rulesets, either on initial startup or when the 
real-time rules group changes. To do so, ArcSight Manager uses a standalone process 
executor (instead of using “in process” or “direct process” execution). ArcSight Manager 
sends commands to be executed via the file system. The process executor uses the 
<ARCSIGHT_HOME>\tmp directory, so you should restrict system level access for this 
directory.

The process executor is used, by default, on all Unix platforms. The ArcSight Manager 
scripts ensure that the Process Executor will be executed as a daemon before the ArcSight 
Manager is started. This has some implications with regards to troubleshooting ArcSight 
Manager startup and runtime problems. The ArcSight Manager, if configured to use the 
Process Executor, will not start if the presence of a running Process Executor cannot be 
detected. The Process Executor runs within its own watchdog, in the same fashion as the 
ArcSight Manager, so if the process stops for any reason, it will restart automatically. The 
process executor is transparent to users regarding the way that ArcSight Manager is 
started or stopped. 

The stdout and stderr of the executed process will be written into the following two 
files:

<ARCSIGHT_HOME>/tmp/[commandfile-name].stdout

<ARCSIGHT_HOME>/tmp/[commandfile-name].stderr

Starting the ArcSight Console
Before you start ArcSight Console or SmartConnectors, be sure ArcSight Manager is 
installed and has completed a successful startup. To start up the ArcSight Console:

1 Open a command window or terminal box on <ARCSIGHT_HOME>\bin.

2 Type in the following line and press Enter.

arcsight console

Closing the command prompt or terminal box in which ArcSight Manager was 
started, or pressing CTRL-C keys in the window, will initiate a controlled and 
graceful shut down of the ArcSight Manager.
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1 Basic Administration Tasks
Setting up a Custom Login Message
You can configure the ArcSight Manager to display a custom message before allowing users 
to log in to the Console or ArcSight Web. Set the following property in 
server.properties:

auth.login.banner=config/loginbanner.txt

This property configures the Manager to display the text from the file 
<ARCSIGHT_HOME>\config\loginbanner.txt whenever a user runs the Console. 
(Changes to the properties file take effect the next time the Manager is started.)

 Create a text file named loginbanner.txt in the <ARCSIGHT_HOME>\config 
directory. This feature is often used to display a legal disclaimer message. Users must close 
the message window before they can log in.

The ArcSight Web console will display the custom banner as well, provided that the 
browser used supports JavaScript and has JavaScript enabled. To configure a custom 
banner for Web Console:

1 Create a custom logo image in .gif or .png format (such as MyLogo.gif). The image 
should be approximately 138 x 39 pixels.

2 On the Web server machine, copy this custom logo image file to the 
<ARCSIGHT_HOME>\webapp\images directory.

3 Copy the following properties from the example.styles.properties file located 
at <ARCSIGHT_HOME>\config\web directory to styles.properties file in the 
same directory. 

# logo image for login page 

loginLogoImg = <demo-logo-login.png>

4 Replace 'demo-logo-logo-login.png' with your custom logo image file name. For 
example, loginLogoImg=MyLogo.gif

5 Close the Web Console.

6 Restart Web server and log into the Web console.

You should see this newly added custom Web logo image in Web console Login 
Window.

Starting ArcSight SmartConnectors
Before you start ArcSight SmartConnectors, make sure ArcSight Manager is running. It’s 
also a good idea for the ArcSight Console to also be running, so that you can see the status 
of configured SmartConnectors and view messages as they appear on the Console. To start 
up an ArcSight SmartConnector:

1 Open a command window or terminal box.

2 Type in the following line and press Enter:

arcsight agents

When you uninstall the Web, style.properties and your custom 
logo image files are deleted. Make sure to save these files so that you 
can use them when you reinstall the Web
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1 Basic Administration Tasks
Stopping the ArcSight Manager
When not running as a service, press Ctrl-C in the command window or terminal box 
where the ArcSight Manager is running to initiate a controlled shutdown of ArcSight 
Manager.

Reconnecting to the ArcSight Manager
If the ArcSight Console loses its connection to the ArcSight Manager—because the Manager 
was restarted, for example—a dialog box appears in the ArcSight Console stating that your 
connection to the ArcSight Manager has been lost. Click Retry to re-establish a connection 
to the ArcSight Manager or click Relogin. 

Configuring ArcSight Manager or ArcSight Web as a 
Service

The ArcSight Manager (or ArcSight Web) can be configured as a Windows Service or Unix 
daemon. When you start the ArcSight Manager as a service (or daemon) you can monitor 
whether or not it has successfully started by viewing the server.std.log file located in 
<ARCSIGHT_HOME>\logs\default.

ArcSight Manager Service Setup on Windows
If the ArcSight Manager was not originally configured as a service, you can do so at any 
time using the Manager service tool, managersvc. To set up ArcSight Manager as a service 
in Windows:

From a command window in the <ARCSIGHT_HOME>\bin directory, enter the following 
command:

arcsight managersvc –i

On a 64-bit machine enter:

arcsight managersvc64 -i

Starting and Stopping the ArcSight Manager Service on 
Windows

To start or stop the ArcSight Manager service:

1 Right-click the My Computer icon, and select Manage. The Computer Management 
window appears.

2 Within the Computer Management window, expand the Services and Applications 
folder.

Closing the command prompt or terminal box will shut down the ArcSight 
Manager.

The connection to the ArcSight Manager cannot be re-established while the 
ArcSight Manager is restarting. In some cases, a connection cannot be 
established without resetting one or both machines. 

Clicking Retry may display connection exceptions while the ArcSight Manager 
is restarting, or as the connection is re-established.
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3 Click Services.

4 Right-click the ArcSight Manager service name and select Start to begin the service 
or Stop to end the service

Removing the ArcSight Manager Service on Windows
Stopping the ArcSight Manager service does not remove it from your system. To remove 
the service you must do the following:

Within a Windows command prompt, type in the following command from the 
<ARCSIGHT_HOME>\bin directory:

arcsight managersvc –r

On 64-bit machine enter:

arcsight managersvc64 -r

Check to ensure that the service was removed. If it was not, reboot the Windows system to 
completely remove the service.

Doing an uninstall should automatically remove the service too. For the Manager service to 
start automatically at system boot the option for it must be selected in the Manager setup.

ArcSight Manager or ArcSight Web Service Setup on Unix 
Platforms

The following provides a brief overview of how to set up ArcSight Manager or ArcSight Web 
as a daemon, the “service” equivalent on Unix platform machines. After installation, 
ArcSight Manager can be controlled using /etc/init.d/arcsight_manager 
start|stop, (or arcsight_web for ArcSight Web) following the standard method of 
starting daemon services in Unix. Change the configuration file 
/etc/arcsight/arcsight_manager.conf (or arcsight_web.conf for ArcSight 
Web) to reflect the installation directory and other settings. In addition, the 
/etc/init.d/arcsight_* scripts will be hooked into the Unix startup procedure, 
making the ArcSight Manager or Web start and shut down in lock step with the host OS.

To set up ArcSight Manager or ArcSight Web as a UNIX daemon, open a command window 
on <ARCSIGHT_HOME>/bin and run the appropriate wizard:

arcsight managersetup

arcsight websetup

Once everything is configured properly, test your configuration setup the next time you 
start the ArcSight Manager using /etc/init.d/arcsight_manager (or 
arcsight_web).

Make sure to start ArcSight Manager this way at least once before relying on it to start 
correctly during system boot or startup.

Script output will go to 
<ARCSIGHT_HOME>/logs/default/server.script.log. The stdout output of 
the ArcSight Manager will go to 
<ARCSIGHT_HOME>/logs/default/server.std.log. ArcSight recommends 
that you tail these two files to identify the cause of any startup failures.
ArcSight Confidential ArcSight ESM Administrator’s Guide 5
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Reducing Impact of Anti-Virus Scanning
Files in certain ArcSight ESM directories are updated frequently; for example, the log 
directory. When an anti-virus application monitors these directories, it can impact the 
system in these ways:

Place a large and constant load on the CPU of the machine.

Slow down ArcSight ESM as frequent scanning can impede writes to disk.

Therefore, ArcSight recommends that you exclude the following directories (and any 
subdirectories under them) in <ARCSIGHT_HOME> from the virus scan list:

caches\server

logs

system

tmp

user, but include the user\agent\lib directory in the scan

archive
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Chapter 2

Configuration

This chapter describes the various tasks that you can perform to manage ArcSight 
component configuration. The following topics are covered in this chapter:

Managing and Changing Properties File Settings
Various components of ArcSight ESM use properties files for configuration. Many sections 
of this documentation require you to change properties in those files. Some of the 
properties files are also modified when you use one of the configuration wizards that come 
with ESM. 

Property File Format
Generally, all properties files are text files containing pairs of keys and values. The keys 
determine which setting is configured and the value determines the configuration value. 
For example, the following property configures the port on which ArcSight Manager listens: 

servletcontainer.jetty311.encrypted.port=8443

Blank lines in this file are ignored as well as lines that start with a pound sign ( # ). Lines 
that start with a pound sign are used for comments.

Defaults and User Properties
Most configuration items in various components consist of at least two files. The first, 
generally referred to as the defaults properties file, contains the default settings that ESM 

“Managing and Changing Properties File Settings” on page 7

“Adjusting Console Memory” on page 12

“Installing New License Files Obtained from ArcSight” on page 12

“Configuring ArcSight Manager Logging” on page 13

“Understanding SSL Authentication” on page 20

“Reconfiguring the ArcSight Console after Installation” on page 58

“Reconfiguring ArcSight Manager” on page 58

“Manager Password Configuration” on page 59

“Compression and Turbo Modes” on page 63

“Configuring the ArcSight Database Monitor” on page 64

“Sending Events as SNMP Traps” on page 65
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provides. These files should never be modified, but can be used as a reference. Updates to 
ESM components will overwrite this file to include new settings. 

The second file, generally referred to as the user properties file, contains settings that are 
specific to a particular installation. Settings in the user properties file override settings in 
the defaults properties file. Typically, the user properties file for a component is created 
and modified automatically when you configure the component using its configuration 
wizard. Because the user properties file contains settings you specify to suit your 
environment, it is never replaced by an upgrade. 

The following table lists the most important properties files in ArcSight ESM.

Editing Properties
 You can edit the properties using a regular text editor, for example vi or emacs on Unix 
platforms or MS Notepad on Windows.

If you configured the Console and SmartConnectors using default settings in the 
configuration wizard, a user properties file is not created automatically for that component. 
If you need to override a setting on such a component, use a text editor to create this file 
in the directory specified in the above table.

When you edit a property on a component, you must restart the component for the new 
values to take effect except for the Manager properties listed in the next section. 

 If you change a communication port, be sure to change both sides of the connection. For 
example, if you configure a Manager to listen to a different port than 8443, be sure to 
configure all the Manager’s clients (Consoles, SmartConnectors, ArcSight Web, and so on) 
to use the new port as well.

Default Properties User Properties Purpose

config\

server.defaults.properties

config\server.properties ArcSight Manager 
Configuration

config\

console.defaults.properties

config\console.properties ArcSight Console 
Configuration

config\

client.defaults.properties

config\client.properties ArcSight Common Client 
Config

config\agent\

agent.defaults.properties

user\agent\agent.properties SmartConnector 
Configuration

Protocol Port Configuration

TCP 8443 ArcSight Console to ArcSight Manager communication

TCP 8443 ArcSight SmartConnector to ArcSight Manager 
communication

TCP 9443 ArcSight Web

TCP 1521 ArcSight Manager to ArcSight Database (Oracle 
communication

TCP 389 ArcSight Manager to LDAP server (w/o SSL if enabled)*
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Dynamic Properties
When you change the following properties in the server.properties file on the 
Manager, you do not need to restart the Manager for the changes to take effect:

auth.auto.reenable.time

auth.enforce.single.sessions.console

auth.enforce.single.sessions.web

auth.failed.max

auth.password.age

auth.password.age.exclude

auth.password.different.min

auth.password.length.max

auth.password.length.min

auth.password.letters.max

auth.password.letters.min

auth.password.maxconsecutive

auth.password.maxoldsubstring

auth.password.numbers.max

auth.password.numbers.min

auth.password.others.max

auth.password.others.min

auth.password.regex.match

auth.password.regex.reject

auth.password.unique

auth.password.userid.allowed

auth.password.whitespace.max

auth.password.whitespace.min

external.export.interval

process.execute.direct

TCP 636 ArcSight Manager to LDAP server (w/ SSL if enabled)*

TCP 25 ArcSight Manager to SMTP server (for Notifications)

TCP 110 ArcSight Manager to POP3 server (for Notifications)

TCP 143 ArcSight Manager to IMAP server (for Notifications)

UDP 1645 or 1812 ArcSight Manager to RADIUS server (if enabled)

UDP/TCP 53 ArcSight Console to DNS Server communication 
(nslookup tool)

UDP/TCP 43 ArcSight Console to Whois Server communication (whois 
tool)

ICMP none ArcSight Console to Target communication (ping tool)

Protocol Port Configuration
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servletcontainer.jetty311.log

servletcontainer.jetty311.socket.https.expirationwarn.days

ssl.debug

web.accept.ips

whine.notify.emails

xmlrpc.accept.ips

After you make the change, you use the manager-reload-config command to load 
those changes to the Manager. Every time the manager-reload-config command is 
successful, a copy of the server.properties file it loaded is placed in 
<ARCSIGHT_HOME>\config\history for backup purposes. The server.properties 
file in <ARCSIGHT_HOME>\config\history is suffixed with a timestamp and does not 
overwrite the existing versions, as described in the following example. 

Example
Manager M1 starts successfully for the first time on September 27, 2006, at 2:45 p.m. A 
backup copy of its server.properties file is written to 
<ARCSIGHT_HOME>\config\history with this timestamp:

server.properties.2006_09_27_14_45_27_718

On September 28, 2006, the M1 administrator adds the following property to the 
server.properties file:

notification.aggregation.max_notifications=150

When the administrator runs the manager-reload-config command at 1:05 p.m. the 
same day, it runs successfully because this property can be loaded dynamically.

As soon as the updated server.properties file is loaded in M1’s memory, a backup 
copy of the updated server.properties file is written to 
<ARCSIGHT_HOME>\config\history with appropriate timestamp.

Now, <ARCSIGHT_HOME>\config\history contains these two backup files:

server.properties.2006_09_27_14_45_27_718

server.properties.2006_09_28_01_05_40_615

On September 29, 2006, the M1 administrator adds this property to the 
server.properties file:

notification.aggregation.time_window=2d

As this property can be also loaded dynamically, similar to the previous change, once the 
updated server.properties is loaded in M1’s memory, a backup copy of the 
server.properties file is written to <ARCSIGHT_HOME>\config\history with 
appropriate timestamp.

Now, <ARCSIGHT_HOME>\config\history contains these three backup files:

server.properties.2006_09_27_14_45_27_718

server.properties.2006_09_28_01_05_40_615

server.properties.2006_09_29_03_25_45_312
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On September 30, 2006, the M1 administrator updates the whine.notify.emails 
property in the server.properties file. When he runs the manager-reload-config 
command, the command fails because this property cannot be loaded dynamically. As a 
result, these things happen:

The updated server.properties file is not loaded into M1’s memory, however, 
changes made to it are not reverted.

M1 continues to use the properties that were loaded on September 29th.

No backup copy is made. The <ARCSIGHT_HOME>\config\history directory 
continues to contain the same three backup files:

server.properties.2006_09_27_14_45_27_718

server.properties.2006_09_28_01_05_40_615

server.properties.2006_09_29_03_25_45_312

The changes made on September 30th will not be effective until M1 is restarted.

Changing Manager Properties Dynamically
To change any of the properties listed previously, do these steps:

1 Change the property in the server.properties file and save the file. 

2 (Optional) Use the –diff option of the manager-reload-config command to 
view the difference between the server properties the Manager is currently using and 
the properties that will be loaded after you run this command: 

arcsight manager-reload-config –diff

3 Run this command in <ARCSIGHT_HOME>\bin to load the new values for the 
properties you changed:

arcsight manager-reload-config 

If this command fails with a warning, it indicates that you are changing properties that 
require a Manager restart before those changes can take effect. When you get such a 
warning none of the property changes, including the ones that can be reloaded without 
restarting the Manager, are applied. You can do one of the following in this situation:

Revert changes to properties that cannot be loaded without restarting the Manager 
and rerun the arcsight manager-reload-config command. 

Force an update of all properties using the –as option, as follows:

arcsight manager-reload-config -as

When you use the -as option, the properties that can be changed without restarting the 
Manager take effect immediately. The properties that require a Manager restart are 
updated in the server.properties but are not effective until the Manager is restarted. 

For example, if you change auth.password.length.min to 7 and search.enabled to 
false, you will get the above warning because only auth.password.length.min can be 
updated without restarting the Manager. If you force an update of the server.properties file, 

The -diff option compares all server properties—default and user 
properties. For all options available with the manager-reload-config 
command, see Appendix A‚ ArcSight Commands‚ on page 201.
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auth.password.length.min will be set to 7, but search.enabled will continue to be set 
to true until the Manager is restarted. 

Securing the ArcSight Manager Properties File
The ArcSight Manager’s server.properties file contains sensitive information such as 
database passwords, keystore passwords, and so on. Someone accessing the information 
in this file can do a number of things, such as tampering with the database and acting as a 
pseudo ArcSight Manager. As a result, the server.properties file must be protected so 
that only the user account under which the ArcSight Manager is running is able to read it. 
This can be accomplished by issuing a chmod command in Unix and Linux, for example:

chmod 600 server.properties

This operation is performed during the ArcSight Manager installation. As a result, only the 
owner of the file (which must be the user that runs the ArcSight Manager) may read or 
write to the file. For all other users, access to the file is denied.

Adjusting Console Memory
Because the ArcSight Console can open up to ten independent event-viewing channels, 
out-of-memory errors may occur. If such errors occur, or if you simply anticipate using 
numerous channels for operations or analysis, please make the following change to each 
affected Console installation. 

In the bin/scripts directory, in the console.bat (Windows) or console.sh (Unix) 
configuration files, edit the memory usage range for the Java Virtual Machine. 

Installing New License Files Obtained from ArcSight
 To change the license file you obtained from ArcSight, please follow the steps below:

1 On the system where ArcSight Manager is installed, copy the package (.zip file) to 
the <ARCSIGHT_HOME> directory (the directory that contains the ArcSight Manager 
installation).

2 Run the following command: 

arcsight deploylicense

3 Restart the Manager.

 

Be careful in using the –as option to force reload properties. If an invalid 
static change is made, it may prevent the Manager from starting up once it 
reboots.

 

You can also protect the server.properties file on Windows systems with 
an NTFS file system using Microsoft Windows Access Control Lists (ACLs).

 

You will receive new license files packaged as .zip files and sent via e-mail 
from ArcSight.
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This wizard replaces the license currently installed with the one included in the file. The 
Manager detects the new license automatically.

Installing in Silent Mode
To install the license file in silent mode, you are required to create a properties file and use 
it. To do so:

1 Open a command prompt/shell window.

2 From the Manager’s \bin directory, run the following command to open the sample 
properties file:

arcsight deploylicense -g

3 Copy and paste the text generated by the command above into a text file.

4 Set the following properties:

LicenseChoice=1 

LicenseFile.filename=<name_of_the_license_zip_file> 

replaceLicenseQuestion =yes

5 Save this text file as properties.txt in the Manager’s <ARCSIGHT_HOME>.

6 From the Manager’s \bin directory, run:

arcsight deploylicense -f properties.txt -i silent

Configuring ArcSight Manager Logging
 ArcSight Manager outputs various types of information to log files. By default, the logs are 
located in:

<ARCSIGHT_HOME>\logs\default\server.log

Various ArcSight Manager utilities write logging information to different sets of log files. 
Each of those sets can consist of multiple files. 

The number and size of the log files are configurable, a typical setting is 10 files with 10 
megabytes each. When a log file reaches a maximum size, it is copied over to a different 
location. Depending on your system load, you may have to change the default settings. To 
make changes to the logging configuration, change the log channel parameters. The 
default log channel is called file. 

 For the main ArcSight Manager log file, called server.log, the following 
server.properties settings are used: 

# Maximum size of a log file.

log.channel.file.property.maxsize=10MB

# Maximum number of roll over files.

log.channel.file.property.maxbackupindex=10

The first setting affects the size of each individual log file; the second setting affects the 
number of log files created. The log file currently in use is always the log file with no 
number appended to the name. The log file with the largest number in its extension is 
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always the oldest log file. All of the log files are written to the 
<ARCSIGHT_HOME>\logs\default directory. 

ArcSight Manager and its related tools write the following log files:

Sending logs and diagnostic information to ArcSight
ArcSight Customer Support may request log files and other diagnostic information to 
troubleshoot problems. The Send Logs utility automatically locates the log files, 
compresses them, and (optionally) uploads them to the ArcSight Customer Support server. 

Starting with version 4.0, this utility has been enhanced as follows:

You can run this utility as a wizard directly from the Console interface (GUI) in addition 
to the command-line interface of each component. 

Optionally, gather diagnostic information such as session wait times, thread dumps, 
and database alert logs about your ArcSight system, which helps ArcSight Customer 
Support analyze performance issues on your ArcSight components. 

When you run this utility from the Console, Manager, or ArcSight Web, you can gather 
logs and diagnostic information for all components of the ArcSight system. 

Guidelines for using the Send Logs utility
Keep these guidelines in mind when using the Send Logs utility:

You can be connected as any valid user on an ArcSight component to collect its local 
logs; however, you must have administrator access to collect logs from other 
components. For example, if you are connected as user ‘joe’ to the Console, you can 

Log File Description

server.log*  The main ArcSight Manager log.

server.status.log*  System status information, such as memory usage etc.

server.channel.log*  Active Channel logs.

server.std.log*  All output that ArcSight Manager prints on the console (if 
run in command line mode)

server.pulse.log*  ArcSight Manager writes a line to this set of logs every ten 
seconds. Used to detect service interruptions.

server.sql.log*  If database tracing is enabled, the SQL statements are 
written to this set of log files. 

execproc.log*  Log information about externally executed processes (only 
on some platforms)

serverwizard.log*  Logging information from the arcsight managersetup 
utility.

dbwizard.log*  Logging information from the arcsight database init utility. 

archive.log*  Logging information from the arcsight archive utility.

 

 You can also use the arcdt command to run specific diagnostic utilities 
from the Manager command line. For more information, see Appendix A‚ 
ArcSight Commands‚ on page 201. 
14 ArcSight ESM Administrator’s Guide ArcSight Confidential



2 Configuration
collect its logs. But if you need to collect logs for the Manager and the database, you 
must connect to the Console as the ArcSight administrator.

SmartConnectors must be running version 4037 or later to remotely (using a Console 
or the Manager) collect logs from them.

You can only collect local logs on SmartConnectors or ArcSight Database. That is, if 
you run the Send Logs utility on ArcSight Database, only the database log files are 
gathered. 

You can run the Send Logs utility on a component that is down. That is, if ArcSight 
Database is down, you can still collect its logs using this utility.

If the Manager is down, you can only collect its local logs. However, if you need to 
collect the database logs as well, use the arcdt command on the Manager. For more 
information, see Appendix A‚ ArcSight Commands‚ on page 201.

All log files for a component are gathered and compressed. That is, you cannot select 
a subset of log files that the utility should process. 

The compressed file is uploaded to the ArcSight Customer Support server using SSL. 
Therefore, you must have one of the following to allow your ArcSight component to 
make SSL connections to the ArcSight Customer Support server:

Port 443 open on your firewall

A proxy server that the ArcSight component can use

Automatic upload of the compressed file is optional. If you do not choose to upload 
automatically, the Send Logs utility generates a compressed file on your local system 
that you can send to ArcSight Customer Support by e-mail. 

You can review the compressed file before it is uploaded to ensure that only a desired 
and appropriate amount of information is sent to ArcSight support. 

You can remove or sanitize information such as IP addresses, host names, and e-mail 
addresses from the log files before compressing them. The options are:

Send log as generated

This option, the default, does not remove any information from the logs files.

Only remove IP address

This option removes IP addresses, but not host names or e-mail addresses, from 
the logs files.

Remove IP address, host names, e-mail addresses

This option removes all IP addresses and enables you to specify a list of 
host-name suffixes for which all host names and e-mail addresses will be removed 
from the logs. 

For example, if you specify ‘company.com’ as a host-name suffix to remove, the 
Send Logs utility will remove all references to domains such as 
‘www.company.com’ and e-mail addresses such as ‘john@company.com’ from the 
logs. 

Gathering logs and diagnostic information 
When you run the Send Logs utility on ArcSight SmartConnectors or ArcSight database, it 
gathers logs and diagnostic information (if applicable) for only those components. 
However, when you run this utility on ArcSight Console, Manager, or ArcSight Web, you can 
gather logs and diagnostic information for all or a selected set of ArcSight components.

To run this utility on SmartConnectors, enter this in <ARCSIGHT_HOME>\bin:

arcsight agent sendlogs
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To gather logs and diagnostic information for all or a selected set of ESM components, do 
one of the following:

On the ArcSight Console, click Tools | SendLogs.

Enter this command in <ARCSIGHT_HOME>\bin on Console, Manager, or ArcSight 
Web: 

arcsight sendlogs

The above action starts the Send Logs wizard. In the wizard screens, perform these steps:

1 Decide whether you want the wizard to gather logs only from the component on which 
you are running it or from all ESM components. 

2 Select the components and the time range for which you want to gather logs. In 
addition, select whether you want to run the diagnostic utilities to gather additional 
information for those components. 

If you choose to specify the diagnostic utilities to run, you will be prompted to select 
the utilities from a list in a later screen. The diagnostic utilities you can select are:

runsql—Run SQL commands contained in a file that is specified as a parameter 
of this utility. Note that the file must contain only one SQL command; multiple 
SQL commands are not allowed.

For example, to use the runsql utility to find out the number of cases in your 
ArcSight Database, do the following:

i Create a file called sample.txt in <ARCSIGHT_HOME>\temp on the 
Manager with this SQL command:

select count(*) from arc_resource where resource_type=7

Do not end the SQL command in the above example with a semi-colon (;).

ii Run this command:

arcdt runsql temp\sample.txt

db-alertlog—Retrieve the database alert log from the database machine.

 

The Send Logs wizard remembers most of the choices you make when you 
run it for the first time. Therefore, for subsequent runs, if you choose to use 
the previous settings, you will need to enter only some of the following 
information. 
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session-waits—Retrieve the currently running JDBC (Java Database 
Connection) sessions and their wait times.

thread-dumps—Obtain thread dumps from the Manager.

3 Enter information to log in to your ArcSight Manager.

4 If you chose to gather logs from the SmartConnectors, select those SmartConnectors 
in the next screen.  

 

At a minimum, the SmartConnectors should be running version 4037 or 
later.
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5 If you chose to select the diagnostic utilities you want to run earlier in this wizard, 
select them in the next screen.

6 If you chose to specify a time range for which the wizard will gather the logs, specify it 
in the next screen.

7 Select from various upload options available as shown in the next screen.

8 Select whether a proxy server is required to connect to the external web from the 
component on which you are running the wizard. 
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If a proxy server is required, enter that information, in the next screen.

9 Enter the information for the ArcSight Customer Support server to which the 
sendlogs command uploads the compressed logs and diagnostic information.  

10 Select whether you want to review the compressed log file information before 
uploading that file to the ArcSight Customer Support site. 

11 Select whether you want to sanitize the logs before sending. For more information 
about sanitizing options, see Guidelines for using the sendlogs utility. 

If you choose to remove IP addresses, host names, and e-mail addresses, enter the 
host name suffixes for which host names and e-mail addresses should be removed.

12 Enter the incident number.

The sendlogs utility uses this number to name the compressed file it creates. 

Use the incident number that ArcSight Customer Support gave you when you reported 
the issue for which you are sending the logs. Doing so helps Customer Support easily 
relate the compressed file to your incident.

 

Use the e-mail address and password that you use to log in to ArcSight 
Customer Support’s web site, https://software.arcsight.com. If you do 
not have this information, contact ArcSight Customer Support.
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If you have not reported an incident for which you are uploading logs, ArcSight 
strongly recommends that you do so before uploading the logs.

13 Click Next to start the compression and, if you previously chose to do so, the 
automatic upload process.

Understanding SSL Authentication
Secure Socket Layer (SSL) technology is used for communication between ArcSight 
Manager and its clients—Console, SmartConnectors, and ArcSight Web. SSL is also used 
between ArcSight Web and the web browsers that communicate with it.

SSL enables the Manager and ArcSight Web (referred to as a “server” from here on) to 
authenticate to its clients and communicate information over an encrypted channel, thus 
providing the following benefits:

Authentication—Ensuring that clients send information to an authentic server and not 
to a machine pretending to be that server. 

Encryption—Encrypting information sent between the clients and the server. 

Data Integrity—Hashing information to prevent intentional or accidental modification.

By default, clients submit a valid user name and password to authenticate with the server; 
however, these clients can be configured to use SSL client authentication. 

 

Most of the values you entered during the first run of the Send Logs 
wizard are retained. The next time you run this wizard, you need to enter 
only a few settings such as the incident number and password for 
uploading logs to ArcSight Customer Support. 

 

SSL is not used between ArcSight Manager and ArcSight Database.
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Terminology
These terms are used in describing and configuring SSL:

Certificate 

A certificate contains the public key, identifying information about the machine such as 
machine name, and the authority that signs the certificate. SSL certificates are defined 
in the ISO X.509 standard.

Key pair

A key pair is a combination of a private key and the public key that encrypts and 
decrypts information. A machine shares only its public key with other machines; the 
private key is never shared. The public and private keys are used to set up an SSL 
session. For details, see “How SSL Works” on page 30.

SSL server-SSL client 

An SSL session is set up between two machines—one of them acts as the server and 
the other as a client. Typically, a server must authenticate to its clients before they will 
send any data. However, in client-side SSL authentication, the server and its clients 
authenticate each other before communicating. 

ArcSight Manager is an SSL server, while SmartConnectors, Console, and browsers are 
SSL clients. ArcSight Web is an SSL client to the Manager and an SSL server to the 
web browsers that connect to it.

Key store 

A key store is an encrypted repository on the SSL server that holds the SSL certificate 
and the server’s private key. The following table lists the ArcSight component, the 
name of the key store on that component, and its location.

*When client-side authentication is used, a key store exists on both—the server and 
the client. 

 

 The keytoolgui utility, used to perform a number of SSL configuration 
tasks, refers to a combination of an SSL certificate and private key as the 
key pair.

The keytoolgui utility is discussed in “Tools for SSL configuration” on 
page 25.

Log File Key Store File Name Location of Key Store

Manager keystore <ARCSIGHT_HOME>\config\jetty

ArcSight Web webkeystore <ARCSIGHT_HOME>\config\jetty

Clients* (for 
client-side 
authentication)

keystore.client <ARCSIGHT_HOME>\config
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Trust store 

Trust store is an encrypted repository on SSL clients that contains a list of certificates 
of the issuers that a client trusts.

When an issuer issues a certificate to the server, it signs the certificate with its private 
key. When the server presents this certificate to the client, the client uses the issuer’s 
public key from the certificate in its trust store to verify the signature. If the signature 
matches, the client accepts the certificate. For more details, see how SSL handshake 
occurs in “How SSL Works” on page 30.

The following table lists the ArcSight component, the name of the trust store on that 
component, and its location.

[1] The utilities that exist on the Manager machine such as archive are treated as 
clients of the Manager. The cacerts file on the Manager is used for authenticating the 
Manager to these clients. 

[2] When client-side authentication is used. 

[3] When client-side authentication is used, ArcSight Web contains two trust 
stores—cacerts for connections to the Manager and webtruststore for connections to 
browsers.

The keytoolgui utility, used to view a trust store, is discussed in “Tools 
for SSL configuration” on page 25.

Component Trust Store File Name Location of Trust Store

Clients cacerts <ARCSIGHT_HOME>\jre\lib\security

Manager cacerts[1] <ARCSIGHT_HOME>\jre\lib\security

ArcSight Web cacerts <ARCSIGHT_HOME>\jre\lib\security

Manager truststore[2] <ARCSIGHT_HOME>\config\jetty

ArcSight Web webtruststore[2][3] <ARCSIGHT_HOME>\config\jetty
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Alias

Certificates and key pairs in a key store or a trust store are identified by an alias. For 
example, in the following trust store, techpubs.arcsight.com is an alias for a 
certificate created for the machine techpubs.arcsight.com. 

Key store / Trust store password

A key store password is used to encrypt the key store file. Similarly, a trust store 
password is used to encrypt a trust store file. Without this password, you cannot open 
these files. 

You specify a key store password when creating a key pair, which is discussed in later 
sections of this chapter. The password is obfuscated and stored in the ArcSight 
component’s *.properties file. The following table lists the property file and the 
property name where the key store password is stored for each component.

A default trust store password is set up for each ArcSight component in its 
*.defaults.properties file. The password is unobfuscated. Typically, you will not 
need to change this password. However, if you want to change or obfuscate this 
password, use the changepassword utility. For information about 
changepassword, see Appendix A. The following table lists the property name where 
the obfuscated trust store password is stored.

Password Type Property File Property Name

Key Store

Manager server.properties server.privatekey.password.encr
ypted

ArcSight Web webserver.properties server.privatekey.password.encr
ypted

Client* client.properties** ssl.keystore.password.encrypted

Trust Store

Client client.properties** ssl.truststore.password
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*For client-side authentication

** If the client.properties file does not exist on your client, you will need to 
create it using an editor of your choice.

Cipher suite

A set of authentication, encryption, and data integrity algorithms used for securely 
exchanging data between an SSL server and a client. 

In v3.5 and later, the following cipher suites are enabled by default:

TLS_RSA_WITH_AES_128_CBC_SHA

SSL_RSA_WITH_3DES_EDE_CBC_SHA

SSL_RSA_WITH_RC4_128_MD5

SSL_RSA_WITH_RC4_128_SHA

Other supported cipher suites are:

TLS_DHE_RSA_WITH_AES_128_CBC_SHA

TLS_DHE_DSS_WITH_AES_128_CBC_SHA

SSL_DHE_RSA_WITH_3DES_EDE_CBC_SHA

SSL_DHE_DSS_WITH_3DES_EDE_CBC_SHA

SSL_RSA_WITH_DES_CBC_SHA

SSL_DHE_RSA_WITH_DES_CBC_SHA

SSL_DHE_DSS_WITH_DES_CBC_SHA

SSL_RSA_EXPORT_WITH_RC4_40_MD5

SSL_RSA_EXPORT_WITH_DES40_CBC_SHA

SSL_DHE_RSA_EXPORT_WITH_DES40_CBC_SHA

SSL_DHE_DSS_EXPORT_WITH_DES40_CBC_SHA

SSL_RSA_WITH_NULL_MD5

SSL_RSA_WITH_NULL_SHA

SSL_DH_anon_WITH_RC4_128_MD5

TLS_DH_anon_WITH_AES_128_CBC_SHA

SSL_DH_anon_WITH_3DES_EDE_CBC_SHA

SSL_DH_anon_WITH_DES_CBC_SHA

SSL_DH_anon_EXPORT_WITH_RC4_40_MD5

SSL_DH_anon_EXPORT_WITH_DES40_CBC_SHA

Although in most cases you do not need to change cipher suites, you can configure 
them in the properties file for an ArcSight component:

Manager—server.properties

Arcsight Web—webserver.properties

Manager* server.properties servletcontainer.jetty311.trust
store.password.encrypted

ArcSight Web webserver.properties servletcontainer.jetty311.trust
store.password.encrypted

Password Type Property File Property Name
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Clients—client.properties 

During the SSL handshake, the client provides a list of cipher suites that it can accept, 
in descending order of preference. The server compares the list with its own set of 
acceptable cipher suites, picks one to use based on its order of preference, and 
communicates it to the client. 

Tools for SSL configuration

Keytoolgui
 The keytoolgui utility enables you to perform a number of SSL configuration tasks. 
Some of these tasks are:

Creating a new key store

Creating a new key pair

Creating a request for a CA-signed certificate (.csr file)

Exporting and Importing a key pair

Exporting and Importing a certificate

The keytoolgui utility is available on all components of ArcSight ESM in the 
<ARCSIGHT_HOME>\bin\scripts directory.

To run keytoolgui, run this command in <ARCSIGHT_HOME>\bin:

arcsight keytoolgui

On SmartConnectors, use:

arcsight agent keytoolgui

Using Keytoolgui to Export a Key Pair
1 Start the keytoolgui by running the following from the Manager’s \bin directory:

arcsight keytoolgui

2 Click File->Open KeyStore and navigate to the component’s keystore.

3 Enter the password for the keystore when prompted. The default password is 
“changeit” (without quotes).

4 Right-click the key pair and select Export.

5 Select Private Key and Certificates radio button and click OK.

6 Enter the password for the key pair when prompted. The default password is 
“changeit” (without quotes).

Not all ESM versions or ArcSight Express models support the FIPS mode.

PKCS#11 token support may not be available for all ESM versions and ArcSight 
Express models.

Be sure to have X11 enabled on UNIX to run this tool.
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7 Enter a new password which will be used for the exported key pair file, then re-enter it 
to confirm it and click OK.

8 Navigate to the location on your machine to where you want to export the key pair.

9 Enter a name for the key pair with a .pfx extension in the Filename textbox and click 
Export.

10 You will see an Export Successful message.

11 Click OK.

Using Keytoolgui to Import a Key Pair
1 Start the keytoolgui from the component to which you want to import the key pair. To 

do so, run the following command from the component’s <ARCSIGHT_HOME>\bin 
directory.

arcsight keytoolgui

2 Select File->Open KeyStore and navigate to your component’s keystore.

3 Enter the key store password when prompted. The default password is “changeit” 
without the quotes.

4 Select Tools->Import Key Pair and navigate to the location of the key pair file, 
select it and click Choose.

5 Enter the password for the key pair file when prompted and click OK.

6 Select the key pair and click Import.

7 Enter an alias for the key pair and click OK.

8 Enter a new password for the key pair file to be imported, re-enter it to confirm it , and 
click OK.

9 You will see a message saying Key Pair Import Successful. Click OK.

10 Select File->Save Key Store to save the changes to the keystore and exit the 
keytoolgui.

Using Keytoolgui to Export a Certificate
1 Start the keytoolgui from the component from which you want to export the 

certificate. To do so, run the following command from the component’s 
<ARCSIGHT_HOME>\bin directory.

arcsight keytoolgui

2 Select File->Open KeyStore and navigate to your component’s truststore.

3 Enter the truststore password when prompted. The default password is “changeit” 
without the quotes.

4 Right-click the certificate and select Export.
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a Make sure to select Head Certificate as Export Type and DER Encoded as the 
Export Format in the following dialog and click OK:

b Navigate to the location where you want to export the certificate, and enter a 
name for the certificate with a .cer extension and click Export.

c You will see the following message:

5 If the component into which you want to import this certificate resides on a different 
machine than the machine from which you exported the certificate (the current 
machine), copy this certificate to the to the other machine.

Using Keytoolgui to Import a Certificate
1 Start the keytoolgui from the component into which you want to import the certificate. 

To do so, run the following command from the component’s <ARCSIGHT_HOME>\bin 
directory.

arcsight keytoolgui
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2 Click File->Open Keystore and navigate to the truststore 
(<ARCSIGHT_HOME>\jre\lib\security) of the component.

3 Select the store named cacerts and click Open. 

4 Enter the password for the truststore when prompted. The default password is 
‘changeit’ (without quotes).

5 Click Tools->Import Trusted Certificate and navigate to the location of the 
certificate that you want to import.

6 Click Import.

7 You will see the following message. Click OK.

8 The Certificate details are displayed. Click OK. 

9 You will see the following message. Click OK.

10 Enter an alias for the Trusted Certificate you just imported and click OK.
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Typically, the alias Name is same as the fully qualified host name.

11 You will see the following message. Click OK. 

12 Save the trust store file.

Creating a Keystore Using Keytoolgui
1 Start the keytoolgui from the component into which you want to import the certificate. 

To do so, run the following command from the component’s <ARCSIGHT_HOME>\bin 
directory.

arcsight keytoolgui

2 Click File->New KeyStore.

3 Select JKS and click OK.

4 Click File->Save KeyStore.

Generating a Key Pair Using Keytoolgui
1 Start the keytoolgui from the component into which you want to import the certificate. 

To do so, run the following command from the component’s <ARCSIGHT_HOME>\bin 
directory.

arcsight keytoolgui

2 Click File->Open KeyStore and navigate to your keystore.

3 Click Tools->Generate Key Pair and fill in the fields in the General Certificate dialog 
and click OK.

4 Enter an alias for the newly created key pair and click OK.

5 Save the keystore by clicking File->Save Key Store.

keytool
 The keytool utility is the command-line version of keytoolgui that you can use to 
manipulate the key stores and trust stores directly. To use keytool, enter this command:

arcsight keytool [options] –store store

where store can be managercerts, managerkeys, clientcerts, clientkeys, 
webcerts, webkeys, ldapcerts, or ldapkeys.

On SmartConnector hosts, use:

arcsight agent keytool [options] –store store
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To see options available for each store, enter:

arcsight keytool –store store

tempca
 The tempca utility enables you to manage the SSL certificate in many ways. To see a 
complete list of parameters available for this utility, enter this in <ARCSIGHT_HOME>\bin: 

arcsight tempca

On SmartConnectors, use:

arcsight agent tempca

A few frequently performed operations using this utility are:

Viewing the type of certificate in use on the Manager:

arcsight tempca –i

Removing the Demo certificate from the list of trusted certificates:

arcsight tempca -rc

How SSL Works
When a client initiates communication with the SSL server, the server sends its certificate to 
authenticate itself to the client. The client validates the certificate by verifying:

The hostname is identical to the one with which the client initiated communication.

The certificate issuer is in the list of trusted certificate authorities in the client’s trust 
store (<ARCSIGHT_HOME>\jre\lib\security\cacerts) and the client is able to 
verify the signature on the certificate by using the CA’s public key from the certificate 
in its trust store.

The current time on the client machine is within the validity range specified in the 
certificate to ensure that the certificate is valid.

If the certificate is validated, the client generates a random session key, encrypts it using 
the server’s public key, and sends it to the server. The server decrypts the session key 
using its private key. This session key is used to encrypt and decrypt data exchanged 
between the server and the client from this point forward.

 

There are few restrictions on the contents of a key store or trust store 
including that the Manager’s certificate should have the alias mykey.
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The next figure illustrates the handshake that occurs between the client and Manager. 

Figure 2-1 SSL handshake between an SSL server and client

If client-side authentication is used, the server requests the client’s certificate when it 
sends its certificate to the client. The client sends its certificate along with the encrypted 
session key.
ArcSight Confidential ArcSight ESM Administrator’s Guide 31



2 Configuration
SSL certificates

Types
 You can use three types of SSL certificates for ArcSight ESM:

CA-signed 

Self-signed (applicable to default mode only)

Demo (applicable to default mode only)

CA-signed certificates are issued by a third party you trust. The third party may be a 
commercial Certificate Authority (CA) such as VeriSign and Thawte or you might have 
designated your own CA. Because you trust this third party, your clients’ trust stores might 
already be configured to accept its certificate. Therefore, you may not have to do any 
configuration on the client side. The process to obtain a CA-signed certificate is described 
in “Obtaining a CA-signed certificate” on page 38.

You can create your own self-signed certificates. A self-signed certificate is signed using 
the private key from the certificate itself. You will need to configure clients to trust each 
self-signed certificate you create. 

ArcSight includes a built-in “demo” Certificate Authority that can issue a temporary demo 
certificate during the Manager installation. This CA is provided only to enable you to 
complete installation in the absence of a signed certificate. However, ArcSight does not 
recommend using a certificate issued by this CA in production environments. If your 
Manager was installed with a Demo certificate, you will need to configure your clients to 
accept this certificate. 

Comparing Self-signed and CA-signed certificates
Self-signed certificates are as secure as CA-signed, however, CA-signed certificates scale 
better as illustrated in this example:

If you have three SSL servers that use self-signed certificates, you will have to configure 
your clients to accept certificates from all of them (the three servers are three unique 
issuers). If you add a new server, you need to configure clients again. However, if these 
servers use a CA-signed certificate, you need to configure the clients once to accept the 
certificate. If the number of Managers grows in the future, you do not need to do any 
additional configuration on the clients.

To replace an expired certificate, you have to delete the old expired 
certificate from the truststore, cacerts, first and then import the new 
certificate into cacerts. Since the common name (CN) for the new certicate 
will be identical to the CN in the old certificate, you are not permitted have 
both the expired as well as the new certificate co-exist in the cacerts. 

To delete a certificate from the truststore, start the keytoolgui and navigate 
to the certificate, right-click on the certificate and select Delete. 

Use the keytoolgui to import the new certificate into the truststore or cacerts. 

Not all ESM versions or ArcSight Express models support the FIPS mode.

PKCS#11 token support may not be available for all ESM versions and ArcSight 
Express models.
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Using a Demo Certificate 

 To use a demo certificate:

1 On the Manager:

a Run this command in <ARCSIGHT_HOME>\bin:

arcsight managersetup

b In the Manager Configuration Wizard, select Demo key pair in the screen that 
prompts you to select the certificate type.

2 On SmartConnectors:

a Run this command in <ARCSIGHT_HOME>\bin:

runagentsetup

b In the SmartConnector Configuration Wizard, select Yes, the ArcSight Manager 
is using a demo certificate.

3 On a Console:

a Run this command in <ARCSIGHT_HOME>\bin:

runconsolesetup

b In the Console Configuration Wizard, select Yes, the ArcSight Manager is 
using a demo certificate.

4 On ArcSight Web server:

a Run this command in <ARCSIGHT_HOME>\bin:

runwebsetup

b In the Web Configuration Wizard, select Demo key pair in the screen that 
prompts you to select the certificate type.

5 On web browsers connecting to ArcSight Web, you do not need to set anything; 
however, the browsers display a security dialog every time they connect. To stop a 
browser from displaying this dialog:

a In <ARCSIGHT_HOME>\bin, run this command on the Manager machine to 
export the demo CA’s certificate:

arcsight tempca –dc

A file named demo.crt is created in your current working directory.

b Import the demo.crt file into your web browser. 

See your Web browser’s documentation for details.

You can use a demo certificate in default mode only.
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Using a Self-Signed Certificate
The procedure you follow depends on the number of ArcSight Managers with which your 
clients communicate. 

When clients communicate with one ArcSight Manager
 To use a self-signed certificate for deployments in which clients communicate with only 
one ArcSight Manager, perform these steps:

1 On the Manager, create a self-signed key pair:

a In <ARCSIGHT_HOME>\bin, run this command:

arcsight managersetup

b In the Manager Configuration Wizard, select Replace with new Self-Signed 
key pair.

 

Steps to create a self-signed key pair may be different for a new ArcSight 
Manager installation as the Configuration Wizard is launched 
automatically during the installation process.
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c Enter information about the SSL certificate, as shown in this example. Click Next.

d Enter the SSL key store password that will be used for the certificate. Click Next. 

Remember this password. You will need to use it to open the key store. 

e Step through the Configuration Wizard. 

At the end of the Configuration Wizard, these three things happen:

i The Manager’s key store, <ARCSIGHT_HOME>\config\jetty\keystore, 
is replaced with the one created using this procedure.

ii A self-signed.cer certificate file is generated in the 
<ARCSIGHT_HOME>\config\jetty directory. 

iii The newly generated self-signed certificate is added to the Manager’s trust 
store file, <ARCSIGHT_HOME>\jre\lib\security\cacerts. 

 

The self-signed certificate does not take effect until the Manager 
is restarted later in this procedure.
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2 Import the cacerts file from the Manager to the 
<ARCSIGHT_HOME>\jre\lib\security directory on all clients. See “Using 
Keytoolgui to Import a Certificate” on page 27.

3 Restart the Manager process so that the Manager can start using the self-signed 
certificate.

4 Restart all clients.

5 When installing a new client, repeat Step 2 of this procedure.

6 On the ArcSight Web server, perform the steps listed in section “Setting up SSL Client 
Authentication on ArcSight Web” on page 50

When clients communicate with multiple ArcSight Managers
To use self-signed certificate for a deployment in which clients communicate with more 
than one ArcSight Managers, perform these steps for each Manager:

1 Follow Step 1 from the previous procedure on all Managers.

2 Copy the self-signed.cer file from all Managers to the 
<ARCSIGHT_HOME>\jre\lib\security directory on one of your clients.

To prevent a certificate file from overwriting another when you copy multiple 
certificate files with the same name to the same location, rename each certificate file 
as you copy. For example, copy the certificate file from ManagerA and rename it to 
SelfSigned_MgrA.cer. 

3 On that client, use the keytoolgui utility to import certificates into the trust store 
(cacerts):

a In <ARCSIGHT_HOME>\bin, run this command:

arcsight keytoolgui

b Click File->Open Keystore.

c In <ARCSIGHT_HOME>\jre\lib\security, select the store named cacerts. 
Use the password ‘changeit’ (without quotes) to open cacerts.

d Click Tools->Import Trusted Certificate:

i Select the self-signed certificate for a Manager and click Import.

 

This step overwrites your existing cacerts file with the new one that 
contains the information about the Trusted Certificate Authority (CA) 
that signed your self-signed certificate. However, the new cacerts file 
does not take effect until the client is restarted later in this procedure.

 

Make sure you have copied the cacerts file to all existing clients before 
proceeding further. Otherwise, after you perform the next steps, only 
clients with the new cacerts file will be able to connect to the Manager.

 

By following this procedure you append the self-signed certificate to the 
existing client trust store, cacerts. Doing so prevents overwriting cacerts, 
which happens if you follow the previous procedure.
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ii You will see the following message. Click OK.

The Certificate details are displayed. Click OK. 

iii You will see the following message. Click OK.

iv Enter an alias for the Trusted Certificate you just imported and click OK.

Typically, the alias Name is same as the fully qualified host name.

v You will see the following message. Click OK. 

vi Save the trust store file.
ArcSight Confidential ArcSight ESM Administrator’s Guide 37



2 Configuration
vii Repeat Steps i through vi for all self-signed certificates you copied.

e On the client, enter this command in <ARCSIGHT_HOME>\bin to stop the client 
from using the currently in-use Demo certificate:

arcsight tempca -rc 

For SmartConnectors, run: 

arcsight agent tempca –rc

4 Copy the <ARCSIGHT_HOME>\jre\lib\security\cacerts file from the client in 
the previous step to all other clients.

5 Restart the Manager service so that the Manager can start using the self-signed 
certificate.

6 Restart the client.

7 When installing a new client, copy the cacerts file from any client you updated earlier 
in this procedure.

Using a CA-Signed Certificate
 Obtaining and deploying a CA-signed certificate involves these steps:

1 Obtaining a CA-signed certificate.

2 Replacing your demo or self-signed certificate with the CA-signed certificate.

Obtaining a CA-signed certificate
To obtain your own CA-signed SSL certificate for ArcSight Manager and ArcSight Web, 
perform these steps:

1 Create a key pair:

a On the Manager machine, run this command to launch the keytoolgui utility in 
<ARCSIGHT_HOME>\bin:

arcsight keytoolgui

b Click File->New KeyStore to create a new key store.

Select from these key store types:

JKS (ArcSight default)

PKCS #12 

c To create the key pair, click Tools->Generate Key Pair. 

Generating the key pair can take some time. 

 

You should obtain two CA-signed certificates—one for the Manager and 
the other for ArcSight Web, unless both components are installed on the 
same machine. Follow the procedure described in this section to obtain 
and import the certificates to the Manager, and if appropriate, to 
ArcSight Web.
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d Enter information about the new key pair, including the length of time for its 
validity (in days). Click OK. 

e Specify an alias (a name for referring to the new key pair in the future). 

f Click File->Save to save the key store. 

Save the key store with a name such as keystore.request. 

If saving the key store on ArcSight Web, save the file with a name such as 
webkeystore.request.

Use the password of your existing key store to save this key store. If you do not 
remember the password, run the Manager Configuration Wizard and change the 
password of your existing key store first.

2 Create a certificate signing request (CSR):

a In the keytoolgui utility, right-click the new key pair you created (mykey) and 
select Generate CSR to create a Certificate Signing Request. 

b Choose a path and filename, and click Generate. 

The default file name is certreq.csr.

A CSR file is generated in the current working directory. 

3 Send the CSR to the selected Certificate Authority (CA).

After verifying the information you send, the CA electronically signs the certificate 
using its private key and replies with a certification response that contains the signed 
certificate.

 

For Common Name (CN), enter the fully qualified domain name of 
the Manager. Ensure that DNS servers, which the clients connecting 
to this host will use, can resolve this host name.

Provide a valid e-mail address as the CAs typically send an e-mail to 
this address to renew the certificate. 

 

The default alias is the Common Name (CN) you provided in the 
previous step. However, it is mandatory that you change the name 
to mykey. 
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Importing a CA-signed certificate into Manager’s key store
 When the CA has processed your request, it sends you a file with the signed certificate. 

The SSL certificate you receive from the Certificate Authority must be a 128-bit X.509 
Version 3 certificate. The type of certificate is the same one that is used for common web 
servers. The signed certificate must be returned by the CA in base64 encoded format. It 
will look similar to this:

-----BEGIN 
CERTIFICATE-----MIICjTCCAfagAwIBAgIDWnWvMA0GCSqGSIb3DQEBBAUAMIGHMQ
swCQYDVQQGEwJaQTEiMCAGA1UECBMZRk9SIFRFU1RJTkcgUFVSUE9TRVMgT05MWTEd
MBsGA1UEChMUVGhhd3RlIENlcnRpZmljYXRpb24xFzAVBgNVBAsTDlRFU1QgVEVTVC
BURVNUMRwwGgYDVQQDExNUaGF3dGUgVGVzdCBDQSBSb290MB4XDTAyMDkyNzIzMzI0
MVoXDTAyMTAxODIZMzI0MVowaDELMAkGA1UEBhMCrVMxDTALBgNVBAgTBGJsYWgxDT
ALBgNVBAcTBGJsYWgxDTALBgNVBAoTBGJsYWgxDTALBgNVBAsTBGJsYWgxHTAbBgNV
BAMTFHppZXIuc3YuYXJjc2lnaHQuY29tMIGfMA0GCSqGSIb3DQEBAQUAA4GNADCBiQ
KBgQCZRGnVfQwG1b+BgABd/p8UhsaNov5AjaagAoBmouJCwgW2vwN4JViC

CSBkDpiqVF7K11Sx4ZVSXX4+VQ6k4gT5G0kDNvQeN05wWkzEMygMB+ZBnYqPA/XtWR
ZtjxvH

MoqS+JEqHruiMLITC6q0reUB/txby6+S9zNo/fUG1pkIcQIDAQABoyUwIzATBgNVHS
UEDDAKBggrBgEFBQcDATAMBgNVHRMBAg8EAjAAMA0GCSqGSIb3DQEBBAUAA4GBAFY3
7E60+P4b3zTLnaG7EVM57GtkED6PwCIilB6ixjvNL4MNGRubPa8kyaZp5fEDoNUPQV
QxnpABjzTalRfYgjNFJ6ltI6ZKjBO5kim9UBeCnKiNNzhIyDyFwbHXOPB/JaLIV+jG
ugYNS7hf/ay0BXKlfueO07EgjhhB/mQFs2JB

-----END CERTIFICATE-----

This file must be imported into the key store. 

Before proceeding with the following procedure, make sure the issuer that signed your 
certificate exists as a Trusted CA in cacerts. (Use keytoolgui to check your cacerts.) If 
the issuer does not exist, import the root certificate of the CA in the cacerts trust store 
before importing it in Manager’s key store. If the certificate is a chain, you must also import 
all intermediate certificates. 

Follow these steps to import the signed certificate:

1 Copy the signed certificate on the Manager in the 
<ARCSIGHT_HOME>\config\jetty directory.

2 On the Manager machine, run this command in <ARCSIGHT_HOME>\bin:

arcsight keytoolgui

3 Click File->Open Keystore and select the key store (keystore.request or 
webkeystore.request) you saved in Step f in “Obtaining a CA-signed certificate” on 
page 38. You will need to provide the password you used to save the key store in that 
step.

4 Right-click the key pair you created at the beginning of the process and named mykey.

5 Select Import CA Reply from the menu. 

6 Select the CA reply certificate file and click Import. 

If the CA reply file contains a chain of certificates, the keytoolgui utility tries to 
match the reply’s root CA to an existing Trusted Certificate in your cacerts trust store. 
If this operation fails, the Certificate Details dialog appears for manual verification. 
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Acknowledge the certificate by clicking OK and answering Yes to the subsequent 
challenge. Answer No if the certificate is not trustworthy for some reason. 

After the key pair you generated has been updated to reflect the content of the CA 
reply, the key store named keystore.request contains both the private key and 
the signed certificate (in the alias mykey). 

7 Choose Save from the File menu or the toolbar. 

The key store is now ready for use by the ArcSight Manager or ArcSight Web. 

8 Rename <ARCSIGHT_HOME>\config\jetty\keystore to 
<ARCSIGHT_HOME>\config\jetty\keystore.old. 

If, for any reason, the new key store does not work properly, you can revert back to 
the demo key store by replacing keystore.old with the new keystore. 

For ArcSight Web, rename the file to webkeystore.old.

9 Copy <ARCSIGHT_HOME>\config\jetty\keystore.request to 
<ARCSIGHT_HOME>\config\jetty\keystore.

For ArcSight Web, copy webkeystore.request to webkeystore.

10 If your Manager clients trust the CA that signed your server certificate, go to Step 12. 

Otherwise, perform these steps to update the client’s cacerts (trust store):

a Obtain a root certificate from the CA that signed your server certificate and copy it 
to your client machine.

b For one client, use the keytoolgui utility to import the certificate into the trust 
store (cacerts):

i In <ARCSIGHT_HOME>\bin, run this command:

arcsight keytoolgui

ii Click File->Open Keystore.

iii Select the store named cacerts. Use the password changeit to open 
cacerts.

iv Click Tools->Import Trusted Certificate and select the certificate you 
copied in Step 10a of this procedure.

v You will see the following message. Click OK.

 

You also need to perform these steps on the Manager to update the 
Manager’s cacerts so that Manager clients such as the archive utility can 
work.
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vi Enter an alias for the Trusted Certificate you just imported and click OK.

vii Right-click the alias ca in the key store and choose Delete from the menu.

viii Save the key store.

c Copy the <ARCSIGHT_HOME>\jre\lib\security\cacerts file from the 
client in the previous step to all other clients. 

11 If your ArcSight Web browser clients trust the CA that signed your ArcSight Web 
certificate, go to Step 12.

Otherwise, perform these steps:

a Obtain a root certificate from the CA that signed your ArcSight Web certificate.

b Import the certificate into your web browser. See your browser’s documentation 
for details. 

12 Restart the Manager process. 

13 Restart all clients.

14 To verify that the new certificate is being used, point a web browser that trusts the 
CA, which signed the certificate, to ArcSight Web or connect to the Manager using 
your Console.

Replacing an Expired Certificate
When a certificate in your truststore/cacerts expires, you need to replace it with a new one. 
To replace the certificate:

1 Delete the expired certificate from the truststore/cacerts. 

To delete a certificate from the truststore or cacerts, start the keytoolgui and navigate 
to the certificate, right-click on the certificate, and select Delete. 

2 Replace the certificate by importing the new certificate into truststore/cacerts as the 
case may be. Use the keytoolgui to import the new certificate into the truststore or 
cacerts. See “Using a Demo Certificate” on page 33, “Using a Self-Signed Certificate” 
on page 34, or “Using a CA-Signed Certificate” on page 38 section (depending on the 
type of certificate you are importing) for steps on how to import the certificate.

Since the common name (CN) for the new certicate is identical to the CN in the old 
certificate, you are not permitted to have both the expired as well as the new certificate 
co-exist in the truststore, cacerts. 

Establishing SSL Client Authentication
By default, clients (SmartConnectors, Consoles, and ArcSight Web) authenticate using user 
name and password. ESM clients can optionally use SSL authentication for clients. If SSL 

 

Clients will lose connectivity to the Manager after you restart it. However, 
you will be able to reconnect the clients after you perform the next step.
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client authentication is enabled, you can optionally disable user name and password login, 
as described in the next section.

When client-side authentication is used, the SSL clients contain a key store and the SSL 
server contains a trust store. 

Setting up SSL Client Authentication on ArcSight Console 
running in Default Mode

If you want to enable client-side authentication for ArcSight Console running in default 
mode, perform these steps in addition to the ones you perform for setting up server 
authentication:

1 On each Console, generate a key pair. For CA-signed certificate follow the steps in 
section “Obtaining a CA-signed certificate” on page 38.:

a From the Console’s <ARCSIGHT_HOME>\bin directory start the keytoolgui by 
running the following command:

arcsight keytoolgui

b Open File->New Keystore. This will open the New Keystore Type dialog.

c Select JKS and click OK.

d Click Tools->Generate Key Pair and fill in the fields in the following dialog:

 

Before you enable client-side authentication, make sure that you log in to the 
Console and create a new user or modify an existing user such that you set 
the user’s external_id to the one specified in the certificate created on the 
Console. The external id should be set to the users name set as the CN 
(Common Name) setting when creating the certificate.
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e Enter an alias for the key pair in the following dialog and click OK:

f Enter a password for the keystore and confirm it and click OK.

g You will see the following message.

2 Export the key pair you just generated.

a In the keytoolgui right-click the key pair you just generated and select Export.

If you plan to install the Console, Manager, and Web on the same machine, 
make sure that this alias is unique. Also, make sure not to use the machine 
name or IP address for the alias. ArcSight Web and Console cannot have 
identical CNs when installed on the same machine as the Manager. 

When you install ArcSight Web, you will be required to set the CN of the 
ArcSight Web’s key pair you generate to the name or IP address of the 
machine on which you are installing it. Hence, if both Web and Console are on 
the same machine, and if you use the machine name or IP address for the CN 
for both the Web and the Console, then ArcSight Web will give you an error 
when configuring. 
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b Make sure to select Head Certificate as Export Type and DER Encoded as the 
Export Format in the following dialog and click OK:

c Enter a name for the certificate and click Export.

d You will see the following message:

e If your Console is on a different machine than the Manager, copy this certificate to 
the Manager’s machine.

3 If you are using self-signed certificate skip this step and continue with step 4. 

Import the signed certificate response in the keystore of all Consoles.

Import the signed certificate response in the Console’s keystore, 
keystore.client. Follow the steps in section “Importing a CA-signed 
certificate into Manager’s key store” on page 40.

Use the changepassword tool to set an encrypted key store password in the 
client.properties file:
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arcsight changepassword -f config\client.properties -p 
ssl.keystore.password

4 Save the keystore in the Console’s <ARCSIGHT_HOME>\config directory by clicking 
on File->Save KeyStore.

a Enter a password for the keystore and confirm it.

b Give the keystore a name and click Save.

5 Change the following properties in the Console’s 
<ARCSIGHT_HOME>\config\client.properties file and save the file:

ssl.keystore.password=<set-this-to-password-set-when-you-saved-
the-keystore>

ssl.keystore.path=config\keystore.client

6 Import Console’s certificate into the Manager’s truststore.

If your Manager trusts the CA that signed your Console’s certificates, go to the next 
step. Otherwise perform these steps to update the Manager’s truststore.

a Start the keytoolgui by entering arcsight keytoolgui command from the 
Manager’s bin directory.
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b Click File->Open KeyStore and navigate to 
<ARCSIGHT_HOME>\config\jetty\truststore.

c Enter “changeit” (without the quotes) when prompted for the password and click 
OK.

d Click Tools->Import Trusted Certificate.

e Navigate to the Console’s certificate that you exported earlier and click Import.

f You will see the following message. Click OK.
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g Review the certificate details and click OK.

h Click Yes in the following dialog.

i Enter an alias for the certificate.

j You will get the following message if the import was successful.

k Click OK and save the changes to the truststore.

7 Export the Console’s private key. If you use ArcSight Web, you are required to import 
the Console’s private key into the Web browser you use with ArcSight Web.

a Start the keytoolgui from the Console’s bin directory.
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b Click on File->Open KeyStore and navigate to the Console key store you 
created.

c Right-click on the Console’s key pair and select Export.

d Select Private Key and Certificates as Export Type and PKCS#12 as the 
Export Format if not already selected and click OK.

e Enter the password that you had set for the Console’s keystore when prompted 
and click OK.

f Enter a new password for the keystore and confirm the password and click OK.
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g Enter a name for the Console’s private key with a .pfx extension and click Export.

h You will receive a message saying Export Successful. Click OK and exit the 
keytoolgui.

8 Exit keytoolgui.

9 Restart the Manager.

10 Restart ArcSight Console.

Setting up SSL Client Authentication on ArcSight Web
If you want to enable client-side authentication for clients running in default mode, perform 
these steps in addition to the ones you perform for setting up server authentication:

1 Generate a key pair on ArcSight Web. For CA-signed certificate follow the steps in 
section “Obtaining a CA-signed certificate” on page 38

a From the Web’s <ARCSIGHT_HOME>\bin directory start the keytoolgui by 
running the following command:

arcsight keytoolgui

b Open File->New Keystore. This will open the New Keystore Type dialog.

c Select JKS and click OK.
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d Click Tools->Generate Key Pair and fill in the fields in the following dialog:

e Enter an alias for the key pair and click OK:

2 Export the key pair you just generated.

a In the keytoolgui right-click the key pair you just generated and select Export 
Key pair.

b Make sure to select Head Certificate as Export Type and DER Encoded as the 
Export Format in the following dialog and click OK:

Make sure to use the machine name or IP address on which ArcSight Web is 
installed for the CN name.
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c Enter a name for the certificate and click Export.

d You will see the following message:

e If your ArcSight Web is on a different machine than the Manager, copy this 
certificate to the Manager’s machine.

3 Save the keystore in the Web’s <ARCSIGHT_HOME>\config directory by clicking on 
File->Save KeyStore.

a Enter a password for the keystore and confirm it.

b Give the keystore a name and click Save.

4 If you are using self-signed certificate skip this step and continue with step 5. 

Import the signed certificate response in the keystore of ArcSight Web.

Import the signed certificate response in the Web’s keystore. Follow the steps in 
section “Importing a CA-signed certificate into Manager’s key store” on page 40.

Use the changepassword tool to set an encrypted key store password in the 
client.properties file:

arcsight changepassword -f config\client.properties -p 
ssl.keystore.password

5 Add the following properties in the Web’s 
<ARCSIGHT_HOME>\config\client.properties file and save the file:

ssl.keystore.password=<password-set-when-you-saved-the-keystore
>
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ssl.keystore.path=config\jetty\webkeystore

6 Import Web’s key pair into the Manager’s truststore.

If your Manager trusts the CA that signed your client’s certificates, go to the next step. 
Otherwise perform these steps to update the Manager’s truststore.

a Start the keytoolgui by entering arcsight keytoolgui command from the 
Manager’s bin directory.

b Click File->Open KeyStore and navigate to 
<ARCSIGHT_HOME>\config\jetty\truststore.

c Enter “changeit” (without the quotes) when prompted for the password and click 
OK.

d Click Tools->Import Trusted Certificate.

e Navigate to the Web’s certificate that you exported earlier and click Import.
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f You will see the following message. Click OK.

g Review the certificate details and click OK.

h Click Yes in the following dialog.

i Enter an alias for the certificate.

j You will get the following message if the import was successful.

k Click OK and save the changes to the truststore.

7 Import Console’s certificate into webtruststore.

a Start the keytoolgui from ArcSight Web’s bin directory.

b Click File->Open KeyStore and navigate to the Web’s 
<ARCSIGHT_HOME>\config\jetty\webtruststore.

c Enter “changeit” (without quotes) when prompted for password.

d Click Tools->Import Trusted Certificate.
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e Navigate to the Console’s certificate and click Import.

f Click OK in the next message box prompting you that “Could not establish a trust 
path for the certificate...”

g View the certificate details and click OK.

h Click Yes when prompted whether you want to accept the certificate as trusted.

i Enter an alias for the console’s certificate and click OK.

j You will see a message saying “Trusted Certificate Import Successful.”

k Click OK. 

l Save changes to the webtruststore and exit the keytoolgui.

8 Import the following into the web browser that you will be using with ArcSight Web:

Web’s certificate you exported in Step 2 on page 51 above.

Console’s private key you created in Step 7 on page 48 in section “Setting up SSL 
Client Authentication on ArcSight Console running in Default Mode” on page 43.

See your web browser’s documentation for steps to do the above.

9 Restart the Manager.

10 Restart ArcSight Web.

Migrating from one certificate type to another
When you migrate from one certificate type to another on the Manager, you have to update 
all Consoles, SmartConnectors, and ArcSight Web installations.

Migrating from Demo to Self-Signed
To migrate from a demo to self-signed certificate:

1 Follow the steps described in “Using a Self-Signed Certificate” on page 34.

2 Follow the instructions in “Verifying SSL Certificate Use” on page 56 to ensure that a 
self-signed certificate is in use.

Migrating from Demo to CA-Signed
To migrate from a demo to CA-Signed certificate:

1 Follow the steps described in “Using a CA-Signed Certificate” on page 38.

2 Follow the instructions in “Verifying SSL Certificate Use” on page 56 to ensure that 
CA-signed certificate is in use.

Migrating from Self-Signed to CA-Signed
To migrate from a self-signed to CA-signed certificate:

1 Follow the steps described in “Using a CA-Signed Certificate” on page 38.

2 Follow the instructions in “Verifying SSL Certificate Use” on page 56 to ensure that a 
CA-signed certificate is in use.
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Verifying SSL Certificate Use
After the migration, run this command in <ARCSIGHT_HOME>\bin on the client to ensure 
the certificate type you intended is in use: 

arcsight tempca –i

In the resulting output, a sample of which is available below, do the following:

1 Review the value of the line: Demo CA trusted.

The value should be “no.”

If the value is “yes,” the demo certificate is still in use. Follow these steps to stop using 
the demo certificate:

a In <ARCSIGHT_HOME>\bin, enter the following command to make the client 
stop using the currently in use demo certificate:

arcsight tempca -rc 

For SmartConnectors, run:

arcsight agent tempca –rc

b Restart the client.

2 Verify that the Certificate Authority that signed your certificate is listed in the output. 

For a self-signed certificate, the Trusted CA will be the name of the machine on which 
you created the certificate

Sample output for verifying SSL certificate use
This is a sample output of the arcsight tempca –i command:

ArcSight TempCA starting...

SSL Client

  Trust Store C:\arcsight\Console\jre\lib\security\cacerts

    Type JKS

    Demo CA trusted no

    Trusted CA Equifax Secure eBusiness CA-1 []

    Trusted CA VeriSign Class 1 Public Primary 

    Trusted CA VeriSign Trust Network [...]

    Trusted CA VeriSign Class 3 Public Primary 

 .

 .

 .

Demo CA

  Key Store C:\arcsight\Console\config\keystore.tempca

Exiting...
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Using Certificates to Authenticate Users to ArcSight
Instead of using a user name and password to authenticate a user to ArcSight Manager or 
ArcSight Web, you can configure these systems to use a digitally-signed user certificate. 
This section tells you how to do that. You can use Manager’s this capability in environments 
that make use of Public Key Infrastructure (PKI) for user authentication. 

The Manager and ArcSight Web accept login calls with empty passwords and use the 
Subject CN (Common Name) from the user’s certificate to identify the user.

You must enable SSL client authentication as described in the previous section to use 
digitally-signed user certificates for user authentication. 

To configure the Manager or ArcSight Web to use user certificates, do the following:

1 On the Console, make sure that External ID field in the User Editor for every user is set 
to a value that matches the CN in their user certificate.

2 Restart the system you are configuring.

3 Restart the Consoles.

When you start the Console, the user name and password fields will be grayed out. Simply 
select the Manager to which you want to connect and click OK to log in. 

Using the Certificate Revocation List (CRL)
Starting in v4.0 SP2, ArcSight ESM supports the use of CRL to revoke a CA-signed 
certificate which has been invalidated. The CA that issued the certificates also issues a CRL 
file which contains a signed list of certificates which it had previously issued that it now 
considers invalid. ArcSight Manager checks the client certificates against the list of 
certificates listed in the CRL and denies access to clients whose certificates appear in the 
CRL.

Before you use the CRL feature, make sure:

Your certificates are issued/signed by a valid Certificate Authority or an authority with 
an ability to revoke certificates.

The CA’s root certificate is present in the Manager’s 
<ARCSIGHT_HOME>\config\jetty\truststore directory.

The Manager validates the authenticity of the client certificate using the root certificate 
of the signing CA.

You have a current CRL file provided by your CA. 

The CA updates the CRL file periodically as and when additional certificates get 
invalidated.

To use the CRL feature:

1 Make sure you are logged out of the Console.

 

Before you enable client-side authentication, make sure that you log in to the 
Console and create a new user or modify an existing user such that you set 
the user’s external_id to the one specified in the certificate created on the 
Console. The external id should be set to the users name set as the CN 
(Common Name) setting when creating the certificate.
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2 Copy the CA-provided CRL file into your Manager’s 
<ARCSIGHT_HOME>\config\jetty\crls directory.

After adding the CRL file, it takes approximately a minute for the Manager to get 
updated.

Reconfiguring the ArcSight Console after Installation
You can reconfigure ArcSight Console at anytime by typing arcsight consolesetup 
within a command prompt window. 

Run the ArcSight Console Configuration Wizard by entering the following command in a 
command window in the <ARCSIGHT_HOME>\bin directory:

arcsight consolesetup

To run the ArcSight Console Setup program without the graphical user interface, type:

arcsight consolesetup -i console

The ArcSight Console Configuration Wizard appears.

Reconfiguring ArcSight Manager
To reconfigure ArcSight Manager settings made during installation, run the ArcSight 
Manager Configuration Wizard by typing the following command in a terminal box or 
command prompt window:

arcsight managersetup

The arcsight managersetup command opens the ArcSight Manager Configuration Wizard, 
but you can also run the ArcSight Manager Setup program silently by typing:

arcsight managersetup -i console

The ArcSight Manager Configuration Wizard appears to help you re-configure ArcSight 
Manager. 

To change advanced configuration settings (port numbers, database settings, log location, 
and so on) after the initial installation, change the server.properties file. ArcSight’s 
default settings are listed in the server.defaults.properties file. You can override 
these default settings by adding the applicable lines from 
server.defaults.properties to the server.properties file. These files are 
located in <ARCSIGHT_HOME>\config. 

Changing ArcSight Manager Ports
In order for every component of ArcSight to communicate, any ArcSight SmartConnectors 
and ArcSight Consoles must be aware of what IP address the ArcSight Manager is running 
on. Also, the ArcSight SmartConnectors and ArcSight Consoles must use the same HTTP or 
HTTPS port numbers the ArcSight Manager is currently using.

ArcSight Manager uses a single port (by default, 8443) that any firewalls between the 
ArcSight Manager, ArcSight Console, and any ArcSight SmartConnectors must allow 
communication through. Port 8443 is the default port used when initially installing 
ArcSight, however, you can change this default port number using the ArcSight Manager 
Configuration Wizard. For more information, refer to the ArcSight ESM Installation and 
Configuration Guide.
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Changing ArcSight Web Session Timeouts
The session timeout affects the web browser pages (i.e., Knowledge Base, reports, and so 
forth) that appear within ArcSight Web. After the session has elapsed, or timed out, you 
must log back into ArcSight Web to start a new session. You can change the Web default 
session timeout in this file in the Manager’s:

<ARCSIGHT_HOME>\config\jetty\server.xml

The ArcSight Web default session timeout can be changed in this file in ArcSight Web’s:

<ARCSIGHT_HOME>\config\jetty\webserver.xml

In the above .xml files you will see the following lines:

<session-config>

<session-timeout>15</session-timeout>

</session-config>

The value specified, in this case 15, is the session timeout in minutes. Simply change this 
number to the session timeout desired and save the file.

Manager Password Configuration
ArcSight Manager supports a rich set of functionality for managing users passwords. This 
section describes various password configuration options. Generally, all the settings are 
made by editing the server.properties file. See “Managing and Changing Properties 
File Settings” on page 7.

Enforcing Good Password Selection
There are a number of checks that ArcSight Manager performs when a user picks a new 
password in order to enforce good password selection practices.

Password Length
The simplest one is a minimum and, optionally, a maximum length of the password. The 
following keys in server.properties affect this:

auth.password.length.min=6

auth.password.length.max=20

By default, the minimum length for passwords is six characters and the maximum length is 
20 characters and can contain numbers and/or letters.

Configuring the above properties to a value of -1 sets the password length to unlimited 
characters.

Restricting Passwords Containing User Name
 Another mechanism that enforces good password practices is controlled through the 
following server.properties key:

auth.password.userid.allowed=false

When this key is set to false (the default), a user cannot include their user name as part of 
the password.
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Requiring Mix of Characters in Passwords
Good passwords consist not only of letters, but contain numbers and special characters as 
well. This makes them a lot harder to guess and, for the most part, prevents dictionary 
attacks. 

By default, the minimum length for passwords is six characters and the maximum length is 
20 characters and can contain numbers and/or letters.

The following properties control the distribution of characters allowed in new passwords: 

auth.password.letters.min=-1

auth.password.letters.max=-1

auth.password.numbers.min=-1

auth.password.numbers.max=-1

auth.password.whitespace.min=0

auth.password.whitespace.max=0

auth.password.others.min=-1

auth.password.others.max=-1

The *.min settings can be used to enforce that each new password contains a minimum 
number of characters of the specified type. The *.max settings can be used to limit the 
number of characters of the given type that new passwords can contain. Letters are all 
letters from A-Z, upper and lowercase, numbers are 0-9; “whitespace” includes spaces, 
etc.; “others” are all other characters, including special characters such as #$%@!. 

Additionally, the following server.properties key lets you restrict the number of 
consecutive same characters allowed.

auth.password.maxconsecutive=3

For example, the default setting of 3 would allow "adam999", but not "adam9999" as a 
password. 

Furthermore, the following server.properties key enables you to specify the length of 
a substring that is allowed from the old password in the new password.

auth.password.maxoldsubstring=-1

For example, if the value is set to 3 and the old password is “secret”, neither “secretive” 
nor “cretin” is allowed as a new password. 

Checking Passwords with Regular Expressions
To accommodate more complex password format requirements, ArcSight Manager can also 
be set up to check all new passwords against a regular expression. The following 
server.properties keys can be used for this purpose: 

auth.password.regex.match=

auth.password.regex.reject=

The auth.password.regex.match property describes a regular expression that all 
passwords have to match. If a new password does not match this expression, ArcSight 
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Manager rejects it. The auth.password.regex.reject property describes a regular 
expression that no password may match. If a new password matches this regular 
expression, it is rejected. 

For more information on creating an expression for this property, see 
http://www.regular-expressions.info/. The following are a few examples of regular 
expressions and a description of what they mean. 

auth.password.regex.match= /^\\D.*\\D$/

Only passwords that do not start or end with a digit are accepted. 

auth.password.regex.match= 
^(?=.*[A-Z].*[A-Z])(?=.*[a-z].*[a-z])(?=.*[0-9].*[0-9])(?=.*[^a
-zA-Z0-9].*[^a-zA-Z0-9]).{10,}$

Only passwords that contain at least 10 characters with the following breakdown are 
accepted:

At least two upper case letters

At least two lower case letters

At least two digits

At least two special characters (no digits or letters)

auth.password.regex.reject= 
^(?=.*[A-Z].*[A-Z])(?=.*[a-z].*[a-z])(?=.*[0-9].*[0-9])(?=.*[^a
-zA-Z0-9].*[^a-zA-Z0-9]).{12,}$

The passwords that contain 12 characters with the following breakdown are rejected:

At least two upper case letters

At least two lower case letters

At least two digits

At least two special characters (no digits or letters)

Password Uniqueness
In some environments, it is also desirable that no two users use the same password. To 
enable a check that ensures this, the following server.properties key can be used: 

auth.password.unique=false

If set to true, ArcSight Manager checks all other user’s passwords and makes sure nobody 
else is using the same password. 

 

Backslash ( \ ) characters in regular expressions must be duplicated 
(escaped)—instead of specifying \, type \\.

 

This feature may not be appropriate for some environments as it allows valid 
users of the system to guess other user’s passwords.
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Setting Password Expiration
ArcSight Manager can be set up to expire passwords after a certain number of days, 
forcing users to choose new passwords regularly. This option is controlled by the following 
key in server.properties: 

auth.password.age=60

By default, a password expires 60 days from the day it is set. 

When this setting is used, however, some problems arise for user accounts that are used 
for automated log in, such as the user accounts used for Manager Forwarding Connectors. 
These user accounts can be excluded from password expiration using the following key in 
server.properties:

auth.password.age.exclude=username1,username2

This value is a comma-separated list of usernames. The passwords of these users never 
expire. 

ArcSight Manager can also keep a history of a user’s passwords to make sure that 
passwords are not reused. The number of last passwords to keep is specified using the 
following key in server.properties:

auth.password.different.min=1

By default, this key is set to check only the last password (value = 1). You can change this 
key to keep up to last 20 passwords. 

Restricting the Number of Failed Log Ins
ArcSight Manager tracks the number of failed log in attempts to prevent brute force 
password guessing attacks. By default, a user's account is disabled after three failed log in 
attempts. This feature is controlled through the following key in server.properties: 

auth.failed.max=3

Change this to the desired number or to -1 if you do not wish user accounts to be 
disabled, regardless of the number of failed log in attempts. 

Once a user account has been disabled, ArcSight Manager can be configured to 
automatically re-enable it after a certain period of time. This will reduce the amount of 
administrative overhead, while at the same time effectively preventing brute force attacks. 
This mechanism is controlled by the following key in server.properties:

auth.auto.reenable.time=10

This value specifies the time, in minutes, after which user accounts are automatically 
re-enabled after they were disabled due to an excessive number of incorrect log ins. Set 
the property key to -1 to specify that user accounts can only be re-enabled manually.

Re-Enabling User Accounts
Under normal circumstances, user accounts that have been disabled—for example, as a 
result of too many consecutive failed log ins—can be re-enabled by any user with sufficient 
permission. Check the Enabled check box for a particular user in the User Inspect/Editor 
panel in the ArcSight Console.
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If there is no user with sufficient privileges remaining enabled—for example, if the only 
remaining administrator user account is disabled—a command line tool can be run on the 
system where ArcSight Manager is installed to re-enable user accounts. First, ensure that 
the ArcSight Manager is running. Then, from the command line, run the following 
command: 

arcsight reenableuser username

where username is the name of the user you want to re-enable. After this procedure, the 
user can log in again, using the unchanged password.

Compression and Turbo Modes
Enabling Compression for ArcSight SmartConnector 
Events

ArcSight SmartConnectors can send event information to the ArcSight Manager in a 
compressed format using HTTP compression. The compression technique used is standard 
GZip, providing compression rates of 1:10 or higher, depending on the input data (in this 
case, the events the ArcSight SmartConnector is sending). Using compression lowers the 
overall network bandwidth used by ArcSight SmartConnectors dramatically, without 
impacting their overall performance.

By default, all ArcSight SmartConnectors have compression enabled. To turn it off, add the 
following line to the <ARCSIGHT_HOME>\user\agent\agent.properties file:

compression.enabled = false

ArcSight SmartConnectors will determine whether the ArcSight Manager they are sending 
events to supports compression (ArcSight Manager version 2.2 or later).

Understanding ArcSight Turbo Modes
If your configuration, reporting, and analytic usage permits, you can accelerate the transfer 
of sensor information through SmartConnectors by choosing one of the "turbo" modes. The 
default transfer mode is called Complete, which passes all the data arriving from the 
device, including any additional data (custom, or vendor-specific).

ArcSight SmartConnectors can be configured to send more or less event data, on a 
per-SmartConnector basis, and the ArcSight Manager can be set to read and maintain more 
or less event data, independent of the SmartConnector setting. Some events require more 
data than others. For example, operating system syslogs often capture a considerable 
amount of environmental data that may or may not be relevant to a particular security 
event. Firewalls, on the other hand, typically report only basic information. 

ArcSight defines the following Turbo Modes:

When Turbo Mode is not specified (mode 3, Complete), all event data arriving at the 
SmartConnector, including additional data, is maintained. (Versions of ArcSight prior to 3.0 

Turbo Modes

1 Fastest Recommended for firewalls

2 Faster Manager default
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ran in Turbo Mode 3.) Turbo Mode 2, Faster, eliminates the additional custom or 
vendor-specific data, which is not required in many situations. Turbo Mode 1, Fastest, 
eliminates all but a core set of event attributes, in order to achieve the best throughput. 
Because the event data is smaller, it requires less storage space and provides the best 
performance. It is ideal for simpler devices such as firewalls. 

The ArcSight Manager processes event data using its own Turbo Mode setting. If 
SmartConnectors report more event data than the Manager needs, the Manager ignores 
the extra fields. On the other hand, if the Manager is set to a higher Turbo Mode than a 
SmartConnector, the Manager will maintain fields that are not filled by event data. Both 
situations are normal in real-world scenarios, because the Manager configuration reflects 
the requirements of a diverse set of SmartConnectors.

Event data transfer modes are numbered (1 for Fastest, 2 for Faster, 3 for Complete), and 
possible Manager-SmartConnector configurations are therefore:

1-1 Manager and SmartConnector in Fastest mode

1-2 SmartConnector sending more sensor data than Manager needs

1-3 SmartConnector sending more sensor data than Manager needs

2-1 SmartConnector not sending all data that Manager is storing*

2-2 Manager and SmartConnector in Faster mode

2-3 Default: Manager does not process additional data sent by SmartConnector

3-1 Manager maintains Complete data, SmartConnector sends minimum*

3-2 Manager maintains additional data, but SmartConnector does not send it

3-3 Manager and SmartConnector in Complete mode

*When the SmartConnector sends minimal data (Turbo Mode 1), the Manager can infer 
some additional data, creating a 2-1.5 or a 3-1.5 situation.

Configuring the ArcSight Database Monitor
The Database Monitor is an ArcSight Manager component that monitors the ArcSight 
Database for critical conditions. The Database Monitor performs the following check tasks 
to ensure that the ArcSight Database can always be used by the ArcSight Manager:

Free space in Oracle tablespaces: This check will send an e-mail message if the free space 
in any of the Oracle tablespaces falls below a specified threshold.

Database failure: This check will send an e-mail message if the connection to the database 
is lost or if the ArcSight Manager detects a fatal, unrecoverable situation in the database, 
such as lack of disk space.

If a critical condition occurs, the ArcSight Manager will stop accepting incoming events 
from ArcSight SmartConnectors and, in some cases, will also stop Console sessions. A 
message is printed to server.std.log and server.log and sent to a list of administrators via 
e-mail. The message will contain a URL that can be used to reactivate ArcSight Manager 
after the problem has been addressed. In many cases, however, the ArcSight Manager can 
detect that the problem has been resolved and will resume normal operation automatically. 
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For more information about database checks performed to monitor configuration and 
runtime attributes of your database, see Appendix C‚ Monitoring Database Attributes‚ on 
page 265.

Configuring Database Monitor e-mail message recipients
Use the ArcSight Manager Configuration Wizard to configure Database Monitor e-mail 
message recipients. Run the ArcSight Manager Configuration Wizard by typing arcsight 
managersetup in a command prompt window or terminal box. The ArcSight Notifier is 
not used for Database Monitor notifications since the ArcSight Manager could already be in 
such a fatal state that the Notifier may not be able to function properly.

Configuring the check for free space in Oracle tablespaces
You can set the threshold for checking free space in a tablespace. An e-mail message is 
sent if the free space in a tablespace falls below the threshold specified. The threshold is 
specified as a percentage. In <ARCSIGHT_HOME>\config\server.properties, set 
the threshold:

databaseinfo.oracle.freespace.percentage.threshold=5

You can also explicitly exclude certain tablespaces from the check in 
server.properties. By default, the system tablespace is excluded:

databaseinfo.oracle.freespace.exclude.tablespaces=SYSTEM

Sending Events as SNMP Traps
ArcSight can send a sub-stream of all incoming events (that includes rule-generated 
events) via SNMP to a specified target. A filter is used to configure which events will be 
sent. ArcSight’s correlation capabilities can be used to synthesize network management 
events that can then be routed to your enterprise network management console.

Configuration of the SNMP trap sender
The SNMP trap sender is configured using the ArcSight Manager configuration file. The 
<ARCSIGHT_HOME>\config\server.default.properties file includes a template 
for the required configuration values. Copy those lines into your 
<ARCSIGHT_HOME>\config\server.properties file and make the changes there. 
After making changes to this file, you need to restart the ArcSight Manager. 

properties: The following provides a description of specific SNMP configuration parameters:

snmp.trapsender.enabled=true

Set this property to true in order to enable the SNMP trap sender.

snmp.trapsender.uri=

/All Filters/System Filters/SNMP Trap Sender

Setting the Manager to send SNMP v3 traps is not FIPS compliant. This is 
because SNMP v3 itself uses MD5 algorithm. However, SNMPv1 and v2 are 
compliant.
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 The filter (specified by URI, all on one line) is used to decide whether or not an event is 
forwarded. There is no need to change the URI to another filter, as the "SNMP Trap 
Sender" filter can be changed through the ArcSight Console. Changes to the filter specified 
will immediately affect the SNMP trap sender. By default, the "SNMP Trap Sender" filter 
logic is Matches Filter (Correlated Events)—that is, only rules-generated events will be 
forwarded.

snmp.destination.host=

snmp.destination.port=162

 The host name and the port of the SNMP listener that wants to receive the traps.

snmp.read.community=public

snmp.write.community=public

The SNMP community strings needed for the traps to make it through to the receiver. The 
read community is reserved for future use, however, the write community must match the 
community of the receiving host. This will depend on your deployment environment and 
your receiving device. Please consult your receiving device's documentation to find out 
which community string should be used.

snmp.version=1

snmp.fields=\

event.eventId,\

event.eventName,\

event.eventCategory,\

event.eventType,\

event.baseEventCount,\

event.arcsightCategory,\

event.arcsightSeverity,\

event.protocol,\

event.sourceAddress,\

event.targetAddress

These event attributes should be included in the trap. The syntax follows the 
SmartConnector SDK as described in the FlexConnector Developer’s Guide. All the ArcSight 
fields can be sent. The identifiers are case sensitive, do not contain spaces and must be 
capitalized except for the first character. For example:

ArcSight Field SDK/SNMP trap sender identifier

Event Name eventName

Device Severity deviceSeverity

Service service
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The SNMP field types will be converted as:

Additional data values are accessible by name, for example:

snmp.fields=event.eventName,additionaldata.myvalue

This will send the Event Name field and the value of myvalue in the additional data list 
part of the SNMP trap. Only the String data type is supported for additional data, therefore 
all additional data values will be sent as OCTET STRING.

ArcSight SNMP

STRING OCTET STRING

INTEGER INTEGER32

Address IP ADDRESS

LONG OCTET STRING

BYTE INTEGER
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Chapter 3

Database Administration

This chapter describes the different tasks that you can perform in order to effectively 
manage and maintain the ArcSight Database. The topics covered in this chapter include:

Changing Oracle Initialization Parameters
Almost all database parameters can be changed after an instance is created. Some of these 
parameters are dynamic, whereas many others are static. You can change a dynamic 
parameter while the instance is running. However, to change a static parameter, you have 
to change its setting in the initialization parameter file and restart the database to have the 
modified parameter setting take effect.

Changing these parameters is recommended only for experienced database administrators.

An instance created using an ArcSight template uses a binary version of the initialization 
parameter file when the database starts up. The binary version (also known as SPFILE) is, 
by default, on UNIX:

$ORACLE_HOME/dbs/spfile$ORACLE_SID.ora 

and, on Windows:

%ORACLE_HOME%\database\SPFILE%ORACLE_SID%.ORA

The ArcSight Installer also generates a text version of the initialization parameter file (also 
known as PFILE), which is, by default, on UNIX:

“Changing Oracle Initialization Parameters” on page 69

“Monitoring Available Free Space in Tablespaces” on page 70

“Setting Up Database Threshold Notification” on page 70

“Resetting the Oracle Password” on page 70

“Speeding up partition compression” on page 71

“Partition logs” on page 71

To enhance database security and lessen your risk and vulnerability, if you did 
not use the ArcSight DB Installer to create and configure the ArcSight 
Database, it is highly recommended that you change the default passwords for 
the SYS and SYSTEM Oracle user accounts and lock the three accounts 
DBSNMP, TRACESVR, and OUTLN. In addition, you should delete the following 
automatically-created Oracle user accounts: ADAMS, BLAKE, CLARK, JONES, 
and SCOTT. These accounts may have been generated by the Oracle installer.
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$ORACLE_HOME/admin/$ORACLE_SID/pfile/ini.ora

and, on Windows:

%ORACLE_HOME%\..\admin\pfile\%ORACLE_SID%.ora

When making changes to dynamic parameters, the binary initiation parameter file will be 
updated automatically. However, Oracle does not synchronize the text version with the 
binary version automatically. You will have to log in as SYS (use the command, arcdbutil 
sql and type in / as sysdba when prompted for the user name) and run the following 
command to update the text version:

CREATE PFILE='InitParamFilePath' FROM SPFILE

Where InitParamFilePath is the text version. After making changes to static 
parameters by editing the text version, you will have to re-start the database. You log in as 
SYS (use the command, arcdbutil sql and type in / as sysdba when prompted for 
the user name) and run the following command to update the binary version:

STARTUP PFILE='InitParamFilePath';

If you have the full Oracle license, you can run the sql / as sysdba command directly 
instead of using arcdbutil.

Without following these procedures, changes to either version will be lost when the 
database is re-started.

Monitoring Available Free Space in Tablespaces
Write scripts to alert when the file systems reach a threshold—say 85%. You can use 
standard df -k command on Unix systems.

Setting Up Database Threshold Notification
The ArcSight Manager can be configured to automatically notify the administrator when an 
ArcSight tablespace is nearly full. The default threshold setting is in the file 
config\server.defaults.properties (under <ARCSIGHT_HOME> on the Manager 
host):

databaseinfo.freespace.warning.threshold=5

This example reflects the default setting, which sends an alert when the amount of free 
space in any of the ArcSight tablespaces for data or indexes falls to 5% or below.

To override the default threshold, copy this line from the read-only file 
server.defaults.properties to server.properties and change the threshold 
value. 

Resetting the Oracle Password
Depending upon your Oracle settings, you may need to reset your password from time to 
time. Oracle can be set to expire passwords, which will lock out the ArcSight Manager. To 
reset or renew the password for the ArcSight Database user (arcsight by default), log in 
to Oracle with / as sysdba and run the following command:

ALTER USER arcsight IDENTIFIED BY ArcSightPassword ACCOUNT UNLOCK

Oracle database passwords must start with a letter followed by letters, digits, ‘_’, ‘#’, or ‘$.’
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If you change the password for the ArcSight Database user, you will have to reconfigure 
the ArcSight Manager and Partition Archiver to use the new password.

To reconfigure ArcSight Manager password, run the ArcSight Manager Configuration Wizard 
by typing the following command in a command window on the Manager host in 
<ARCSIGHT_HOME>\bin:

arcsight managersetup

If you change the password for the ArcSight Database user, run the command  
arcsight database pc to update the password so that Partition Archiver can continue 
to log in.

Speeding up partition compression
Starting in ArcSight ESM v3.0 SP2 Patch2, the NOLOGGING option is disabled by default to 
allow event data backup and use of DataGuard. As a result, redo log entries are generated 
for all database operations (including data compression by Partition Compressor), making 
the compression process appear somewhat slow.

If database backup is not required or DataGuard is not being used, you can speed up the 
compression process by enabling the NOLOGGING option for Partition Compressor.

To enable the NOLOGGING option for Partition Compressor, add the following line to the 
config\server.properties file:

partition.compress.exchange.table.logging=false

Partition logs
All log entries including the ones for the database partition utilities are written to the 
server.log file on the ArcSight Manager. In addition, the partition entries are duplicated 
to one of the following log files on the Manager:

partitionmanager.log—For Partition Manager logs

partitioncompressor.log—For Partition Compressor logs

partitionarchiver.log—For Partition Archiver logs

partitionstatisticsupdater.log—For Partition Statistics Updater logs

Entries in a duplicate log file are specific to a partition utility and are based on the log filters 
defined in <ARCSIGHT_HOME>\config\server.defaults.properties file for that 
utility. These duplicate files enable you to easily browse the relevant information about a 
partition utility. Additionally, these files are attached in e-mail notifications sent from the 
partition management utilities.

Additional Partition Archiver logs are available on the ArcSight database machine. These 
logs are more detailed than the ones available on the Manager and are duplicated to 
<ARCSIGHT_HOME>\logs\partitionarchiver.log file on the database machine. 
Unlike the duplicated Manager log files, this file is not sent in e-mail notifications.

For information about incomplete logs, see the “Database” on page 261 of the 
Troubleshooting chapter in this guide.
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Chapter 4

Managing Resources

This chapter discusses the administrator tasks necessary to manage ArcSight ESM.

“Managing Users” on page 74

“Managing Permissions and Resources” on page 79

“Locking and Unlocking Resources” on page 90

“Modeling Your Network” on page 92

“Working with Assets, Locations, Zones, Networks, Vulnerabilities, and Categories” on 
page 111

“Managing Filters” on page 123

“Managing Notifications” on page 126

“Managing File Resources” on page 131

“Managing Packages” on page 135

“Managing SmartConnectors” on page 142

“Selecting Resources” on page 179

“Finding Resources” on page 180

“Visualizing Resources” on page 183

“Viewing Resources in Grids” on page 186

“Validating Resources” on page 186

“Extending Audit Event Logging” on page 193

“Managing Partitions” on page 193

“Managing Customers” on page 197

“Saving Copies of Read-Only Resources” on page 198

“Using the Image Editor” on page 198

“Common Resource Attribute Fields” on page 198
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Managing Users
You manage numbers of users by organizing them into groups based on roles or other 
logical groupings, setting their permissions and passwords, and enabling or disabling their 
login functionality. Permissions to access specific ArcSight resources (for example, to create 
rules or reports) are granted to specific groups by editing the access control lists (ACLs) for 
those groups.

All ArcSight user group memberships and permissions are stored in the ArcSight Database. 
When users log in, they are allowed to perform any operations for which they are granted 
permission through their membership in one or more groups.

Handling Users
When you create an ArcSight user, that person automatically receives access to a set of 
resource groups. Users can store, create, edit, or delete resources within their groups 
without jeopardizing other users' resources.

Creating a User
1 In the Navigator panel drop-down menu, choose Users.

2 In the Users resource tree, right-click the group in which to place the new user and 
choose New User.

3 In the User Editor, fill in these fields on the Attributes tab in the Login section:

User Fields Description

User ID User name for login ID. This is a required field.

User Type Choose a user type from the drop-down menu. This is a required 
field.

The currently supported user types are:

• Normal User: Has full privileges to use the ArcSight Console or 
ArcSight Web client, and all tools. Only apply this user type to 
accounts that actually need access to the ArcSight Manager.

• Management Tool: Has only the privileges needed to run 
certain management tools used in conjunction with network 
management products.

• Forwarding Connector: Has only the privileges needed by the 
ForwardingConnector.

• Archive Utility: Has only the privileges needed to run the 
archive utility. Access to specific resources is controlled through 
ACLs.

• Connector Installer: A specialized identity used only to add 
SmartConnectors to the system.

• Web User: Has privileges to use the ArcSight Web client only 
(not the ArcSight Console or other tools).

See also “About the System User” on page 77.
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4 Fill in these fields on the Attributes tab in the User section:

5 In the UserID text field, enter a user login name. This field is required.

6 Click OK.

Login Enabled • Select the Login Enabled checkbox to give the user login 
privileges (a checkmark indicates this feature is on):

 

• Or leave it deselected and off (no checkmark showing) to 
disable logins for this user:

Note: A user account login must be enabled to allow login access to 
the ESM Console. If you disable a login for a user account, the user 
cannot log into the Console with the credentials associated with the 
disabled account.

External User 
ID

Optionally, provide an alternate, external user ID. (An external user 
ID might be relevant if you have user accounts from other 
applications feeding into ESM user database.)

Password Enter a password for this user. This is a required field.

By default, passwords require a minimum of 6 characters, can 
contain a maximum of 20 characters, and can contain numbers 
and/or letters. System administrators can set special policies or 
requirements for their sites via a configuration file.

(Passwords can be modified later as a part of editing user 
information. See “Resetting User Passwords” on page 76.)

Confirm Re-type the password to confirm it. This is a required field.

User Fields Description

Last Name User's last name

First Name User's first name

Title User's job title

Department User's department

Phone User's phone number

Fax User's fax number

E-mail User's e-mail address. Use the format user@host.domain. The "@" 
sign and host domain are required. E-mail addresses are not case-
sensitive.

Pager User's pager number

For phone, fax, and pager numbers, parentheses (), dashes (-), and periods 
(.) are allowed. Alphabetic characters are not allowed.

User Fields Description
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Editing a User
1 In the Users resource tree, right-click the user and choose Edit User.

2 In the User Editor, edit the text fields as described in the table above.

3 Grant or withhold login permission by selecting or deselecting the check box next to 
Login Enabled.

4 In the Password and Confirm text fields, edit the user password and confirm it by 
typing it again. These fields are required.

By default, passwords require a minimum of 6 characters, can contain a maximum of 
20 characters, and can contain numbers and/or letters. System administrators can set 
special policies or requirements for their sites via a configuration file.

5 Click OK.

Resetting User Passwords
Administrators may also reset user passwords; for example, if a user's original password 
has been compromised or you want to make users update their passwords.

1 While logged into the Console as an administrator, choose the Users resource in the 
Navigator panel.

2 Right-click the user whose password you want to reset and choose Reset Password.

The ArcSight Manager assigns a new random password (8 characters, including numbers 
and letters) and sends it to the selected user's assigned e-mail address.

Alternatively, the following command on ArcSight Manager can be used to reset a user’s 
password:

arcsight resetpwd

Moving or Linking a User
1 In the Users window, navigate to a user and drag and drop it into another group.

2 Choose Move to move the user or Link to create a copy of the user that is linked to 
the original user.

If you choose Link, you create a copy of the user that is linked to the original user. 
Therefore, if you edit a linked user, whether it is the original or the copy, all links are 
edited as well. When deleting linked users, you can either delete the selected user or 
all linked user copies.

Deleting a User
1 In the Users resource tree, right-click the user and choose Delete User.

2 In the dialog box, click Delete to delete the user and the listed user's resources or 
click Disable Login to disable the user.

Be aware that sending a password by e-mail can be dangerous since e-mails 
can be intercepted.
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About the System User
Starting with ESM v4.0, a special user called the system user is created automatically when 
ArcSight ESM is installed. This user can lock and unlock ArcSight System Core content.

The system user is configured as ‘systemuser’ by default. ArcSight recommends that you 
change this name to a non-standard name. This name can be changed only once. For 
example, once you change the name to ‘coreuser’, you cannot change this name again.

Handling User Groups
User groups associate related users or groups of users. When a group is created within a 
group, the new group inherits the existing group's permissions.

By default, only ESM Administrators have permissions to delete users in a 
group. If you want to grant non-Administrator users permission to delete 
users in a particular group, you first need to provide Write access to the 
group by editing access to User Groups in the ACL Editor.

Starting with ESM v4.5 GA, an additional step (providing Write access to user 
Reports) is necessary.

To grant non-Administrator users permissions to delete other users in a 
group, do the following:

1 In the server.default.properties file, set the 
user.allowmodification=true.

2 Restart the ESM Manager.

3 Log into the Console as Administrator, and select the Users resource in 
the Navigator.

4 Select the non-administrators group for which you want to provide 
permissions, right-click, and choose Edit Access Control to bring up the 
ACL Editor.

5 On the ACL Editor, click the Resources tab.

6 Select Report in the Resource drop-down menu, and click Add  to bring 
up the Reports Selector dialog.

7 In the Selector dialog, select all users under Reports/Shared/Personal/ 
and click OK. All users are shown as Resources targets.

8 Click to set Read (R) and Write (W) permissions as desired (e.g., a 
checkmark indicates the permission is granted or “on”). Any user in the 
group now has Edit access to Report groups showing Write access (i.e., 
where W is checkmarked), and therefore can delete users in this group.

9 Click Apply or OK to save your changes.

With Write permissions enabled on Reports for users you want to delete, 
members of this group can log into the Console and delete those users.

For more information, see “Granting or Removing User Group Permissions” on 
page 83.

ArcSight strongly discourages you from logging in as the system user for 
regular ArcSight system administration tasks. The purpose of this user is 
special and its capabilities are limited. For example, the system user cannot 
use channels or dashboards, install ArcSight SmartConnectors, or log in to 
ArcSight Web.
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Groups and users can be managed with drag-and-drop functionality. You can move or copy 
groups and users into other groups from the Users resource tree. If a group is deleted, the 
users within that group are also deleted, unless they are also contained by other groups. 

Creating User Groups
1 On the Navigator panel's drop-down menu, choose Users.

2 In the Users resource tree, right-click a group and choose New Group.

A name text field appears under the group you selected.

3 In the name text field, type in a name.

4 Press Enter.

Renaming User Groups
1 In the Users resource tree, right-click a group and choose Rename.

2 In the "name" text field, rename the group.

3 Press Enter.

Editing User Groups
1 In the Users resource tree, right-click a group and choose Edit Group.

2 In the Group Editor, edit the Name and Description text fields.

3 Click OK.

Moving or Linking User Groups
1 In the Users resource tree, navigate to a group and drag and drop it into another 

group.

2 Choose Move to move the group or Link to create a copy of the group that is linked 
to the original group.

If you choose Link, you create a copy of the group that is linked to the original group. 
Therefore, if you edit a linked group, whether it is the original or the copy, all links are 
edited as well. When deleting linked groups, you can either delete the selected group 
or all linked groups.

Deleting User Groups
1 In the Users resource tree, right-click a group and choose Delete Group.

2 In the dialog box, click Yes.

To copy multiple resources at once, use Copy and Paste. You can drag and 
drop only one resource at a time.

You can grant or block non-administrator user access to deploy or un-deploy 
data monitors. These permissions are configured at the user group level.

For information on how to set user group permissions to enable or disable 
data monitors, see “Controlling Who Has Permissions to Deploy Data 
Monitors” on page 88.
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Setting Startup Views
You can define the set of active channel and dashboard resource groups that members of a 
given ArcSight user group will see by default when they first log in. This includes both 
Console and ArcSight Web users. These channels and dashboards are initial defaults only: 
once users begin changing the content of the Viewer panel, the Console and ArcSight Web 
follow their normal behavior of remembering the most recent state.

The default active channels and dashboards you select for user groups are listed in the 
User Group Editor on the Startup Views tab.

1 Right-click a user group in the Navigator panel's Users resource tree, and choose Edit 
Group.

2 In the User Group Editor, click the Startup Views tab, then the Active Channels or 
Dashboards tabs.

3 In either resource tab, click Add to open a resource selector dialog box.

4 Navigate to and select the appropriate active channels or dashboards to set as users' 
start-up resources, and click OK. Repeat this step to add more resources.

5 Click Refresh to update the current list of resources, or click Remove to take a 
selected resource off the list. Click Edit to change a selected resource in its own editor.

6 Click Apply to make changes and leave the editor open, or click OK to apply your 
changes and close the editor.

Managing Permissions and Resources
The subject of managing users is largely that of managing their access to and use of 
resources.

Editing Access Control Lists (ACLs)
The user groups ACL Editor has these tabs for viewing or editing permissions on resources, 
operations, user groups, events, and sortable field sets:

Resources tab - Lists all resources available to the user group with either inspect or 
edit permissions, and lets you add/edit resource permissions.

Operations tab - Lists operations for which this user group has permissions, and lets 
you add/edit operations permissions. (For example, a user group can have permissions 
to enable or disable data monitors.)

User Groups tab - Lists the user groups with either inspect or edit access to the user 
group itself, and lets you add user groups.

Events tab - Lists event filters for which this group has permissions, and lets you 
add/edit event filter permissions. This user group is permitted to see only events from 
the filters listed on the Events tab.

Sortable Field Sets tab - Lists sortable field sets for which this user group has 
permissions. Lets you add/edit field set permissions. 

Always remember to have both ArcSight Console and ArcSight Web users log 
out and back in after changing user or resource access permissions, so they 
can see those changes.
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Granting or Removing Resource Permissions
1 In the Navigator panel's drop-down menu, choose Users.

2 In the Users resource tree, expand it and select a group.

3 Right-click the user group and select Edit Access Control.

4 In the ACL Editor, select the Resources tab.

The Resources tab lists all resources available to this user group with either inspect 
(Read) or edit (Write) permissions, and lets you add/edit resource permissions. 
Available resources are listed based on user permissions, so some might not show.

The Resource ACL display shows relationships between users and groups, and 
how permissions are acquired for each of the user groups. Child groups 
inherit permissions from parent groups.

For example, consider the following scenario.

• A user logged in as Administrator (belonging to the group /All 
Users/Administrators) has read and write permissions by virtue of being 
in the Administrators group.

• All users have read permissions because they belong to the group /All 
Users/Default User Groups by default.

• A user logged in as an Analyzer Administrator has both read and write 
permissions because they inherit read permissions from the parent group 
(/All Users/Default User Groups) and get write permissions per the 
Analyzer Administrators child group.
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5 Add or remove permissions on a resource for this user group as follows.

To edit permissions on a resource shown in the current list, click the (R) 
read or (W) write checkbox next to a target resource to add or remove 
permissions on that resource.

A checkmark means that this user group has access to the associated resource. A 
blank checkbox means this group does not have access to the resource.

To add permissions for a resource not shown in the current list, select a 
resource from the Resource drop-down menu at the top of the Resources tab and 
click Add.

This brings up the resource selector dialog for the chosen resource. Select the 
resources you want to add permissions for and click OK.

 The resource you added will be listed as a target on the Resources tab and then 
you can edit its Read/Write permissions as needed.

To remove a resource from the list (and remove all permissions on it for this 
group), select the resource in the list and click Delete. (The Delete button is at 
the bottom of the Resources tab).

6 Click OK on the User Group ACL Editor to save changes to Resources permissions.
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Granting or Removing Operations Permissions
Starting with ESM v4.5, data monitor deployment is controlled through User Access Control 
Lists (ACLs). Administrators can allow or block users for data monitor deployment 
permissions by setting permissions on this particular “operation”. For ESM v4.5, the only 
operation available to set permissions on is data monitor deployment. It is likely that fine-
grained permissions control will be added for other operations as needed. (See also, 
“Controlling Who Has Permissions to Deploy Data Monitors” on page 88.)

1 In the Navigator panel's drop-down menu, choose Users.

2 In the Users resource tree, expand it and select a group.

3 Right-click the user group and select Edit Access Control.

4 In the ACL Editor, select the Operations tab.

The operations for which this user group has permissions (if any) are listed. 

5 Add or remove user group permissions to perform an operation as follows.

To add permissions to perform an operation not listed, click Add.

Select the operations you want to add permissions for and click OK.
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The list of Operations is updated to include the one you added. Operations listed 
are those this user group has permissions to perform.

To remove permissions to perform an operation, select the operation in the 
list and click Delete. (The Delete button is at the bottom of the Operations tab).

6 Click OK on the User Group ACL Editor to save changes to Operations permissions.

Granting or Removing User Group Permissions
1 In the Navigator panel's drop-down menu, choose Users.

2 In the Users resource tree, expand it and select a group.

3 Right-click the user group and select Edit Access Control.

4 In the ACL Editor, select the User Groups tab.

The User Groups tab lists all user groups for which members of the selected group 
have inspect (Read) or edit (Write) permissions, and lets you add/edit group 
permissions.

5 Add or remove permissions on a user group as follows.

To edit permissions on a user group shown in the current list, click the 
(R) read or (W) write checkbox next to a target resource to add or remove edit 
permissions on that user group.

A checkmark means that this user group can edit permissions on the associated 
group. A blank checkbox means this group does not have edit permissions on it.

To add permissions on a user group not shown in the current list, click 
Add.

This is where you grant or deny members of the group you are editing 
permissions to edit their own user groups. Depending on your own user 
permissions, some user groups may or may not be shown, and 
Read/Write checkbox options may or may not be editable.
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This brings up the resource selector dialog for the chosen resource. Select the 
groups you want to add permissions for and click OK.

The user group you added is now listed on the User Groups tab and then you can 
edit its Read/Write permissions as needed.

To remove a user group from the list (and remove all edit permissions on it), 
select the user group in the list and click Delete. (The Delete button is at the 
bottom of the User Groups tab).

6 Click OK on the User Group ACL Editor to save changes to User Group permissions.

Granting or Removing Event Permissions
1 In the Navigator panel's drop-down menu, choose Users.

2 In the Users resource tree, expand it and select a group.

3 Right-click the user group and select Edit Access Control.

4 In the ACL Editor, select the Events tab.
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The event filters that return the types of events for which this user group has 
permissions are listed. 

5 Add or remove user group permissions to view events as follows.

To add permissions to view events captured by a filter not shown in the 
current list, click Add.

Select the event filters you want to add permissions for and click OK.

User groups are granted permissions to events by means of event filters 
applied to groups. The event filters limit the types of events group 
members can access through the ESM Console.

For example, members of the ESM Administrators group can view all 
events, as indicated by the event filter assigned to the Administrators 
group by default: /All Filters/ArcSight System/Core/All Events.

For more information about events, see “Monitoring Events” in the ESM 
User’s Guide or the Console Help.
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The list of event filters is updated to include the ones you added. Filters listed 
capture and allow all event types this user group has permissions to view.

To remove event filters (permissions to view certain types of events), select a 
filter in the Events “Filter” list and click Delete. (The Delete button is at the 
bottom of the Events tab).

6 Click OK on the User Group ACL Editor to save changes to Operations permissions.

Granting or Removing Sortable Field Sets Permissions
1 In the Navigator panel's drop-down menu, choose Users.

2 In the Users resource tree, expand it and select a group.

3 Right-click the user group and select Edit Access Control.

4 In the ACL Editor, select the Sortable Field Sets tab.

The event field sets for which this user group has access permissions are listed. 

5 Add or remove user group permissions on sortable field sets as follows.

To add permissions to use a field set not shown in the current list, click Add.
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Select the sortable field sets you want to add permissions for and click OK.

The list of sortable field sets is updated to include the ones you added. Field sets 
listed represent those this user group has permissions to use.

To remove sortable field sets, select a field set in the list and click Delete. 
(The Delete button is at the bottom of the Sortable Field Sets tab).

6 Click OK on the User Group ACL Editor to save changes to Sortable Field Sets 
permissions.

Sharing Resources
You can share your resources with other users by moving, copying, or linking your resource 
to or into another resource's Public group; for example, to share a filter you would move it 
into the Public Filters group in the Filters resource tree.

To share a resource
1 In a resource tree, drag a resource and drop it into the Public group (this can be a 

single resource or a resource group).

2 Choose Move to move the group, Copy to make a separate copy of the group, or 
Link to create a copy of the group that is linked to the original group.

If you choose Copy, you create a separate copy of the resource that will not be 
affected when the original resource is edited. If you choose Link, you create a copy of 
the resource that is linked to the original resource. Therefore, if you edit a linked 
resource, whether the original or the copy, all links are edited as well. When deleting 
linked resources, you can either delete the selected resource or all linked resources.

You can also multiple-select resources with the Shift key, and drag-and-drop or 
keyboard copy-and-paste, to move, copy, or link them in another group.

To copy multiple resources at once, use Copy and Paste. You can drag and 
drop only one resource at a time.
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Controlling Who Has Permissions to Deploy Data Monitors
Starting with ESM v4.5, data monitor deployment is controlled through User Access Control 
Lists (ACLs). Administrators can allow or block users for data monitor deployment 
permissions.

Depending on the permissions associated with the user group to which they belong, users 
may or may not have options available on their consoles to Enable (deploy) or disable (un-
deploy) data monitors.

Administrators (all users belonging to the admin user group) have permissions to 
deploy/undeploy data monitors.

Administrators can grant permissions to deploy/undeploy data monitors to other non-
Administrator through the Users resource Access Control Lists (ACLs) editor, as described in 
“Granting or Removing Operations Permissions” on page 82. As with user permissions for 
other resources, these are applied at a user group level. As an administrator, you can grant 
all users in a given group permission to deploy data monitors. Once user groups are set up 
and appropriate permissions applied to those groups, you can add new users to 
appropriate groups, and change access permissions for existing users by moving them in or 
out of various groups. If you want to allow or disallow a particular user the option to deploy 
data monitors, move the user in or out of a group that has that permission.

To configure data monitor deployment permissions:

1 If needed, set up one or more user groups for non-admin users to whom you want to 
control permissions to deploy data monitors. (For example, at the simplest level you 
might have a group for analysts and operators who are allowed to deploy data 
monitors and another for those you want to block from this option.)

See “Handling Users” on page 74 and “Handling User Groups” on page 77 for 
information on adding, deleting, and editing users and user groups.
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2 Follow the instructions provided in “Granting or Removing Operations Permissions” on 
page 82 to grant or remove permission to deploy data monitors to a particular group. 
As a part of these instructions, you’ll select the Users resource in the navigator, right-
click a group and choose Edit Access Control.

3 In the ACL Editor, click the Operations tab, and click Add.

4 On the Permissions Selector, select Deploy under Permissions\Shared\All 
Permissions\ArcSight System\Data Monitor\ and click OK to save the 
settings and close the dialog.

The list of Operations is updated to include deployment permissions on data monitors.

(To remove the permission for this group, select the permission and click Delete.)

5 Click OK on the ACL Editor to save your changes.

For more information on administrator tasks of working with user permissions and ACLs, 
see “Managing Permissions and Resources” on page 79.

How Upgrades Affect Data Monitor Deploy Permissions
Upon installation and deployment of a different version of ESM software (e.g., version or 
service pack upgrades), only administrators (admin users) will keep permissions to 
deploy/undeploy data monitors. Non-admin users will not have deploy permissions on data 
monitors even if they had such permissions as part of the previous ESM configuration.
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After upgrades, all users will have access to already-deployed data monitors. But, initially, 
non-admin users will not have permissions to enable/disable data monitors, nor have 
access to new data monitors unless an administrator enables (deploys) these. 

To re-establish data monitor deployment permissions for non-admin users after an 
upgrade, administrators can reconfigure fine-grained permissions. They can re-group users 
and perhaps link non-admin users into existing or new groups with more permissions (like 
data monitor deployment), as described in “Controlling Who Has Permissions to Deploy 
Data Monitors” on page 88.

Deployment Permissions on Imported Data Monitors
If a user without data monitor deploy permissions imports a data monitor that was 
archived in the enabled state, the import will succeed but the data monitor will be disabled 
(undeployed). After the import, the user will not have permissions to deploy the data 
monitor unless an administrator reconfigures permissions for that user.

If a user with data monitor deploy permissions imports a data monitor that was archived in 
the enabled state, the import will succeed and the data monitor will keep its enabled 
(deployed) setting. After the import, this user will be able to view the data monitor and re-
set its deployment state as needed.

Locking and Unlocking Resources
The locking and unlocking capability applies to the following ArcSight content:

System core content

User created content

System Core Content
When you install the ArcSight ESM system, a set of predefined content called the System 
Core content is installed by default. This content provides the foundation building blocks for 
the ArcSight ESM to work. 

System Core content is available in the Core group under the ArcSight System sub-tree of 
each resource tree. For example, core content for the Filters resource is available in /All 
Filters/ArcSight System/Core.

The modification of System Core content can adversely impact the operation of ESM, 
therefore, it is locked by default. ArcSight strongly recommends against unlocking or 
modifying this content. If there is a need to unlock this content, contact ArcSight Customer 
Support. 

User Created Content
ArcSight users can lock any resource or a group of resources to which they have write 
access privileges. Locking prevents a resource from being modified or deleted. Once 
locked, such resources or groups can be unlocked only by these users:

The user who applied the lock—the lock owner.

Use the resources available in ArcSight Foundation packages or ArcSight 
Administration to create content to suit your needs.
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Any user who has write permissions to the lock owner. That is, a user who has 
privileges over the user who applied the lock. For example, the administrator user has 
write permissions over all users by default. Therefore, if user joe locks a resource, the 
user administrator can unlock it. 

The system user. 

You can edit resources in a locked group if you have write access privileges to the resource, 
however you cannot do the following:

Delete or remove resources from it.

Add a new resource to it. 

Unlocking a User-locked Resource
To unlock a resource, right-click the locked resource and select Unlock from the drop-
down menu. For detailed instructions, see the Console online Help.

You can make a copy of a locked resource even if you do not have the 
privileges to unlock it.
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Modeling Your Network
ArcSight ESM operates on a data model that enables you to build a business-oriented view 
of data derived from physical information systems. These distinctions help ESM clearly 
identify the events in your network, and provide more layers of detail to ESM correlation 
capabilities. Modeling your network and the assets it includes is part of ESM setup and 
ongoing maintenance.

Figure 4-1 Modeling the network and assets.  The ESM network model consists of the 
asset model and the network model, which, combined, facilitate building detailed correlation 
criteria. All of the Network Modeling resources, except Customers, are available as part of the 
Assets resource.

The “Network Model” on page 92 is a representation of the nodes on your network 
and certain characteristics of the network itself. 

The “Asset Model” on page 97 describes attributes of the assets themselves for 
different purposes.

The following topics provide a conceptual overview of network modeling, and describe how 
to configure, update, and maintain a network model in ESM.

Network Model
The network model is a representation of the nodes on your network and certain 
characteristics of the network itself. 

Before you can make an informed decision about what to do about a particular event, it 
helps to know something about the event's source and destination. Is the source a 
previous attacker, does it come from a hostile region of the world, or is it a trusted server 
that has suddenly become the source of a hostile attack? Does the destination expose 
relevant vulnerabilities, does it host critical applications, or is it a known server of forbidden 
services? 

• For a description of techniques for dealing with hundreds of thousands of 
assets, see “Asset Scalability” on page 115.

• For a more detailed conceptual overview, information about configuring 
each type of ESM asset and modeling your network, refer to the ArcSight 
ESM 101 chapter on the “ESM Network Model.”
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ESM captures this kind of information by modeling the assets on your network and 
particular attributes of the network itself that are pertinent to ESM. The network model 
represents information for individual assets and whole zones.

For critical assets on the protected network, network modeling captures important facts 
that will help inform your decisions, such as: 

All open ports

The operating system running on that host

Known vulnerabilities that might be exposed

Applications present

The missions these applications support and their criticality to your operation

For less critical assets, such as a particular block of addresses on the Internet, it may be 
sufficient to just know general information about them, such as the country in which those 
assets reside. 

The ESM Network Model consists of the following resources. All of these resources, except 
Customers, are part of the Assets resource. 

“Assets” on page 93 represent individual nodes on the network, such as servers, 
routers, and laptops. 

“Asset Ranges” on page 95 represent a set of network nodes addressable as a 
contiguous block of IP addresses. 

“Zones” on page 95 represent portions of the network itself that are characterized by a 
contiguous block of addresses. 

“Networks” on page 97 provide an additional distinction to differentiate between two 
private address spaces with overlapping IP address ranges. 

Customers describe the internal or external cost centers or separate business units 
associated with networks, if applicable to your business environment. Customer 
tagging is a feature developed mainly to support Managed Security Service Provider 
(MSSP) environments, although it can also be used by private organizations to denote 
cost centers, internal groups, or subdivisions. The Customer designation keeps event 
traffic from multiple cost centers and/or business units clearly identified and separate. 
A customer can be thought of as the "owner" of an event, rather than the source or 
target of an event. For more about Customers, see “Managing Customers” on 
page 197.

Assets
An asset is any network endpoint with an IP address, MAC address, host name, or external 
ID. For network modeling purposes, an asset is any endpoint you consider significant 
enough to characterize with details that will make ESM correlation and reporting more 
meaningful. 

ESM automatically creates assets to model the network nodes that host ArcSight 
components (Managers, Databases, Consoles, and SmartConnectors). It also automatically 
creates assets for events received from device endpoints on your network that do not 
already have assets modeled in ArcSight. This auto-asset creation feature could require 
configuration, depending on the assets reporting in to ESM. 

Auto-Created Assets
By default, ESM automatically creates assets for ESM components and, if applicable, for 
assets arriving from scan reports sent by vulnerability scanners via scanner 
SmartConnectors. 
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As a configuration option, you can also configure ESM to create assets for devices reporting 

through SmartConnectors. 

Auto-Created Assets for ESM Components

ESM automatically creates assets to model the network nodes that host ESM components. 
These assets do not contain vulnerability information, and are used for system 
administration. 

Devices Discovered by a Vulnerability Scanner

ESM also imports asset and vulnerability information from vulnerability scanner reports 
generated by products such as Nessus, FoundStone, and ISS Internet Scanner. Asset 
information is passed to the Manager via the scanner SmartConnector appropriate for your 
vulnerability scanner product based on IP address, MAC address, and host name. 

Updated vulnerability information is added to existing assets with matching identifiers. If a 
matching asset does not already exist, ESM creates one.

ESM creates assets from vulnerability scan reports differently for dynamic and static zones. 
For more about dynamic and static zones, see “Dynamic and Static Zones” on page 96. 

For details about how ESM creates assets from vulnerability scans, see the Reference topic 
“Creating Assets from a Vulnerability Scan Report” in the ESM Console Help. 

Devices Reporting Through SmartConnectors

ESM can be configured by the Administrator to also create an asset for each device that 
reports to that SmartConnector based on IP address, MAC address, and host name when 
ESM receives events from SmartConnectors. 

This feature makes it possible to add assets to the network model that may not be part of 
a regular asset scanning report without having to create them individually. Assets created 

Component

Manager An asset for the Manager is added (if needed) every 
time the Manager service starts.

ESM database An asset for the ESM database is added (if needed) 
every time the Manager starts.

Consoles An asset is added for each Console the first time it 
connects with the Manager.

SmartConnectors An asset is created for SmartConnectors only when the 
SmartConnector begins reporting base events from the 
device it represents. A Connector can be successfully 
added to the Manager, but until it starts reporting 
events from the device it represents, an asset will not 
be created for it in the Asset Model. 

ESM creates assets differently for SmartConnectors in 
static zones and those in dynamic zones. For more 
about static and dynamic zones, see “Dynamic and 
Static Zones” on page 96. 

For details about how ESM creates assets for 
SmartConnectors, see the Reference topic “Creating 
Assets for SmartConnectors” in the ESM Console Help.
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using this method do not contain vulnerability information, although once they are added 
to the network model, they can be supplemented with matching data that arrives from a 
scanner report or that you add individually using the Console.

Administrators can enable the option to create assets for network devices in the Manager 
Configuration Wizard. For more about running the Manager Configuration Wizard, see the 
topic “Reconfiguring ArcSight Manager” in the ESM Administrator’s Guide.

ESM creates assets differently for devices in static zones and those in dynamic zones. For 
more about static and dynamic zones, see “Dynamic and Static Zones” on page 96. 

For details about how ESM creates assets for devices reporting through SmartConnectors, 
see the Reference topic “Creating Assets for Network Devices” in the ESM Console Help.

For more about how to tune asset auto creation from the Console, see the following topics:

For ESM: “Configure Asset Auto-Creation Filters” in “Standard Content” in the ESM 
User’s Guide or Console Help

For ArcSight Express: “Configure Asset Auto-Creation Filters” in “ArcSight Express” 
in the ESM User’s Guide or Console Help.

It is also possible to customize how the asset auto-creation function works by modifying 
settings in the ESM server.properties file. For details, see the reference topic Asset 
Auto-Creation Advanced Configuration Options in the ESM User’s Guide or Console Help. 

For an overview of how the network model can be populated with assets, see “Populating 
the Network Model with Assets” on page 98.

Asset Ranges 
An asset range is a group of assets attached to a network that use a contiguous block of IP 
addresses. An asset range is useful if you have many network nodes that would be 
impractical to track individually, or that may come and go from the network, such as 
desktop PCs and laptops.

When an event is processed by the SmartConnector, the Manager, or the correlation 
engine, its endpoints are either identified as a single asset or as an asset belonging to a 
particular asset range. A reference to the asset or asset range identifier is populated in the 
event schema. 

Zones
Zones are ArcSight resources that represent a functional part of the network with 
contiguous IP addresses, such as DMZ, VPN, wireless LAN, or DHCP.

With ArcSight v4.0, every asset or address range is associated with a zone. ArcSight comes 
configured with the standard global IP address ranges already represented as zones, so if 
your network uses only these public IP addresses, ArcSight can resolve them without 
setting up any additional zones. 
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ESM comes with the following standard zones:

You would need to create your own zones if you have overlapping private networks. Private 
networks usually model a functional group within your network or a subnet, such as a 
wireless LAN, the engineering network, the VPN or the DMZ.

For details about using the zone editor, see “Managing Zones” on page 121 in “Working 
with Assets, Locations, Zones, Networks, Vulnerabilities, and Categories” on page 111.

Dynamic and Static Zones
Zones are created to model functional portions of the network that share a contiguous 
block of IP addresses. 

The ESM asset auto-creation feature (see “Auto-Created Assets” on page 93) relies on 
zones that are already in place before device discovery occurs, either customer-created 
zones, or the default zones that come with ESM. When you add a SmartConnector, you 
assign one or more existing Networks to that Connector. All assets reported by that 
Connector are then associated with that Network and the zones the Network represents. 

ESM differentiates between dynamic zones and static zones to classify the types of assets 
they represent.

Static Zones

Devices in a static zone use static (constant) IP addresses. This represents devices that 
stay on the network and use the same IP address for all traffic. In order for ESM to identify 
assets classified in static zones, the assets must have either a unique IP address, a unique 
host name, or both.

Dynamic Zones

Devices in a dynamic zone use dynamic addressing (such as DHCP). Dynamic zones 
represent assets that come and go from the network, such as laptops. By default, ESM 
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requires either a MAC address or a host name to identify assets in dynamic zones. ESM first 
looks for a MAC address; if one is not present, it uses the host name. 

Static Assets in Dynamic Zones

If an asset is classified as static, but belongs to a dynamic zone, ESM treats the asset as if 
it was in a static zone. See the description and links above for how ESM asset auto-creation 
feature works for static zones. 

Networks
Networks are ArcSight resources that are used to differentiate between zones whose IP 
ranges overlap, such as when branch locations assign the same private address spaces to 
resources used in other corporate locations.

ESM comes configured with two standard networks: Local and Global. The Local network is 
where you add your custom zones. Zone mappings in the Local network override the 
default zone mappings provided by the Global network.

The Global network provides default zone mapping if no local networks are defined, and 
automatically provides the correct addressing information to ArcSight SmartConnectors 
when they are installed. 

Custom Networks are also used to compartmentalize Customer designations in MSSP 
situations. 

When you associate a customer or a location with a network in the Network Editor, zones 
automatically access this information. (See “Managing Networks” on page 122 in “Working 
with Assets, Locations, Zones, Networks, Vulnerabilities, and Categories” on page 111.)

Asset Model
The resources that make up the asset model are part of the overall network modeling 
process. The asset model resources describe attributes of the assets themselves for 
different purposes. Locations and Vulnerabilities are part of the Assets resource. 

Locations
ESM provides a location database that maps an IP address to the owning body for the 
block of IP addresses to which it belongs. Your organization may have finer-grained detail, 
such as the physical location of all of your networks or networks outside your control, or 
corrections to the database that ESM supplies. The Location resource is the way you can 
override the ESM default location mappings with location information relevant to your 
network. 

Location is an attribute you can set if the asset you are modeling resides in a geographic 
location that differs from the location set by the mapping database that associates IP 
addresses with location information.

Classifying Zones as Static and Dynamic

It is important that zones are classified properly as dynamic or static. 

If a zone is classified as static, but hosts assets that come and go from the 
network, ESM may not be able to update the network model properly. For 
example: 

• The updated network might have duplicate and disabled assets

• Other information, such as vulnerability information and open ports, may 
not get updated properly
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Vulnerabilities
The asset vulnerabilities on your network are normally discovered and updated 
automatically by scanners. The most common manual change to a vulnerability resource is 
to associate it with a Knowledge Base article. You can associate assets with vulnerabilities 
from either the Vulnerabilities or Assets editors. (See “Vulnerability Editor” on page 117 in 
“Working with Assets, Locations, Zones, Networks, Vulnerabilities, and Categories” on 
page 111.)

Asset Categories
Asset categories are ArcSight resources that describe the properties of an asset in terms of 
how it is used. Asset categories are one of the key ways that ESM adds differentiation, 
relevance, and context to the millions of events passing through your network. 

Asset categories establish identity, ownership, and criticality of the assets on your network. 
Asset categories present an extensible schema that adds value to the business properties 
of your assets. The root of a particular category (for example, Criticality in the group  
/All Asset Categories/System Asset Categories/Criticality) defines the 
property itself, whereas the members of the category (for example, the criticality levels 
Very High, High, and so on) define the possible values for that property.

You can create new asset categories as a right-click option in the navigation panel, and 
associate categories with assets through the Asset Editor. Multiple asset categories can be 
applied to one asset. You can also apply categories to zones. See “Managing Asset 
Categories” on page 122 in “Working with Assets, Locations, Zones, Networks, 
Vulnerabilities, and Categories” on page 111.

Populating the Network Model with Assets
There are several ways to populate the network model with the assets that represent your 
monitored network. Most enterprises use a combination of these methods:

Always exercise caution when deleting or changing existing asset categories. 
Changing an asset category can break existing conditions that use that 
category. As a best practice, create new categories in new groups.

ESM Console-Based Methods:

• “Individually Using Network Modeling Resources” on page 99

• “In a Batch Using the ESM Network Modeling Wizard” on page 99

SmartConnector-Based Methods:

• “In a Batch Using the Asset Import FlexConnector” on page 100

• “Automatically From a Vulnerability Scanner Report” on page 100

ArcSight-Assisted Method:

• “As an Archive File From an Existing Configuration Database” on page 101
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ESM Console-Based Methods
The ESM Console provides two ways to populate the network model: individual network 
modeling resources, and a Network Modeling wizard (available in ESM v4.5 and later). 

Figure 4-2 Console-based methods for populating the Network Model.  All the individual 
tools for modeling the network are available in the Console. The Network Modeling Wizard 
provides a quick way to add basic assets to your Network Model at ESM setup time. 

Individually Using Network Modeling Resources 
Set every parameter for every asset individually using ESM's network modeling resources 
(Assets, Asset Ranges, Zones, Networks, and Customers) and asset modeling resources 
(Asset Categories, Vulnerabilities, and Locations).

You can also use these tools in conjunction with the other batch-loading methods that only 
offer limited distinctions. As long as primary identifiers, such as IP address, host name, and 
MAC address, remain the same, the automatic update methods only update fields with new 
information, so the Network Model remains stable. 

For more about ESM’s network and asset modeling tools, see the topic “ArcSight ESM 
Network Model” in ESM 101, and “Modeling the Network and Managing Assets” in the ESM 
User’s Guide and Console Help.

In a Batch Using the ESM Network Modeling Wizard
The ESM v4.5 Console provides a Network Modeling wizard as a set-up and configuration 
tool (menu option Tools > Network Model). The Network Modeling wizard enables you 
to load Assets, Asset Ranges, and Zones along with Asset Category information. If you also 
add a vulnerability scanner as described in “SmartConnector-Based Methods” on page 100, 
the existing assets in the model are updated with the vulnerability scan report data. 

The Network Modeling Wizard is flexible, in that it can take output from any device type in 
CSV format. The CSV file can be extended to include as many new or pre-existing asset 
categories as are relevant to the device(s) without having to add asset category 
information one by one later using the Asset Category resource in the Console. This tool is 
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appropriate for initial set-up and configuration, not as a method for maintaining the 
network model. 

For more about the Network Modeling Wizard, see “Populating the Network Model Using 
the Wizard” on page 102. 

SmartConnector-Based Methods
Both of these methods enable batch loading and automatic ongoing maintenance. Both 
methods offer limited distinctions. Both of these methods are described in more detail 
below. 

In a Batch Using the Asset Import FlexConnector
ESM offers an Asset Import file FlexConnector that enables you to save Asset, Location, 
and Asset Category information in a CSV file, which is then automatically pulled into the 
ESM Manager as part of the SmartConnector heartbeat. Existing assets in the model are 
updated with any new details discovered by the Asset Import FlexConnector, so the 
Network Model remains stable. 

This method does not create asset ranges, and assumes that Zones and Networks are 
already created. You can add Customer and Location distinctions to the assets individually. 
You can find details about how vulnerability information arriving from a scanner report will 
be added to the Network Model in the tech note “ESM Asset Auto-Creation.”

This method also takes output from any device type in CSV format. The CSV file for this 
method can be extended to include as many new or pre-existing asset categories as are 
relevant to the device(s) without having to add asset category information one by one later 
using the Asset Category resource in the Console. For details about how to use the Console 
to import an existing network model as a.csv file, see “Uploading Files and Creating a File 
Resource” on page 132.

This method is appropriate for updating and maintaining your network model. Updated 
CSV files are automatically uploaded to ESM. New data is added to existing assets with 
matching identifiers. If an existing asset is not present, ESM will create one. 

For more about the Asset Import File Connector, see the ArcSight Asset Import 
SmartConnector Configuration Guide. 

Automatically From a Vulnerability Scanner Report
Set up a scanner SmartConnector (such as FoundStone, ISS Internet Scanner, or Nessus) 
to use the output of a vulnerability scan to convert device information into ESM Assets 
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along with Vulnerability information, and basic Asset Categories, such as operating system 
and open ports. The scanner connector that corresponds with your vulnerability scanning 
product sets up a directory that ESM regularly scans for updated reports. It then converts 
the scanner report output into internal ESM scanner meta-events, which the Manager 
converts into Assets, open port and OS Asset Categories, and Vulnerabilities. For more 
about the architecture of how this works, see the topic “How Vulnerability Scans Populate 
and Update the Network Model” in ESM 101. 

You can also set the scanner SmartConnector to save network model data as a CSV file, 
which you can then upload into the ESM Manager using the Files resource during your 
initial network model setup. For details about how to import an existing network model as 
a File resource, see the topic “Uploading Files and Creating a File Resource” in the ESM 
User’s Guide and Console Help. 

Data derived from vulnerability scanner reports does not create asset ranges, and assumes 
that Zones and Networks are already created. Once scanner data is imported, you can add 
Customer and Location distinctions to the assets individually. For details about how ESM 
adds updated vulnerability information arriving from a new scanner report, see the tech 
note “ESM Asset Auto Creation.” 

This method is appropriate for updating and maintaining your network model. Subsequent 
scans will update the basic Asset, Asset Category, and Vulnerability information without 
overwriting the other network modeling settings you add individually. 

For more information about the scanner SmartConnector for your vulnerability scanning 
product, see the SmartConnector Configuration Guide that corresponds with your 
vulnerability scanning equipment.

ArcSight-Assisted Methods
ArcSight Professional Services can help you populate the Network Model from an existing 
configuration database. 

As an Archive File From an Existing Configuration Database
Many enterprise networks have third-party systems that already model the properties of 
the assets on your network. With the help of ArcSight Professional Services, you can export 
these network models, translate the format into the ESM schema using an ArcSight 
resource-generating utility, and import it to the ESM Manager as a resource archive with 
the help of ArcSight Professional Services. 
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The tools ArcSight Professional Services use can generate any type of resource, so using 
this method, you can have a fully populated network model without having to do any 
individual configuration. 

Populating the Network Model Using the Wizard
Starting with ESM v4.5, a Network Model wizard is provided on the ESM Console (menu 
option Tools > Network Model). The Network Model wizard provides the ability to 
quickly populate the ESM network model by batch loading asset and zone information from 
Comma Separated Values (CSV) files. 

The following data can be imported into an ArcSight ESM Manager from CSV files:

Zones define functional parts of a network, such as a wireless LAN, an engineering 
network, a VPN or a DMZ. For the column types of the zones CSV file, see “Zones CSV 
File Format” on page 105.

Assets represent individual nodes on the network, such as servers and routers. For 
the column types of the assets CSV file, see “Assets CSV File Format” on page 106.

Asset ranges represent sets of network nodes addressable as a contiguous block of 
IP addresses. Asset ranges are useful when you have many network nodes that would 
be impractical to track individually, or that may come and go from the network, such 
as laptops. Asset ranges should be a subset of the IP address ranges defined for 
zones. For the column types of the asset ranges CSV file, see “Asset Ranges CSV File 
Format” on page 108.

You can import combinations of input CSV files at one time using the Network Model wizard 
but only one file of each type can be imported during a single import. For example, if you 
only have assets to import, you can import only an assets CSV file. If you have a zones CSV 
file, an assets CSV file, and an asset ranges CSV file to import, you can import all three at 
once using the Network Model wizard.

Specifying CSV Column Types
Each CSV file type defines a set of required column(s) and optional columns. In addition, 
the CSV file can contain columns that are not used by the Network Model wizard. The 
columns can be in any order but the Network Model wizard requires that you specify the 
types of each column so the wizard knows how to interpret each column. You can specify 
the column type using one of the following methods:

Specify the column type in the header of the CSV file itself, prior to launching the 
Network Model wizard. For instructions, see “Specify the Column Type Using a Header” 
on page 103.

While running the Network Model wizard, assign the appropriate column type for each 
column in the Select Column Headers panel. For instructions, see “Assign the Column 
Type in the Wizard” on page 103.

Columns not used by the Network Model wizard must be assigned the column type 
Ignore. Only columns of type Ignore and Category URI can be repeated in the CSV 
file. For all other column types, only one instance of the column type can be assigned in 
the file. For example in a zones CSV file, only one column should be assigned the Name 
column type. If duplicate columns of a non-repeatable column type exist in the CSV file, 
one of the columns should be assigned the Ignore column type. For example if two name 

Populating the Network Model Using the Wizard

Network Model Wizard requires Administrator privileges: The ESM Network 
Model Wizard is available to users with Administrator privileges.  
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columns appear in the CSV file, one should be assigned the Name column type and the 
other should be assigned the Ignore column type.

Specify the Column Type Using a Header
In this method, you specify the column type in the first row (header) of the CSV file itself 
before importing the CSV file using the wizard. The column name in the header must 
match the column type specified in the Table 4-1, “Zones CSV File Format,” on page 105, 
Table 4-2, “Assets CSV File Format,” on page 107, or Table 4-3, “Asset Ranges CSV File 
Format,” on page 109. 

As shown in following sample zones CSV file, the column names in the first row 
(highlighted in bold) match the column types specified in Table 4-1, “Zones CSV File 
Format,” on page 105. The wizard determines how to interpret each column using the 
column type specified in the header.

Name,Start Address,End Address,Dynamic,Category URI
DMZ Public,192.168.1.0,192.168.1.255,FALSE,
DMZ Corporate,192.168.2.0,192.168.2.255,FALSE,/All Asset Categories/Site 
Asset Categories/Business Impact Analysis/Network Domains/Email/
LAN Corporate,10.0.0.0,10.255.255.255,TRUE,

When this zones CSV file is imported into the wizard, the wizard correctly matches the 
column types because the column types have been correctly specified in the header, as 
shown in Figure 4-3.

Figure 4-3 Importing Zones CSV File with Header Row

Assign the Column Type in the Wizard
In this method, you assign the column type in the Select Column Headers panels while 
running the wizard. When the following sample zones CSV file (which does not contain a 
header row) is imported, the wizard does not know how to interpret all the columns as 
shown in Figure 4-4. 

DMZ Public,192.168.1.0,192.168.1.255,FALSE,
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DMZ Corporate,192.168.2.0,192.168.2.255,FALSE,/All Asset Categories/Site 
Asset Categories/Business Impact Analysis/Network Domains/Email/
LAN Corporate,10.0.0.0,10.255.255.255,TRUE,

Figure 4-4 Importing Zones CSV File without Header Row

By default, when this sample data is imported into the wizard, the second column is 
automatically assigned to the Select column type but the second column is a description 
of the zone and should be assigned the Ignore column type. To change the column type, 
click the title of the column and from the drop-down menu select the appropriate column 
type as shown in Figure 4-5.

Figure 4-5 Assigning a Column Type
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Zones CSV File Format
Zones define functional parts of a network, such as a wireless LAN, private networks, or 
subnets. For example, the following network areas could be identified as a zone: the VPN, 
the DMZ, or an engineering network. Zones are identified with a contiguous block of 
addresses. 

You can define a set of zones in ArcSight ESM by batch loading zone definitions from a 
zones CSV file. Zone CSV files contain the columns listed in Table 4-1 on page 105. When a 
zones CSV file is selected for import, by default only the first fifteen rows of data are 
displayed in Select Column Headers for the Zone Data panel. However, when the data is 
imported into the ArcSight ESM Manager, all the rows are imported. For more information, 
see “Increasing the Number of Rows Displayed” on page 109.

For the wizard to determine how to process the imported data, the type of each column 
must be specified. For more information, see “Specifying CSV Column Types” on page 102.

When the Next button is clicked in the Summary of Data to Import panel, the zone data is 
imported into the ArcSight ESM Manager. The new zones are created in the /All 
Zones/Site Zones group. For example, if a zone called DMZPublic was specified in the 
imported zones CSV file, a new zone is created at the following URI: /All Zones/Site 
Zones/DMZ Public. The new zones are assigned to the default network called Local.

Table 4-1 Zones CSV File Format 

Each zone should specify a unique range of IP addresses. The IP addresses 
specified by zones should not overlap. If you import a zone that overlaps with a 
zone already specified on the ArcSight ESM Manager and the new zone has a 
different name than the existing zone, the following occurs:

• the new zone is created

• the existing zone is invalid and is displayed with the broken zone icon in the 
ArcSight ESM Console

Column 
Type

Description
Required 
Column?

Repeatable 
Column?

Example Value

Name A descriptive name for the zone 
such as the purpose or 
geographical location.

Yes No DMZ Public

Start 
Address

The start of the range of IP 
addresses that defines the zone.

Yes No 192.168.1.0

End 
Address

The end of the range of IP 
addresses that defines the zone.

Yes No 192.168.1.255

Dynamic Determines whether the devices 
defined in the zone use dynamic 
addressing:

• true—devices in the zone 
use dynamic addressing 
(DHCP)

• false—devices in the zone 
use static IP addressing

No

Default is 
false

No false
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An Example of a Zones CSV File
Here is an example of the Zones CSV file:

HRZoneA,<Starting-IP-address>,<Ending-IP-address>,FALSE,/All Asset 
Categories/ArcSight System Administration/Databases/

IT Zone,<Starting-IP-address>,<Ending-IP-address>,TRUE,/All Asset 
Categories/ArcSight System Administration/Databases/

Assets CSV File Format
Assets represent individual nodes on the network, such as servers and routers. For more 
information, see “Network Model” on page 92.

You can define a set of assets in ArcSight ESM by batch loading asset definitions from an 
Assets CSV file. Asset CSV files contain the columns listed in Table 4-2 on page 107. 

When an assets CSV file is selected for import, by default only the first fifteen rows of data 
are displayed in Select Column Headers for the Asset Data panel. However, when the data 
is imported into the ArcSight ESM Manager, all the rows are imported. For more 
information, see “Increasing the Number of Rows Displayed” on page 109.

For the wizard to determine how to process the imported data, the type of each column 
must be specified. For more information, see “Specifying CSV Column Types” on page 102.

When the Next button is clicked in the Summary of Data to Import panel, the asset data is 
imported into the ArcSight ESM Manager. The new assets are created in the /All 
Assets/Site Assets group. For example, if an asset called DMZCorpEmailServer was 
specified in the imported assets CSV file, a new asset is created at the following URI: /All 
Assets/Site Assets/DMZCorpEmailServer. When imported, the new assets are 
auto-zoned. For more information, see “Auto-zoning of Imported Assets” on page 110. 

Category 
URI

The asset category to assign to 
zone.

NOTE: The wizard does not 
create new categories. For the 
category to be assigned, it must 
already exist.

No Yes

This column 
can be 
repeated 
because a 
zone can be 
categorized 
into more 
than one 
asset 
category.

/All Asset 
Categories/All 
Site Asset 
Categories/Busine
ss Impact 
Analysis/Business 
Role/Service/Web/

Ignore The column contains data that is 
not used by the Network Model 
wizard when creating zones. For 
example, this column could 
contain a description of the 
zone.

No Yes This zone defines 
the public 
subnetwork of the 
DMZ.

Column 
Type

Description
Required 
Column?

Repeatable 
Column?

Example Value
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Table 4-2 Assets CSV File Format 

Column 
Type

Description
Required 
Column?

Repeatable 
Column?

Example Value

Name A descriptive name for the 
asset. This name must be 
unique. It is recommended to 
specify a name. However, if a 
name is not specified, a 
unique name is generated 
using the other fields.

No No DMZ Corp Email 
Server 1

Host Name The host name of the network 
device represented by the 
asset.

No No dmz_corp_eml1

IP Address The IP address of the network 
device represented by the 
asset. 

NOTE: If no value is specified 
for this column (,,) the asset 
is created with an IP address 
of 0.0.0.0.

Yes No 192.168.2.1

MAC 
Address

The MAC address of the 
network device represented 
by the asset. The MAC 
address is made up of six 
groups of two hexadecimal 
digits can be separated by 
colons (:) or hyphens (-). 

No No 21-4D-5B-2A-3B-FF

Static 
Addressing

Defines if the network device 
is statically addressed even 
though the IP address of the 
asset is in a dynamic zone:

• true—asset uses static IP 
addressing

• false—device uses 
dynamic addressing 
(DHCP)

For more information, see 
“Static Addressing in a 
Dynamic Zone” on page 108.

No

Default is 
false

No false

Category 
URI

The asset category to assign 
to network device.

NOTE: The wizard does not 
create new categories. For 
the category to be assigned, 
it must already exist.

No Yes

This column 
can be 
repeated 
because a 
network 
device can 
be 
categorized 
into more 
than one 
asset 
category. 

/All Asset 
Categories/Site 
Asset 
Categories/Busine
ss Impact 
Analysis/Network 
Domains/Email/
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An Example of an Assets CSV File
Here is an example of the Assets CSV file:

Lab Test machine,lab-111,<IP-address>,<Mac-address>,true,/All Asset 
Categories/ArcSight System Administration/Consoles/,/All Asset 
Categories/ArcSight System Administration/Databases/

Oracle Server,server-oracle,<IP-address>,<Mac-address>,false,/All 
Asset Categories/ArcSight System Administration/Consoles/,/All 
Asset Categories/ArcSight System Administration/Databases/

Static Addressing in a Dynamic Zone
Set the Static Addressing column to true if the network device is statically addressed 
even though the IP address of the asset is in a dynamic zone. For example, set this column 
to true, for the following conditions:

A dynamic zone is defined with the following IP range: 192.168.2.1 - 
192.168.2.255.

A network device with an IP address of 192.168.2.15 is statically addressed even 
though it is defined in the dynamic zone. 

For more about static and dynamic zones, see “Dynamic and Static Zones” on page 96.

Asset Ranges CSV File Format
Asset ranges represent sets of network nodes addressable as a contiguous block of IP 
addresses. Asset ranges are useful when you have a number of network nodes that would 
be impractical to track individually, or that may come and go from the network, such as 
laptops. An asset range can define a group of assets that are not addressed individually. 
Asset ranges should be a subset of the IP address ranges defined for zones. 

You can define a set of asset ranges in ArcSight ESM by batch loading asset range 
definitions from an asset range CSV file. Asset range CSV files contain the columns listed in 
Table 4-3 on page 109. When an assets CSV file is selected for import, by default only the 
first fifteen rows of data are displayed in Select Column Headers for the Asset Ranges Data 
panel. However, when the data is imported into the ArcSight ESM Manager, all the rows are 
imported. For more information, see “Increasing the Number of Rows Displayed” on 
page 109.

Ignore The column contains data 
that is not used by the 
Network Model wizard when 
creating assets. For example, 
this column could contain a 
description of the asset.

No Yes This asset 
defines the 
Corporate Email 
Server in the 
DMZ.

Each asset range should specify a unique range of IP addresses. The IP 
addresses specified by asset ranges should not overlap. If you import an asset 
range that overlaps with an asset range already specified on the ArcSight ESM 
Manager and the new asset range has a different name than the existing asset 
range, the following occurs:

• the new asset range is created

• the existing asset range is invalid and displays with the broken asset range 
icon in the ArcSight ESM Console

Column 
Type

Description
Required 
Column?

Repeatable 
Column?

Example Value
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For the wizard to determine how to process the imported data, the type of each column 
must be specified. For more information, see “Specifying CSV Column Types” on page 102. 

When the Next button is clicked in the Summary of Data to Import panel, the asset range 
data is imported into the ArcSight ESM Manager. The new asset ranges are created in the 
/All Assets/Site Assets group. For example, if an asset range called DMZCorpHR 
was specified in the imported asset range CSV file, a new asset range is created at the 
following URI: /All Assets/Site Assets/DMZCorpHR.

Table 4-3 Asset Ranges CSV File Format 

An Example of an Asset Ranges CSV File
Here is an example of the Asset Ranges CSV file:

HRRangeA,<Starting-IP-address>,<Ending-IP-address>,/All Asset 
Categories/ArcSight System Administration/Databases/

IT Range X,<Starting-IP-address>,<Ending-IP-address>,/All Asset 
Categories/ArcSight System Administration/Databases/

Increasing the Number of Rows Displayed
By default, only the first fifteen rows of data are displayed in Select Column Headers for the 
<Resource Type> Data panels. However, when the data is imported into the ArcSight ESM 
Manager, all the rows are imported.

Column Type Description
Required
Column?

Repeatable 
Column?

Example Value

Name A descriptive name for the 
asset range. This name 
must be unique.

Yes No DMZ Corp HR

Start 
Address

The start of the range of 
IP addresses that defines 
the asset range.

Yes No 192.168.2.11

End Address The end of the range of IP 
addresses that defines the 
asset range.

Yes No 192.168.2.20

Category URI The asset category to 
assign to asset range.

NOTE: The wizard does 
not create new categories. 
For the category to be 
assigned, it must already 
exist.

No Yes

This column 
can be 
repeated 
because an 
asset range 
can be 
categorized 
into more than 
one asset 
category.

/All Asset 
Categories/Site 
Asset 
Categories/Busin
ess Impact 
Analysis/Data 
Role/HR Data/

Ignore The column contains data 
that is not used by the 
Network Model wizard 
when creating asset 
ranges. For example, this 
column could contain a 
description of the asset 
range.

No Yes This asset range 
defines the all 
the corporate 
human resources 
assets.
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To increase the number of rows displayed, add the property 
usecase.networkmodeling.maxrowfortable to the 
<ARCSIGHT_HOME>/config/console.properties file and set the value of the 
property to a number greater than fifteen. Restart the ArcSight ESM Console. 

Summary of Data to Import
In the Summary of Data to Import panel, a summary of the network modeling data ready 
to import into the ArcSight ESM Manager is displayed. If you click Cancel in this panel or 
any of the preceding panels, no data is imported into the ArcSight ESM Manager.

1 Click Next to start the import process. 

A temporary Archive Resource Bundle (ARB) file with the import data is created and 
the Install Packages dialog displays. 

2 To install the data from the temporary ARB file, in the Update Packages dialog, click 
OK.

The network modeling data is imported into the ArcSight ESM Manager and the Data 
Imported pane displays. In addition, the Installing Packages and the Importing 
Packages dialogs display.

3 Close the open dialogs:

a In the Installing Packages dialog, click OK.

b In the Importing Packages dialog, click OK. 

Network Data Imported into Manager
When network modeling data is imported from the network modeling data CSV files, new 
resources are created in the following groups on the ArcSight ESM Manager:

New zones are created in the /All Zones/Site Zones group. For example, if a 
zone called DMZPublic was specified in the imported zones CSV file, a new zone is 
created at the following URI: /All Zones/Site Zones/DMZ Public.

The new zones are assigned to the default network called Local.

New assets are created in the /All Assets/Site Assets group. For example, if 
an asset called DMZCorpEmailServer was specified in the imported assets CSV file, a 
new asset is created at the following URI: /All Assets/Site 
Assets/DMZCorpEmailServer. When imported, the new assets are auto-zoned. 
For more information, see “Auto-zoning of Imported Assets” on page 110.

New asset ranges are created in the /All Assets/Site Assets group. For 
example, if an asset range called DMZCorpHR was specified in the imported asset range 
CSV file, a new asset range is created at the following URI: /All Assets/Site 
Assets/DMZCorpHR.

In the Data Imported dialog, click Finish to close the wizard. 

Auto-zoning of Imported Assets
When new assets are imported into the ArcSight ESM Manager using the Network Model 
wizard, an attempt is made to assign the assets to the appropriate zone from the default 
network called Local. This process is called auto-zoning. 

When the asset is imported, if a zone is found with an address range that includes the 
imported asset and that zone is located in the Local network, the matching zone is 
assigned to the asset. For the asset to find the matching zone, the matching zone must 
either:
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Already exist on the ArcSight ESM Manager prior to the import. 

Be imported with the asset as part of the same import process—part of the same 
transaction. Zones are created before assets in the import process.

If no matching zone is found in the network, no zone is assigned.

The following example illustrates the auto-zone process. A zone called DMZCorporate is 
defined in the Local network on the ArcSight ESM Manager with a starting address of 
192.168.2.0 and an ending address of 192.168.2.225. If an asset called 
DMZCorpDatabase with an IP address of 192.168.2.11 is imported by the wizard, the 
DMZCorporate zone is assigned to DMZCorpDatabase asset because the IP address of 
the DMZCorpDatabase asset is in the range of addresses specified in the DMZCorporate 
zone and the DMZCorporate zone is located in the Local network.

Working with Assets, Locations, Zones, Networks, 
Vulnerabilities, and Categories

The Assets resource provides tools for managing assets and asset ranges (see “Assets” on 
page 93 and “Asset Ranges” on page 95), and tools for managing the other network and 
asset modeling features associated with assets: 

Networks

Zones

Locations

Vulnerabilities

Asset Categories

Networks and Zones describe characteristics of how the asset is represented in the network 
itself; Locations, Vulnerabilities, and Asset Categories describe attributes of the assets that 
can be used for prioritization and correlation. 

You can organize any of these distinctions into groups upon which you can set up user 
access controls. 

You can also create a channel based on any of these distinctions to get additional 
monitoring views into the events happening on your network. 

This section describes how to manage these resources, and the context actions you can 
take from right-click menus. 

Managing Assets
This topic explains how to create, edit, move, add to, and delete assets, and how to select 
them in the Common Conditions Editor. For an overview of what assets are, the resources 
that comprise them, how they fit into the ESM network model, and the ways to populate 
the ESM network model, see “Network Model” on page 92. 

Only one asset with a given host name is allowed in a given zone on a 
network. When two assets with the same host name are imported, and if the 
ArcSight ESM Manager assigns them to the same zone in the same network, 
both assets are imported but one of the assets is disabled and displays with 
the broken-asset icon in the ArcSight ESM Console. 
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Creating an Asset
This topic describes how to create an asset manually through the Console.

1 In the Navigator panel's drop-down menu, choose Assets.

2 Right-click a group and choose New Asset.

3 Select the Attributes tab and enter values in the fields described below.

4 Click OK.

Table 4-4 Asset Attribute Fields

After you fill in the attribute fields, use the other tabs in the Asset Editor as necessary to 
add resources.

Table 4-5 Additional Asset Editor Tabs 

Editing an Asset
1 In the Assets resource tree, right-click an asset and choose Edit Asset.

2 On the Attributes tab, edit the text fields as described above. 

You can create assets manually using the Console (as described in this topic), 
using the Network Model wizard, or dynamically from scanner data. See also, 
“Network Model” on page 92 and “Populating the Network Model Using the 
Wizard” on page 102.

Asset Attributes Description

Name The asset's friendly name. This field can default to the 
asset's host name or IP address.

IP Address The asset's IP address, in dotted-decimal notation.

MAC Address The unique hardware ID for the network device.

Host Name The asset's DNS name.

Location As described in Assets and Changing Assets.

Zone As described in Assets and Changing Assets.

Asset View Contents

Categories Use the Add button on this tab to select network categories 
with which to associate the asset.

Alternate Interfaces Use the Add button on this tab to select a second asset ID 
if this asset has an additional ID on another network. 
Alternate interfaces usually apply only to network boundary 
devices, such as bridges, that have two MACs.

Vulnerabilities Use the Add button on this tab to select certain 
vulnerabilities with which to associate the asset.

Notes Use the text box and Save button on this tab to write and 
file additional information concerning the asset.
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3 On the other tabs, add or delete information as necessary.

4 Click OK.

Moving or Copying an Asset
1 In the Assets resource tree, navigate to an asset and drag and drop it into another 

group.

2 Choose Move to move the asset, Copy to make a separate copy of the asset, or Link 
to create a copy of the asset that is linked to the original asset.

If you choose Copy, you create a separate copy of the asset that will not be affected 
when the original asset is edited. If you choose Link, you create a copy of the asset 
that is linked to the original asset. Therefore, if you edit a linked asset, whether the 
original or the copy, all links are edited as well. When deleting linked assets, you can 
either delete the selected asset or all linked asset copies.

Deleting an Asset 

1 In the Assets resource tree, right-click an asset and choose Delete Asset.

2 In the dialog box, click Yes.

Showing Assets in a Channel
1 In the Assets resource tree, right-click an asset or group of assets and choose Show 

Assets.

The asset(s) are displayed in an active channel grid view.

2 If applicable, you can also show assets recursively. To do so, right-click an asset group, 
and choose Show Assets Recursively. This will show assets not only in the selected 
group but also all children in an active channel. 

Auto Zoning an Asset
1 In the Assets resource tree, right-click an asset or group of assets and choose Auto 

Zone.

The Network Selector dialog displays.

2 Browse for the network that contains the zone with an IP address range that includes 
the asset. 

3 Select the network and click OK.

If a matching zone with an address range that includes the selected asset can be 
found in the network, the zone is assigned to the asset. 

For example, a zone called DMZCorporate is defined in the Local network on the 
ArcSight ESM Manager with a starting address of 192.168.2.0 and an ending 
address of 192.168.2.225. If an asset called DMZCorpDatabase with an IP 
address of 192.168.2.11 is selected for auto zoning in the Local network, the 
DMZCorporate zone is assigned to DMZCorpDatabase asset because the IP 

Take care when deleting assets. Asset groups required for correct ESM 
operation are locked, however, depending on your permissions, it is possible to 
delete the individual assets in those groups, such as the assets ESM 
automatically creates to track ArcSight components. 

Do not delete ArcSight System Administration assets without consulting an 
ArcSight administrator. 
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address of the DMZCorpDatabase asset is in the range of addresses specified in the 
DMZCorporate zone.

If no matching zone is found in the network, no zone is assigned. 

An asset can be selected for auto zoning manually by right-clicking and choosing the Auto 
Zone option as described above. In addition, auto zoning can automatically occur when 
assets are imported using the Network Model wizard. For more information, see “Auto-
zoning of Imported Assets” on page 110.

Managing Asset Groups
Asset groups are created to store similar groups or assets in a single location. Groups can 
be created within groups to meet enterprise needs. When a group is created within a 
group, the new group inherits the existing group's permissions. If a group is deleted, the 
assets within that group are also deleted. ArcSight provides these groups: 

Shared: this group lists assets to which the user has permission.

Unassigned: this group lists assets not assigned to a group.

If you have Administrator access you will also see another group named "All Assets" that 
contains all asset groups and assets.

Creating an Asset Group
1 In the Navigator panel's drop-down menu, choose Assets.

2 In the Assets resource tree, right-click a group and choose New Group. A "name" 
text field appears under the group you selected.

3 In the name text field, type in a name.

4 Press Enter.

Renaming an Asset Group
1 In the Assets resource tree, right-click a group and choose Rename.

2 In the "name" text field, rename the group.

3 Press Enter.

Editing an Asset Group
1 In the Assets resource tree, right-click a group and choose Edit Group.

2 In the Group Editor, edit the Name and Description text fields.

3 Click OK.

Moving or Copying an Asset Group
1 In the Assets resource tree, navigate to a group and drag and drop it into another 

group.

2 Choose Move to move the group, Copy to make a separate copy of the group, or Link 
to create a copy of the group that is linked to the original group.

If you choose Copy, you create a separate copy of the group that will not be affected 
when the original group is edited. If you choose Link, you create a copy of the group 
that is linked to the original group. Therefore, if you edit a linked group, whether the 
original or the copy, all links are edited as well. When deleting linked groups, you can 
either delete the selected group or all linked groups.
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Deleting an Asset Group
1 In the Assets resource tree, right-click a group and choose Delete Group.

2 In the dialog box, click Yes.

Asset Scalability
ArcSight stores information about hosts and network devices in resources called Assets. 
These resources can be automatically created by vulnerability scanner SmartConnectors. 
Asset Scalability refers to ArcSight's ability to manage hundreds of thousands of assets or 
more without adversely affecting security event throughput. 

Viewing Assets in Active Channels
Starting with ArcSight ESM v4.0, the Console shows assets, vulnerabilities, asset 
categories, scanner reports, and cases in active channels (rather than static grid views, as 
in previous releases). Now you can leverage the power of channels for asset management, 
including use of filters, field sets, better sorting capabilities, and dynamic display of an 
unlimited number of items (continually updated).

To start working with assets in active channels, choose Assets in the Navigator, and see 
“Modeling Your Network” on page 92.

Note also that you can create an “asset channel”. For more information on active channels, 
see the ESM User’s Guide or Console Help.

Finding Assets 
Resource search helps you find one asset in a potentially large set, avoiding the resource 
tree in the Navigator. 

Selecting Assets in the Common Conditions Editor 
Once assets are added to your network model, you can select them in order to write 
conditions that help you analyze their role in the event traffic they process. 

The Asset Selector appears in the Query Editor (in Reports), Rules Editor, Filters Editor, and 
in the Filter Settings panel, when creating an asset condition. In the Asset Selector, select 
the assets to add as a new condition.
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Right-click a node in the Common Conditions Editor (CCE) and choose New "Assets" 
Condition. (For more about using the CCE, the ESM User’s Guide or Console Help.)

Managing Vulnerabilities
This topic describes how to perform the authoring and management tasks for 
vulnerabilities. See also “Modeling Your Network” on page 92.

Note also that you can create a “vulnerability channel”. For more information on active 
channels, see the ESM User’s Guide or Console Help.
116 ArcSight ESM Administrator’s Guide ArcSight Confidential



4 Managing Resources
Vulnerability Editor

In addition to vulnerability Attributes (described above), the Vulnerability Editor includes 
a subtab for selecting and adding assets as vulnerabilities.

Creating a Vulnerability
1 In the Navigator panel's drop-down menu, choose Assets, then click the 

Vulnerabilities tab. 

2 Right-click a group and choose New Vulnerability. 

3 On the Vulnerabilities Attributes tab, type in the following text fields:

4 On the Vulnerable Assets tab, click the Add New button, if you've defined assets that 
include this vulnerability.

5 Click OK.

Editing a Vulnerability
1 In the Vulnerabilities tree, right-click a vulnerability and choose Edit Vulnerability.

2 On the Attributes tab, type in the text fields as described above. 

3 On the Vulnerable Assets tab, click the Add New button, if you've defined assets that 
include this vulnerability.

4 Click OK.

Vulnerability 
Attribute

Description

Name A descriptive name for the vulnerable asset (required)

Knowledge Base Article Optionally, provide a link to a relevant knowledge base 
article.

External ID Provide an alternate identifier for the vulnerability.

Vulnerability 
Attribute

Description

Name The vulnerability's name. It can be generated by the 
ArcSight Manager in response to vulnerability scanners. If 
so, this field will be identical to the External ID field 
except that the pipe (|) will be replaced with a dash (-), 
such as CVE - CVE-1999-200.

Knowledge Base Article A Knowledge Base article that further describes the 
vulnerability.

External ID An ID of the format <standards body>|<id>, such as CVE | 
CVE-1999-200.

Owners ArcSight users who are interested in the vulnerability.

Notification Groups ArcSight users who are notified of events involving the 
vulnerability. 
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Moving or Copying a Vulnerability
1 In the Vulnerabilities tree, navigate to a vulnerability and drag and drop it into another 

group.

2 Choose Move to move the vulnerability, Copy to make a separate copy of the 
vulnerability, or Link to create a copy of the vulnerability that is linked to the original 
vulnerability.

If you choose Copy, you create a separate copy of the vulnerability that will not be 
affected when the original vulnerability is edited. If you choose Link, you create a 
copy of the vulnerability that is linked to the original vulnerability. Therefore, if you edit 
a linked vulnerability, whether it be the original or the copy, all links are edited as well. 
When deleting linked vulnerabilities, you can either delete the selected vulnerability or 
all linked vulnerability copies.

Retrieving Vulnerable Assets
1 In the Vulnerabilities resource tree, right-click a vulnerability and choose Edit 

Vulnerability.

2 Select the Vulnerable Assets tab.

If you used a vulnerability scanner, all vulnerable asset discovered by the scanner are 
listed on this tab.

3 To refresh the vulnerabilities list, click the Refresh button ( ).

Adding an Asset to a Vulnerability
1 In the Vulnerabilities resource tree, right-click a vulnerability and choose Edit 

Vulnerability.

2 In the Vulnerability Editor, select the Vulnerable Assets tab.

3 Click the Add button ( ).

4 Select an asset in the Assets Selector and click OK.

5 In the Vulnerability Editor, click OK.

Deleting an Asset From a Vulnerability
1 In the Vulnerabilities tree, right-click an asset and choose Edit Vulnerability.

2 In the Vulnerability Editor, select the Vulnerable Assets tab.

3 Select an asset and click the Delete button ( ).

4 In the dialog box, click Yes.

5 In the Vulnerability Editor, click OK.

Deleting a Vulnerability
1 In the Vulnerabilities tree, right-click a vulnerability and choose Delete Vulnerability.

2 In the dialog box, click Yes.

Managing Vulnerability Groups
This topic describes the tasks involved in managing vulnerability groups.
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Creating a Vulnerability Group
1 In the Navigator panel's drop-down menu, choose Assets, then the Vulnerabilities 

tab.

2 In the Vulnerabilities resource tree, right-click a group and choose New Group.

A "name" text field appears under the group you selected.

3 In the "name" text field, type in a name.

4 Press Enter.

Renaming a Vulnerability Group
1 In the Vulnerabilities resource tree, under Assets, right-click a group and choose 

Rename.

2 In the "name" text field, rename the group.

3 Press Enter.

Editing a Vulnerability Group
1 In the Asset resource tree's Vulnerabilities tab, right-click a group and choose Edit 

Group. 

2 In the Group Editor, edit the Name and Description text fields.

3 Click OK.

Moving or Copying a Vulnerability Group
1 In the Vulnerabilities tree, navigate to a group and drag and drop it into another 

group.

2 Choose Move to move the group, Copy to make a separate copy of the group, or 
Link to create a copy of the group that is linked to the original group.

If you choose Copy, you create a separate copy of the group that will not be affected 
when the original group is edited. If you choose Link, you create a copy of the group 
that is linked to the original group. Therefore, if you edit a linked group, whether the 
original or the copy, all links are edited as well. When deleting linked groups, you can 
either delete the selected group or all linked groups.

Deleting a Vulnerability Group
1 In the Vulnerabilities tree, right-click a group and choose Delete Group.

2 In the dialog box, click Yes. 

Selecting Vulnerabilities in the Common Conditions Editor
You can open the Vulnerability Selector from the Reports Query Editor, Rules Editor, Filters 
Editor, and in the Filter Settings panel. In the Vulnerability Selector, you select 
vulnerabilities to add to reports, rules, or filters as a new condition.
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Right-click a node in the Common Conditions Editor (CCE) and choose New "Has 
Vulnerability" Condition. (For more about using the CCE, see the ESM User’s Guide or 
Console Help.)

You use the Vulnerability Selector when performing these tasks:

Adding a vulnerability condition to a report query (see the “Query Conditions” topic in 
the ESM User’s Guide or Console Help)

Specifying rule conditions (see the ESM User’s Guide or Console Help)

Using filters (see “Using Filters” on page 124)

Reporting on Output from Vulnerability Scanners
You can review the output of asset-vulnerability scanners in active channels and in the 
Vulnerabilities tab of the Asset Editor.

1 Choose the Assets resource tree in the Navigator panel.

2 In the Assets tab of the Assets tree, right-click an individual asset and choose 
Scanner Reports. If scanner asset-vulnerability reports are available for the selected 
asset, they appear in a Viewer panel grid view as an active channel.
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3 You can use the standard controls described in Using Grids and Active Channels to 
review the reports collectively.

4 Also in the channel view, you can double-click vulnerability scanner events to open 
them in the Asset Editor, where the Vulnerabilities tab lists the vulnerability details.

For information on creating and editing assets, see “Modeling Your Network” on page 92.

You can create an active channel for selected scanner reports. For information on using 
active channels, see the ESM User’s Guide or Console Help.

Reporting on Asset Vulnerabilities
You can create reports to show which assets are vulnerable to particular vulnerabilities or 
threats. ArcSight also provides Asset Reports that can be run from the Reports resource 
tree in the Navigator panel. For more information, see the ESM User’s Guide or Console 
Help.

1 In the Navigator panel's drop-down menu, choose Assets, then click the 
Vulnerabilities tab.

2 In the Vulnerabilities tree, right-click a vulnerability and choose Vulnerable Assets 
Report.

3 In the Report Parameters dialog box, accept the vulnerability listed in the 
Vulnerability URL text field or click the Vulnerability button to run the report on 
another vulnerability. 

4 Choose a Report File Format from the drop-down menu and click OK.

Reports can be archived in PDF, HTML, Excel, Comma Separated Value (csv), or Rich Text 
Format (rtf). The default PDF format should be used when archiving reports. Compared to 
PDF reports, other reports may lose formatting information and will appear differently. In 
addition, Excel format is more memory intensive than PDF. 

Managing Zones
For an overview of zones and how they fit into the ESM network model, see “Zones” on 
page 95. 

Shrinking or Splitting Zones 

The Zone Editor cannot be used to shrink a zone if there are assets that will 
fall outside the range of the new zone. For example, if you have a zone with 
an address range of 1.1.1.1 to 1.1.1.100 and an asset in that zone with an 
IP address of 1.1.1.86, you cannot change the upper end of the zone range to 
1.1.1.80 but you can change it to 1.1.1.90. 

For shrinking or splitting zones that might encounter such issues, we suggest 
using a package export and import operation. You can export the asset 
resources and then import them back in. Package import and install 
automatically assigns assets to appropriate zones similar to the auto-zoning 
used by the Network Model Wizard. See “Managing Packages” on page 135, 
“Populating the Network Model Using the Wizard” on page 102, and “Auto-
zoning of Imported Assets” on page 110.

Zone Attribute Description

Name A descriptive name for the zone (required)
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In addition to zone Attributes (described above), the Zone Editor includes subtabs for 
adding Assets and Categories into the zone you are configuring.

Managing Networks
For an overview of networks and how they fit into the ESM network model, see “Networks” 
on page 97.

In addition to network Attributes (described above), the Network Editor includes subtabs 
for adding Connectors and Zones into the selected network you are configuring.

Managing Asset Categories
The Asset Categories subtab in the Navigator provides options to organize assets into 
groups based on categories. From the Navigator right-click menu on Asset Categories, you 
have several views and tools to help manage and monitor assets. For example, from this 
menu, you can:

Create channels to show asset categories and assets

Move assets into and out of category groups

Create new category groups 

Configure access control lists (ACLs) to limit or allow user access to groups of assets 
(see “Managing Permissions and Resources” on page 79)

Start Address Provide an IP address that identifies the start of the 
network scope.

End Address Provide an IP address that identifies the end of the network 
scope.

Dynamic Addressing Click this option on or off to indicate whether this network 
uses dynamic addressing

• Checkmark (toggle on) this option to indicate that the 
network you are describing uses dynamic addressing 
(Dynamic Host Configuration Protocol or DHCP server)

• Leave this option unchecked (toggle off), if the network 
you are describing does not use dynamic addressing 
(but, rather, uses static IP addresses)

Location Select a location for this zone.

Network Select the network in which this zone resides.

Network Attribute Description

Name A descriptive name for the network (required)

Customer Customer name

This option is typically used if configuring assets for a 
customer on behalf of a managed security service provider 
(MSSP) or similar scenario.

Location This is an optional field for a descriptive name of the 
geographical location of the network.

Zone Attribute Description
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One asset can be categorized in more than one asset category. You can also assign asset 
categories to groups of resources. This transfers the asset category onto all the members 
of the group and its sub-groups. To assign an asset category:

1 In the Navigator drop-down menu, go to Assets. Select the Assets tab. Go to 
ArcSight System Administration/Agents, where you will find the 
SmartConnectors installed for your environment. 

2 Right-click the asset or asset group you wish to categorize and select Edit Asset (or 
Edit Group). 

3 In the Inspect/Edit panel, click the Categories tab. Click the add icon ( ) at the top 
of the screen. 

4 In the Asset Categories Selector pop-up window, select the asset categories that apply 
to this asset and click OK. For example:

a The usage category that applies to the asset (for example, /All Asset 
Categories/Site Asset Categories/Business Impact 
Analysis/Business Role/Revenue Generation)

b The criticality level that applies to the asset (for example, /All Asset 
Categories/System Asset Categories/Criticality/Very High)

5 Repeat steps 3 and 4 for every asset or group of assets you wish to classify in one of 
the ESM asset categories. 

For an overview of asset categories and how they fit into the ESM network model, see 
“Asset Categories” on page 98. 

Managing Locations
For an overview of locations and how they fit into the ESM network model, see “Locations” 
on page 97. 

Managing Filters
The Filters resource tree in the Navigator panel is pre-populated with some typical event 
filters you can use directly, or as templates for more specific purposes.

Location Attribute Description

Name A descriptive name for the geographical location (required)

Latitude Latitude for the location.

The format for this measurement is a preference setting for 
the Console (menu option Edit > Preferences, click 
Latitude and Longitude). For more information, see 
“Latitude and Longitude Options” on page 587 in “Changing 
User Preferences” on page 582.

Longitude Longitude for the location

The format for this measurement is a preference setting for 
the Console (menu option Edit > Preferences, click 
Latitude and Longitude). For more information, see 
“Latitude and Longitude Options” on page 587 in “Changing 
User Preferences” on page 582.

Address Provide details for City, Region Code, Postal Code, and 
Country
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Using Filters
The maintenance tasks for filters include editing, moving, copying, importing, exporting, 
and deleting. (Tasks described here are considered administrator tasks. For information on 
using filters, see also “Filtering Events” in the ESM User’s Guide or Console Help.)

Editing a Filter

1 In the Filters resource tree, right-click a filter and choose Edit Filter.

2 In the Filters Editor, edit the filter name.

3 In the conditions editor, edit logical operators and condition statements by doing the 
following:

To edit a logical operator, right-click the logical operator and choose Edit, then 
choose a logical operator and click OK. (For more information, see the ESM User’s 
Guide or Console Help.)

To edit a condition statement, right-click the condition statement and choose an 
operator, condition editor, or selection operation. (For more information, see the 
ESM User’s Guide or Console Help.)

To delete a logical operator, right-click the operator and choose Delete. In the 
confirmation dialog box, click Yes. The logical operator and all its condition 
statements are removed.

To delete a condition statement, right-click it and choose Delete. In the 
confirmation dialog box, click Yes.

To edit or delete a filter, right-click the filter and choose Edit or Delete.

4 Click OK.

Importing and Exporting filters

For information on how to import and export filters on SmartConnectors, see “Importing 
and Exporting SmartConnector Configurations” on page 171 (especially the topics on 
“Creating SmartConnector Filters” on page 159 and “Adding SmartConnector Filter 
Conditions” on page 160).

Moving or Copying Filters
1 In the Filters resource tree, navigate to a filter and drag and drop it into another 

group.

2 Choose Move to move the filter, Copy to make a separate copy of the filter, or Link to 
create a copy of the filter that is linked to the original filter.

Understanding how to use the Common Conditions Editor (CCE) is integral to 
creating and editing filters. (For more information, see the ESM User’s Guide 
or Console Help.)

To import and export filters, use the packages feature. Packages supersedes 
the import/export facility provided in previous releases and offers enhanced 
functionality, including version support, dependency management, and 
import/export capabilities. Portable ArcSight packages can automatically 
manage dependencies across resources and other packages. For more 
information on packages, see “Managing Packages” on page 135.
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If you choose Copy, you create a separate copy of the filter that will not be affected 
when the original filter is edited. If you choose Link, you create a copy of the filter 
that is linked to the original filter. Therefore, if you edit a linked filter, whether it be the 
original or the copy, all links are edited as well. When deleting linked filters, you can 
either delete the selected filter or all linked filter copies.

Deleting Filters
1 In the Filters resource tree, right-click a filter and choose Delete filter.

2 In the dialog box, click Yes.

Using Filter Groups
Filter groups are created to store similar groups or filters in a single location. Groups can be 
created within groups to meet enterprise needs. When a group is created within a group, 
the new group inherits the existing group's access control list (ACL).

Groups and filters can be managed with drag and drop functionality. You can move or copy 
groups and filters into other groups. If a group is deleted, the filters within that group are 
also deleted.

Creating Filter Groups
1 In the Navigator panel, choose Filters.

2 In the Filters resource tree, right-click a group and choose New Group.

3 In the Name text field, type in a name.

4 Press Enter.

Renaming Filter Groups
1 In the Filters resource tree, right-click a group and choose Edit Group.

2 In the Name text field, rename the group.

3 Press Enter and click OK.

Editing Filter Groups
1 In the Filters resource tree, right-click a group and choose Edit Group.

2 In the Group Editor, edit the Name and Description text fields, and press Enter 
after each.

3 Click OK.

Moving or Copying Filter Groups
1 In the Filters resource tree, navigate to a group and drag and drop it into another 

group.

2 Select Move to move the group, Copy to make a separate copy of the group, or Link 
to create a copy of the group that is linked to the original group.

If you select Copy, you create a separate copy of the group that will not be affected 
when the original group is edited. If you select Link, you create a copy of the group 

To copy multiple resources at once, use Copy and Paste. You can drag and 
drop only one resource at a time.
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that is linked to the original group. Therefore, if you edit a linked group, whether it be 
the original or the copy, all links are edited as well. When deleting linked groups, you 
can either delete the selected group or all linked groups.

Deleting Filter Groups
1 In the Filters resource tree, right-click a group and choose Delete Group.

2 In the dialog box, click Yes.

Managing Notifications
Managing Received Notifications

When the Notifications button in the Console toolbar indicates that new notifications have 

arrived ( ), you click that button to open the Notifications tab in the Viewer panel. This 
is your central notification repository.

You can open the Notifications manager at any time by clicking the toolbar button, even if 

no new notifications are present ( ).

To use the Notifications manager you first choose a category tab for the type of notification 

received.

In a category, click Acknowledge to mark a selected notification as acknowledged. Click 
View Event to see the event that triggered a notification. Click Resolve to reclassify the 
notification as Resolved.

Notification Category Use

Pending These are notifications that you have not yet handled 
(reassigned to one of the following categories). Pending 
notifications older than 24 hours are automatically refiled 
as Not Acknowledged.

Undelivered These are notifications that were not delivered.

Acknowledged These are notifications to which you have replied.

Not Acknowledged Pending notifications that go unacknowledged or 
unresolved for more than 24 hours are automatically refiled 
as Not Acknowledged.

Resolved These are notifications for which you or a colleague have 
found a resolution and so have marked the notification 
accordingly.

Informational These are notifications that are provided for information 
purposes only and do not require resolution or intervention.

If you don't see notifications appearing, make sure your ArcSight user 
identity (not just your e-mail address) is set as a destination in the 
Notifications Editor.
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For each category of notification there is a common set of columns of information 

concerning them..

Managing Notification Groups and Levels
This chapter describes how to handle the tasks required for managing notification groups 
and levels.

Creating Notification Groups
1 On the Navigator panel drop-down menu, choose the Notification resource tree.

2 In the Notification panel, right-click All Destinations and choose New Group.

A "name" text field appears under the group you selected.

3 In the "name" text field, type in a name.

4 Press Enter.

Renaming Notification Groups
1 In the Notifications resource tree, right-click a group and choose Rename.

2 In the "name" text field, rename the group.

3 Press Enter.

Editing Notification Groups
1 In the Notifications resource tree, right-click a group and choose Edit Group.

2 In the Group Editor, edit the Name and Description text fields.

3 Click OK.

Notification Column Definition

Priority This is the same priority set by the SmartConnector and 
modified by the current threat level formula (and seen in 
grid views), unless modified by the rule that triggered the 
notification.

Triggering Event The event that caused the rule to trigger the notification.

Notification Group The branch of the Notifications resource tree to which this 
destination belongs.

Escalation Level The Escalation Level (and implied destinations) the 
notification has reached while waiting for resolution.

Create Time The time at which the notification was created

Also note that you can set a severity threshold for notification pop-ups and 
sounds in Console Preferences, and also manage your notifications from an 
ArcSight Web browser client.

As a user, you can create new groups under All Destinations, but not new 
subgroups under existing system-defined groups.
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Deleting Notification Groups
1 In the Notifications resource tree, right-click a group and choose Delete Group.

2 In the dialog box, click Yes.

Adding Escalation Levels
In the Notifications resource tree, right-click a notification group and choose Add 
Escalation Level.

New escalation levels are added in sequential order. If you want to add a level between two 
existing levels, add another level then move destinations accordingly. For example, if you 
have Level 1 and Level 2 and you want to add a level between them, add another level, 
Level 3. Then, move all destinations from Level 2 to the new Level 3.

Deleting Escalation Levels
1 In the Notifications resource tree, select the last escalation level in a notification 

group.

2 Right-click the escalation level and choose Delete Escalation Level.

Managing Notification Destinations
The task descriptions in this topic explain how to manage notification destinations.

Creating Destinations
1 In the Notification resource tree in the Navigator panel, right-click an escalation level 

(such as Level 1) and choose Add New Destination.

2 In the Notification Editor, enter a label for the notification in the Name field.

3 Set a Start Time and End Time during the day within which the notification will be 
active. The default is all day (12:00:00 AM to 11:59:59 PM).

4 For destinations other than the ArcSight Console, select that Destination Type and 
enter the Address, PIN, or Provider for that device.

5 For the ArcSight Console, choose a User/Group identity.

6 Click OK.

Editing Destinations
1 In the Notification resources tree, right-click a notification destination and choose Edit 

Destination.

2 In the Notification Editor, edit the Value fields for the necessary destination attributes.

3 Click OK.

All destinations within this escalation level will also be deleted. If you want to 
save the destinations, make sure you move them to another level before 
deleting.

Always set the ArcSight User/Group identity. If not set, notifications cannot 
be sent to users' Consoles.
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For more information, see “Changing Notification and Acknowledgement Settings” on 
page 129.

Moving or Copying Destinations
1 In the Notification resources tree, find a destination and drag it to a different 

escalation level. You can drag across groups if needed.

2 Right-click the destination and choose Move to move it, Copy to make a separate 
copy, or Link to create a copy of the destination that is linked to the original 
destination.

If you choose Copy, you create a separate copy of the destination that will not be 
affected when the original destination is edited. If you choose Link, you create a copy 
of the destination that is linked to the original destination. Therefore, if you edit a 
linked destination, whether the original or the copy, all links are edited as well. When 
deleting linked destinations, you can either delete the selected destination or all linked 
destination copies.

Deleting Destinations
1 In the Notification resource tree, right-click a notification destination and choose 

Delete Destination.

2 In the dialog box, click Yes.

Changing Notification and Acknowledgement Settings
Administrators can configure notifications, acknowledgements, and wait-time settings. The 
escalation time window or wait-time depends on the event's severity.

Changing E-mail Settings
1 In the Notification resource tree, right-click a group and choose Settings, then Edit 

E-mail Settings.

2 In the Notification Editor, type in the following text fields:

If notifications and/or acknowledgements were disabled during Manager 
setup, mail server settings made through the Console will not take effect until 
you re-run the Manager setup to enable notifications and/or 
acknowledgements on the Manager side.

To run the Manager setup: (1) stop the Console and Manager, (2) re-run the 
Manager setup wizard from the Manager’s /bin directory (arcsight 
managersetup). See the ArcSight ESM Installation and Configuration Guide 
for more information.

Notification Fields Definition

From Address The e-mail address from where the notification messages 
are sent. It is important that the "from address" specified is 
one that will not be rejected by the SMTP server, since 
some SMTP servers will reject unknown e-mail addresses. 
For notifications sent by cell phone, any cell phone must be 
e-mail enabled.
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3 Type the E-mail Account password in the Password text field and confirm it in the 
Confirm Password text field.

4 Click OK.

Adding New Pager Service Providers
1 In the Notification resource tree, right-click a group and choose Settings, Edit Pager 

Providers, then New Service Provider.

2 In the Notification Editor, type in the following text fields:

3 Click OK.

Editing Pager Service Provider Settings
1 In the Notification resource tree, right-click a group and choose Settings, Edit Pager 

Providers, then the Provider Name.

Outgoing Mail Server The host name of the local outgoing mail server. This is the 
SMTP server ArcSight uses to send e-mail. The Outgoing 
Mail Server must be accessible from the ArcSight Manager 
for e-mail notifications to be sent. SMTP is used to send e-
mail. An SMTP server must be configured either at install 
time or set here.

Incoming Mail Server The local incoming mail server host name.

Incoming Mail Protocol Select either IMAP or POP3 mail protocols.

E-mail Account The e-mail account name. For notifications sent by e-mail, 
you need to add an address to the e-mail Address field.

POP3 and IMAP can be used to check for e-mail acknowledgments. You can 
specify these options at install time, or set them here. For 
acknowledgements, the relevant fields are "incoming mail server," which is 
the POP/IMAP server to specify to check e-mail, "incoming mail protocol," 
which is either POP3 or IMAP, "account" and "password," which are the login 
name and password to access the mailbox from the incoming mail server. 
Note that replying to mails from the notification "from address" should reach 
the mailbox accessible to the "account" login.

Pager Notification 
Field

Description

Provider Name The name of the service provider, such as Skytel.

Host The host name for the service provider's server, such as 
snpp.skytel.com. SNPP is used to send pages. Sending 
notification pages requires that you configure the 
appropriate pager provider host and port information.

Port The port number for the service provider's server.

For notifications sent by pager, firewalls must be configured so that the pager 
can connect directly to the paging service provider. ArcSight currently 
supports any provider that supports SNPP.

Notification Fields Definition
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2 In the Notification Editor, edit the text fields.

3 Click OK.

Deleting Pager Service Providers
1 In the Notification resource tree, right-click a group and choose Settings, Edit Pager 

Providers, then the Provider Name.

2 In the Notification Editor, click Delete.

Changing Wait Time Settings
The default wait-time values for Very-High severity and High severity are set at 5 
minutes, Medium is set for 30 minutes, and Low is set for 2 hours.

1 In the Notification resource tree, right-click a group and choose Settings, then Edit 
Escalation Wait Time.

2 In the Notification Editor, type in the wait time for the hour (Hr) and minute (Min) text 
fields for Very-High, High, Medium, or Low severity.

3 Click OK.

Testing Notification Groups and Destinations
This topic describes how to test notification groups and destinations.

Testing Group Notifications
In the Notification resource tree, right-click a populated notification group and choose Test 
Group Notification.

A test notification message is sent to the notification destination. Test notifications are not 
sent to group notification destinations if the End Time has expired. For example, if you test 
group notification at 6:00:00 PM and the End Time states 5:00:00 PM, a notification 
message will not be sent to the group.

Testing Destination Notifications
In the Notification resource tree, right-click a notification destination and choose Test 
Destination Notification.

A test notification message is sent to the notification device. Test notifications are not sent 
to notification destinations if the End Time has expired. For example, if you test a 
notification destination at 6:00:00 PM and the End Time states 5:00:00 PM, a notification 
message will not be sent to the device.

Managing File Resources
The Files resource tree, when populated, lists various files that have been saved as 
resources so that they are accessible to all users of the system who are authorized for such 
access. File resources include Case file attachments, templates, and general-purpose 
shared files.

In addition to the tasks detailed below, you can also rename or lock a file, get a Graph 
View of a file, and so forth. Simply select the file in the Navigator, right-click, and choose a 
menu option. Operations on groups are also available. Options may vary depending on 
which file or folder you have selected in the Navigator.
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Uploading Files and Creating a File Resource
1 Choose the Files resource tree in the Navigator panel.

2 Right-click a file group and choose New File.
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This brings up the File Editor in the Inspect/Edit panel.

3 Click the Upload button on the File Editor and select the local file to add.

4 On the File Editor Attributes tab, enter values for the attributes that identify the file.

The Name attribute is initially the same as the Filename attribute, but you can change 
the Name.

Certain attributes are read-only: Upload type is Console, and Filename, File size, and 
Mime type are set based on the selected file.

5 Click Apply to update the file and leave the editor open, or OK to complete editing 
and close the editor.
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Viewing Files
1 Choose the Files resource tree in the Navigator panel.

2 Right-click a file and choose Open.

3 The file will be downloaded to a temporary directory (in a sub-directory called 
arcsight-files) and will launch in an appropriate viewer, usually a web browser.

You can also open a file resource from the File Editor by clicking the Open button.

Downloading Files Locally
1 Choose the Files resource tree in the Navigator panel.

2 Right-click a file and choose Download.

3 Specify a location and file name for the new local file.

You can also Download a file resource from the File Editor by clicking the Download button.

Editing File Resource Attributes
1 Choose the Files resource tree in the Navigator panel.

2 Right-click a file and choose Edit File.

3 Change the values, as appropriate.

4 Click Apply to update the file and leave the editor open, or OK to complete editing 
and close the editor.

Replacing File Resource Contents
1 Choose the Files resource tree in the Navigator panel.

2 Right-click a file and choose Edit File.

3 Click Replace and select the local file containing the new contents for the file 
resource. The file resource name will change if the selected local file has a different 
name.

4 Click Apply to update the file and leave the editor open, or OK to complete editing 
and close the editor.

Deleting File Resources
1 Choose the Files resource tree in the Navigator panel.

2 Right-click a file and choose Delete File.

3 Click Yes to confirm the deletion.

File resources can be downloaded as often as needed by any console user 
authorized to access the file resources. Downloading a file does not change 
the file resource, or the shared file contents on the server.
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Adding a File or Folder to a Package
From the Files resource Navigator, you can add a file or folder to an existing package or 
create a new package and add the file to it.

1 Choose the Files resource tree in the Navigator panel.

2 Right-click a file or folder and choose Add to Package.

This brings up the Package Selector dialog.

3 In the Package Selector dialog, do one of the following:

Navigate to a package to which you want to add the file or folder, and click OK. 
(The file is saved to the selected package.)

Or

Navigate to a location where you want to create a new package and click New 
Package. This brings up the Package Editor where you can name and configure 
the new package. The selected file or folder will be included in the new package.

For more about managing packages, see “Managing Packages” on page 135.

Finding Files
To find files stored on the Manager, choose Files in the Navigator and browse the folders 
or choose Edit > Search from the menus, enter a file name in the Search query field, 
and click Find. (See “Finding Resources” on page 180 for more information on this utility.)

Managing Packages
Packages are collections of resources that can be installed into the system resource tree.

To access available packages, click the Packages tab of the Navigator panel. The tree of 

all packages is displayed along with the resources within each package. The ( ) button 
toggles between Normal and Advanced view of the package tree. In the Advanced view, 
uninstalled packages are visible and package dependencies are shown. 
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Viewing Installed Packages

Click the Packages tab in the Navigator panel. If the ( ) button is highlighted, click it to 
return to Normal view. The tree view is like the tree view of any other resource except that 
the resources contained within packages may be of many different types. 

Viewing all Packages (with Dependencies)

Click the Packages tab in the Navigator panel. If the ( ) button is not highlighted, click 
it to switch to Advanced view. In the Advanced view, all packages (including uninstalled 
packages) and package dependencies are shown.

Showing Package Archive Contents

Click the Packages tab in the Navigator panel. If the ( ) button is not highlighted, click 
it to switch to Advanced view (to show all packages including uninstalled packages). Right-
click a package and choose Show Package Archive Contents or Show Current 
Package Archive Contents (available only on installed packages). This lists all resources 
in the package, including details such as resource name, type, and full path to location in 
the tree.

Creating Packages
1 Right-click the Package Group in the Packages tree that will contain the new Package. 

Choose New Package.

2 In the Package Editor that opens in the Inspect/Edit panel, enter the following fields:

The Packages tree view is independent of which resource you have selected in 
the Navigator. Regardless of which resource is selected, when you click the 
Packages tab, you will see the same set of packages. These include the 
ArcSight stock content packages installed on the Manager along with any 
custom packages administrators have created on this Manager.

In this field... ...enter this

Name

Enter a name for the new package.

Required Packages Specify the packages that must be installed for this 
package to function.

Optional Packages Specify packages that are related to this package, but 
which are not required for it to function.

Required Features Enter any ArcSight ESM features that must be available for 
this package to function. The pick list of features includes 
Pattern Discovery, for example.

Installed (Read-only.) Check this box to indicate that the new 
package is installed. Unchecking this box is a good way to 
preview a new package before making its resources visible 
to all users of the system.

Update Available (Read-only.) Check this box to indicate to other users that a 
newer version of the package exists.
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Author Name Enter the name of the author or source for the new 
package.

Package Version The package version can be any string, but by convention, 
ArcSight recommends a format of 0.0.0.0, with numbers in 
decreasing importance (major, minor, release, build).

ArcSight Version (Read-only.) The minimum ArcSight Version needed to 
support this package.

Format (Advanced) if you need a specific behavior, choose one of 
the choices other than default. Otherwise, leave this field 
set to default.

Default - Appropriate format for backing up resources on a 
Manager. This format captures more information than the 
other options, including information specific to a Manager 
installation.

Export - A portable format appropriate for packaging 
resources for transport between systems in which Manager-
specific information is excluded from the exported package 
for resources with attributes that would otherwise retain 
such information upon a "default" export.

For example, a trend packaged in "export" format does not 
include Start Time or End Time trend attributes nor original 
table IDs. Instead, the imported trend uses Start and End 
times that correspond to the time the package is installed 
on a new system. Also at time of package install, a new 
trend table is created. (See also, descriptions of Imported 
Trend Start Time and Imported Trend End Time fields under 
advanced Trend Attributes in “Building Trends” in the ESM 
User’s Guide or Console Help.)

Similarly, active lists and session lists packaged in "export" 
format do not include locked by attributes, table IDs, or 
session/active list entry attributes, respectively. New tables 
are created when the lists are imported, and the other 
attributes are tracked starting with launch of these 
resources on the new system.

The package "export" format packages other resources 
similarly as a means of optimizing portability for content 
distribution.

ArcSight system content is packaged using the "export" 
format. Also, Managed Security Service Providers (MSSPs) 
who provide content to ArcSight ESM installations at 
various customer sites might typically package resources in 
this format.

Exportuser - Highly portable format appropriate only for 
exporting user accounts with no permissions, personal 
group information, or relationships to other resources. If 
you want to export user accounts that include permissions 
and groups, use the default format instead.

Upgrade - For use by Arcsight Professional Services only.

This format might be used for ArcSight initiated 
incremental resource upgrades of older systems in 
particular circumstances. (In most cases, standard upgrade 
utilities and processes are used instead.)

Obfuscated (Advanced) Check this box to scramble the package 
contents to prevent unauthorized viewing or modification.

In this field... ...enter this
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3 Click the Resources tab in the Package Editor. Click the Add drop-down menu to 
select the resources that this package will contain. You can select groups or individual 
resources.

Check the Children Only box to include resources below the specified resource in the 
tree. For example, selecting the group /All Session Lists/ArcSight Administration/User 
and checking Children Only would include only the session list resources in that 
group, not the group itself.

Check the Only If Referenced box to conditionally include resources if they are 
referenced by other resources without the Only If Referenced box checked.

4 To exclude resources from the new package by resource type or by specifying actual 
resources to be removed, use the Removed Resources panel in the lower half of the 
Resources tab. To exclude resources by type, click the Excluded Resource Types 
tab and select from the list of available types. To exclude specific resources, click the 
Removed Resources tab, click the Add drop-down menu, then choose the 
resource(s) you wish to exclude using the resource picker.

Importing Bundles
1 Click the Packages tab in the Navigator panel.

2 Click the  icon to import a bundle.

3 Choose an .arb file to import and click Open.

4 Review the Import dialog for any conflicts. Each conflict will display one or more 
resolution options. To resolve a conflict, choose the preferred resolution option and 
click the OK button next to the options window.

5 Click OK to continue. When the import is done, a Summary Report is displayed 
describing the packages that were imported.

Exclude Reference IDs (Advanced) Check this box to remove reference IDs from 
the package when it is exported. Generally, you would 
exclude reference IDs only when you plan to import the 
package into a different ArcSight system. Leave the box 
unchecked to include reference IDs, which improve 
performance for packages that are imported to the same 
Manager from which they were exported.

The only way to exclude Asset Category resources from a package is to specify 
the Asset Categories explicitly using the Removed Resources tab.

In this field... ...enter this
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6 By unchecking the box next to each package, you can choose to import a package 
without installing it. The default is to install all imported packages.

For more information, see “Resolving Package Conflicts” on page 141.

Exporting Packages
1 Click the Packages tab in the Navigator panel and click to select one or more 

packages to export.

2 Right-click and choose Export Package to Bundle.

3 Enter a name and folder for the local bundle file. The default extension is .arb.

The exported bundle will have reference IDs if that box was checked in the Package Editor, 
and it will be obfuscated if that box was checked in the editor.

Installing Packages
If you chose not to install a package when its bundle was imported, or if you left the 
Installed checkbox unchecked when you created a package, it will be uninstalled. 
Uninstalled packages are not shown in the Normal view of the package tree.

1 Click the Packages tab in the Navigator panel. If the  icon is not highlighted, click 
it to switch to the Advanced view.

2 Right-click the uninstalled package (shown with a gray icon) that you would like to 
install and choose Install Package.

3 Review the dialog for any conflicts. Each conflict will display one or more resolution 
options. To resolve a conflict, choose the preferred resolution option and click the OK 
button next to the options window.

For more information, see “Resolving Package Conflicts” on page 141.

Uninstalling Packages
1 Click the Packages tab in the Navigator panel.

2 Right-click the package to be uninstalled. Choose Uninstall Package. (This 
command is disabled if the package is already uninstalled or if it is locked.)

Uninstalling a package removes its resources from the system and hides the package in 
Normal view, but it remains in the system and can easily be installed again.

Dependent resources will be deleted automatically unless they are contained in another 
package.

Packages, like other resources, are always displayed under the user folder in 
which they were created. Upon import, the Summary Report shows the URI or 
full path into which the package was imported (for example, "Packages 
Imported: /All Packages/Personal/Vicky's Packages/VPN Logins Reporting"). 
The import location is not configurable. If you log in with a different username 
and import a package, you may or may not have write access to the package 
(depending on permissions). If you import the package with a different 
username on a Manager that does not include an account for the package 
originator, you will not see the imported package. If you recreate an account 
on the Manager with the same username as the package originator, the 
imported package will be visible again.
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For more information, see “Resolving Package Conflicts” on page 141.

Editing Packages
1 Click the Packages tab in the Navigator panel.

2 Right-click the package to be edited and choose Edit Package. The Package Editor 
opens in the Inspect/Edit panel.

3 Change the package name or other properties on the Attributes tab. For more 
information on package fields, see “Creating Packages” on page 136.

4 Click the Resources tab to add or remove resources from the package.

Adding Resources to Packages
You can add to a resource to an existing package by using the right-click menu on a 
selected resource in the Navigator tree.

1 Click the Resources tab in the Navigator panel.

2 Choose the resource type you want to add (for example, Reports).

3 Navigate to and right-click the particular resource you want to add (for example, My 
Report), and choose Add to Package. The system displays the Package Selector 
dialog.

4 Select a package to which to add the selected resource and click OK.

Removing Resources from Packages
1 Click the Packages tab in the Navigator panel.

2 Right-click the package to be edited and choose Edit Package. The Package Editor 
opens in the Inspect/Edit panel.

3 Click the Resources tab in the Package Editor.

4 In the upper half of the Resources tab, select the resource you want to remove. (A 
gray highlight on the entire row indicates the resource is selected.)

5 Click Remove.

Deleting Packages
1 Click the Packages tab in the Navigator panel.

2 Right-click the package to be deleted and choose Delete Package.

3 Confirm that you want to delete the specified package.

4 Choose Remove Resources in Package or Leave Resources. If you Leave 
Resources, only the package itself will be deleted. The resource that it contained will 
remain in the system resource tree. If you Remove Resources, all resources that the 
package contained will be deleted from the system resource tree. 

Deleting a package that contains resources that maintain state—active lists 
with values, session lists, or trends—will delete the state information as well.
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For more information, see “Resolving Package Conflicts” on page 141.

Resolving Package Conflicts
Package conflicts can occur during install, uninstall, delete, or import of packages. Most 
package conflicts are resolved internally by the ArcSight Manager without the need for user 
intervention. However, some package conflicts will prompt the administrator for an 
appropriate course of action from among several options. This section describes two of 
these scenarios as examples.

If the ArcSight Manager detects package conflicts for a pending package uninstall, the 
Console provides choices for resolving the conflict and proceeding, or aborting the uninstall 
operation. The options provided depend on the type of conflict detected.

For example, if you attempt to uninstall a package that changed since it was installed, the 

conflict is indicated and you are asked to choose from the following Resolution Options.

If the ArcSight Manager detects package conflicts for a pending package import or install, 
the Console provides choices for resolving the conflict and proceeding, or aborting the 
import operation. The options provided depend on the type of conflict detected.

For example if you attempt to import a package with content that is older than the 
currently imported package, the conflict is indicated and you are asked to choose from the 

following Resolution Options:

Option Description

Create a new archive for 
package

Creates a new archive for the modified package 
(and retains original).

Create new archive for 
remaining changed packages

Creates new archives for all changed packages 
before uninstall (retains all originals).

Continue without saving 
changes

Uninstalls this package without saving changes.

Uninstalls this and remaining 
packages without saving 
changes

Uninstalls all selected packages without saving 
changes.

Abort Abandons the uninstall process and keeps the 
package(s) as is.

Option Description

Leave newer packages Leaves the newer packages installed.

Never override newer packages Completes the import but imports only packages 
that are newer than those currently installed.

Update packages Imports the selected packages, and prompts for 
package conflict resolutions on a per-package 
basis.

Always update packages Imports the selected packages, and overwrites 
newer packages if they exist.

Abort Abandons the uninstall process and keeps the 
package(s) as is.
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Managing SmartConnectors
ArcSight SmartConnectors can be configured to optimize their performance and increase 
their functionality. You can configure SmartConnectors to enable aggregation, batching, 
and time filter correction functionality. You can also send control commands, from the 
ArcSight Console, to SmartConnectors to manage the flow of events. 

Selecting and Setting SmartConnector Parameters
From the Console, use the Connector Editor to control SmartConnectors. 

Configuring the SmartConnector
1 In the Navigator panel, choose the Connectors resource tree.

2 In the Connectors resource tree, right-click the ArcSight SmartConnector you want to 
manage and choose Configure. This opens the Inspect/Edit panel for the 
Connector Editor. On the Connector tab, the Name field is automatically populated 
with the name assigned during SmartConnector Installation.

3 Type in the Connector Location and the Device Location. All events are tagged 
with these fields by the ArcSight SmartConnector. Creation date and other information 
is automatically populated.

4 On the Default tab, change any additional Batching, Time Correction or other 
parameters as desired, using the configuration fields explanations provided below.

5 Click Apply to add your changes and to keep the Connector Editor open. To apply 
your changes and close the Connector Editor click OK, or, if applicable, click Add 
Alternate to save your changes as an alternate configuration you can select and 
apply later.

The description entry associated with the setting provides tool tip information. These 
parameters are not localized since they come directly from the connector and the 
connector may contain new resources (since it may be a newer version). 

The framework for connector commands operates in a similar way. Configuration of the 
connector command menu is achieved by sending the list of commands that are supported 

on the connector at registration time.

There are several controls you can adjust in the Connector Editor. The variety of options 
are best summarized by briefly describing what's available at each of the editor's tabs or 
subtabs.

Connector Editor Option Tabs

Table 4-6 Connector Editor Option Tabs 

The ArcSight Console doesn't currently provide support for command 
parameters.

Connector Tabs Options

Connector Tab Configuration 
Fields

Basic identification, ownership, and date/time 
parameters.
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Connector Tab Configuration Fields
You do basic configuration through the Connector and Default: Content tabs. Many of 
these fields correspond to resource editor fields. See also “Common Resource Attribute 
Fields” on page 198.

Table 4-7 Connector Tab Configuration Fields

Networks The ArcSight network(s) to which the connector is 
or can be assigned.

Default Content Tab 
Configuration Fields

Includes options for report batching, aggregation, 
and time corrections. 

Default: Filters A filter condition editor for constraining what the 
connector reports. (Please see “Managing 
SmartConnector Filter Conditions” on page 159 for 
details on how to define filters for connectors.)

Alternate: Content A set of options identical to those under Default, 
which you can use to create alternate 
configurations.

Alternate: Filters A filter condition editor for constraining what the 
connector reports, in an alternate configuration.

Notes: Table A text editor for, and tabular list of, configuration 
notes. 

Notes: List A text editor for, and text presentation of, 
configuration notes.

Name Field Value Field

Name The Name text field is automatically populated 
with the name assigned during SmartConnector 
installation.

ID The identification string assigned during 
SmartConnector installation.

Status The SmartConnector's current mode of operation.

Connector Location A description of the (usually) physical location of 
the SmartConnector. This appears in all the events 
issued from the connector.

Device Location A description of the (usually) physical location of 
the device the SmartConnector is monitoring. This 
appears in all the events issued from the 
connector.

Version The connector's software version number.

Connector Tabs Options
ArcSight Confidential ArcSight ESM Administrator’s Guide 143



4 Managing Resources
External ID An identification string suitable for, and which can 
be referenced by, systems outside ArcSight ESM. 
Common applications of External IDs include 
appropriate naming for Case and Asset resources 
that are tracked in common with defect reporting 
or vulnerability-management systems. If your 
system interfaces with a third-party incident 
tracking system, such as Remedy, enter an ID that 
corresponds to that system. Your ArcSight ESM 
administrator can advise you on the correct values 
for this field, if applicable.

Alias An identification string suitable for referencing 
resources within ArcSight ESM. A given alias will 
appear in place of the resource's name 
everywhere it may be seen. Your ESM 
administrator can advise you on the correct values 
for this field, if applicable.

Description A text description of the configuration or other 
related information. This text appears as a tooltip 
to any ArcSight user who has Console access to 
the connector.

Owner An ArcSight ESM user selected from the Users 
resource tree who should be notified about this 
connector.

Notification Groups The ArcSight ESM user groups selected from the 
Users resource tree who should be notified about 
this connector.

Created By A user identity provided at SmartConnector 
installation.

Creation Time The time of SmartConnector installation.

Time Since Creation A value calculated from Creation Time.

Last Updated By The time of the last configuration change.

Last Update Time The time of the last configuration change.

Time Since Last Update A value calculated from Last Update Time.

Name Field Value Field
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Default Content Tab Configuration Fields

Table 4-8 Default Content Tab Configuration Fields

SmartConnector configuration options available may vary depending on 
which version of SmartConnectors you are using. SmartConnector 
configuration options come directly from the connector, and newer versions of 
connectors might contain new or different resources than previous versions.

Name Field Value Field

Batching SmartConnectors can batch events to increase 
performance and optimize network bandwidth. 
When activated, SmartConnectors create blocks of 
events and send them when they either (1) reach 
a certain size or (2) the time window expires. You 
can also prioritize batches by severity, forcing the 
SmartConnector to send the highest-severity 
event batches first and the lowest-severity event 
batches later.

Enable Batching (per event) Create batches of events of this specified size (5, 
10, 20, 50, 100 events).

Enable Batching (in seconds) The SmartConnector sends the events if this time 
window expires (1, 5, 10, 15, 30, 60).

Batch By This is Time Based if the SmartConnector should 
send batches as they arrive (the default) or 
Severity Based if the SmartConnector should 
send batches based on severity (batches of 
Highest Severity events sent first).

Time Correction The values you set for these fields establish 
forward and backward time limits, that if 
exceeded, cause the SmartConnector to 
automatically correct the time reported by the 
device.

Use Connector Time as Device 
Time

(No | Yes) Override the time the device reports 
and instead use the time at which the connector 
received the event. This option assumes that the 
connector will be more likely to report the correct 
time. The default is No.

Enable Device Time Correction 
(in seconds)

The SmartConnector can adjust the time reported 
by the device Detect Time, using this setting. This 
is useful when a remote device's clock isn't 
synchronized with the ArcSight Manager. This 
should be a temporary setting. The recommended 
way to synchronize clocks between Manager and 
devices is the NTP protocol.

Enable Connector Time 
Correction (in seconds)

The SmartConnector can also adjust the time 
reported by the Connector Time SmartConnector 
itself, using this setting. This is for informational 
purposes only and allows you to modify the local 
time on the SmartConnector. This should be a 
temporary setting. The recommended way to 
synchronize clocks between Manager and 
SmartConnectors is the NTP protocol.
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Set Device Time Zone To (Disabled | <TimeZone>)(Default is Disabled) 
Ordinarily, it is presumed that the original device 
is reporting its time zone along with its time. And 
if not, it is then presumed that the 
SmartConnector is doing so. If this is not true, or 
the device isn't reporting correctly, you can switch 
this option from Disabled to GMT or to a particular 
world time zone. That zone is then applied to the 
time reported.

Device Time Auto-correction

Future Threshold The connector sends the internal alert if the detect 
time is greater than the connector time by Past 
Threshold seconds.

Past Threshold The connector sends the internal alert if the detect 
time is earlier than the connector time by Past 
Threshold seconds.

Device List A comma-separated list of the devices to which 
the thresholds apply. The default, (ALL) means all 
devices.

Time Checking These are the time span and frequency factors for 
doing device-time auto-correction.

Future Threshold The number of seconds by which to extend the 
connector's forward threshold for time checking.

Past Threshold The number of seconds by which to extend the 
connector's rear threshold for time checking. 
Default is 1 hour (3,600 seconds).

Frequency The SmartConnector checks its future and past 
thresholds at intervals specified by this number of 
seconds. Default is 1 minute (60 seconds).

Cache Changing these settings will not affect the events 
cached, it will only affect new events sent to the 
cache. 

Cache Size SmartConnectors use a compressed disk cache to 
hold large volumes of events when the ArcSight 
Manager is down or when the SmartConnector 
receives bursts of events. This parameter specifies 
the disk space to use. The default is 1 GB which, 
depending on the connector, can hold about 15 
million events, but it also can go down to 5 MB. 
When this disk space is full, the SmartConnector 
drops the oldest events to free up disk cache 
space. (5 MB, 50 MB, 100 MB, 200 MB, 250 MB, 
500 MB, 1 GB, 2.5 GB, 5 GB, 10 GB, 50 GB.) 

Notification Threshold The size of the cache's contents at which to trigger 
a notification. Default is 10,000.

Notification Frequency How often to send notifications once the 
Notification Threshold is reached. (1 min, 5 min, 
10 min, 30 min, 60 min.)

Name Field Value Field
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Payload Cache If the represented SmartConnector supports it, 
setting this to True causes the connector to 
automatically create and populate a cache for 
device payload data. The payload data is retrieved 
from the original device or retained from the 
received event data, depending on how it 
operates. The default setting is False. Consult a 
SmartConnector's Configuration Guide to find out 
whether it supports this capability. Changes to this 
setting take effect after you restart the 
SmartConnector.

Payload Cache Size If Payload Cache is True, these choices 
determine the maximum size of the cache. The 
cache operates on a last-in-first-out (LIFO) basis.

Network

Heartbeat Frequency This setting controls how often the connector 
sends a heartbeat message to the ArcSight 
Manager. The default is 10 seconds, but it can go 
from 5 seconds to 10 minutes. Note that the 
heartbeat is also used to communicate with the 
SmartConnector; therefore, if its frequency is set 
to 10 minutes, then it could take as much as 10 
minutes to send any configuration information or 
commands back to the SmartConnector.

Enable Name Resolution (Enabled | Disabled) The SmartConnector tries to 
resolve IP addresses to host names, and host 
names to IP addresses, if the event rate allows it 
and if required. This setting controls this 
functionality. The Source, Target and Device IP 
addresses and Hostnames may also be affected by 
this setting. (Default is Enabled)

Name Resolution Host Name 
Only

(Yes | No) If set to Yes, for reverse resolution (IP 
Address to Host name), only the host name field is 
set. If set to No, the host name is split up and put 
into both the DNS domain and the host name 
fields. This affects the source, destination, device 
and SmartConnector name fields. (Default is Yes)

Name Resolution Domain from 
Email

(Yes | No) If set to Yes, the host name and DNS 
domain fields are empty, and the corresponding 
user name field appears as an e-mail address, 
then the domain from the e-mail address is put in 
the DNS domain field. This only affects the source 
and destination fields. (Default is Yes)

Clear Host Names Same as IP 
Address

(Yes | No) If set to Yes and the host name field is 
set to an IP Address that matches the 
corresponding IP Address field, then the host 
name field is cleared. This affects the source, 
destination, and device fields. (Default is Yes)

Name Field Value Field
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Don’t Resolve Host Names 
Matching

By default, host names are resolved to their IP 
addresses. You have the option to specify a 
regular expression for all or part of a host name 
for which you do not want the system to attempt 
host name resolution to an IP address.

When this option is configured, the system will not 
attempt to resolve host names matching this 
expression.

Don’t Reverse-Resolve IP 
Ranges

By default, IP addresses are resolved to their 
domain names. You have the option to specify IP 
address ranges for which you do not want the 
system to attempt reverse-resolution to domain 
names.

When this option is configured, the system will not 
attempt to reverse-resolve IP addresses that fall 
within any of the specified ranges.

Limit Bandwidth To A list of bandwidth options you can use to 
constrain the connector's output over the network. 
(Disabled, 1 kbit/sec to 10 Mbits/sec.)

Transport Mode You can configure the SmartConnector to cache to 
disk all the processed events it receives. This is 
equivalent to pausing the SmartConnector. 
However, you can use this setting to delay event-
sending during particular time periods. For 
example, you could use this setting to cache 
events during the day and send them at night. You 
can also set the connector to cache all events, 
except for those marked with a very-high severity, 
during business hours, and send the rest at night. 
(Normal | Cache | Cache (but send Very High 
severity events).

Address-based Zone Population 
Defaults Enabled

This field applies to v3.0 ArcSight Managers, as 
discussed in the Zones section of the 
SmartConnectors topic. This field is not relevant in 
v3.5 or newer versions because the system has 
integral zone mapping. 

Address-based Zone Population This field applies to v3.0 ArcSight Managers, as 
discussed in the Zones section of the 
SmartConnectors topic. This field is not relevant in 
v3.5 because the system has integral zone 
mapping.

Customer URI Applies the given customer URI to events 
emanating from the connector. Provided the 
customer resource exists, all customer fields are 
populated on the ArcSight Manager. If this 
particular connector is reporting data that might 
apply to more than one customer, you can use 
Velocity templates in this field to conditionally 
identify those customers.

Name Field Value Field
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Source Zone URI When populated, this field shows the URI of the 
zone associated with the SmartConnector's source 
address. How this field gets populated is discussed 
in the Zones section of the SmartConnectors topic. 
This field is present for v3.0 compatibility. It is not 
relevant in v3.5 or newer versions because of 
integral zone mapping. 

Source Translated Zone URI When populated, this field shows the URI of the 
zone associated with the SmartConnector's 
translated source address. The translation is 
presumed to be NAT (network address 
translation). How this field gets populated is 
discussed in the Zones section of the 
SmartConnectors topic. This field is present for 
v3.0 compatibility. It is not relevant in v3.5 or 
newer versions because of integral zone mapping. 

Destination Zone URI When populated, this field shows the URI of the 
zone associated with the SmartConnector's 
destination address. How this field gets populated 
is discussed in the Zones section of the 
SmartConnectors topic. This field is present for 
v3.0 compatibility. It is not relevant in v3.5 or 
newer versions because of integral zone mapping. 

Destination Translated Zone URI When populated, this field shows the URI of the 
zone associated with the SmartConnector's 
translated destination address. The translation is 
presumed to be NAT (network address 
translation). How this field gets populated is 
discussed in the Zones section of the 
SmartConnectors topic. This field is present for 
v3.0 compatibility. It is not relevant in v3.5 or 
newer versions because of integral zone mapping.

Connector Zone UR When populated, this field shows the URI of the 
zone associated with the SmartConnector's 
address. How this field gets populated is discussed 
in the Zones section of the SmartConnectors topic. 
This field is present for v3.0 compatibility. It is not 
relevant in v3.5 or newer versions because of 
integral zone mapping.

Connector Translated Zone URI When populated, this field shows the URI of the 
zone associated with the SmartConnector's 
translated address. The translation is presumed to 
be NAT (network address translation). How this 
field gets populated is discussed in the Zones 
section of the SmartConnectors topic. This field is 
present for v3.0 compatibility. It is not relevant in 
v3.5 or newer versions because of integral zone 
mapping.

Device Zone URI When populated, this field shows the URI of the 
zone associated with the device's address. How 
this field gets populated is discussed in the Zones 
section of the SmartConnectors topic. This field is 
present for v3.0 compatibility. It is not relevant in 
v3.5 or newer versions because of integral zone 
mapping.

Name Field Value Field
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Device Translated Zone URI When populated, this field shows the URI of the 
zone associated with the device's translated 
address. The translation is presumed to be NAT 
(network address translation). How this field gets 
populated is discussed in the Zones section of the 
SmartConnectors topic. This field is present for 
v3.0 compatibility. It is not relevant in v3.5 
because of integral zone mapping.

Field Based Aggregation This feature is an extension of basic connector 
aggregation. Basic aggregation aggregates two 
events if, and only if, the fields of the two events 
are the same per the fields listed in the description 
of “Enable Aggregation (in seconds)” on page 154. 
However, field-based aggregation implements a 
more flexible aggregation mechanism; two events 
are aggregated if only the selected fields are the 
same for both events. (Note: Field-based 
aggregation creates a new alert that contains only 
the fields that were specified, so the rest of the 
fields are ignored, unless “Preserve Common 
Fields” is set to “Yes”.)

Field-based aggregation offers several advantages 
over basic aggregation, including:

• Control over what fields to aggregate on

• Start and end time set to the earliest start time 
and latest end time, respectively (instead of 
taking the values from the first event in the 
group, like basic aggregation) 

• Option to preserve common fields 

• Option to sum one or more numeric fields 

SmartConnector aggregation significantly reduces 
the amount of data received, and should be 
applied only when you use less than the total 
amount of information the event offers. For 
example, you could enable field-based 
aggregation to aggregate "accepts" and "rejects" 
in a firewall, but you should use it only if you are 
interested in the count of these events, instead of 
all the information provided by the firewall.

Note: The legacy, basic aggregation feature is 
described in the field description for Enable 
Aggregation (in seconds).

Time Interval Choose a time interval, if applicable, to use as a 
basis for aggregating the events the connector 
collects. It is exclusive of Event Threshold. 
(Disabled, 1 sec, 5 sec, and so on, up to 1 hour.)

Name Field Value Field
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Event Threshold Choose a number of events, if applicable, to use 
as a basis for aggregating the events the 
connector collects. This is the maximum count of 
events that can be aggregated; for example, if 
150 events were found to be the same within the 
time interval selected (i.e., contained the same 
selected fields) and you select an event threshold 
of 100, you will then receive two events, one of 
count 100 and another of count 50. This option is 
exclusive of Time Interval. (Disabled, 10 events, 
50 events, and so on, up to 10,000 events.)

Field Names Choose one or more fields, if applicable, to use as 
the basis for aggregating the events the connector 
collects. Use Ctrl+click to select multiple fields. 
The result is a comma-separated list of fields to 
monitor. For example, 
"eventName,deviceHostName" would aggregate 
events if they have the same event- and device-
host names. You can use any of the event fields 
displayed in the event inspector; the name can 
contain no spaces and the first letter should not be 
capitalized.

Fields to Sum Choose one or more fields, if applicable, to use as 
the basis for aggregating the events the connector 
collects.

If specified, this set of numeric fields is summed 
rather than aggregated, preserved, or discarded. 
The most common fields to sum are bytesIn and 
bytesOut. Note that if any of the fields listed here 
are also in the list of field names to aggregate, 
they are aggregated and not summed. 

Preserve Common Fields (Yes | No) Choosing Yes adds fields to the 
aggregated event if they have the same values for 
each event. Choosing No, the default, ignores 
non-aggregated fields in aggregated events.

Filter Aggregation Filter Aggregation is a way of capturing 
aggregated event data from events that would 
otherwise be discarded due to an agent filter. Only 
events that would be filtered out are considered 
for filter aggregation (unlike Field-based 
aggregation, which looks at all events).

SmartConnector aggregation significantly reduces 
the amount of data received, and should be 
applied only when you use less than the total 
amount of information the event offers. 

Time Interval Choose a time interval, if applicable, to use as a 
basis for aggregating the events the connector 
collects. It is exclusive of Event Threshold. 
(Disabled, 1 sec, 5 sec, and so on, up to 1 hour.)

Name Field Value Field
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Event Threshold Choose a number of events, if applicable, to use 
as a basis for aggregating the events the 
connector collects. This is the maximum count of 
events that can be aggregated; for example, if 
150 events were found to be the same within the 
time interval selected (i.e., contained the same 
selected fields) and you select an event threshold 
of 100, you will then receive two events, one of 
count 100 and another of count 50. This option is 
exclusive of Time Interval. (Disabled, 10 events, 
50 events, and so on, up to 10,000 events.)

Fields to Sum (Optional) Choose one or more fields, if applicable, 
to use as the basis for aggregating the events the 
connector collects.

Processing

Preserve Raw Event (Yes | No) Some devices contain a raw event that 
can be captured as part of the generated alert. If 
that is not the case, most connectors can also 
produce a serialized version of the data stream 
that was parsed/processed to generate the 
ArcSight event. This feature allows the connector 
to preserve this serialized "raw event" as a field in 
the event inspector. This feature is disabled, by 
default, since using raw data increases the event 
size and therefore requires more database storage 
space.

You can enable this by changing the Preserve 
Raw Event setting. If you choose Yes, the 
serialized representation of the "Raw Event" is 
sent to the ArcSight Manager and preserved in the 
Raw Event field.

Name Field Value Field
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Turbo Mode If your configuration, reporting, and analytic 
usage permits, you can greatly accelerate the 
transfer of a sensor's event information through 
SmartConnectors by choosing one of two "turbo" 
(narrower data bandwidth) modes. The default 
transfer mode is called Complete, which passes 
all the data arriving from the device, including any 
additional data (custom, or vendor-specific).

Complete mode does indeed use all the database 
performance advances of ArcSight v3.x.

The first level of Turbo acceleration is called 
Faster and drops just additional data, while 
retaining all other information. The Fastest mode 
eliminates all but a core set of event attributes, in 
order to achieve the best throughput. Consider the 
possible effects such a restricted data set might 
have from a given device (e.g., on reports, rules, 
threat resolution) before selecting it.

The specific event attributes that apply to these 
modes in your enterprise are defined in the self-
documented 
$ARCSIGHT_HOME/config/connector/agent.prop
erties file for the ArcSight Manager. Because 
these properties may have been adjusted for your 
needs, you should refer to this file for definitive 
lists.

Only scanner SmartConnectors must run in 
Complete mode, to capture the additional data.

Note: SmartConnector Turbo Modes are 
superseded by the Turbo Mode in use by the 
ArcSight Managers processing their events. For 
example, a Manager set to Faster will not pass all 
the data possible for a SmartConnector that is set 
for the default of Complete.

Name Field Value Field
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Enable Aggregation (in seconds) Note: If you have already used this feature for 
setting up previous SmartConnectors, you can 
continue to do so. However, ArcSight recommends 
that you use the new Field Based Aggregation 
feature as a more flexible option. (Please see 
“Field Based Aggregation” on page 150.)

Here is the description of the legacy “Enable 
Aggregation” feature, for those of you who are still 
using it:

When enabled, Enable Aggregation (in 
seconds) aggregates two or more events on the 
basis of the selected time value. (Disabled, 1, 2, 
3, 4, 5, 10, 30, 60)

The aggregation is performed on one or more 
matches for a fixed subset of fields:

• Agent ID

• Name

• Device event category

• Agent severity

• Destination address

• Destination user ID

• Destination port

• Request URL

• Source address

• Source user ID

• Source port

• Destination process name

• Transport protocol

• Application protocol

• Device inbound interface

• Device outbound interface

• Additional data (if any)

• Base event IDs (if any)

The aggregated event shows the event count (how 
many events were aggregated into the displayed 
event) and event type. The rest of the fields in the 
aggregated event take the values of the first event 
in the set of aggregated events.

Limit Event Processing Rate You can moderate the SmartConnector's burden 
on the CPU by reducing its processing rate. This 
can also be a means of dealing with the effects of 
event bursts.

The choices range from Disabled (no limitation on 
CPU demand) to 1 eps (pass just one event per 
second, making the smallest demand on the CPU).

Be sure to note that this option's effect varies with 
the category of SmartConnector in use, as 
described in the SmartConnector Processing 
Categories table below. 

Name Field Value Field
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Fields to Obfuscate Using MD5 hashing, this option allows you to 
specify a list of fields for obfuscation in a security 
event. 

Store Original Time In This parameter allows you to move the original 
device receipt time to a specified field if altered by 
the time correction.

Enable Port-Service Mapping (Disabled | Enabled)

If Enabled and one of the two fields destination 
port and application protocol is set, and the other 
is not, the one that is set is used to set the other. 
For example, if the destination port is 22 and 
application protocol is not set, then the application 
protocol is set to ssh.

Default is Disabled.

Uppercase User Names (Disabled | Enabled)

Default is Disabled. If set to any of the enabled 
settings, the two user name fields are 
automatically changed to uppercase. 

The original values are saved as follows: 

• Enabled (orig to ID) saves the original 
values to the sourceUserID and 
destinationUserID fields, respectively, 
overwriting any values that may have been 
there previously.

• Enabled (orig to ID or Flex) saves the 
original values in the same fields if they do not 
already contain values, or to the flexString1 
(source) and flexString2 (destination) fields 
if the ID fields do contain values.

• Enabled (orig to Add. Data) saves the 
original values to additional data fields called 
OrigSrcUsrName and OrigDstUsrName, 
respectively.

Note: The uppercase operation is typically done 
using the default Locale for the chosen platform. 
You can set this to a particular Locale by setting 
the connector.uppercase.user.name.locale 
property in agent.properties to the desired Locale 
(using "en_US" for U.S. English, for example). 

Enable User Name Splitting (Yes | No) If this is set to yes and the destination 
user name contains commas in the event, this 
parameter duplicates that event. Each user name 
in the list is placed in one of the events.

For example, if the destination user name in an 
event is “User 123, User 456”, then that event is 
sent twice, with the destination user name set to 
“User 123” in the first and “User 456” in the 
second.

Default is No

Name Field Value Field
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Split File Name into Path Name (Yes | No) If this is set to yes and an event’s file 
name field is set but its file path field is not, this 
parameter splits the file name into a path and a 
name, placing each part into appropriate fields.

For example, if the file name field is set to 
C:\dir\file.ext and the file path is not set, then 
the file path is set to C:\dir and the file name to 
file.ext. The separator character can be either \ or 
/ as the system looks to the SmartConnector to 
determine its platform.

Default is No

Event Integrity Algorithm (Disabled | SHA-256 | SHA-1 | MD5 | SHA-512)

If this is set to one of the algorithms (such as 
SHA-256), and the Preserve Raw Event 
parameter is Enabled, then additional event 
integrity internal events are generated, normally 
at a rate of about 1 per 50 normal events.

The crypto signature field is also set in each event 
in the format: "#seq(alg):digest", where seq is 
a persistent event sequence number, alg is the 
message digest algorithm, and digest is the 
hexadecimal message digest.

These extra events and the crypto signature field 
values can be used to verify that no events were 
tampered with after generation.

Supported algorithms are: SHA-256, SHA-1, MD5, 
and SHA-512.

Default is Disabled (i.e., no algorithm is applied)

Generate Unparsed Events (Yes | No) If set to yes and some incoming event 
data cannot be parsed (perhaps because a device 
has been upgraded since the SmartConnector 
parser was written), then a special event named 
“Unparsed Event” is generated. The raw event 
appears in the event message field. 

If set to No, the SmartConnector log files indicate 
the unparsed events.

Default is No

Preserve System Health Events (Yes | No) If set to yes, internal system health 
events are preserved.

SmartConnectors generate system health events 
that provide information about the systems on 
which they are installed (e.g., disk usage, network 
memory, JVM memory, percentage of processing 
of CPU memory usage, and so forth). By default, 
these events are not retained or passed on to 
ArcSight destinations like ESM and, therefore, not 
available for viewing. Setting this option to yes 
makes them available in the Console.

Name Field Value Field
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Enable Device Status Monitoring 
(in milliseconds)

(<NumberOfMilliseconds> | -1 (disabled))

If set to a <NumberOfMilliseconds>, the selected 
SmartConnector generates internal events 
periodically 1 minute (60000 milliseconds) or 
greater with the status of the devices for which 
the connector is receiving normal events.

These events have the name "Connector Device 
Status," and are intended primarily for the use of 
content in ESM v4.0 SP3 and newer versions.

Enabling periodic device status monitoring events 
helps monitor both the SmartConnector and 
device uptime.

Device status monitoring events include this 
information, if available:

• Event name (Connector Device Status)

• Vendor and Product information

• Source Address and Host Name

• Zone

• Last event received

• Total number of events for the device since the 
connector started

• Event count since last call

Device status monitoring events can be set to 
generate every 1 minute (60000 milliseconds), or 
less frequently (i.e., a greater number of 
milliseconds than the minimum).

If you specify a number less than 60000, you will 
get a warning message in the log indicating that 
the minimum is 60000 milliseconds (1 minute) 
and that the system will use the minimum.

If you enter a non-number in the field, this 
generates an error in the log indicating the value 
could not be parsed. In this case, the feature will 
be disabled (and the log message will say that).

In such cases, there is no indication on the 
Console that anything went wrong because there 
is no mechanism for the Connector to convey that 
error.

Name Field Value Field
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SmartConnector Processing Categories

Table 4-9 SmartConnector Processing Categories

Payload Sampling Payload sampling is used by some 
SmartConnectors to send a portion of packet 
payload (as opposed to the complete packet 
payload) along with the original event. This 
portion is retrieved using the on-demand payload 
retrieval in the event inspector.

Maximum Length This feature allows you to configure the maximum 
length of the payload sample using the following 
values:

• Discard

• 128 bytes

• 256 bytes

• 512 bytes

• 1 Kbyte

When the Discard option is chosen, no payload 
sample is sent inside the original event.

Mask Non-printable Characters This feature allows you to mask the non-printable 
characters in the payload sample.

SmartConnector 
Type

Effects of Limited Usage

Syslog connectors Due to the nature of UDP (the transport protocol used by 
Syslog), these connectors can potentially lose events if the 
configurable event rate is exceeded. This is because the 
connector delays processing to match the event rate 
configured, and while in this state, the UDP cache may fill 
and the operating system drop UDP messages. Note that 
ArcSight does not recommend using the Limit CPU 
Usage option with these connectors because of this 
possibility of event loss.

SNMP connectors Similar to Syslog connectors, when the event rate is limited 
on SNMP connectors, they potentially lose events. SNMP is 
also UDP-based and has the same issues as Syslog.

Database connectors Since connectors "follow" the database tables, limiting the 
event rate for database connectors can slow the operation 
of other connectors. The result can be an event backlog 
sufficient to delay the reporting of alerts by as much as 
minutes or hours. On the other hand, note that no events 
will be lost, unless the database tables are truncated. After 
the event burst is over, the connector may eventually catch 
up with the database if the event rate does not exceed the 
configured limit.

Name Field Value Field
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SmartConnector Time Interval Options
This time interval applies to the Alternate Settings and it specifies when the alternate 
settings must be used by the SmartConnector. For example, if you want to cache the 
events during the day and send everything at night, you can configure the Transport Mode 
to cache in the default configuration and configure the Transport Mode to normal in the 
Alternate Settings, then you would set the time interval from 8PM to 8AM (next day).

“From:” Specifies the starting time to apply the Alternate settings.

“To:” Specifies the ending time that the Alternate settings will no longer apply (and 
revert to the default settings). If this is less than the From setting, the value will be 
interpreted as "next day". For example, a setting from 8PM to 8AM will be interpreted 
as starting at 8PM and ending at 8AM the following day.

To save configuration changes to the SmartConnector, click OK.

Managing SmartConnector Filter Conditions
SmartConnector can function as a filtering tool between devices and the ArcSight Manager, 
using filtering conditions. Filtering conditions are set with a combination of AND or OR 
statements and data field values. Extraneous events are filtered out to minimize the 
number of events sent to the ArcSight Manager and analyzed in the ArcSight Console.

Creating SmartConnector Filters
1 In the Navigator panel, choose the Connectors resource tree.

2 In the Connectors resource tree, right-click an ArcSight SmartConnector and choose 
Configure.

3 In the Default | Filter tab, right-click and choose Add new condition.

File connectors Similar to database connectors, file-based connectors 
"follow" files, so limiting their event rates also causes an 
event backlog. This can eventually force the connector to 
fall behind by as much as minutes or hours, depending on 
the actual event rate. Similarly, the connectors may catch 
up if the event rate does not exceed the configured rate.

Proprietary API 
connectors

These connectors' behavior depends on the particular API, 
(e.g., OPSEC behaves differently than PostOffice and 
RDEP). But in most cases, there will be no event loss unless 
the internal buffers and queues of the API implementation 
fill up. Therefore, these connectors work much like 
database or file connectors.

SmartConnector 
Type

Effects of Limited Usage
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4 In the Filter Condition dialog box, select a data field from the drop-down menu. (See 
“Using Field Sets” under the topic “Common Conditions Editor” in the ESM User’s 
Guide or Console Help.)

5 Choose logic operators from the drop-down menu.

6 Type a value in the last text field.

7 Click OK.

Adding SmartConnector Filter Conditions
1 In the Navigator panel, choose the Connectors resource tree.

2 In the Connectors resource tree, right-click an ArcSight SmartConnector and choose 
Configure.

3 In the Default: Filters tab, right-click the if folder and choose Add OR condition to 
create an OR condition, or right-click the existing filter condition and choose Add AND 
condition to create an AND condition.

4 In the Filter Condition dialog box, choose a data field on the drop-down menu.

5 Choose logic operators on the drop-down menu.

6 Type a value in the last text field.

7 Click OK.

Deleting SmartConnector Filter Conditions
1 In the Navigator panel, choose the Connectors resource tree.

2 In the Connectors resource tree, right-click the ArcSight SmartConnector and choose 
Configure.

3 In the Filtering section on the Advanced tab, right-click a condition and choose Delete 
condition.

Setting Special Severity Levels
You can customize or conditionalize the event-severity levels reported by SmartConnectors. 
Customizing means pre-setting a given SmartConnector's filter to one specific severity 
level; conditionalizing is essentially the same, but with the addition of a filter condition to 
determine when the pre-set severity level is reported.

Setting a Custom Severity Level
1 Choose the Connectors resource tree in the Navigator panel.

2 In the Connectors resource tree, right-click the appropriate SmartConnector and 
choose Configure.

3 In the Connector Configuration Editor, select the Connector: Default: Filters tab.

4 In the Filters tab, right-click the Right-click to add an action item and choose Add 
severity action. The filter shows SetSeverity Very-High.

5 Right-click the SetSeverity value and choose a different severity level from the Set 
severity to menu, if necessary.

6 Click Apply or OK.
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Configuring a Conditional Severity
1 Choose the Connectors resource tree in the Navigator panel.

2 In the Connectors resource tree, right-click the appropriate SmartConnector and 
choose Configure.

3 In the Connector Configuration Editor, select the Connector: Default: Filters tab.

4 In the Filters tab, right-click the Right-click to add an action item and choose Add 
severity action. The filter shows SetSeverity Very-High.

5 Right-click the SetSeverity value and choose a different severity level from the Set 
severity to menu, if necessary.

6 Right-click the SetSeverity value and choose Add new condition.

7 In the Filter Condition dialog box choose a field, a logical operator, and enter a value 
for the condition.

8 Click OK in the Filter Condition dialog box and Apply or OK in the Connector 
Configuration Editor.

For more information, see “Managing SmartConnector Filter Conditions” on page 159.

Sending Model Mappings to SmartConnectors
Updates to network model mappings are sent automatically from the ArcSight Manager to 
SmartConnectors within heartbeat messages. The heartbeat messages themselves are sent 
on an interval which can be anywhere from every 5 seconds to every 10 minutes, but 
network model mappings are included in the messages only when there are updates to the 
model. 

If you have made several configuration updates to the network model on the Manager and 
would like these changes to take effect immediately on the SmartConnectors without 
waiting for the next automatic refresh, you can use the following command to send the 
update information to a selected Connector.

Sending Model Mappings to a Connector
1 In the Navigator panel, choose the Connectors resource tree.

2 In the Connectors resource tree, right-click the ArcSight SmartConnector you want to 
update and choose Send Model mappings now.

This sends information about the current network model mappings from the Manager to 
the selected Connector. It will force a comprehensive refresh of the zone mappings and 
network model information on the Connector.

Sending Control Commands to SmartConnectors
From the Console you can issue basic event-flow-control commands to SmartConnectors, 
get the operational status of a SmartConnector, or issue control commands to network 
devices through their SmartConnectors. This topic discusses the first two points. To author 

The interval on which information is exchanged between the Manager and 
SmartConnectors is determined by the Heartbeat Frequency setting on each 
Connector. (See information on “Heartbeat Frequency” on page 147 in default 
content tab configuration fields under “Selecting and Setting SmartConnector 
Parameters” on page 142.)
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rule-driven device-command responses to events, please see “Creating Rule Actions” in the 
ESM User’s Guide and/or Console Help.

Getting Status Reports
You can see a SmartConnector's current operational state at any time.

1 Choose the Connectors resource tree in the Navigator panel.

2 In the Connectors resource tree, right-click the ArcSight SmartConnector, choose 
Send Command>Status>Get Status.

3 In the Connector Status window you can see a readout of all the connector's current 
parameters.

Sending Flow-Control Commands
1 Choose the Connectors resource tree in the Navigator panel.

2 In the Connectors resource tree, right-click the ArcSight SmartConnector, choose 
Send Command, and one of the following menu options described below.

3 The Console's status bar shows a confirmation message when the flow control option 
takes effect.  

• Commands available on this menu will vary depending on which 
SmartConnectors you are using. The standard set of commands is 
described here.

• Because there is no local cache, events that occur while a connector is 
stopped or paused are not retained.

• If a SmartConnector runs out of disk space, it can lose its ability to track 
events.

• The Terminate command should only be used in very special 
circumstances as it will kill all SmartConnector processes.

• See “Creating Rule Actions” in the ESM User’s Guide or Console Help for a 
description of the rule-based automated alternative for giving 
SmartConnector commands.

Flow 
Category

Command Description

Status

Get Status Provides a full report on the 
selected SmartConnector's 
current operational state.

Get Device Status Provides the status of the device 
that reports to the 
SmartConnector. (Currently only 
available for the CiscoIDS/IPS 
SmartConnector.)
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Connector 
Process 

Restart Restarts a running 
SmartConnector.

Caution: Once a connector is 
terminated, Console commands 
cannot access it. Therefore, a 
"restart" works only on a 
connector that is currently 
running. Sending a restart 
command to a running 
connector will terminate and 
restart the connector.

Terminate Shuts down the SmartConnector 
and all processes the 
SmartConnector started.

Caution: Once a connector is 
terminated, Console commands 
(including Connector Process > 
Restart) cannot access it. The 
connector must be restarted 
manually from the machine on 
which it is installed.

Event Flow 

Pause Stops the SmartConnector from 
sending events to the ArcSight 
Manager.

Note: Events received from the 
target device will be saved in the 
connector cache (even though 
the connector is in Pause 
state).

Stop Stops the SmartConnector from 
sending events to the ArcSight 
Manager.

Caution: A Stop command 
causes the SmartConnector to 
drop all events, including events 
stored in the connector cache.

Start Prompts the SmartConnector 
(previously in Stop or Pause 
state) to start sending events to 
the ArcSight Manager.

Network

Flush Name Resolver Cache Clears cache for Network name 
resolver.

Flow 
Category

Command Description
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Upgrade

Upgrade Launches a Command 
Parameters dialog for remote 
upgrade to newer versions of 
ArcSight SmartConnectors for 
managed assets.

Provide the version number of 
the connector to which you want 
to upgrade and a wait time to 
verify that the upgrade 
completed successfully. (If the 
upgrade is not successful, the 
system performs an automatic 
rollback to the previous version 
of the connector.)

Click OK to start the upgrade.

See “Upgrading 
SmartConnectors” on page 173 
for prerequisites for the upgrade 
process and detailed information 
on how to upgrade Connectors.

Rollback Upgrade Launches a Command 
Parameters dialog for remote 
rollback of connector version to 
a specified previous version. See 
“Upgrading SmartConnectors” 
on page 173 for complete 
information.

Tech Support commands are provided for use primarily by ArcSight Customer 
Support. Brief descriptions of these Tech Support commands are provided for 
informational purposes, but these commands are not intended for use by 
ArcSight customers except as instructed by ArcSight Customer Support.

Flow 
Category

Command Description

Tech Support 

Get support info Gets logs and other feedback on 
SmartConnectors.

Get 'agent.properties' Shows the list of properties for 
the selected SmartConnector.

Get Upgrade Logs Get upgrade logs on 
SmartConnectors.

Get 'agent.wrapper.conf' Shows the wrapper configuration 
for the selected SmartConnector.

Get Configuration XML File Shows the XML configuration file 
for the selected SmartConnector.

Get Thread Dump Gets one thread dump for the 
selected SmartConnector.

Flow 
Category

Command Description
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Get Two Thread Dumps... Gets two thread dumps for the 
selected SmartConnector spaced 
by the time interval specified. By 
comparing both thread dumps, 
ArcSight Customer Support can 
troubleshoot connectors with 
threads that are hanging for 
unknown reasons.

Get last N lines of 'agent.log'... Shows an excerpt from the 
connector log file based on the 
number of lines you specify. The 
default is 500 lines.

Get system properties Shows system properties for the 
selected connector, including 
details on variables such as Java 
runtime name, Java virtual 
machine (VM) version, operating 
system name, paths for various 
Java components, paths for 
ArcSight Home, user directories, 
user home, and so forth.

Enable Event Flow Tracing... Allows you to specify a 
component and fields to log for 
initiating an event flow trace. 
Component and field names 
must be provided per 
appropriate syntax. The 
component should be chosen 
from the components listed in 
the Get Status results.

Disable Event Flow Tracing... Disables event flow tracing on 
the selected component.

Get Event Flow Tracing Log When tracing is enabled on the 
selected connector, the 
connector logs data about 
events it receives.

The following commands provide access to SmartConnector component 
mapping and event categorization for advanced users.

Flow 
Category

Command Description
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Flow 
Category

Command Description

Mapping Get Additional Data Names

Returns a list of additional data names 
seen for each device vendor/product 
combination since the connector started 
running. For example:

Additional Data Names Seen:  

Generic (no vendor/product):

test1 [3 times]

test11

test13 [2 times]

Vendor/product [vend/prod]:

test1

test10 [6 times]

By default, the command limits the list to 
show only the most recent 100 device 
vendor/product combinations and the 
most recent 100 names for each.

Tip: You can change this limit by editing 
the SmartConnector property 
agent.additionaldata.mapper.track.m
ax.names in the file 
$ARCSIGHT_HOME/ArcSightSmartAgents/
current/user/agent/agent.properties 
on the machine where the connector is 
installed. However, in most cases we 
recommend keeping the defaults. If you 
do change a property setting such as this, 
you will need to restart the connector.

If a data name is not a string, its data 
type is displayed in the list. If the 
connector saw an additional data name 
more than once, the command output 
indicates the number of times the name 
was seen.

Map Additional Data Name... Brings up a dialog where you can map an 
additional data name for the selected 
connector.
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For a generic mapping, you can leave the 
Device vendor and Device product 
fields blank. For a specific mapping, fill in 
these fields with the appropriate vendor 
and product names.

Typically, the Additional data name is 
one of the names shown in the Get 
Additional Data Names output (but can 
be another name not on that list).

The ArcSight field must be a valid 
ArcSight event field.

Click OK to create the mapping.

Here is an example of the command 
output for a successful generic mapping:

Successfully mapped additional data 
name [test11] to event field 
[message] for vendor/product []

A successful device vendor/product-
specific mapping returns output similar to 
this:

Successfully mapped additional data 
name [test10] to event field 
[message] for vendor/product 
[vend/prod]

If the additional data name has not been 
seen, the name is still mapped, but with a 
warning like this:

Successfully mapped additional data 
name [foo] to event field 
[deviceCustomString1] for 
vendor/product [vend/prod] (note 
that additional data name [foo] has 
not been seen for vendor/product 
[vend/prod])

If the ArcSight field is not valid, the error 
returned is similar to this:

Failed to map additional data name 
[bar] to event field [messages] for 
vendor/product [vend/prod] (event 
field [messages] is unknown)

Unmap Additional Data Name... Brings up a dialog where you can unmap 
an additional data name for the selected 
connector.

Flow 
Category

Command Description
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To remove a generic mapping, you can 
leave the Device vendor and Device 
product fields blank. To remove a 
specific mapping, fill in these fields with 
the appropriate vendor and product 
names. The additional data name should 
be one that was previously mapped for 
the specified device vendor and product 
combination.

Click OK to unmap the data name.

Here is an example of the command 
output for a successful generic 
unmapping:

Successfully unmapped additional 
data name [test11] for 
vendor/product []

A successful device vendor/product-
specific unmapping returns output similar 
to this:

Successfully unmapped additional 
data name [foo] for vendor/product 
[vend/prod]

If the specified additional data name was 
not previously mapped, the output looks 
like this:

Failed to unmap additional data 
name [foo] for vendor/product 
[vend/prod] (not previously mapped)

Notes:

• One additional data name can be 
mapped to more than one ArcSight 
field for the same device 
vendor/product combination, and in 
this case unmapping it unmaps it 
from all ArcSight fields for that device 
vendor/product. This is an unlikely 
scenario, however.

• The converse case, where multiple 
additional data names are mapped to 
the same ArcSight field for the same 
device vendor/product combination, 
results in the last mapping taking 
precedence over any previous 
mappings to that ArcSight field for 
that device vendor/product. No 
warning is generated in this case.

Flow 
Category

Command Description
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Managing SmartConnector Groups
You can best manage ArcSight SmartConnectors when you organize them into groups. 
You'll find all uncategorized SmartConnectors in the Unassigned group.

You can move or copy groups and SmartConnectors into other groups in the Connectors 
resource tree by using drag-and-drop. If a group is deleted, the SmartConnectors within 
that group are also deleted.

You should not delete a Connector resource at the ArcSight Console, unless the 
corresponding SmartConnector is first stopped. If the SmartConnector on the device is 
running and its Connector resource is deleted, the SmartConnector will no longer be able to 
send events to the ArcSight Manager, causing the SmartConnector to start caching events 
and eventually dropping these events.

Categorizer/ 
mapper

Reload custom categorizations There are several ways to set event 
category information for events. The 
least common of these is to store custom 
categorization files (organized by vendor 
and product) on the connector machine in 
the 
user/agent/aup/acp/categorizer/curr
ent directory (or the 
user/agent/acp/categorizer/current 
directory).

If such categorization files exist and have 
been changed, this command reloads 
them without restarting the connector.

Reload custom map files Rescans and reloads map files in 
user/agent/map directory on the machine 
where the connector is installed.

The map files are named in the form 
map.n.properties, where n is a number 
starting with 0. Changes to these files will 
be seen periodically in any case, but you 
can use this command to immediately 
apply the latest changes. Not all 
connector setups include custom map 
files.

Caution: Map files are created on some 
connector machines to fulfill specific 
needs. If you are not familiar with the 
categorizer/mapping setup of an 
environment, we recommend that you do 
not use these commands.

This menu also provides options to test commands.

Flow 
Category

Command Description
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Creating SmartConnector Groups
1 In the Navigator panel, choose the Connectors resource tree.

2 In the Connectors resource tree, right-click a group and choose New Group.

A "name" text field appears under the group you selected.

3 In the "name" text field, type in a name.

4 Press Enter.

Renaming SmartConnector Groups
1 In the Navigator panel, choose the Connectors resource tree.

2 In the Connectors resource tree, right-click a group and choose Rename.

3 In the "name" text field, rename the group.

4 Press Enter.

Editing SmartConnector Groups
1 In the Navigator panel, choose the Connectors resource tree.

2 In the Connectors resource tree, right-click a group and choose Edit Group.

3 In the Group Editor, edit the Name and Description text field.

4 Click OK.

Moving or Copying SmartConnector Groups
1 In the Navigator panel, choose the Connectors resource tree.

2 In the Connectors resource tree, navigate to a group and drag and drop it into another 
group.

3 Choose Move to move the group, Copy to make a separate copy of the group, or 
Link to create a copy of the group that is linked to the original group.

If you choose Copy, you create a separate copy of the group that will not be affected 
when the original group is edited. If you choose Link, you create a copy of the group 
that is linked to the original group. Therefore, if you edit a linked group, whether it be 
the original or the copy, all links are edited as well. When deleting linked groups, you 
can either delete the selected group or all linked groups.

Deleting SmartConnector Groups
1 In the Navigator panel, choose the Connectors resource tree.

2 In the Connectors resource tree, right-click a group and choose Delete Group.

3 In the dialog box, click Yes.

The SmartConnector's resource is deleted from the ArcSight database and the ArcSight 
Manager no longer recognizes this resource.

Managing SmartConnector Resources
This topic describes how to do basic resource management for SmartConnectors.

Moving or Copying a SmartConnector Group
1 In the Navigator panel, choose the Connectors resource tree.
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2 In the Connectors resource tree, navigate to a group and drag and drop it into another 
group.

3 Choose Move to move the group, Copy to make a separate copy of the group, or 
Link to create a copy of the group that is linked to the original group.

If you choose Copy, you create a separate copy of the group that will not be affected 
when the original group is edited. If you choose Link, you create a copy of the group 
that is linked to the original group. Therefore, if you edit a linked group, whether it be 
the original or the copy, all links are edited as well. When deleting linked groups, you 
can either delete the selected group or all linked groups.

Deleting a SmartConnector Group
1 In the Navigator panel, choose the Connectors resource tree.

2 In the Connectors resource tree, right-click a group and choose Delete Group.

3 In the dialog box, click Yes.

The SmartConnector's resource is deleted from the ArcSight database and the ArcSight 
Manager no longer recognizes this resource.

Importing and Exporting SmartConnector Configurations
As a part of Managing SmartConnectors, you may want to share configurations among 
several instances of the same or a similar connector.

You can import and export SmartConnector configurations as a means of sharing custom 
configurations among several connectors on the same or multiple Managers. Rather than 
redefining a complex configuration on each connector, you can export the configuration as 
an XML file and then import it into connectors that share some or all of its configuration 
settings. An override feature allows you to make changes to any of the parameter values 
upon import.

Importing a SmartConnector Configuration 
1 In the Navigator panel, choose the Connectors resource tree.

2 In the Connectors resource tree, right-click the ArcSight SmartConnector into which 
you want to import a new configuration and choose Import Connector 
Configuration...

This brings up a file browser where you can select the file to import.

3 In the file browser, navigate to and select the.xml file that contains the connector 
configuration, and click Open. 

This brings up a dialog showing original and proposed new configuration settings for the 
selected connector, with an option to override any of the proposed new values. (Click 
Show to show the details of the import or Hide to hide them.)

On the Import Connector Configuration dialog, review the import information and 
override any values that you do not want to import.

This dialog shows original values for the selected connector configuration and new 
values that will be applied upon import. You can override any of the settings you do 

SmartConnector configurations must be saved and imported as XML files.
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not want to import by either keeping the parameter value in the original configuration 
or defining a new value.

For example, you even can limit the import to only filters by keeping all values in the 
original configuration and choosing to override only the filter values with the imported 
values as is detailed in SmartConnector Filters. (Scroll down to the Filters section at 
the end of the Import dialog to see the filters.)

When you are satisfied with the settings to import and overrides (if any), click OK to 
import the configuration.

Exporting a SmartConnector Configuration 
1 In the Navigator panel, choose the Connectors resource tree.

2 In the Connectors resource tree, right-click the ArcSight SmartConnector you want to 
export, and choose Export Connector Configuration As...

This brings up a file browser where you can navigate to the location where you want 
to save the configuration as an XML file.
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3 In the file browser, navigate to and select the location where you want to save the 
configuration, provide a name for the file, and click Save. 

SmartConnector Filters
You can import and export only the filters associated with SmartConnectors as a part of an 
import or export on a SmartConnector.

To export a SmartConnector filter, export the connector that uses the filter (as 
described in the previous topic on exporting a SmartConnector configuration).

To import a SmartConnector filter into another connector, start by selecting in the 
Navigator the SmartConnector to which you want to add a new filter. Follow the steps 
to import the connector that includes the filter you want to import (as described in the 
topic on importing a SmartConnector configuration). On the Import Connector 
Configuration dialog, limit the import to only the filter(s) you want by keeping all 
values in the original configuration and choosing to override only the filter values with 
the import. (Scroll down to the Filters section at the end of the Import dialog to see 
the SmartConnector Filters.) When you have the new, imported filter values selected 
to override those in the original connector, complete the import by clicking OK on the 
Import Connector Configuration dialog. This adds the imported filter(s) to the original 
SmartConnector.

Upgrading SmartConnectors
ArcSight Enterprise Security Management (ESM) now provides the ability to not only 
centrally manage and configure SmartConnectors, but also to update them remotely. You 
can use the Upgrade command on the Console to upgrade to newer versions of ArcSight 
SmartConnector software for managed devices. (And you can use the Rollback command 
to revert to a previous version on an upgraded connector.)

The Upgrade command lets you launch, manage, and review the status of upgrades for all 
SmartConnectors. A fail-over mechanism launches SmartConnectors with previous versions 
if upgrades fail. All communication and upgrade processes between components (Console, 
Manager, connectors) take place over secure connections.

The ArcSight Console reflects current version information for all of your SmartConnectors.

Overview of the Upgrade Process
1 As an ArcSight customer, you will receive e-mail notifications about new connector 

releases from ArcSight Customer Support.

SmartConnector configurations must be saved as XML files.

For this release, SmartConnector remote upgrade is supported for connectors 
installed on Linux, Solaris, and Windows platforms only.
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2 ArcSight administrators download the latest releases to the ArcSight Manager where 
they are available for SmartConnector upgrades. 

3 From the ArcSight Console, administrators select connectors to be upgraded (one at a 
time) and launch the upgrade command for each of them.

4 Upon receipt of the upgrade command, the selected connectors upgrade themselves, 
restart, and send upgrade results (success or failure) back to the ArcSight Console 
through the ArcSight Manager.

If the upgrade is successful, the new connector starts and reports on successful 
upgrade status. (The upgraded connector runs in the same home directory as the 
old connector.)

If the upgraded connector fails to start, the original connector restarts 
automatically as a fail-over measure. (This is essentially an automatic rollback, 
and re-start.)

SmartConnector "upgrade" version files are delivered as ArcSight Update 
packs (.aup) files. (ArcSight update packs are compressed file sets, similar 
to.zips.) The administrator copies the.aup file to 
ARCSIGHT_HOME/updates/ onto a running Arcsight Manager. The Manager 
automatically unzips the.aup file and copies its contents to 
ARCSIGHT_HOME/repository/.

Tips on Monitoring SmartConnector Upgrade Status 

SmartConnectors automatically determine their upgrade status when they 
start.

• When a connector starts up, it determines whether it is upgraded.

• If so, it waits for a configurable time interval for events from the 
monitored device to be processed.

• If, after that time interval, events have been processed, the 
SmartConnector is deemed up and running. The Console indicates that 
the upgrade for that connector is a success and the newer connector 
version is reflected.
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The Upgrade SmartConnectors command is available as one of several SmartConnector 
control commands.

Upgrading SmartConnectors
1 Choose the Connectors resource in the Navigator panel.

2 In the Connectors resource tree, select the connector you want to upgrade, right-click 
to bring up the context menu, and choose Send Command > Upgrade > Upgrade.

This launches a Command Parameters dialog.

3 Provide the following information in the dialog.

Version - The Version field provides a drop-down menu showing the connector 
versions available on this Manager. Choose the Version number of the connector to 
which you want to upgrade.

Event wait (sec) - Number of seconds the upgrade process will wait for the first 
event from the device after the new, upgraded connector is started. If no events are 
received from the device within the specified time frame, the upgrade is considered 
"failed" and the old connector is launched.

This optional check is an additional safeguard against upgrade failures. For example, the 
connector binaries may have been upgraded successfully, but the new version may have 
problems communicating with the device. In that case, this check will assume that the 
upgrade failed and bring back the old connector.

If the Event wait (sec) value is 0 (the default), then the upgrade does not perform this 
check.

4 Click OK to close the dialog and start the upgrade.

Notes on SmartConnector Upgrade Procedure

• When upgrading SmartConnectors, be sure to download current versions 
of the connector Configuration Guides from the ArcSight Customer 
Support Web site. New or revised information is provided in these guides 
as appropriate per each release of SmartConnectors. (To check version 
numbers on your current connectors, see “Getting Status and Versions on 
Installed SmartConnectors” on page 176.)

• You need administrative permissions to upgrade connectors.

• Newer versions of the connectors you want must be available on the 
Manager to which you are connected.

• The option for remote upgrade is available only in ArcSight ESM v4.0 
Console and only on SmartConnectors of version 4.0.2.xxxx.0 or newer. 
Earlier versions of Connectors (or Agents) must be upgraded manually as 
per the original process by installing a newer version of the connector.

• As a prerequisite to upgrading connectors, both the ArcSight Manager and 
the connector you want to upgrade must be running.
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As the upgrade proceeds, the connector will show as "down" and then "running" again in 
the resource tree. Status messages on the Console will indicate whether the upgrade 
succeeds or fails. You can check the logs for the connector to determine if the upgrade 
succeeded. (Send Command > Tech Support > Get 'agent.properties' and Get 
Upgrade Logs.)

Rolling back to a Previous Version 

You can roll back an upgraded connector to the previous version with the Rollback 
command.

1 Choose the Connectors resource in the Navigator panel.

2 In the Connectors resource tree, select the connector you want to upgrade, right-click 
to bring up the context menu, and choose Send Command > Upgrade > Rollback.

As the rollback proceeds, the connector shows as "down" and then "running" again in the 
resource tree. You can check the logs for the connector to determine if the rollback 
succeeded. (Send Command > Tech Support > Get 'agent.properties' and  Get 
Upgrade Logs.)

Troubleshooting
If an upgrade or rollback fails, you can review the related logs. Choose Send Command > 
Tech Support > Get Upgrade Logs from the ArcSight Console menus.

You can also use the Send Logs wizard to collect and send logs, including upgrade logs, to 
ArcSight for support help.

Getting Status and Versions on Installed SmartConnectors
Before or after you upgrade a SmartConnectors, you may want to check version numbers 
of currently installed connectors or get other status information. There are several ways to 
get information on currently installed connectors (including various control commands, 
channels, dashboards). Two of these are highlighted here as easy ways to get connector 
version information.

Getting Status on a SmartConnector
1 Choose the Connectors resource in the Navigator panel.

2 In the Connectors resource tree, select the connector you want to upgrade, right-click 
to bring up the context menu, and choose Send Command > Status > Get Status.

Notes on SmartConnector Rollback Procedure

• You need administrative permissions to roll back Connectors.

• The option for SmartConnector rollback is available only in ArcSight ESM 
v4.0 Console and only on SmartConnectors of version 4.0.2.xxxx.0 or 
newer that have been previously upgraded.

• Rollback automatically reinstates the most recent version prior to the 
currently installed version. You cannot do a remote rollback on a 
connector to other than the previously installed version. (For example, if 
you start with a connector of version 4.0.2.4793, upgrade to 4.0.2.4794, 
then upgrade again to 4.0.2.4795, a remote rollback at this point will re-
install/start connector version 4.0.2.4794. If you wanted to roll back to an 
earlier version, you would need to do this manually.)
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The Status information on a connector includes "Agent Version" near the top of the 
message window. Here is an example snip-it of the Get Status command results for a Test 
Alert connector, Version 4.0.2.4793.0:

Status Generated: Wed Mar 07 13:20:09 PST 2007 
   Memory Usage: 65Mb out of 253Mb

Agent Content Version.......................2007-03-01-09-02-05_4793 
     Agent Type..................................testalertng 
     Agent Version...............................4.0.2.4793.0 
     CommandResponses Processed..................1097 
     Current Max Rate............................22 
     Event rate LTC..............................Wed Mar 07 13:18:42 PST 2007 
     Events Processed.............................24003

SmartConnector Dashboards
Choose Dashboards from the Navigator panel, and expand the folders to find various 
dashboards. To view a dashboard, right-click it and choose Show Dashboard.

You can find some these SmartConnector dashboards in /Dashboards/Shared/All 
Dashboards/ArcSight Administration/Connector/:

Connector and Device - Heads Up Display

Connector Status

Logger Integration Commands
Starting in ESM v4.5 SP1, Patch 2, new integration commands allow ESM users to run 
Logger searches within the ESM Console. These commands are supported with ArcSight 
Logger v4.0, and are fully described in the ArcSight Logger v4.0 GA Administrator’s Guide.

An integration command has three components: 

The command, which defines the search command the user wants to run on the 
Logger Appliance.

The target, which specifies the Logger Appliance to be searched.

The configuration, which can combine multiple commands in the integration command 
menu.

Two types of integration commands were introduced in ESM v4.5 SP1, Patch 2: Logger 
Search and Logger Quick Search. These commands are supported with ArcSight Logger 
v4.0.

Logger Search allows the user to right-click an event in an active channel and then run a 
search based on one of the fields presented in a list. If there is more than one Logger 
Appliance accessible from ESM, the user can select which Logger to search.

In summary, Logger Search:

Displays a pop-up dialog with search options.

Allows users to search by:

Event Name

Destination

Source

Destination and Source
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User

Service Vendor and Product

Allows users to select the Logger Appliance on which to run the search.

In contrast, Logger Quick Search allows users to right-click a field in an active channel to 
perform a quick search based on the field and value selected. If there is more than one 
Logger appliance set up, a pop-up dialog box allows users to choose which appliance to 
search.

In summary, Logger Quick Search:

Allows quick search without a pop-up dialog

Creates a search with the type and value of the field that has been selected

Enabling Integrated Searches
This section describes the configuration steps required to enable integrated searches on 
Logger. 

1 Log in to the ESM Console.

2 Set up integration targets:

a In the Navigator, click the Resources tab, and then navigate to Integration 
Commands > Targets. 

b Create an integration target for your Logger Appliance, or edit one of the existing 
entries.

c On the Integration Parameters tab, add the following parameter:

Parameter: LoggerHost

Type: Text

Value: [IP address or hostname of the Logger Appliance]

d If you have more than one Logger Appliance, create an additional integration 
target for each appliance to be made searchable.

3 Set up integration configurations:

a In the Navigator, click the Resources tab, and then navigate to Integration 
Commands > Configurations. 

b Edit the Logger Search integration configuration:

i Click the Targets tab, and then add the integration target(s) you created in 
Step 2.

c Edit the Logger Quick Search integration configuration:

i Click the Targets tab and then add one integration target from the list of 
targets you just created.

4 Set up ESM users:

a In the Navigator, click the Resources tab, and then navigate to Users. 

b Edit the ESM users that will have access to the Logger Appliance. In most cases, 
these users should have administrator privileges.
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c Click the Integration Parameters tab, and then create an integration 
parameter for the Logger user:

Parameter: LoggerUser

Type: Text

Value: [Logger username]

Targets: select targets for that Logger user

d Create an integration parameter for the Logger password:

Parameter: LoggerPassword

Type: Password

Value: [Logger password]

Targets: select targets for that Logger user (same as for Logger User).

Selecting Resources
You often need to select resources to act on or use while authoring or configuring analysis 
tools. Selecting is often the first step in managing, authoring, or analyzing resources.

While the Navigator panel is your usual means of selecting resources, you can also 
encounter the Select Resources dialog box any time selection is a necessary part of some 
task, such as adding a case group to a rule action or adding user groups to access control 
lists (ACLs).

For resource groups, click to highlight and select the group you want to choose, then click 
OK. For options that allow multiple selections, select the check boxes next to individual 
entries in the list under a group, then click OK.

This dialog is also displayed for setting user permissions on resources and operations.
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For information about setting permissions on resources, see “Managing Permissions and 
Resources” on page 79.

For information about setting action permissions on who can deploy data monitors, see 
also Step 4 on page 89 in “Controlling Who Has Permissions to Deploy Data Monitors” on 
page 88.

Finding Resources
Apart from visually navigating the resources in the Navigator panel, you can also find items 
in busy resource trees by searching or by locating them.

Searching for System Resources
The search capability uses conventional query elements to search the entire set of system 
resources, returning a ranked list of qualifying items. Each user sees only those resources 
for which they have permission, regardless of the query. You can search for a string in All 
Resources or within a particular resource with both of the following methods.

Search Field on Console Tool Bar

In the Search field   on the Console toolbar type a name 

or phrase and click the “Find Resource” button ( ). The Search hits are displayed in the 
Viewer. Single-click an item to display a preview of its definition in the Details pane on the 
Viewer, or double-click it to open its definition in an Editor in the Inspect/Edit panel.

To limit a search to a particular resource type, click the drop-down menu tab on the 
Search field and choose a resource type from the menus. Notice that some resource types 
have sub-types from which you can choose. If you limit the Search to a resource type, an 
icon representing the resource type you are searching on is displayed in the Search field 
(instead of the standard looking glass Search icon).

For example, to search for a name or phrase only in Trends, choose Reports > Trends 
from the Search drop-down, enter the search string, and click the Find Resource button.
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The Search field in the toolbar accepts all the Query Options described below.

As an alternative to using the quick Search field option, you can get a full Search panel in 
the Viewer:

1 Choose Edit > Find Resource in the Console's menus, or press Ctrl+F.

2 In the Viewer panel's Resource Search tab, enter a query string in the Search query 
line, set the number of results to allow, and click Find. See “Query Options” on 
page 181.

3 When the search returns its results, click any item to see its details or click a result 
column heading to change the order.

When you click a resource listing in the Details panel, it shows you the various pieces of 
related system information that justified that item's ranking.

Query Options
Pose your queries using these conventions.

Query 
Elements

Descriptions Examples

Full or partial 
strings

Phrases, words, or partial words. "Attack Notification" 
notification notif
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Result Columns
Click any column heading to toggle between descending and ascending order.

Locating Specific Resources
The resource trees in the Navigator panel are handy for finding and using the security 
assets available in your organization and provided by ArcSight. However, when you are 
working with a particular resource in an editor or grid view, locating that item's position in 
a heavily populated resource tree can be inconvenient.

Wildcards Question marks (?) for single-
character substitutions and 
asterisks (*) for multi-character 
substitutions.

attack?? (attacker, attacked) 
notif* (notify, notifier, 
notification)

Boolean 
Operators

Use AND and OR to join strings. attack AND suspicious AND high

Fields Resource field labels (grid view 
columns) followed by a colon, 
with the data expressed as plain 
strings, Boolean strings, quoted 
strings, or parenthetical 
expressions.

type:datamonitor AND 
name:"event counts" 
name:"address space" 
name:(address+space) 
name:(+address space)

Exclusion Use NOT, the minus sign (-), and 
the exclamation point (!) to 
exclude strings.

at???? - attack at???? NOT 
attack at???? AND !attack 
at???? AND !attack AND 
!type:zone

Proximity Extend data-field queries' scope 
with a proximity factor 
expressed as a numeral 
following a tilde (~). The 
numeral sets the maximum 
number of words allowed 
between the specified words in 
the resources found.

name:("top events"~1) (top 
attack events) name:("top 
events"~2) (top serious attack 
events)

Fuzzy Broaden query results with a 
relative letter-substitution factor 
expressed as a decimal fraction 
following a tilde (~). The values 
0.0 to 0.9 apply, with the higher 
values increasing the 
substitutions made in the string.

name:mssp~0.2

Column Description

Score Ranking of resources a query returns, based how frequently 
the search term appears in each resource.

Type Top-level categorization of the resource, as shown on the 
Navigator panel.

Name The full name of the individual resource.

URI Full uniform resource identifier for the individual resource.

Query 
Elements

Descriptions Examples
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You can use two right-click commands to instantly spot resource entries in the Navigator 
panel, from applicable grid view resource listings or resource editors.

1 In an entry in a resources grid view, or in the top tab of a resource editor, right-click 
and choose Find <asset type> in Navigator.

2 Look for the highlighted item in the Navigator panel's resource tree.

Visualizing Resources
The resources presented in the Navigator panel or graphically in the Viewer panel are 
organized into hierarchical groups for easy browsing. Among similar types of resources, 
there can be logical relationships. Graphs can make these relationships readily visible.

Graphing Resources
1 Choose any resource tree in the Navigator, with the exception of Notifications and 

Partitions.

2 Select and right-click one or more individual resources or resource groups.

3 Choose Graph View in the context menu.

The Viewer panel graphs the resources in a new channel.

Using Graphs
Once generated, you can manipulate graphs further. There is a set of command buttons at 
the top of the view and a parallel set of commands available by right-clicking the graph 
itself.
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Table 4-10 Resource Graph Buttons and Right-click Commands

Command Button Description

Inspect Opens a new event-monitoring channel, using the 
visualization's current timeframe, event and node 
filters.

Refresh Updates the graph.

Fit Content Sizes the graphic to the available display space.

Zoom In / 
Zoom Out

Increases or decreases the size of the displayed 
graphic.

Zoom Selected Zooms in on a selected portion of a graphic.

Hierarchic 
Layout

Presents nodes in a vertically descending cascade, 
similar to a family tree. Hierarchic layouts are 
appropriate when viewing event relationships that 
have a common root.

Organic 
Layout

Displays nodes in an arrangement based on 
minimum edge length, which tends to cluster 
nodes that relate to a common node. Likewise, 
node clusters with nodes in common will also tend 
to group together.

Circular 
Layout

Positions nodes in hub-and-spoke arrangements 
with each node radiating edges to, or receiving 
edges from, the nodes with which it interacts. 
Circular layouts are most useful when multiple 
roots are present or there are a number of source-
target relationships to clarify. If an organic layout 
is difficult to read because the edges are too 
dense, try a circular layout instead.

Orthogonal 
Layout

Arranges nodes on the basis of logical 
connections, using electrical schematic-style right-
angle layouts. These layouts are very useful for 
clearly tracing connections and identifying node 
clusters.

Overview Opens a reduced rendering of the entire graph. 
You can drag the highlighted section in the 
reduction to move the displayed area in the main 
view.

Hierarchy Tree Opens a complete list of the nodes plotted in 
graphic layouts. Click a node in the list to scroll to 
that node in the main view.

Print Prints the displayed graphic.

Export to JPEG Create and save a JPEG-format copy of the current 
image.
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Configuring Resource Graphs
1 Choose any resource tree in the Navigator, with the exception of Notifications and 

Partitions.

2 Select and right-click one or more individual resources or resource groups.

3 Choose Graph View in the context menu.

4 Hover cursor or click anywhere in the Viewer panel, and right-click Configure 
Resource Graph option on the context menu.

Add Graph 
View to Case

Adds the current graph view to a case you select.

Choosing this option opens the Case Selector 
dialog, where you can browse cases. Select a case 
to which to add the current graph view and click 
OK on the Case Selector dialog. The graph view is 
added to the selected case as an attachment, 
accessible on the Attachments tab in the case 
editor for that case.

Help Display the relevant ArcSight Console online Help 
topic.

Snapshot Creates a new copy of the visualization itself. This 
graphic is not associated with a dashboard, even 
when starting from a dashboard viewer.

Snapshot 
Selection

Opens a new visualization that contains only the 
selected nodes and their connecting edges.

Command Button Description
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This brings up the Configure Resource Graph dialog where you can specify which 
resources to display in graph views.

5 Select resources to show or hide. (Click checkboxes to toggle show/hide options on 
resources. Resources with check marks are configured to show for the selected graph 
view.)

6 Click OK to save your changes.

For more information, see “Selecting Resources” on page 179.

Viewing Resources in Grids
While the grids you see in the Viewer panel are most often views of events, these grids can 
also display organized sets of information about resources in the Navigator panel.

In the Navigator panel, certain resource groups include Grid View in their right-click 
context menus. This command causes the items in the group to display in a grid view, 
where you can review them using the sorting and column customization features that grid 
views offer. You can also right-click resource items in grid views and use the same context 
commands that those resources have in the Navigator panel.

Validating Resources
Resources can break or become invalid because they are improperly built or cannot find 
other resources they depend on. The following topics describe how to identify valid and 
invalid resources, show how to troubleshoot and fix broken resources, list requirements for 
valid resources, and provide tips for manual and automatic resource validation.
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Valid and Invalid Resources
Valid resources show up in the Navigator with their associated icons as described in 
”Navigating” in the ESM User’s Guide or Console Help.

A resource can "break" or become "invalid" either because it is constructed improperly (for 
example, when an active list schema does not match the underlying table) or because 
another resource it depends on is missing from the database (for example, when a rule 
references an unavailable filter). The latter can happen when a resource used in other 
resources is deleted from the Manager, or not retained during an upgrade, import, or 
export.

Invalid resources show up in the Navigator as broken or torn. For example, the Navigator 

displays a valid filter like this: , and an invalid filter like this: . An invalid resource 
also includes an “Invalid Reason” field under on the Attributes tab of its editor, as described 
in Common Resource Attribute Fields under “Invalid Reason” on page 199.

A valid resource is fully available to other resources that reference it, and can participate in 
the event flow, trends, reports, data monitors, channels, filters, rules, and so forth.

An invalid resource cannot participate in the event flow or other resources in real time. For 
example, an invalid asset cannot participate in event asset resolution. Correlated events in 
which the source or target address points to the invalid asset are not generated. Similarly, 
an invalid rule does not trigger and generate correlation events.

Fixing and Validating Resources
When a resource become becomes invalid, its Editor includes a Validate button that you 
can use to test and validate the resource after you fix it. Clicking the Validate button on a 
resource that was previously broken results in a check of the resource logic and 
dependencies. If the system determines the resource is now valid, the resource icon in the 
Navigator is updated to reflect a working resource. If the system determines the resource 
is still broken, it displays an error message describing the problem.

The general flow of steps to fix and validate a resource are:

1 Identify an invalid resource. Sometimes problems with filters or rules (which are used 
in many other resources) are a result of broken resources. (A valid resource looks like 

this: , and an invalid resource looks like this: )

For example, if "My Top Threats" filter depends on "My Hotlist" filter, removing "My 
Hotlist" filter breaks "MY Top Threats" filter.

A scheduled job (like a scheduled rule group or archived report) can also break if one 
of the resources it depends on is missing. The broken icon for a scheduled job shows 
up on the Current Jobs list.

2 If you do not already know why a resource is broken, open its editor (double-click the 
resource in the Navigator panel) and click the Validate button in the resource editor. 
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This will give you an error message that describes the problem. The error dialog 
includes a Copy button for copying longer messages to an external editor.

3 Fix the problems with the resource. This may involve adding back in missing resources 
or rebuilding the resource to fit various other requirements as described in 
Troubleshooting Invalid Resources below.

To continue with our example, adding back in the filter "My Hotlist" would fix the 
problem we mentioned in step 1.

4 In the resource editor(s), click Apply to save changes to the resources you modified. 

For problems that can be validated on the local client, you can click Validate 
before clicking Apply and if the resource is fixed its "working" icon is 
immediately reflected in the Navigator. However, for other types of problems; 
you need to Apply the changes to the resource before you Validate the 
resource. This is because some types changes must be processed on the 
Manager to determine dependencies and relationships to other data not 
available on the local client.

If you think you have fixed a resource but it is still not showing as fixed in the 
Navigator, make sure you Apply all the changes you made to it and then click 
Validate again.
188 ArcSight ESM Administrator’s Guide ArcSight Confidential



4 Managing Resources
5 In the resource editor for the resource that was broken, click Validate. If the resource 
passes validation, its icon in the Navigator updates to reflect a working resource.

To validate a scheduled job, click the Open scheduled jobs list tool button ( ) to 

display scheduled jobs in the Viewer, right-click the job you want to validate, and choose 
Validate from the context menu. If the job passes validation, its icon in the Current Jobs 
list updates to reflect a valid task.

Troubleshooting (Requirements for Valid Resources)
The most common cause of an invalid resource is a dependency issue; another resource 
that the broken resource depends on is missing from the database. Some resources have 
additional requirements or limits that can also affect validity. Following is a summary of 
requirements for creating valid resources.

If any of these requirements are not met, the resource will break. To fix the resource, edit 
its definition to be in line with these requirements.

All Resources - If the definition for a resource references another resource, the 
referenced resource must be available in the Manager database. This requirement is 
true for all types of resources.

Devices and Assets - Each asset address must be unique within a zone, an asset can 
belong to one zone only, and the asset IP address must fall within the address range of 
its network zone.
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Device and Asset Ranges - Start addresses must be less than end addresses, asset 
ranges must be within the address range of the associated network zone, and asset 
ranges should not overlap another asset range in the same zone.

Zones - Start addresses must be less than end addresses and network zones should 
not overlap other zones in the same network.

Reports - Report templates cannot contain more than 20 charts or more than 15 
tables.

Active Lists - Active List schema must match the underlying table and must not include 
programming errors.

Resources become invalid when they violate one or more of their constraints. The following 
table lists the resources that can become invalid: 

This resource becomes 
invalid…

when it violates one or 
more of the following 
constraints…

which results in…

Device/Asset • Asset address must be 
unique within a zone

• An asset only belongs 
to one zone

• Asset IP address must 
fall in the address 
range of its network 
zone

The invalid device/asset 
cannot participate in the 
event asset resolution. 
Therefore, if an event has 
source/target address 
pointing to the invalid 
device it will not be 
resolved.

Device/Asset Range • Start address must be 
less than end address

• Asset range must be 
within the address 
range of its network 
zone

• Asset range should not 
overlap another asset 
range in the same zone

The invalid device/asset 
range cannot participate in 
the event asset resolution. 
Therefore, if an event has 
its source/target address 
fall in an invalid device 
range its asset resolution 
will not be resolved.

Zone • Start address must be 
less than end address

• Network zone should 
not overlap other 
zones in the same 
network

The assets falling within 
this invalid zone will get 
invalidated and cannot 
participate in the event 
asset resolution.

Filter Dependency constraint. 
For example, a filter may 
depend on other 
resources, like asset, 
active list, vulnerability 
etc.

The invalid filter will cause 
the resources that depend 
on it to get invalidated. 

Rule Dependency constraint. 
For example, a rule may 
depend on other 
resources, like filter, asset, 
vulnerability, active list, 
session list etc.

The invalid rule cannot be 
triggered, so the 
corresponding correlation 
events will be missed.
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Data Monitor Dependency constraint. 
For example, a data 
monitor may depend on 
other resources such as a 
filter

The invalid data monitor 
will stop fetching live data 
to feed the dashboard.

Active Channel Dependency constraint. 
For example, an active 
channel may depend on 
other resources such as a 
filter, or asset vulnerability

You will not be able to 
attach or open an invalid 
active channel

Report Dependency constraint.

For example, a report may 
depend on other 
resources, such as filter or 
asset, vulnerability and 
active list

The invalid report cannot 
be run either manually 
from console or as a 
scheduled task.

Trend Dependency constraint.

For example, a trend that 
depends on a query will be 
invalid as soon as a query 
is changed

The invalid trend will stop 
generating any trend data.

Scheduled Task Dependency constraint.

For example, a scheduled 
task may depend on other 
resources, such as filter

The invalid scheduled task 
will not run.

Report Template The report template 
cannot contain more than 
20 charts or more than 15 
tables

The invalid template will 
cause the reports that 
depend on it to become 
invalid.

Profile Dependency constraint. 
The Profile depends on 
resources such as the filter 
it uses to determine which 
events to run discovery 
on. It also depends on the 
group where snapshots 
and patterns are saved. All 
these resource must exist 
and the creator should 
have appropriate 
permissions for them.

This resource will get 
invalidated and the 
scheduled runs may be 
skipped. 

Active List If the Active List schema 
does not match the 
underlying table etc, or 
due to some programming 
error.

The resources (Rules, 
reports etc.) that are 
dependent on the Active 
List get invalidated

Focused Report Dependency constraint.

For example, a focused 
report may depend on 
other resources, such as a 
report, filter or asset.

The invalid focused report 
cannot be run either 
manually from the Console 
or as a scheduled task.

This resource becomes 
invalid…

when it violates one or 
more of the following 
constraints…

which results in…
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Automatic and Manual Validation
You can validate individual resource manually through the Console with the Validate 
button as described above.

Resource validation takes place automatically during an upgrade, package import or 
export, or when you insert or update a resource. (Administrators can use a stand-alone, 
command-line utility on the Manager machine for validating resources and generating 
validation reports on an off-line Manager. This is often useful after an upgrade.)

You can validate resources manually either through the Console (as described in “Fixing 
and Validating Resources” on page 187) or by running the following command from the 
<ARCSIGHT_HOME>/bin directory on the machine where your ArcSight Manager is 
installed:

arcsight resvalidate –persist [true|false] –excludeTypes <list of 
comma-delimited resource types> 

After you run this utility, you can find the validationReport.html report in the 
<ARCSIGHT_HOME> directory, which will list all the invalid resources.

Resource Validation During Upgrade
If the Manager detects a conflict during an upgrade or import process, it invalidates the 
conflicting resource, and continues with the upgrade or import process. The dependent 
resources for the conflicting resource will be automatically re-validated and disabled after 
the resource validation process completes.

After an upgrade process, a report called validationReport.html is generated in the 
<ARCSIGHT_HOME>/upgrade/out/<time-stamp> directory. After an import process, 
you can check the Console to make sure that you do not have any invalid resources. You 
are expected to fix the invalid resources manually. After you resolve the conflict, the 
dependent resources for the conflicting resource will be automatically re-validated.

An invalid resource cannot participate in the event flow, trends, reports, data monitors, or 
channels in real time. For example, if an asset is marked invalid, it cannot participate in the 
event asset resolution. As a result, correlated events in which the source or target address 
points to the invalid asset are not generated. Similarly, when a rule is marked invalid, it 
does not trigger, therefore, the corresponding correlation events will not be generated. 

Query Dependency constraint. 
For example, a query may 
depend on other 
resources, such as a filter, 
asset, or active list.

The invalid query will 
cause the resources that 
depend on it, such as 
report and trend, to 
become invalid.

The resvalidate is a standalone utility and runs as a batch process. We 
recommend that you run it only if need be (when there are many database 
updates that happen offline) after doing a product upgrade only. This utility 
should not be run while the Manager is running.

This resource becomes 
invalid…

when it violates one or 
more of the following 
constraints…

which results in…
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Extending Audit Event Logging
Starting with ESM v4.5, updates to existing resources are logged as audit events, as 
described in “ in the ESM User’s Guide or the Console Help.

If you want to get additional details within the “update resource” audit events (beyond 
what is provided by default), you can enable a resource audit property on the ESM 
Manager to specify which resources should show extended audit event information.

To configure resources for more detailed update auditing, add a URI to the 
resource.audit.update.uris property in the server.defaults.properties 
file.  For example: 

resource.audit.update.uris=/All Users/

will turn on extended audit logging for all resources under the /All Users/ subtree.

Leaving this property blank would turn this feature off (and show only default audit 
information).

To show detailed audit information for multiple resource types, list resource URIs separated 
by commas (no spaces). For example, to show extended update audit logging for users 
and system assets, set the property like this: 

resource.audit.update.uris=/All Users/,/All Assets/ArcSight System 
Administration/

Extended information on the resource update is logged in two places. 

In the internal audit event generated for the resource update, Device Custom 
String5 is set with the update information. The audit event information is shown in 
the Device Custom String5 field in this format:

<UUID generated for this change>:[<name of attribute>:<old 
value>:<new value>]+

The update information is also written to a log file, 
<ARCSIGHT_HOME>/logs/default/resource_update_audit.log file.   The 
audit event information is shown in the log in this format::

<UUID generated for this change>:<URI of resource>:<ID of 
resource>:[<name of attribute>:<old value>:<new value>]+

Managing Partitions
While the Partition Manager operates automatically, and follows the parameters set for it 
through the ArcSight Database Configuration Wizard during installation, you can use the 
Partition features of the Console to review activity and to change partitions' active, inactive, 
or reactivated status.

• The “+” in the message format examples above is regular expression 
notation used to indicate that there can be one or more of <name of 
attribute>:<old value>:<new value> triplets shown in the audit event.

• Any “:” character in any attribute name or value is escaped with a 
backslash to “\:”. 

• Any “\” character in any attribute name or value is escaped with a 
backslash to “\\”.  
ArcSight Confidential ArcSight ESM Administrator’s Guide 193



4 Managing Resources
Getting Partition Information
1 Choose the Partitions resource tree in the Navigator panel and right-click a particular 

partition.

2 Choose Partition Information.

3 Review the partition's properties as displayed in the Partitions Editor, which are 
described below.

Seeing a Partition Schedule
Partition scheduling applies only to the System Partitions>Active Partitions branch of 
the resource tree. The Partitions Calendar graphically shows the partitioning schedule for a 
group in the Partitions resource tree. This view can help clarify relationships not readily 
visible in a resource tree.

1 Choose the Partitions resource tree in the Navigator panel and right-click a partition 
group.

2 Choose Partitions Calendar.

3 View the current schedule or click the Month or Year selectors to change the time 
period.

Archiving Partitions
Archiving a partition removes it from the database and compresses it for long-term 
storage. Although it may still be stored online, it is offline relative to the database until you 
reactivate it. Archiving applies only to the System Partitions>Active Partitions branch of the 
resource tree.
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1 Choose the Partitions resource tree in the Navigator panel and select one or more 
partitions.

2 Right-click the selected partitions and choose Archive Partition(s).

3 In the Select Partitions dialog box, select the partitions to archive and click OK.

Reactivating Archived Partitions
Reactivating a partition restores it to the database, making it available to ArcSight features 
such as active channels and reports. Reactivation applies only to the System 
Partitions>Archived Partitions>Inactive Partitions branch of the resource tree.

1 Choose the Partitions resource tree in the Navigator panel and select one or more 
partitions.

2 Right-click the selected partitions and choose Reactivate Partition(s).

3 In the Select Partitions dialog box, select the partitions to reactivate and click OK.

Reactivating Zipped or Large Archived Partitions
Although you can reactivate most partitions from the Console, follow the process below to 
reactivate these partitions if

Archive Type was configured as ZIP when the partition was archived.

the partition's Data Size field in the Partition Information section of the Partition 
Editor shows a value of 4000 or greater.

If these conditions are true, do the following:

1 Manually unzip the partition with an unzipping tool.

2 Ensure that the arc_event_PartitionName directory contains the files:

arc_event_data_PartitionName.dmp

arc_event_data_PartitionName_01.dbf

If either of these files is missing, the partition archive is invalid and cannot be 
reactivated. Contact ArcSight Customer Support for assistance.

3 On the database machine, enter this in ARCSIGHT_HOME/bin to get an SQL 
interface:

arcdbutil sql <username/password>@tnsname

4 At the SQL prompt, run this script to update the partition's status:

@../utilities/database/oracle/common/sql/SetPartitionArchiveType 
<partition_name>

Example:

@../utilities/database/oracle/common/sql/SetPartitionArchiveType 20060101

5 Check the log SetPartitionArchiveType.partition_name.log to ensure that the script ran 
successfully. The log shows the before and after values for the row corresponding to 
the partition in the ARC_PARTITION_SHADOW table.

6 Reactivate the partition from the Console as described above.
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Deactivating Archived Partitions
Deactivating takes a formerly reactivated partition back out of the database. Deactivation 
applies only to the System Partitions>Archived Partitions>Reactivated Partitions 
branch of the resource tree.

1 Choose the Partitions resource tree in the Navigator panel and select one or more 
partitions.

2 Right-click the selected partitions and choose Deactivate Partition(s).

3 In the Select Partitions dialog box, select the partitions to reactivate and click OK.

Running Scheduled Tasks Right Away
You can manually start certain scheduled tasks to cause them to run immediately, rather 
than wait for the scheduled occurrence. Currently this option covers partition and archive 
maintenance tasks the system performs automatically.

1 Choose the Partitions resource tree in the Navigator panel.

2 Right-click in the panel and choose Run scheduled task now, then Partition 
maintenance or Archive maintenance.

3 Depending on the task, timing, and context, the system reports the degree of success 
or result of the command.

Partition Properties

Partition Property Description

Name The partition's name, usually by date.

Description A description of the partition.

Lower Bound The beginning timestamp for the partition.

Upper Bound The ending timestamp for the partition.

Fully Valid Indicates whether or not the partitions for all five tables 
that make up this logical partition checked as valid. These 
tables are individually validated in the Table Status section 
below.

Usable Indicates whether the most important table, Events, is 
valid.

Active Indicates whether the partition is accessible to the 
database (in contrast to "archived").

Archived Indicates whether the partition has been removed from the 
database (in contrast to "active").

Event Count The number of events recorded in the partition.

Data Size (MB) The number of megabytes of disk space occupied by event 
data (not indexes).

Index Size (MB) The number of megabytes of disk space occupied by 
indexes (not event data).

Index Type Either default or custom.
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Managing Customers
The Customers resource tree, when populated, maps out the various external or internal 
customer accounts your enterprise tracks for cost, security analysis, or administrative 
reasons. These accounts, if present, are usually set up as part of the ArcSight deployment 
process. If the Customers resource tree is abbreviated or empty, your organization is 
probably not using this feature.

When the Customers resource tree is populated, you primarily use its branches as 
references in analysis filters that exclude or include certain customers.

Apart from analysis, the activities necessary to maintain the Customers resource tree 
include creating new customer references, editing existing references, and occasionally 
deleting references.

Creating Customers
When you create a customer, remember that the branch you add to the resource tree has 
to match the Customer URI attribute configured for that branch in the relevant 
SmartConnectors. In other words, you create customer-tracking resources only for those 
customers that have parallel URI values set in the SmartConnectors that monitor their 
devices.

1 Choose the Customers resource tree in the Navigator panel.

2 Right-click a customer group and choose New Customer.

3 In the Customer Editor, enter values for the properties that identify the customer. Note 
that the Name value has to complete the correct Customer URI for this account as 
found in its related SmartConnectors.

4 Click Apply to update the customer and leave the editor open, or OK to complete 
editing and close the editor.

Editing Customers
1 Choose the Customers resource tree in the Navigator panel.

2 Right-click a customer and choose Edit Customer.

3 Change the values, as appropriate.

4 Click Apply to update the customer and leave the editor open, or OK to complete 
editing and close the editor.

Deleting Customers
1 Choose the Customers resource tree in the Navigator panel.

2 Right-click a customer and choose Delete Customer.

3 Click Yes to confirm the deletion.

Table Status These five items show the validity status of the partitions 
for the tables that make up the logical partition. This is 
summarized in the Fully Valid field above.

Partition Property Description
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Saving Copies of Read-Only Resources
Although you may be limited to read-only access to certain resources in the Navigator 
panel, you do have the option to save a copy of such a resource to your own group where 
you do have write access.

Click the Save As button to make a copy of the resource and save it in a specified group.

In the resource group selector dialog, displayed when you click Save As in the editor for a 
read-only resource:

1 Select the group in which you want to save a copy of the resource.

2 Specify the name you want to assign to your copy of the resource.

3 Click OK.

The resource copy appears in the resource tree. You have write permission with this 
copy of the resource.

The Connectors, Users, and Notification editors do not support Save As functionality. In 
these editors, you will see the OK/Cancel/Apply buttons, but the fields for those 
resources are read-only.

Using the Image Editor
Please contact ArcSight Professional Services for assistance with using this feature.

Common Resource Attribute Fields
The following fields are common to several types of resources. You can find these fields in 
the resource editor Attributes tabs for the resources in Common, Assign, Parent Groups, 
Creation Information, and Last Update Information sections. (See also, “Resource 
Attributes” on page 788.)

Common
Entering data in the Common section is optional, depending your environment setup.

Field Description

Resource ID Read-only field that shows the ArcSight ESM system resource ID.

External ID An identification string suitable for, and which can be referenced by, 
systems outside ArcSight ESM. Common applications of External IDs 
include appropriate naming for Case and Asset resources that are 
tracked in common with defect reporting or vulnerability-
management systems. If your system interfaces with a third-party 
incident tracking system, such as Remedy, enter an ID that 
corresponds to that system. Your ArcSight ESM administrator can 
advise you on the correct values for this field, if applicable. 

Alias An identification string suitable for referencing resources within 
ArcSight ESM. A given alias will appear in place of the resource's 
name everywhere it may be seen. Your ESM administrator can 
advise you on the correct values for this field, if applicable.

If you use an alternate event naming scheme in your environment, 
enter an alias for this resource here.
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Assign

Parent Groups

Creation Information

Invalid Reason If a resource is broken or invalid, an “Invalid Reason” field is 
included in its Attributes table. An abbreviated explanation is shown 
in this field. (See also, “Validating Resources” on page 186.)

Click the browse button  at the end of this field to get a popup 
dialog that shows the full text of the explanation.

Description Description of the resource.

You can use this field to communicate the purpose of this resource 
to other users. For example, if this is a resource that leverages or 
depends on another resource (e.g., a query viewer or trend that 
uses an SQL query), this is a good place to make note of that 
relationship. 

Version ID The globally unique version ID for this resource.

Deprecated Toggle to indicate whether the resource is current or deprecated 
(obsolete).

Field Description

Owner A user selected from the Users resource tree who should be notified 
about this resource.

Notification 
Groups

The user groups selected from the Users resource tree who should 
be notified about this resource.

Field Description

Parent Group Read-only field that shows the name and path to parent group of 
this resource.

Field Description

Created By Read-only field that shows the user who created this resource.

Creation Time Read-only field that shows the date/time when this resource was 
created.

Time Since 
Creation

Read-only field that shows the time elapsed since this resource was 
created. This value is calculated from Creation Time.

Field Description
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Last Update Information

Field Description

Last Updated 
By

Read-only field that shows the user who last updated the resource.

Last Update 
Time

Read-only field that shows the date/time when this resource was 
last updated.

Time Since 
Last Update

Read-only field that shows time elapsed since last update. This value 
is calculated from Last Update Time.
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ArcSight Commands

This appendix provides information about ArcSight command scripts and utility programs. 
This appendix is divided into the following sections:

Running an ArcSight Command Script
To run an ArcSight command script on a component, open a command window and switch 
to the <ARCSIGHT_HOME>\bin directory. Execute the following command:

arcsight command_name [parameters]

The following sections describe the supported ArcSight commands.

Categorized ArcSight Commands 
Archives

archive – Import or export resources

archivefilter – Manipulate XML resource file

archivewizard – Archive wizard

ArcSight Components

agents – Start installed SmartConnectors

console – Start the Console

manager – Start the Manager

manager-no-wrapper – Start the Manager without automatic restart

managerstop – Stop the ArcSight Manager

managerup – Get the current state of the Manager

managerthreaddump – Dump threads of the Manager

webserver – Start the ArcSight Web server

“Running an ArcSight Command Script” on page 201

“Categorized ArcSight Commands” on page 201

“Alphabetic List of Commands” on page 204
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webserver-no-wrapper – Start the Web server without automatic restart

webserverstop – Stop the ArcSight Web server

Certificates

agent tempca – Inspect and manage demo certificates for SmartConnectors

dowloadcertificate – Wizard to import certificate

keytool – Manage key stores and trust stores

keytoolgui – Graphical tool to manage key stores and trust stores

listsubjectdns – Display subject distinguished names from a key store

tempca – Inspect and manage demo certificates

Configuration

agentsetup – Configure SmartConnectors

changepassword – Change passwords in properties files

consolesetup – Configure Console

database pc – Partition configuration

managersetup – Configure Manager

websetup – Configure ArcSight Web

Database

database xts – Extend database tablespaces

dbcheck – Gather information and statistics about the current ArcSight Database instance, 
primarily for upgrade

Event Testing 

bleep – Unsupported stress test tool to simulate events (bleepsetup, kickbleep)

csvconvert – Create a replay file from a CSV file

replayfilegen – Wizard for creating replay files from event data

License 

deploylicense – Install a new ArcSight license file

Logs

agent logfu – Analyze SmartConnector logs

exceptions – Search for logged exceptions in logs

logfu – Graphical tool to analyze logs or generate log report

sendlogs – Wizard to sanitize and send logs to ArcSight for analysis
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threaddumps – Utility to extract and reformat thread dumps from logs

Resources

groupconflictingassets – Group conflicting assets

managerinventory – Display configuration information about a Manager

refcheck – Resource reference checker

rescheck – Verify the integrity of the resource database

Services

agentsvc – Install ArcSight SmartConnector as a service

managersvc – Install Manager as a service

webserversvc – Install ArcSight Web as a service

SmartConnectors

agentcommand – Send a command (restart, status, terminate) to SmartConnectors

agent logfu – Analyze SmartConnector logs

flexagentwizard – Generate a simple ArcSight FlexConnector

regex – Graphical tool for regex-based FlexConnectors

Tools

portinfo – Display usage information for specific ports

script – Run a Python script

tproc – Standalone Velocity template processor

whois – Lookup an address

Users

reenableuser – Re-enable a user’s account

resetpwd – Reset a user’s password
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Alphabetic List of Commands
agent logfu

agent tempca

agentcommand

Description Graphical SmartConnector log file analyzer

Applies to SmartConnectors

Syntax agent logfu –a [options]

Options

-a SmartConnector log. Required.

For other options, see logfu command 
(Manager)

Examples
To run logfu:

arcsight agent logfu –a

Description
Inspect and manage temporary certificates for a SmartConnector 
host machine

Applies to SmartConnectors

Syntax agent tempca

Options For options, see tempca command (Manager)

Examples
To run:

arcsight agent tempca

Description Send a command to SmartConnectors

Applies to SmartConnectors

Syntax agentcommand –c (restart | status | terminate)

Options -c Command: restart, status, or terminate

Examples

To retrieve status properties from the SmartConnector:

arcsight agentcommand –c status

To terminate the SmartConnector process:

arcsight agentcommand –c terminate 

To re-start the SmartConnector process:

arcsight agentcommand –c restart
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agents

agentsetup

agentsvc

Description
Run all installed ArcSight SmartConnectors on this host as a 
standalone application.

Applies to SmartConnectors

Syntax agents

Options None

Examples
To run all SmartConnectors:

arcsight agents

Description Run the SmartConnector Configuration Wizard

Applies to SmartConnectors

Syntax
agentsetup [-i mode] [-w] [-f file] [-g] [-t type] [-sn 
name]

Options -f file Properties file (required in –i silent mode)

-g Generate sample properties file for use in –i 
silent mode

-i mode Mode: silent, console, swing

-sn name Short Name

-t type SmartConnector Type (overrides short name)

-w Run in wizard mode

Examples
To run the SmartConnector Configuration Wizard:

arcsight agentsetup

Description Install ArcSight SmartConnector or Partition Archiver as a service.

Applies to SmartConnectors and Database

Syntax agentsvc –i –u user

Options -i Install the service

-u Run service as user user

Examples
To install a SmartConnector or Partition Archiver as a service:

arcsight agentsvc
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agenttempca

agentup

arcdbutil

arcdt

Description See the agent tempca command

Applies to SmartConnectors

Description
Get the current state of a SmartConnector. Returns 0 if the 
SmartConnector is running and reachable. Returns 1 if not

Applies to SmartConnectors

Syntax agentup

Options None

Examples
To check that the SmartConnector is up, running, and accessible:

arcsight agentup

Description
A utility that enables you to launch database utilities for operations 
such as import, export, sql interface, backup, restore, and other 
database commands

Applies to Database

Syntax arcdbutil database_command  command_options

Options
database_command Possible commands include: sql, listener, 

backup, recover, import, export, and other 
database commands

command_options All valid options for the database command 
you use

Examples

To identify all disabled rules in your current installation: 

arcdbutil sql select name from arc_resource where id in 
(select id from arc_rules where active=0);

To get an SQL interface:

arcdbutil sql 

Enter user-name: / as sysdba

Description

A utility that enables you run diagnostic utilities such as session wait 
times, thread dumps, and database alert logs about your ArcSight 
system, which helps ArcSight Customer Support analyze 
performance issues on your ArcSight components

Applies to Manager
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archive

Syntax arcdt diagnostic_utility utility_options

Options

diagnostic_utili
ty

Utilities you can run are: 

runsql—Run SQL commands contained in a 
file that is specified as a parameter of this 
utility. 

db-alertlog—Retrieve the database alert log 
from the database machine.

session-waits—Retrieve the currently 
running JDBC (Java Database Connection) 
sessions and their wait times.

thread-dumps—Obtain thread dumps from 
the Manager

utility_options To see the options available for each utility, 
run this command in <ARCSIGHT_HOME>\bin:

  arcdt help diagnostic_utility

Examples

To find out the number of cases in your ArcSight database:

1 Create a file called sample.txt in <ARCSIGHT_HOME>\temp on the 
Manager with this SQL command:

select count(*) from arc_resource where 
resource_type=7;

2 Run this command in <ARCSIGHT_HOME>\bin:

arcdt runsql temp/sample.txt

To retrieve the last 20 lines of database alert log from your database 
machine and save it to a file called 20060720_dblog, run this 
command:

arcdt db-alertlog -ln 20 -o 20060720_dblog

Description
Import or export resources (users, rules, and so on) to or from one 
or more XML files.

Applies to Manager, Console

Syntax archive –f archivefile [options]

Options
-action action Possible actions include: diff, export, 

i18nsync, import, list, merge, sort, 
upgrade. Default: export.

-all Export all resources in the system (not 
including events)

-base basefile The basefile when creating a migration 
archive. The new archive file is specified with 
–source (the result file is specified with –f)

-config file Configuration file to use.  
Default: 
config\server.defaults.properties
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-exportaction 
exportaction

The action attribute to assign to each 
resource object exported. Export actions are: 

insert: Insert the new resource if it doesn’t 
exist.

update: Update a resource if it exists.

remove: Remove a resource if it exists.

Default: insert

-f archivefile The input (import) or the output (export) file 
specification.  
Note: Filename paths can be absolute or 
relative. Relative paths are relative to 
<ARCSIGHT_HOME>, not the current directory. 
Required

-format fmt Format of the archive: preferarchive, 
force, interactive, overwrite or skip. 
Default: default.

default: Prompts user to resolve import 
conflicts.

force: Conflicts are resolved by the new 
overwriting the old.

overwrite: Merges resources, but does not 
perform any union of relationships.

preferarchive: Merges resources. For 
example, if a group is imported, the resulting 
group will contain all its original members and 
all of the new members from the import file.

skip: Do not import resources with conflicts.

-h Get help for this command

-i (Synonym for –action import.)

-m manager The ArcSight Manager to communicate with

-newids All archival objects within an archive will be 
given new IDs. All refs to these archival 
objects will be changed to the new ID or 
removed if not found. This option is useful 
when an archive is created and then all 
resources in the archive are modified to 
create new resources but the IDs were 
retained

-o Overwrite any existing files
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-optimizedimport Performs pre-processing during import for 
optimization. Forces the import of values even 
though they are the same as what is stored in 
the database. If this flag is not set, each of 
the values in the archive will be compared 
with the value in the database to determine 
whether any changes have been made; if no 
changes are found, then the import for that 
object will be skipped

-p password Password with which to log in to the Manager

-param paramfile The source file for parameters. Any 
parameters in the paramfile can be overridden 
by command line values

-pc configfile Private configuration file to override –config. 
Default: config\server.properties

-pkcs11 Use this option when authenticating with a 
PKCS#11 provider. For example,

arcsight archive -m <hostname> -pkcs11 
-f <file path>

-port port The port to use for Manager communication. 
Default: 8443

-q Quiet: do not output progress information 
while archiving

-source 
sourcefile

The source file used when –f specifies an 
output file

-standalone Operate directly on the Database, not the 
Manager.

Warning: Do not run archive in –standalone 
mode when the Manager is running; database 
corruption could result.

-u username The user name to log in to the Manager with

-uri includeURIs The URI(s) to export. No effect during import. 
All dependent resources are exported, as 
well—for example, all children of a group.

Separate multiple URIs (such as “/All 
Filters/Geographic/West Cost”) with a 
space, or repeat the –uri switch

-urichildren 
includes

The parent URI(s) to export. No effect during 
import. All child resources of the specified 
resources will be exported. The parent 
resources are only exported if there is a 
dependency

-xrefids Exclude reference IDs. This option determines 
whether to include reference IDs during 
export. This is intended only to keep changes 
to a minimum between exports. Do not use 
this option without a complete understanding 
of its implications
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-xtype 
excludeTypes

The type(s) to exclude during export. No 
effect during import. Exclude types must be 
valid type names, such as Group, Asset, or 
ActiveChannel

-xtyperef 
excludeTypes

Same as the –xtype option, but will also 
exclude all references of the specified type

-xuri 
excludeURIs

The URI(s) to exclude during export. No effect 
during import. Resources for which all 
possible URIs are explicitly excluded will not 
be exported. Resources which can still be 
reached by a URI that is not excluded will still 
be exported

-xurichildren 
excludes

The parent URI(s) to exclude during export. 
No effect during import. Resources for which 
all possible URIs are explicitly excluded will 
not be exported. Resources which can still be 
reached by a URI that is not excluded will still 
be exported.

Examples

To import resources from an XML file (on a Unix host):

arcsight archive –action import –f 
\user\subdir\resfile.xml 

To export certain resources (the program displays available 
resources):

arcsight archive –f resfile.xml –u admin –m mgrName –p pwd 

To export all resources to an XML file in quiet, batch mode:

arcsight archive –all –q –f resfile.xml –u admin –m 
mgrName  p password 

To export a specific resource:

arcsight archive –uri “/All Filters/Geographic/West Coast”  
f resfile.xml

Manual import (program prompts for password):

arcsight archive –i –format preferarchive –f resfile.xml –
u admin  m mgrName 

Scheduled or batch importing:

arcsight archive –i –q –format preferarchive –f 
resfile.xml –u admin –m mgrName  p password 

Scheduled or batch exporting:

arcsight archive –f resfile.xml –u admin –m mgrName  p 
password  uri “/All Filters/Geographic/East Coast” –uri 
“/All Filters/Geographic/South” 
210 ArcSight ESM Administrator’s Guide ArcSight Confidential



A ArcSight Commands
archivefilter

Description
Manipulate XML elements and attributes in an archive. The primary 
use of this command is to exclude system content from a v3.x 
archive before importing the archive into a v4.0 installation

Applies to Manager

Syntax archivefilter –source sourcefile –f archivefile  [options]

Options
-a action Action to perform {insert, remove, none} 

(Default: none)

-e element_list Elements to process (Default: ‘*’ which 
denotes all elements)

-extid regex Regular expression to represent all of the 
external IDs to include. This is the external ID 
of the archival object. (Default: none)

-f file Target file (required). If a file with an identical 
name already exists in the location where you 
want to create your target file, the existing 
file will be overwritten. If you would like to 
receive a prompt before this file gets 
overwritten, use the –o option

-o Overwrite existing target file without 
prompting (Default: false)

-relateduri 
regex

Regular expression to get all of the URIs 
found in references to include. This will check 
all attribute lists that have references and if 
any of them have a URI that matches any of 
the expressions, that object will be included

-source file Source file (required)

-uri regex Regular expression to represent all of the 
URIs to include. This is the URI of the archival 
object

-xe element_list Elements to exclude

-xextid regex Regular expression to represent all of the 
external IDs to exclude

-xgroups groups Groups to exclude

-xuri regex Regular expression to represent all of the 
URIs to exclude

-h Help for this command
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archivewizard

bleep

Examples

To include any resources, for example all Active Channels, whose 
attributes contain the URI specified by the –relateduri option:

arcsight archivefilter -source allchannels.xml -f t0.xml -
relateduri "/All Active Channels/ArcSight 
Administration/"

To include any resources whose parent URI matches the URI 
specified by the –uri option:

arcsight archivefilter -source allchannels.xml -f t0.xml -
uri "/All Active Channels/ArcSight Administration/.*"

To exclude resources whose parent URI matches the URI specified 
by the –xuri option:

arcsight archivefilter -source allchannels.xml -f t0.xml -
xuri "/All Active Channels/.*"

To include all the resources that contain either URIs specified by the 
two –relateduri options:

arcsight archivefilter -source allchannelsFilter.xml -f 
t0.xml -relateduri "/All Active Channels/ArcSight 
Administration/" -relateduri .*Monitor.*

Description Archive wizard

Applies to Manager

Syntax archivewizard

Options None

Examples
To run:

arcsight archivewizard

Description

Unsupported stress test tool to supply a Manager with security 
events from replay files (see replayfilegen). Replay files 
containing more than 30,000 events require a lot of memory on the 
bleep host.

Do not run bleep on the Manager host. Install the Manager on the 
bleep host and cancel the configuration wizard when it asks for the 
Manager’s host name.

Run arcsight tempca –ac on the bleep host if the Manager under 
test is using a demo certificate.

Create the file config\bleep.properties using the descriptions in 
bleep.defaults.properties.

Applies to Manager

Syntax bleep [-c file] [-D key=value [key=value…]]
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bleepsetup

changepassword

Options
-c file Alternate configuration file (default: 

config\bleep.properties)

-D key=value Override definition of configuration properties

-m n Maximum number of events to send. (Default: 
-1)

-n host Manager host name

-p password Manager password

-t port Manager port (Default: 8443)

-u username Manager user name

-h Display command help

Examples
To run:

arcsight bleep

Description Wizard to help create the bleep.properties file

Applies to Manager

Syntax bleepsetup

Options -f Properties file (silent mode)

-i Mode: {swing, console, recorderui, silent} 
Default: swing

-g Generate sample properties file

Examples
To run:

arcsight bleepsetup

Description
Utility to change obfuscated passwords in properties files. The utility 
prompts for the new password at the command line

Applies to Manager

Syntax changepassword –f file –p property_name

Options
-f file Properties file, such as 

config\server.properties

-p property_name Password property to change, such as 
server.privatekey.password
ArcSight Confidential ArcSight ESM Administrator’s Guide 213



A ArcSight Commands
checklist

console

Examples
To run:

arcsight changepassword

Description

ArcSight Environment Check. Used internally by the installer.

Right JRE, supported OS, connected to supported Database, 

Can run from Connector, Database, or Manager.

Description Run the ArcSight Console

Applies to Console

Syntax console [-i] [options]

Options -ast file

-debug

-i

-imageeditor

-laf style Look and feel style: metal, plastic, plastic3d

-p password Password

-port Port to connect to Manager (default: 8443)

-redirect

-relogin

-server Manager host name

-slideshow

-theme

-timezone tz Timezone: such as “GMT” or “GMT-8:00”

-trace Log all Manager calls

-u name User name

Examples
To run the console:

arcsight console
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consolesetup

csvconvert

database init

Description
Run the ArcSight Console Configuration Wizard to reconfigure an 
existing installation

Applies to Console

Syntax consolesetup [-i mode] [-f file] [-g]

Options -i mode Mode: console, silent, recorderui, swing

-f file Log file name (properties file in –i silent 
mode)

-g Generate sample properties file for –i silent 
mode

Examples
To change some console configuration options:

arcsight consolesetup

Description
Utility to generate events from a comma-separated values (CSV) 
file, or to convert events as exported from the event grid into replay 
file format

Applies to Manager, SmartConnectors

Syntax csvconvert

Options
-D file (Required) Destination file to be created (or 

extended) in replayagent directory. The 
convention is to name the file “*.events.” 

-h Display command help

-s file Source CSV file

Examples
To run:

arcsight csvconvert –D mystuff.events

Description
Initializes the database. Use this utility to restart the ArcSight 
Database Configuration Wizard if you exit it before configuring all 
options or to re-initialize Oracle at a later date

Applies to Database

Syntax database init

Options
-p Enables you to install Enterprise Manager and 

set partition management parameters
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database pc

database pm

Examples
To initialize the database

arcsight database init

Description Partition configuration utility

Applies to Database

Syntax database pc

Options -d db_type Database type: oracle, db2

-i mode Mode: silent

-f file Properties filename. Required in –i silent 
mode

-g Generate the SQL scripts

-s Generate a sample properties file for use in –i 
silent mode

-x Execute the existing SQL scripts

-p Run this command in expert mode. 

If the statistics updates are timing out and the 
event rate is very high, then the sample size 
should be reduced to 0.1. Using the -p option 
with this command opens the wizard and 
allows you to change the sample size.

Examples
To configure your database partition:

arcsight database pc

Description Partition management tool

Applies to Database (Partition Manager)

Syntax database pm

Options

-cn command-name This is a required parameter. 

Name of command you want to issue on the 
Partition Manager. One of:

• manage

• compress

• update 

-c config The default configuration file to use 
(config/server.defaults.properties)
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database xts

dbcheck

-i invocation-
mode

The invocation mode. Use one of:

• remote

• standalone

-m manager-name The hostname or IP address of the ArcSight 
Manager

-p password The admin password for ArcSight Manager 

-pc custom-
configuration-
file

The custom configuration file to use 
(config/database.properties)

-pn partition-
name

name of partitions for which statistics are to 
be updated

-port Manager-
port

port number of ArcSight Manager (8443)

-u user-name The admin user name for ArcSight Manager 
(usually admin)

-h help. Get help for this command

Examples
arcsight database pm -cn Manage -m linux53_64_45sp3 -u 
admin -p arcsight

Description
Extend the ArcSight Database Tablespaces. (This is a convenience 
tool; If you have the full Oracle license, you can optionally use 
Enterprise Manager or SQL*Plus.)

Applies to Database

Syntax database xts

Options None

Examples
To extend your database space:

arcsight database xts

Description
Gathering information and statistics about the current ArcSight 
Database instance, such as the data to index size ratio

Applies to Database

Syntax dbcheck

Options None

Examples arcsight dbcheck
ArcSight Confidential ArcSight ESM Administrator’s Guide 217



A ArcSight Commands
dbview-generator

defaultzones-upgrade

Description

Utility that generates database views based on the fields of a 
fieldset. Field sets are named subsets chosen from the available 
attributes of an event. To create a new field set or to see the existing 
ones, go to the Active Channels resource tree and click the Field 
Sets tab

Applies to Manager, Database

Syntax
dbview-generator –f fieldset –m manager –n view_name –p 
password –u user_name

Options
-f fieldset URI of the fieldset from which you want to 

generate the database view

-m manager Name of the Manager

-n view_name Name for the view

-u user_name User name to connect to the Manager

-p password Password for the user_name

Examples

To generate a database view containing fields in the Standard field 
set:

dbview-generator –f “/All Field Sets/ArcSight 
System/Active Channels/Standard” –m mymanager –n 
dv_view_standard –p mypassword –u myuser

To retrieve the data from the view you generated run the following 
command in SQL:

select * from db_view_standard

Description

A tool to convert customized defaultZones.csv files for 
SmartConnectors into network model.

This script is required only when you upgrade from v3.0 to v3.5 or 
later and have customized defaultZones.csv files on your 
SmartConnectors.

Applies to Manager

Syntax defaultzones-upgrade  [options]

Options
-source rel_path (Required) The location of the 

defaultZones.csv file on your Manager 
system relative to <ARCSIGHT_HOME>

-agent 
agent_identifier

OR

-allagents

(Required) ID string, the SmartConnector 
Name, or the SmartConnector's URI. 

OR

Use this option if multiple SmartConnectors 
share the same defaultZones.csv file.
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deploylicense

downloadcertificate

-network network The URI of the network to start with for 
modeling the networks. (Default: /All 
Networks/Site Networks/Local)

Examples
arcsight defaultzones-upgrade –source 
mydir/defaultZones.csv –agent SF_agent1

Description
Install a new ArcSight license file. The Manager may be running; it 
will detect the new license file automatically

Applies to Manager

Syntax deploylicense file

Options
-f file Log file name (properties file in –i silent 

mode)

-g Generate sample properties file for –i silent 
mode

-i mode Mode: console, silent, recorderui, swing

Examples
To deploy a new license:

arcsight deploylicense

Description Wizard for importing certificates

Applies to Manager

Syntax downloadcertificate

Options -i mode Mode: console, silent, recorderui, swing

-f file Log file name (properties file in –i silent 
mode)

-g Generate sample properties file for –i silent 
mode

Examples
To run:

arcsight downloadcertificate
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dropSLPartitions

exceptions

Description Utility for dropping old Session List partitions

Applies to Database

Syntax dropSLPartitions

Options -d retentionDays Number of days to retain data

-m manager The ArcSight Manager to communicate with

-p password (Optional) The password to log in with

-u username The user name used for logging in

-p port (Optional) The port used for communication 
(8443 by default)

-h (Optional) Get help for this command

Examples
To run:

arcsight dropSLPartitions

Description Search for logged exceptions in ArcSight log files

Applies to Manager, Console, SmartConnectors

Syntax exceptions logfile_list [options] [log files]

Options -x element Exclude element

-i element Include element

-u string The subject line for notification e-mail

-e target_email E-mail address to receive exception 
notification

-s host SMTP server name

-q Quiet mode; no printing

-p Suppress explanations

-l Only show exceptions that have no 
explanations

-n Group unique exceptions

-r Exclude errors
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execproc

execprocsvc

Examples
To run:

arcsight exceptions

Description
Process Executor tool. Used on Unix platforms to execute shell 
commands

Applies to Manager

Syntax execproc

Options None

Examples
To run:

arcsight execproc

Description Start or stop the Process Executor as a service

Applies to Manager

Syntax
execprocsvc cmd [-wrapperConfig file] [initialHeap 
maxHeap]

Options -c Console mode

-i Install service

initialHeap Initial heap memory size, in MB. (Default: 
128)

maxHeap Maximum heap memory size, in MB. (Default: 
512)

-q Stop service (quit)

-r Remove service

-s Start service

-wrapperConfig 
file

Examples

To install a process called ‘proc:’

arcsight execprocsvc proc –i

To run the installed process with a maximum of 1GB of memory:

arcsight execprocsvc proc –s 128 1024
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export_system_tables

flexagentwizard

groupconflictingassets

Description
Utility to export your database tables. Upon successful completion 
the utility generates two files: a temporary parameter file and the 
actual database dump file, arcsight.dmp

Applies to Manager, Database

Syntax export_system_tables username/password@TNS name

Options username Oracle database username

password Password for the Oracle database user

TNSname Name specified in tnsnames.ora for the 
database from which you are exporting the 
system tables

Examples
To run:

arcsight export_system_tables

Description Wizard-like tool to generate simple ArcSight FlexConnectors

Applies to SmartConnectors

Syntax flexagentwizard

Options None

Examples
To run:

arcsight flexagentwizard

Description
Tool that groups asset resources with common attribute values. 
Group Conflicting Attribute Assets Tool. Assets can have conflicting 
IP addresses or host names within a zone

Applies to Manager

Syntax groupconflictingassets

Options
-c Clean (delete the contents of) the group to 

receive links to assets before starting. 
(Default: false)

-m host Manager host name or address

-o name Name for group to receive links to assets 
which have conflicting attributes. (Default: 
“CONFLICTING ASSETS”)

-p password Password
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idefensesetup

import_system_tables

-port n Port to connect to Manager (Default: 8443)

-prot string Protocol { http | https } (Default: https)

-user name User name

Examples
To run:

arcsight groupconflictingassets

Description Wizard to configure iDefense appliance information on the Manager

Applies to Manager

Syntax idefensesetup

Options None

Examples
To launch the iDefense Setup wizard:

idefensesetup

Description
Utility to import database tables. The file you import from must be 
the one that export_system_tables utility created

Applies to Manager, Database

Syntax
import_system_tables export_username import_username 
import_password TNSname dump_file_path

Options
export_username Oracle database username that was used to 

export system tables using the 
export_system_tables command.

import_username Oracle database username of the database to 
which you are importing system tables

password Password for the import_username

TNSname Name specified in tnsnames.ora for the 
database to which you are importing the 
system tables

dump_file_path Path name where the arcsight.dmp file is 
located

Examples
To run:

arcsight import_system_tables
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initorcl

keytool

keytoolgui

kickbleep

Description
Initializes the database.

This command is deprecated. Use database init instead.

Applies to Database

Description Runs Java Runtime Environment keytool utility to manage key stores

Applies to Manager, Console, SmartConnectors

Syntax keytool –store name

Options

-store name (Required) Specific store {managerkeys | 
managercerts | clientkeys | clientcerts | 
ldapkeys | ldapcerts | webkeys | webcerts } 

(original options) All options supported by 
the JRE keytool utility are passed along. Use 
arcsight keytool

–help  For a list of help topics, or see Java 
documentation

Examples
To view Console key store:

arcsight keytool –store clientkeys

Description
Graphical user interface tool for manipulating key stores and 
certificates

Applies to Manager, Console

Syntax keytoolgui

Options None

Examples
To run:

arcsight keytoolgui

Description Runs a simple, standardized test using the bleep utility

Applies to Manager

Syntax kickbleep

Options -f Properties file (silent mode)
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listsubjectdns

logfu

-g Generate sample properties file

-i Mode: {swing, console, recorderui, silent} 
Default: swing

Examples
To run:

arcsight kickbleep

Description Display subject distinguished names (DN) from a key store

Applies to Manager, SmartConnectors

Syntax listsubjectdns

Options
-store name Specific store { managerkeys | managercerts 

| clientkeys | clientcerts | ldapkeys | ldapcerts 
| webkeys | webcerts } (Default: clientkeys.)

Examples
To list Distinguished Names in the Console key store:

arcsight listsubjectdns

Description Graphical tool for analyzing log files. 

Applies to Manager (See also agent logfu.)

Syntax logfu {-a | -c | -m} [options]

Options -a Analyze SmartConnector logs

-c Analyze Console logs

-f timestamp From time

-i Display information about the log files that 
will be analyzed

-l timespec Analyze only the specified time (Format: 
<time>{smhd}) Examples: 1d = one day, 4h 
= four hours

-m Analyze Manager logs

-mempercent n Percent of memory messages to consider for 
plotting. (Default: 100)

-noex Skip exception processing

-noplot Skip the plotting

-t timestamp To time
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manager

managerinventory

Examples
To analyze Manager logs for the last 12 hours:

arcsight logfu –m –l 12h

Description Runs the ArcSight Manager in command line mode (not as a service)

Applies to Manager

Syntax manager

Options None

Examples
To run the ArcSight Manager:

arcsight manager

Description Display configuration information about the installed Manager

Applies to Manager

Syntax managerinventory

Options -a filter Attribute filter. Default: "*"

-f filter Object filter. Default: "ArcSight:*,*"

-m host Manager host name or address

-o op Operation {list, show}. Default is list

-out file Output filename. Default is stdout

-password pwd Password

-port n Port to connect to Manager (Default: 8443)

-prot string Protocol { http | https } (Default: https)

-user name User name

Examples
To run:

arcsight managerinventory
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manager-no-wrapper

manager-reload-config

managersetup

Description
Run the Manager without automatic restart in case of fatal errors. 
(See manager for options.)

Applies to Manager

Syntax manager-no-wrapper

Options None

Examples
To run the manager without automatic restart:

arcsight manager-no-wrapper

Description
Load the server.defaults.properties and server.properties 
files on the Manager

Applies to Manager

Syntax arcsight manager-reload-config

Options
-diff  Displays the difference between the 

properties the Manager is currently using and 
the properties that this command will load

-as Forces the command to load properties that 
can be changed without restarting the 
Manager. The properties that require a 
Manager restart are updated in the 
server.properties but are not effective until 
the Manager is restarted

-t updateTimeout Number of seconds after which the manager-
reload-config command stops trying to load 
the updated properties file on the Manager

Examples

To reload config:

arcsight manager-reload-config

To view the differences between the properties the Manager is 
currently using and the properties that this command will load:

arcsight manager-reload-config -diff

Description Run the ArcSight Manager Configuration Wizard

Applies to Manager

Syntax managersetup –i console

Options -i mode Mode: console, silent, recorderui, swing
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managerstop

managersvc

managerthreaddump

-f file Log file name (properties file in –i silent 
mode)

-g Generate sample properties file for –i silent 
mode

Examples
To run:

arcsight managersetup

Description
Stop the ArcSight Manager whether it is in service or command line 
mode

Applies to Manager

Syntax managerstop

Options None

Examples
To stop the Manager service:

arcsight managerstop

Description

Start, stop, install, or uninstall the ArcSight Manager as a service.

Note: The start option does not work on Windows. To start Manager 
as a service on Windows, follow instructions in Chapter 1‚ Basic 
Administration Tasks‚ on page 1.

Applies to Manager

Syntax managersvc {start | stop | restart | status | dump}

Options None

Examples
To start the Manager service (only on non-Windows platforms):

arcsight managersvc start

Description Script to dump the Manager's current threads

Applies to Manager

Syntax managerthreaddump

Options None

Examples
To run:

arcsight managerthreaddump
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managerup

monitor

netio

Description
Get the current state of the Manager. Returns 0 if the Manager is 
running and reachable. Returns 1 if not

Applies to Manager

Syntax managerup

Options None

Examples
To check that the Manager is up, running, and accessible:

arcsight managerup

Description Tool used in conjunction with Network Management Systems

Applies to Manager

Syntax monitor

Options -a filter Attribute filter. Default: "*"

-append Append to output file instead of overwriting 
(Default: false)

-f filter Object filter. Default: "ArcSight:*,*"

-m host Manager host name or address

-o op Operation {list, show}. Default is list

-out file Output filename for management service 
information. Default is stdout

-p pwd Password

-sanitize Sanitize IP address and host names (Default: 
false)

-u name User name

Examples
To run:

arcsight monitor

Description Primitive network throughput measurement utility

Applies to Manager

Syntax netio
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Options -c Client mode (Default: false)

-n host Host to connect to (Client mode only)

-p port Port (Default: 9999)

-s Server mode

Examples
To run:

arcsight netio
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package

Description

Import or export resources (users, rules, and so on) to or from one 
or more XML files.

Use this command instead of the archive command.

Note: Some functionality for this command are available from the 
GUI only

Applies to Manager, Database, Console

Syntax
package –action <action-to-be-taken> -package <package 
URI> -f <package-file>

Options

- action action Creates a new package based upon one or 
more packages that you specify. The possible 
actions include bundle, convertarchives, 
export, import, install, uninstall. The 
default is export

-config config 
file

The primary configuration file to use. Default 
is config\server.defaults.properties

-convertbaseuri 
baseuri

The base URI for packages that are converted 
from archives. This option is only used in 
conjunction with the –action 
convertarchives option

-f packagefile-
location

The location of the package bundle file. File 
name paths can be absolute or relative. 
Relative paths are relative to 
<ARCSIGHT_HOME>

-m manager The Arcsight Manager to communicate with

-password 
password

(Optional) The password with which to log in 
to the Manager

-package 
packagerefs

The URI(s) of the package(s). This option is 
used in conjunction with –action install 
and –action uninstall in order to list which 
packages to operate upon

-pc 
privateConfig

This configuration file will override the 
server.defaults.properties file. The 
default location is 
config\server.properties

-pkcs11 Use this option when authenticating with a 
PKCS#11 provider. For example,

arcsight package -m <hostname> -pkcs11 
-f <file path>

-port port The port to use for communication. The 
default port used is 8443

-source 
sourcefile

The source file. This is used in conjunction 
with the –f command which specifies an 
output file

-u username The user name used for logging in to the 
Manager
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-standalone Operate directly on the Database not the 
Manager

Examples

To convert a previously archived package:

arcsight package –action convertarchives –convertbaseuri 
“/All Packages/Personal/Mypackage” –source sourcefile.xml 
–f packagebundle.arb

To install a package:

arcsight package –action install –package “/All 
Packages/Personal/Mypackage” –u username –p password –m 
managername

To uninstall a package:

arcsight package –action uninstall–package “/All 
Packages/Personal/Mypackage” –standalone –config 
/config/server.defaults.properties –pc 
/config/server.properties

To import a package through the Manager:

arcsight package –action import –f packagebundle.arb –u 
username –p password –m managername 

To export a package:

arcsight package –action export –package “/All 
Packages/Personal/Mypackage” –f packagebundle.arb –u 
username –p password –m managername

To export multiple packages:

arcsight package –action export –package “/All 
Packages/Personal/PackageOne” –package “/All 
Packages/Personal/PackageTwo” –f packagebundle.arb –u 
username –p password –m managername

To export packages in a standalone mode (directly from the 
database) Make sure that the ArcSight Manger is not running:

arcsight package –action export –package “/All 
Packages/Personal/Mypackage” –f packagebundle.arb –u 
username –p password –standalone –config 
server.default.properties –pc server.properties

To combine xml files from multiple packages into one package:

arcsight package -action bundle -f myPkgNew.arb -source 
chnpkg.xml -source filterpkg.xml -source rulepkg.xml

In the above example, chnpkg.xml, filterpkg.xml, and 
rulepkg.xml files are extracted from their respective packages and 
will be bundled in one package bundle called myPkgNew.arb.
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portinfo

querytuner

Description
Script used by the portinfo tool of the Console. Displays common 
port usage information for a given port

Applies to Console

Syntax portinfo port

Options
port Port number

Examples
To run:

arcsight portinfo

Description

A troubleshooting tool that generates explain plans for all queries 
within ArcSight ESM, and helps evaluate whether hints may improve 
the performance of some queries. This tool pulls explain plans for all 
the queries used by reports and trends and looks for ones that will 
execute inefficiently without database hints. 

All findings are logged in the file Manager's 
<ARCSIGHT_HOME>\logs\query-tuner.log. 

Run this tool from the Manager’s bin directory either in a standalone 
mode (without the Manager running) or you can run it while the 
Manager is running. 

Applies to Database, Manager, Console

Syntax arcsight querytuner -m analyze -uri <uri_for_the_query> 

Options -m analyze To analyze a query

-d 
<query_duration>

Optional parameter. query_duration is the 
time duration, for example, 1h, 2h, 1d, to be 
used while running the queries

-t <timeout> Optional parameter. timeout is the number 
of seconds after which a slow running query 
will timeout. If you provide this value, 
performance will be measured if and when a 
good hint is found

-uri <uri> Optional parameter. uri is the URI of the 
query

-h Help for this command, for example, 
./arcsight querytuner -h
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Examples

To analyze all the queries

bin>arcsight querytuner –m analyze

To analyze all queries and measure performance if a hint helps, -t is 
the timeout to be used while executing the query:

bin>arcsight querytuner -m analyze -t 300000

To analyze a single query:

bin>arcsight querytuner -m analyze -uri <uri_for_the_query> 

For example,

bin> arcsight querytuner -m analyze -uri "/All 
Queries/ArcSight Foundation/Intrusion Monitoring/Executive 
Summaries/Business Role/Business Role - Successful Attacks" 

This will tell you if any hint may potentially help. You should see the 
message "Hint that Helped=<the_actual_hint>" in the query-tuner.log 
file to look for a hint that might potentially help. 

Open the query-tuner.log file. For every Query at the end of the 
query report look for the keyword “hasBadPattern=true” followed by 
"Hint that Helped=<the_actual_hint>" or sometimes you will see “No 
hints could be found for this pattern.”

Please contact Customer support when you see “hasBadPattern=true” 
followed by “No hints could be found for this pattern.” Be prepared to 
provide the querytuner log and the package export of the query.

Once you run the Query Tuner tool and see that a hint has helped for a 
particular query, you can install the hint on the Manager from the 
ArcSight Console. Refer to the Console’s online help for information on 
how to do so.

Applying a 
Hint to a 
Query

Note: Please contact ArcSight Customer Support before applying any 
hints received by running the Query Tuner.

Once you run the Query Tuner tool and see that a hint has helped for a 
particular query, you can add the hint to the query as follows:

1 In the Console's 
<ARCSIGHT_HOME>\current\config\console.properties file, set 
the following property:

database.hint.editable=true

2 Restart the Console if it is running.

3 Open the query-tuner.log file located in the Manager's 
<ARCSIGHT_HOME>\logs directory.

4 Scan through the file and locate the query URI. Copy the actual hint 
in the line "Hint that Helped=<the_actual_hint>" located below 
the query URI. Make sure not to copy the words “Hint that 
Helped=”

5 In the ESM Console Navigator, open the Reports resource.

6 Click on the Queries tab to bring it forward.

7 Follow the URI for the query for which you want to apply the hint, 
right-click it and select Edit Query.

8 In the Inspect/Edit panel, paste the hint you copied in Step 4 in the 
Database Hint box (the actual hint).
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reenableuser

refcheck

regex

replayfilegen

Description Re-enable a disabled user account

Applies to Manager

Syntax reenableuser username

Options username The name of the user resource to re-enable

Examples
To re-enable a disabled user:

arcsight reenableuser <username>

Description Resource reference checker

Applies to Manager

Syntax refcheck

Options None

Examples
To run:

arcsight refcheck

Description Graphical tool for regex-based FlexConnectors

Applies to SmartConnectors

Syntax regex

Options None

Examples
To run:

arcsight regex

Description

Wizard for creating security event data files (“replay files”) that can 
be run against a Manager for testing, analysis, or demonstration 
purposes.

Note: This is a client side command only and should executed from 
the Console’s ARCSIGHT_HOME\bin directory. 

Applies to Manager

Syntax replayfilegen –m mgr [options]
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rescheck

resetpwd

Options
-f file Log file name (properties file in –i silent 

mode)

-g Generate sample properties file for –i silent 
mode

-i mode Mode: console, silent, recorderui, swing

Examples

Run from the Console’s <ARCSIGHT_HOME>\bin directory:

arcsight replayfilegen

To run in console mode:

arcsight replayfilegen –i console

Description Verify the integrity of the resource database

Applies to Manager

Syntax rescheck

Options
-f file_list Archive file names (Default: Read the 

database, not archives)

-config file Primary configuration file. Default: 
config\server.defaults.properties

-pc Private configuration file

-amiss Only check for resources that are in the 
archive, but which are missing from the 
Database

Examples
To run:

arcsight rescheck

Description
Wizard to reset a user’s password and optionally notify the user of 
the new password by e-mail

Applies to Manager

Syntax resetpwd

Options
-f file Log file name (properties file in –i silent 

mode)

-g Generate sample properties file for –i silent 
mode

-i mode Mode: console, silent, recorderui, swing

-h Display command help
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Examples
To reset a user’s password:

arcsight resetpwd
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resvalidate

ruledesc

Description

Utility for checking whether there are any invalid resources in the 
database. The utility generates two reports called validationReport 
(with .xml and .html extensions) that are written to the directory 
from which you run the resvalidate command

Applies to Manager, Database

Syntax resvalidate 

Options

-excludeTypes 
<exclude_resource
_names>

Resource type to exclude from being checked; 
for example, Rule, DataMonitor

If specifying multiple resource types to 
exclude, use comma to separate them.

Resource type – Rule, DataMonitor(comma 
separated)

-out <output_dir> Output directory for validation report. If none 
is specified, the report is placed in the 
directory from which you run the 
resvalidate command

-persist [false | 
true]

If a resource is found to be invalid, whether to 
mark it invalid or only report it as invalid. For 
example, a rule depends on a filter that is 
missing. When you run the resvalidate 
command and  –persist=false, the rule will 
be reported as invalid but not marked invalid. 
However if –persist=true, the rule will be 
marked as invalid.

Default: persist=false.

Examples
To run:

arcsight resvalidate

Description
Rule description tool to fetch rules information. (Used by HPOVO.) 
Tool to monitor managed objects in the ArcSight Manager

Applies to Manager

Syntax ruledesc –t {ovo|uri} –i info [options]

Options -t type (Required) Type: { ovo | uri } 

-i info (Required) Info (depends on type). 

-m host Manager host name or address

-p pwd Password

-port Port for Manager. Default: 8443
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-prot Protocol {http | https}. Default: https

-u name User name

Examples
To run:

arcsight ruledesc
ArcSight Confidential ArcSight ESM Administrator’s Guide 239



A ArcSight Commands
runcertutil

Description

A wrapper launcher for the nss certutil tool used for managing 
certificates and key pairs. For more details on the certutil tool, you 
can vist the ‘NSS Security Tools’ page on the Mozilla website.

Note: If you do not see any error or warning messages after 
runcertutil has run, it is an indication that the command 
completed successfully.

Applies to N/A

Syntax arcsight runcertutil

Options -A Add a certificate to the database

-a Use ASCII format or allow the use of ASCII 
format for input or output.

-v <certificate_ 
validity_in_mont
hs>

Set the number of months a new certificate 
will be valid. You can use this option with the  
-w option which will set the beginning time for 
the certificate validity. If you do not use the  
-w option, the validity period begins at the 
current system time.

If you do not specify the -v argument, the 
default validity period of the certificate is 
three months.

-w 
<beginning_offse
t_months>

Set an offset from the current system time, in 
months, for the beginning of a certificate's 
validity period. Can be used when creating the 
certificate. Use a minus sign (-) to indicate a 
negative offset. If this argument is not used, 
the validity period begins at the current 
system time. 

-n 
<certificate_nam
e>

Alias for the certificate 

Notes:

• When generating a key pair on the 
Manager or ArcSight Web, it is mandatory 
to set the alias name to “mykey” (without 
the quotes)

• When importing a certificate, you can set 
the alias name to any name of your choice

-t 
<trust_attribute
s>

Set the certificate trust attributes

-d 
<certificate_dat
abase_dir>

Directory of the certificate database

-i Certificate import request

-L List all the certificates

-r Encoding type
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runmodutil

-o <filename> Output file name for new certificates or binary 
certificate requests. Be sure to use quotation 
marks around the file name if the file name 
contains spaces. If you do not specify a 
filename, by default, the output will be 
directed to standard output.

-S Create a certificate to be added to the 
database

-s <subject> Subject name

-k <key_type> Type of key pair to generate

-x Self signed

-m 
<serial_number>

Certificate serial number

-v 
<number_of_days>

Validity period in days, for example, use  
-v 1825 
to change the validity period to 5 years where 
1825 is the number of days in 5 years.

-V Check the validity of the certificate

-n <cert_name> Certificate name

-H Help on this tool

Examples
To run:

arcsight runcertutil

Description

A wrapper launcher for the modutil nss cryptographic module utility.

For more details on the certutil tool, you can vist the ‘NSS Security 
Tools’ page on the Mozilla website.

Applies to N/A

Syntax arcsight runmodutil

Options
-fips 
[true|false]

Alias for the certificate 

-dbdir 
<path_to_directo
ry>

The security database directory

-H Help on this tool

Examples
To run:

arcsight runmodutil
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runpk12util

Description

The pk12util allows you to export certificates and keys from your  
database and import them into nssdb. This is a wrapper launcher for 
the pk12util nss tool.

For more details on the certutil tool, you can vist the ‘NSS Security 
Tools’ page on the Mozilla website.

Applies to N/A

Syntax arcsight runpk12util

Options
-d 
<Certificate_dir
ectory>

Path to your certificate directory (nssdb) 

-i 
<file_to_be_impo
rted>

The name of the file to be imported

-h Help on this tool

Examples
To run:

arcsight runpk12util
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script

searchindex

Description Run a Python script

Applies to Manager

Syntax script –f script_file

Options -f file list The script(s) to run

-a args Command line arguments to pass to script

Examples
To run a Python script:

arcsight script myScript.py

Description

Utility that creates or updates the search index for resources in 
ArcSight Database.

If you provide the credentials for the Manager, it automatically 
associates with the newly created or updated index. However, if you 
do not specify any credentials, you will have to manually configure 
the Manager to use the updated index.

Applies to Manager, Database

Syntax searchindex –a action

Options

-a action Possible actions: create, update, or 
regularupdate 

create—Creates a new search index.

update—Updates all resources in the index 
that were touched since the last daily update 
was run. Although “update” is a scheduled 
task that runs daily, you can run it manually. 

regularupdate—Updates all resources in the 
index that were touched since the last regular 
update was run. Although “regular update” is 
a scheduled task that runs every 5 minutes, 
you can run it manually. 

-m manager Name of the Manager

-p password Password for the user

-t time Time stamp that indicates starting when the 
resources should be updated

-u user User name with which to log in to the 
Manager

Examples
To run:

arcsight searchindex –a action
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sendlogs

startxvfb

tee

Description
Wizard to sanitize and send ArcSight log files to ArcSight for 
analysis. (This utility replaces the old ‘packlogs’ tool.)

Applies to Manager, Database, Console, SmartConnectors

Syntax sendlogs

Options
-f file Log file name (properties file in –i silent 

mode)

-g Generate sample properties file for –i silent 
mode

-i mode Mode: console, silent, recorderui, swing

-n num Incident number (Quick mode)

Examples

To run on all components except SmartConnectors:

arcsight sendlogs

To run on SmartConnectors:

arcsight agent sendlogs

Description Start the X Windows virtual file buffer daemon. (Unix only.)

Applies to Manager, Database, Console

Syntax startxvfb

Options None

Examples
To start the xvfb daemon:

arcsight startxvfb

Description
Displays the output of a program and simultaneously writes that 
output to a file

Applies to Manager

Syntax -f filename

Options -a Append to the existing file

Examples
To run:

arcsight tempca -i | arcsight tee sslinfo.txt
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tempca

testdbconnection

Description Inspect and manage demo certificates

Applies to Console

Syntax tempca

Options -a alias Key store alias of the private key to dump

-ac Add the demo CA’s certificate to the client 
truststore

-ap Create demo SSL key pair and add it to 
ArcSight Manager key store

-dc Dump/export the demo CA’s certificate to a 
file (demo.crt) for browser import

-dpriv Dump private key from ArcSight Manager key 
store

-f file Filename to write the demo CA’s certificate to

-i Display summary of current SSL settings

-k n Key store: Manager (1) or Web Server (2)

-n host Host name of the Manager (opt for the 
creation of a demo key pair)

-nc No chain: Do not include certificate chain 
(option for creation of a demo key pair)

-rc Reconfigure not to trust demo certificates. 
Removes the demo CA’s certificate from the 
client truststore

-rp Remove pair’s current key pair from ArcSight 
Manager key store

-v d Validity of the new demo certificate in days 
(Default: 365)

Examples
To run:

arcsight tempca

Description Test whether the database is up and running

Applies to Manager, Database

Syntax testdbconnection –u username –p password

Options
-u username (Required) User name of the Arcsight user in 

the database. Typically, arcsight

-p password (Required) Password of the ArcSight user in 
the database
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threaddumps

tproc

-i instance Instance of the database. Default: arcsight

-p port Port to connect. Default: 1521

-s host Hostname of the machine on which database 
is located.

Default: localhost

-t dbtype Database type: oracle. Default: oracle

Examples testdbconnection –u arcsight –p password

Description Utility to extract and reformat thread dumps from Manager log files

Applies to Manager

Syntax threaddumps [file]

Options None

Examples
To run:

arcsight threaddumps

Description Standalone Velocity template processor

Applies to Manager

Syntax tproc

Options -d file Definitions file

-Dname=value Defines

-h Display command help

-l Keep log file

-o file Output file

-p file Properties file

-t file Template file

-v Verbose mode

Examples
To run:

arcsight tproc
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uninstallservice

webserver

webserver-no-wrapper

Description Wizard to uninstall service

Applies to Manager, ArcSight Web

Syntax uninstallservice

Options
-c component Component whose service will be 

uninstalled—Manager or Web

Examples
To run:

arcsight uninstallservice

Description Start the ArcSight Web server

Applies to ArcSight Web

Syntax webserver

Options -c file Base configuration file

-host host Manager name or address

-p port Manager port

-pc file User configuration file

Examples
To start the ArcSight Web server:

arcsight webserver

Description Start the ArcSight Web server without automatic restart

Applies to ArcSight Web

Syntax webserver-no-wrapper

Options -ms mem Minimum memory

-mx mem Maximum memory

Examples
To start the ArcSight Web server without automatic restart:

arcsight webserver-no-wrapper
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webserversetup

webserversvc

Description See runwebsetup and websetup

Applies to ArcSight Web

Description Start, stop, restart, or install the ArcSight Web server as a service

Applies to ArcSight Web

Syntax
webserversvc [options] 

You can use the single letter options shown in brackets instead of 
entering the whole word on Windows only

Options Description Windows Solaris Linux AIX

start or (-s)

Start the service No

(Command 
available 
but does 
not work)

Yes Yes Yes

stop or (-q) Stop the service Yes Yes Yes Yes

restart
Restart the 
service

No Yes Yes Yes

status
Check status of 
service

No No Yes Yes

install or (-i) 
<initialHeap> 
<maxHeap>

Install the 
service

Optional 
parameters:

initialHeap—
Initial heap 
memory size, in 
MB. (Default: 
128)

maxHeap—
Maximum heap 
memory size, in 
MB. (Default: 
512)

Yes No No No

remove or (-r)
Remove the 
service

Yes No No No

console  
or (-c)

Console Mode Yes No No No

Examples
To start the ArcSight Web server as a service:

arcsight webserversvc start
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websetup

whois

Description Run the ArcSight Web Configuration Wizard

Applies to ArcSight Web

Syntax websetup

Options None

Examples
To run the ArcSight Web Configuration Wizard:

arcsight websetup

Description Script used by the whois command of the console

Applies to Console

Syntax whois [-p port] [-s host] target

Options -p port Server port

-s host Name or address of ‘whois’ server

target Name or address to lookup

Examples
To run:

arcsight whois
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Appendix B

Troubleshooting

The following information may help solve problems that occur while operating the ArcSight 
system. In some cases, the solution can be found here or in specific ArcSight 
documentation, but ArcSight Customer Support is available if you need it. 

If you intend to have ArcSight Customer Support guide you through a diagnostic process, 
please prepare to provide specific symptoms and configuration information. If you intend 
to do the initial diagnostic steps yourself, proceed through the following checklist 
systematically, trying each applicable item and noting the results for reference.

This appendix is divided into the following sections:

General
Report is empty or missing information.

Check that the user running the report has inspect (read) permission for the data being 
reported.

Running a large report crashes the Manager.
A very large report (for example, a 500 MB PDF report) might require so much virtual 
machine (VM) memory that it can cause the ArcSight Manager to crash and restart. To 
prevent this scenario, you can set up the Manager to expose a special report parameter for 
generating the report in a separate process. The separate process has its own VM and 
heap, so the report is more likely to generate successfully. Even if the memory allocated is 
still not enough, the report failure will not crash the Manager.

This option must be set up on the Manager to expose it in the Console report parameters 
list. The steps are as follows:

“General” on page 251

“Query and Trend Performance Tuning” on page 254

“SmartConnectors” on page 257

“Console” on page 258

“Manager” on page 259

“ArcSight Web” on page 261

“Database” on page 261

“SSL” on page 262
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1 On the ArcSight Manager in the server.properties file, set 
report.canarchivereportinseparateprocess=true. (This will make a new 
report parameter available on the Console.) 

2 Save the server.properties file and restart the Manager. 

3 On the ArcSight ESM Console, open the report that you want to run in a separate 
process in the Report Editor, and click the Parameters tab. Set the parameter 
Generate Report In Separate Process to true. 

4 Run the report. The report should run like a normal report, but it will not consume the 
resources of the Manager VM.

Reports that query over a large time range with complex 
joins take a long time to run.

You can expedite a report that queries over a large time range with complex joins if you set 
it to query with a full scan database hint. To set the query with full scan database hint, do 
this: 

1 On the ArcSight Manager in the server.properties file, set 
report.canquerywithfullscanhint=true. (This will make a new report 
parameter available on the Console.) 

2 Save the server.properties file and restart the Manager. 

3 On the ArcSight ESM Console, open the report that you want to contain the full scan 
hint in the Report Editor, and click the Parameters tab. Set the parameter Query 
with Full Scan Hint to true. 

4 Run the report. 

Some Asian language fonts appear mangled when 
generating reports in PDF

This problem occurs because some Asian language fonts that are truetype fonts are not 
supported directly by versions of Adobe Reader earlier than version 8.0. In order to work 
around this, each truetype font must be mapped to an opentype font supported in Adobe 

Use this parameter only if you experience a Manager crash when running 
large reports such as the ones that contain tables with more than 
500,000 rows and 4 or 5 columns per row.

1 Use this parameter only in special circumstances if your organization has 
determined with the help of ArcSight support or professional services that 
it is appropriate. 

2 If a report is saved with the parameter set to "true", the full database 
optimization hint is applied even if the property 
report.canquerywithfullscanhint in server.properties is set back 
to false later on. 

3 When the property report.canquerywithfullscanhint is set to "true", 
the report uses the FULL_SCAN hint in the SQL queries it generates to 
query the database. The content of the report does not change, but the 
queries logged in server.report.log contain the hint. The main benefit 
of querying the database with the FULL_SCAN hint is that it can 
significantly reduce the runtime for SQL queries that query over events 
within a large time range and contain complex joins.
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Reader 8.0. ArcSight provides this mapping in the 
<ARCSIGHT_HOME>\i18n\server\reportpdf_config_<locale>.properties 
file. You have the option to change the default mapping of any truetype font to the 
opentype font by modifying the respective font mapping in this file.

To work around the issue of mangled fonts, ArcSight recommends that you:

1 Install a localized Adobe Reader 8.0 depending on the language of your platform on 
your Manager machine. This version of the Adobe Reader installs the opentype fonts 
by default.

2 Edit the server.properties file as follows:

a Set report.font.truetype.path property to point to the directory that 
contains the truetype and opentype font. On Windows it is typically 
C:\\WINNT\\fonts;C:\\Program Files\\Adobe\\Reader 
8.0\\Resource\\CIDFont where “;” is used as a path separator to separate 
the multiple paths. Use “:” as a path separator in Unix. On Unix platforms, the 
truetype font path may differ depending on the specific Unix platform, but it is 
typically /usr/lib/font. The CIDFont directory is always the same relative to 
the Adobe Reader installed directory. So, the default directory would be 
/usr/lib/font:<adobe_reader_dir>/Resource/CIDFont.

b Set report.font.cmap.path property to point to Adobe Reader’s CMap 
directory. On windows, it is typically C:\\Program Files\\Adobe\\Reader 
8.0\\Resource\\CMap. On Unix, the CMap path is relative to the Adobe 
Reader installation -- <adobe_reader_dir>/Resource/CMap.

E-mail notification doesn’t happen.
Check server.properties file to find which SMTP server is associated with the 
Manager. Make sure that the SMTP server is up and running.

Review the Notification resource and confirm the e-mail address and other configuration 
settings.

Notification always escalates.
Check server.properties file to find which POP3 or IMAP server is associated with the 
Manager. Make sure that the POP3 or IMAP server is up and running, in order to process 
acknowledgements from notification recipients.

Pager notification doesn’t happen.
Check server.properties file to find which SNPP server is associated with the 
Manager. Make sure that the SNPP server is up and running.

Query or report performance degrades suddenly.
Check that the ArcSight Database host has sufficient disk space.

Check that the ArcSight Database statistics are up to date.

Has the network infrastructure changed? 

Has the ArcSight Database or DBMS configuration changed?

See also, “Query and Trend Performance Tuning” on page 254 for more information on 
performance enhancements and suggestions on how to improve performance with regard 
to queries and trends.
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Query and Trend Performance Tuning
Previous to ESM v.4.0 SP1, some trends exceeded 10 hours to execute queries. This 
eventually caused these queries to fail or lead to ESM scheduler problems. This effect was 
most pronounced on systems with high event rates (typically thousands of events per 
second).

To resolve this issue, various queries used by the trends in the default ArcSight system 
content were studied to ensure that Oracle was choosing optimal query execution plans. In 
a number of cases, the execution plan was not optimal and database "hints" were added to 
the queries to optimize the query execution. Most of these queries were sped up, some of 
them by a significant amount (much more than a factor of 10).

We have enhanced the scheduler to allocate two threads for processing system tasks. This 
change alleviates performance issues caused by conflicts between system tasks and user 
level tasks within the scheduler. 

Starting with ESM v.4.0 SP1, Patch 3, several performance enhancements related to 
queries and trends were included. All follow-on service packs, patches, and releases 
include these performance enhancements, configurable properties, and reports. The 
following sections detail these, and also provide other troubleshooting tips.

Regenerate Event Statistics
Regenerate event statistics using the following command if you are experiencing query 
performance issues. To regenerate event statistics, run this command in 
ARCSIGHT_HOME\bin on your database machine:

./arcdbutil sql username/password 
@../utilities/database/oracle/common/sql/ 
RegenerateEventStats.sql

The RegenerateEventStats.sql command deletes statistics on event tables and 
indexes generated using the ANALYZE command, and regenerates the partition statistics 
using the DBMS_STATS command.

Persistent Database Hints
Database hints are provided in system content packages. These hints are not visible in the 
Console. Please do not attempt to modify the system queries through the Console because 
this will cause the hint to disappear and the query will run slowly again.

server.defaults.properties Entries for Trends
trends.query.timeout.seconds=7200

This is the amount of time that a trend query is allowed to run, in seconds, before the 
SQL statement times out and the trend query fails. If absent or 0, no time-based 
timeout is applied.

trends.query.timeout.percent=50

The time that the RegenerateEventStats.sql command takes to complete 
depends on the number of events in your database and can take from several 
minutes to a few hours.
254 ArcSight ESM Administrator’s Guide ArcSight Confidential



B Troubleshooting
This is the amount of time that a trend query is allowed to run, as a percentage of the 
query interval for interval trends, before the SQL statement times out and the trend 
query fails. If absent or 0, no percentage-based timeout is applied.

As an example, with a 50 percent setting, a query covering a start/end time range of 1 
hour will time out after 30 minutes. A start/end time range covering 1 day would time 
out after 12 hours.

If both timeouts are specified, the system will use the smaller of the two.

trends.query.failures.deactivation.threshold=3

If this many consecutive "accumulate" (not refresh) runs fail for any reason, the 
system automatically disables the trend. The check is always performed after any 
accumulate query run fails. Once the threshold is reached, any remaining queries to be 
executed by this task are skipped. If this setting is absent or 0, the checking 
mechanism is turned off. 

If a trend or query is stopped because of any of the above reasons, an audit event will 
reflect this. 

Troubleshooting Checklist after Restarting the Manager
Use the Console Trend Editor to manually disable any trends that you do not need or 
that you notice have excessive query times. Disabling these trends will help reduce 
scheduler and database contention.

Your own custom trends may have long-running queries and may be timing out. If this 
is the case, use the Query Tuner tool provided with this patch. See “querytuner” on 
page 233 (in ArcSight Commands) for instructions on how to use this tool. Once you 
have identified a hint that might help, please contact ArcSight support and provide a 
package with your query or queries for ArcSight to examine. We will investigate and 
determine if database hints can improve your trend queries. 

As trend data gathering tasks wake up, the trend will attempt to fill in the gaps for 
missing intervals. Depending on the size of the gaps, this may take some time before 
the trends catch up.

A trend will not usually re-run any previously failed runs. If you want to re-run a 
particular time, you need to manually request it from the Trend Editor. 

Reports for Monitoring Trend Performance
The following new reports are available as a part of this Patch. We recommend running 
these reports after installing the Patch to monitor the trend performance:

/All Reports/ArcSight Administration/Resource 
Monitoring/Trends/Trend Query Runs Duration 

/All Reports/ArcSight Administration/Resource 
Monitoring/Trends/Skipped Scheduled Tasks 

Disable these Trends on High Throughput Systems
If your system environment typically processes a very large number of events per second 
(EPS) (e.g., over 1000 EPS or 100 million events per day), we recommend that you 
manually disable the following 9 trends, which are enabled by default:

/All Trends/ArcSight Administration/User/ArcSight User Login Trends 
– Hourly 
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/All Trends/ArcSight Foundation/Configuration Monitoring/Asset 
Configuration Change Tracking/Host Configuration Modifications 

/All Trends/ArcSight Foundation/Configuration Monitoring/Asset 
Restarts/Asset Startup and Shutdown Events - Daily Trend 

/All Trends/ArcSight Foundation/Configuration Monitoring/User 
Account Modifications/User Account Creation 

/All Trends/ArcSight Foundation/Configuration Monitoring/User 
Account Modifications/User Account Modifications 

/All Trends/ArcSight Foundation/Intrusion Monitoring/Operational 
Summaries/Reconnaissance/Port Scanning 

/All Trends/ArcSight Foundation/Intrusion Monitoring/Operational 
Summaries/Reconnaissance/Zone Scanning Events by Priority 

/All Trends/ArcSight Foundation/Intrusion Monitoring/Operational 
Summaries/Vulnerability View/Prioritized Vulnerability Events by 
Zone 

/All Trends/ArcSight Foundation/Network Monitoring/Overall Traffic 

How will you know when a trend is caught up? 
You can use either of the following techniques, both using the ESM Console UI: 

Using the Trend Data Viewer from within the Trends resource tree, you can see at 
most 2000 rows of data. (Select a trend in the resource tree, right-click, and choose 
Data Viewer.) Sort the trend timestamp column so that the timestamps show newest 
to oldest and observe when the newest value indicates it has caught up.

Using the Refresh... button in the Trend Editor, set the start time as far back as 
needed (days or weeks) to see any entries and click Refresh to see which runs show 
up as available to be refreshed. Only the most recent ones should show first. Note that 
you should not actually refresh any runs, but only use this technique to see what has 
been run.

How long will it take a trend to catch up?
This depends on how long the underlying query interval is, but a trend will typically do up 
to 48 runs, as needed, when it wakes up.

For a trend that queries an entire day and runs once a day, this would allow for more than 
a month’s worth of data to be queried. The data must be present on the system, however, 
or the query will return no results (but it will not fail).

Enhancing the Performance Globally for all Database 
Queries

You can enhance the performance for all queries made against the database. When Oracle 
Optimizer decides on a query execution plan, it can dynamically do a sampling of actual 
data to estimate the cost of the query. Based on the findings of this sampling, the 
Optimizer comes up with the best query execution plan which will help improve query 
performance. To enable dynamic sampling, run:

% arcdbutil sql 
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Enter user-name: / as sysdba

SQL> @<ARCSIGHT_HOME>\utilities\database\oracle\common\sql\

SetDynamicSampling.sql

In addition to Dynamic Sampling, you can update the IO transfer speed in the database 
which will help in query performance. If you do not update the IO transfer speed, Oracle 
defaults to a very low IO transfer speed esimate that adversely affects the query execution 
plan. Run the following command (while logged in as sysdba): 

SQL> @ARCSIGHT_HOME\utilities\database\oracle\common\sql\

GatherSystemStats.sql 

This script should also be run every time you make any storage hardware changes that 
affects IO transfer speeds.

SmartConnectors
My device is not one of the listed SmartConnectors.

ArcSight offers an optional feature called the FlexConnector Development Kit which may 
enable you to create a custom SmartConnector for your device.

ArcSight can create a custom SmartConnector. Contact ArcSight Customer Support.

My device is on the list of supported products, but it does 
not appear in the SmartConnector Configuration Wizard.

Your device is likely served by a Syslog sub-connector of either file, pipe, or daemon type.

Device events are not handled as expected.
Check the SmartConnector configuration to make sure that the event filtering and 
aggregation setup is appropriate for your needs.

SmartConnector not reporting all events.
 Check that event filtering and aggregation setup is appropriate for your needs.

Some Event fields are not showing up in the Console.
Check that the SmartConnector’s Turbo Mode and the Turbo Mode of the Manager for the 
specific SmartConnector resource are compatible. If the Manager is set for a faster Turbo 
Mode than the SmartConnector, some event details will be lost.

SmartConnector not reporting events.
Check the SmartConnector log for errors. If the SmartConnector cannot communicate with 
the Manager, it will cache events until its cache is full.

Partition Archiver problems.
See Partition Archiver under “Database” on page 261.
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Console
Can’t log in with any Console.

 Check that the ArcSight Manager is up and running. If the Manager is not obviously 
running, open a command window on <ARCSIGHT_HOME>\bin, and run: 

arcsight manager

If the Manager is running, but you still can’t log in, suspect any recent network changes, 
such as the installation of a firewall that will affect communication with the Manager host.

Can’t log in with a specific Console.
If you can log in from some Console machines but not others, focus on any recent network 
changes and any configuration changes on the Console host in question.

Console reports out of memory.
This can happen when you open many independent viewing channels. If you need to do 
this often, change the memory settings in the console.bat or console.sh file. Find the 
line that starts set ARCSIGHT_JVM_OPTIONS= and change the parameter –Xmx128m to –
Xmx256m. You must restart the Console for the new setting to take effect.

Acknowledgement button is not enabled.
The Acknowledgement button is enabled when there are notifications to be acknowledged 
and they are associated with a destination that refers to the current user. To enable the 
button, add the current user to the notification destination.

The grid view of Live security events is not visible.
To restore the standard grid view of current security events, select Active Channels from 
the Navigator drop-down menu. Double-click Live, found at /Active 
channels/Shared/All Active channels/ArcSight System/Core/Live

The Navigator panel is not visible.
 Press Ctrl+1 to force the Navigator panel to appear.

The Viewer panel is not visible.
 Press Ctrl+2 to force the Viewer panel to appear.

The Inspect/Edit panel is not visible.
 Press Ctrl+3 to force the Inspect/Edit panel to appear.

Internal ArcSight events appear.
Internal ArcSight events appear to warn users of situations such as low disk space for the 
ArcSight Database. If you are not sure how to respond to a warning message, contact 
ArcSight Customer Support.
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The Manager Status Monitor reports an error.
The Console monitors the health of the ArcSight Manager and the ArcSight Database. If a 
warning or an error occurs, the Console may present sufficient detail for you to solve the 
problem. If not, report the specific message to ArcSight Customer Support.

Console logs out by itself.
Check the Console log file for any errors. Log in to the Console. If the Console logs out 
again, report the error to ArcSight Customer Support.

Console stops responding when sending a test SNPP 
notification.

If the Console stops responding when sending a test SNPP notification, it may indicate that 
the SNPP port is blocked by a firewall or packet filtering device.

Cannot log in to ArcSight Web from within the Console.
In ArcSight Console, if you click File->Launch ArcSight Web, it will start the browser 
within the Console window and display the ArcSight Web login screen. Once you enter your 
username and password for the Manager, you should be able to log into the Web from 
within the Console. However, if inspite of entering the correct login information, you cannot 
login to ArcSight Web and your browser appears to hang, then you have to change the 
security settings on your browser. To do so on Internet Explorer:

1 Go to Tools->Internet Options.

2 Click the Security tab.

3 Click the Internet icon.

4 Click the Custom level... button.

5 Select Medium from the Reset to drop down menu. 

6 You will receive a warning asking you whether you want to change the security setting 
of the zone. Click Yes.

7 Click OK in the Security Options box.

8 Click OK in the Internet Options box.

9 Go back to the Console and try to restart ArcSight Web from within the Console by 
clicking File->Launch ArcSight Web.

Manager
Can’t start Manager.

The ArcSight Manager will provide information on the command console which may 
suggest a solution to the problem. Additional information will be written to 
<ARCSIGHT_HOME>\logs\default\server.std.log.

To check database connectivity manually, open a command window on 
<ARCSIGHT_HOME>\bin (on the Manager host) and run:

arcsight testdbconnection
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Manager shuts down.
The Manager stops when it encounters a fatal error. The file 
<ARCSIGHT_HOME>\logs\default\server.std.log will have more details about the 
error condition.

For example, the following error indicates that a connection cannot be established with the 
underlying Oracle DBMS:

[ERROR][default.com.arcsight.common.persist.oracle.OracleDatabaseI
nfoBroker][getDatabaseInfo] 

com.arcsight.common.persist.PersistenceException: Unable to get 
connection: Io exception: Connection reset by peer: socket write 
error

This indicates that the Oracle TNS Listener is running but the actual ArcSight Database 
service is not reachable.

Manager restarts automatically.
If the Java Virtual Machine (JVM) fails to respond within two minutes, an ArcSight 
watchdog program will automatically restart it, which reduces system performance but 
does not cause data loss. This situation has been observed on low-end Windows-based 
host machines with pagefile size optimization enabled. Optimization complicates the 
garbage collection process, rendering the JVM non-responsive for longer than two minutes. 

Disable pagefile size optimization. Perform the following steps to disable pagefile size 
optimization on Windows XP or Windows 2000 Manager hosts:

1 Right-click My Computer and select Properties from the menu. Select the 
Advanced tab.

2 Click Performance Options for Windows 2000 or Settings for Windows XP.

3 On Windows XP, select the Advanced tab and click Change.

4 Set Initial size to the same value as Maximum size.

5 Click Set.

6 Click OK.

The log contains a warning “Side table for [name] is 100% 
full. System performance will be affected.”

This log error message is the result of the default sizes for side object caches being too 
small for some larger production deployments. Although system performance is generally 
not affected, to stop generating the warning message, add the following lines to the 
server.properties file and restart the ArcSight Manager: 

persist.securityevent.stcache.GeoDescriptor=50000

persist.securityevent.stcache.AgentDescriptor=500

persist.securityevent.stcache.DeviceDescriptor=50000

persist.securityevent.stcache.CategoryDescriptor=3000
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persist.securityevent.stcache.LabelsDescriptor=2000

persist.securityevent.stcache.ResourceRef=20000

If you continue to see the error message after this change, one or more SmartConnectors 
may be misconfigured. Contact ArcSight Customer Support.

ArcSight Web
Some content, particularly dashboards, is not visible.

Install the Macromedia Flash plug-in (version 6) to your browser. Visit 
http://www.macromedia.com to download this free plug-in.

Can’t log in to ArcSight Web.
Check that the ArcSight Web Server is up and running. If ArcSight Web is up, check that 
the ArcSight Manager is also up and running.

If the Manager is running, but you still can’t log in, suspect any recent network changes, 
such as the installation of a firewall that will affect communication between the ArcSight 
Web server and the Manager host.

If you can log in to the ArcSight Console but not ArcSight Web, focus on any recent 
network changes and any configuration changes to your browser.

Make sure that the version number of ArcSight Web matches that of the Manager. If the 
version numbers do not match, log in will be disabled.

Can’t start ArcSight Web.
If the ArcSight Web Server cannot start, check that the ArcSight Manager is up and 
running. If the Manager is not obviously running, open a command window on 
<ARCSIGHT_HOME>\bin, and run: 

arcsight manager

Examine the ArcSight Web log file for specific error messages. If the message is not clear, 
contact ArcSight Customer Support.

Database
Partition Archiver can’t connect to Manager.

Check the Partition Archiver log for errors. The log file is found in the logs directory:

<ARCSIGHT_HOME>\logs\default\agent.out.wrapper.log

An SSL Handshake exception in the log indicates a problem with the Manager’s certificate. 
From the SmartConnector’s install directory, run the following command to establish a valid 
certificate:

arcsight agent tempca -ac
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Oracle hangs without warning.
If automatic archive log mode is turned on, Oracle will hang if the archive log destination 
becomes full. Oracle will resume when you make archive log space available.

An e-mail notification reports a problem with the ArcSight 
Database.

Don’t ignore a warning or error notification from the ArcSight system. If the message is not 
clear to you, contact ArcSight Customer Support. Ignoring a database error can lead to the 
Manager suddenly stopping, which will eventually lead to security event data loss.

See Appendix C‚ Monitoring Database Attributes‚ on page 265 for more information.

Partition logs may not be complete.
Only one duplicate log file can be written to at one time. Therefore, if a partition utility is in 
progress and another partition utility starts in parallel, the logs for the first utility will not be 
written anymore to the duplicate log file. However, the log data for the first utility is not 
lost; it is available in the <ARCSIGHT_HOME>\logs\server.log file. 

See Chapter 3‚ Database Administration‚ on page 69, for more information.

SSL
Cannot connect to the SSL server: IO Exception in the 
server logs when connecting to the server

Causes:

?The SSL server may not be running.

?A firewall may be preventing connections to the server.

Resolutions:

?Ensure that the SSL server is running.

?Also, ensure that a firewall is not blocking connections to the server.

Cannot connect to the SSL server
The hostname to which the client initiates an SSL connection should exactly match the 
hostname specified in the server SSL certificate that the server sends to the client during 
the SSL handshake. 

Causes:

You may be specifying Fully Qualified Domain Name (FQDN) when only hostname is 
expected or the other way around.

You may be specifying IP address when hostname is expected.

Resolutions:

Type exactly what the server reports on startup in server.std.log (“Accepting 
connections at http://...”)
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For Network Address Translation (NAT) or multi-homed deployments, use hosts file to 
point client to correct IP.

PKIX exchange failed/could not establish trust chain
Cause: Issuer cannot be found in trust store, the cacerts file.

Resolution: Import issuer’s certificate (chain) into the trust store.

Issuer certificate expired
Cause: The certificate that the SSL server is presenting to the client has expired.

Resolution: Import the latest issuer’s certificate (chain) into the trust store.

Cannot connect to the Manager: Exception in the server 
log

Cause: If you replaced the Manager’s key store, it is likely that the old key store password 
does not match the new password.

Resolution: Make sure the password of the new key store matches the old key store. If you 
do not remember the current key store’s password, run the Manager Configuration Wizard 
on the Manager (ArcSight Web Configuration Wizard on the Web) to set the password of 
the current key store to match the new key store’s password.

Certificate is invalid
Cause: The timestamp on the client machine might be out of the bounds of the validity 
range specified on the certificate.

Resolution: Make sure that the current time on the client machine is within the validity 
range on the certificate.
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Monitoring Database Attributes

This chapter provides information about in-built checks that monitor database attributes 
and generate warning or error messages, as appropriate.

This appendix is divided into the following sections:

Understanding Database Checks
ArcSight ESM provides in-built checks to monitor configurations and runtime attributes of 
your database. These checks inform you if attributes such as password of the Oracle 
account or number of available reserve partitions drop below an acceptable value. 
Depending on the severity of deviation, a warning or an error message is generated. 

If an error or a warning message is generated, these actions take place:

A message is logged to the server.std.log file on the Manager. 

If you have configured the Manager to generate an e-mail message, a message is 
sent. 

A notification message is displayed on the ArcSight Console.

If an error message is generated, the event flow to the Manager is stopped. In that case, 
SmartConnectors start caching the events so there is no loss of events. After you have 
resolved the issue that caused the error, you can click a reactivation URL that is included in 
the error message to restart the event flow.

Each check task is scheduled to run at a predefined interval and compare the current 
system state with a predefined threshold, both of which can be changed to suit your needs. 

The interval and threshold for each task is defined in the 
server.defaults.properties file on the Manager. You can override these values in 
the server.properties file on the Manager. 

Message text
The following is an example of the error or warning e-mail message that is sent:

Date: Fri, 14 Apr 2006 01:24:36 +0000 (GMT+00:00)

To: administrator@mycompany.com

“Understanding Database Checks” on page 265

“Disabling Database Checks” on page 267

“List of Database Check Tasks” on page 267
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[-- Attachment #1 --]

[-- Type: text/plain, Encoding: 7bit, Size: 1.0K --]

== SUBSYSTEM STATUS CHANGED 
====================================================

   Error - Event Receiver

== ORIGIN OF CHANGE 
============================================================

   Error - PartitionManagerCheckTaskTracker

-- DESCRIPTION ---------------------------------------------------
--------------

[PartitionManagerCheckTaskTracker: Fatal Error:  There are only 0 
of 7 reserve

partitions available.   This is likely due to failures in Partition 
Manager

runs for the past few days. If this situation is not fixed, the MAX 
partition

will become the CURRENT partition in the next few days, causing 
system failure.

Check the Partition Manager logs for errors and fix the problem 
before

proceeding.

Fix the root cause of the error reported. If the event flow is 
stopped, use the

following URL to resume:

https://yourmanager.mycompany.com:8443/arcsight/web/reactivate.jsp
?id=87160D7E0425A22FBE5354FE90387A96

]
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The following is an example of the notification message that is displayed on the Console:

Disabling Database Checks
If you do not want to run a specific database check, you can disable it. 

To disable a database check task, specify the name of the check task as the value for the 
whine.check.exclude property in the server.properties file on the Manager. 

For example, to exclude PartitionManagerCheckTask, enter this in the 
server.properties file:

whine.check.exclude=PartitionManagerCheckTask

To exclude multiple check tasks, specify a comma-separated list for the 
whine.check.exclude property; for example,

whine.check.exclude=PartitionManagerCheckTask, 
PartitionCompressorCheckTask

List of Database Check Tasks
The following is a list of check tasks available in this ArcSight ESM release. Each check task 
includes an interval at which that task is performed, any attributes that are checked, and 
the default thresholds at which a Warning or Error message is generated. 

1 AccountCheckTask - Checks User Account Expiry 

# AccountCheckTask is run every 12 hours 
whine.check.interval.AccountCheckTask=43200

# AccountCheck Password Expiry warning threshold (days) 
dbcheck.oracle.account.warn.threshold=5

# AccountCheck Password Expiry error threshold (days) 
dbcheck.oracle.account.error.threshold=2

2 ArchiveDestinationCheckTask - If the redo log archive destination is cross 
mounted in the manager box, this task will check for space availability in such a 
destination

To obtain the name of a task, see List of Database Check Tasks.
ArcSight Confidential ArcSight ESM Administrator’s Guide 267



C Monitoring Database Attributes
# ArchiveDestinationCheckTask is run every 1 hour 
whine.check.interval.ArchiveDestinationCheckTask=3600

# Whether database archive destination filesystems are cross mounted in the Manager 
box 
dbcheck.oracle.archivedest.xmount=false

# Minimum number of hours of archive space that should be available 
dbcheck.oracle.archivedest.threshold.hours=18

3 ArchiveSessionCheckTask - Checks whether any Oracle sessions are stuck on 
"archive required" wait event.

# ArchiveSessionCheckTask is run every 30 seconds 
whine.check.interval.ArchiveSessionCheckTask=30

4 ParameterCheckTask - Checks default and non-default Oracle parameters against 
values specified below.

# ParameterCheckTask is run every 24 hours 
whine.check.interval.ParameterCheckTask=86400

# Suggested % of shared_pool in terms of total sga 
dbcheck.oracle.parameter.sharedpool=20

# Suggested % of db_cache in terms of total sga 
dbcheck.oracle.parameter.dbcache=40

# Suggested minimum db_files value 
dbcheck.oracle.parameter.dbfiles=200

# Suggested maximum java_pool size 
dbcheck.oracle.parameter.javapool=0

# Suggested minimum log_buffer size 
dbcheck.oracle.parameter.logbuffer=1048576

# Suggested maximum parallel_max_servers value 
dbcheck.oracle.parameter.parallelmaxservers=0

# Suggested pga_aggregate_target value 
dbcheck.oracle.parameter.pgaaggregatetarget=40

# Suggested minimum processes value 
dbcheck.oracle.parameter.processes=100

# Suggested minimum undo_retention value 
dbcheck.oracle.parameter.undoretention=43200

# Suggested timed_statistics value 
dbcheck.oracle.parameter.timedstatistics=TRUE

# Suggested workarea_size_policy value 
dbcheck.oracle.parameter.workareasizepolicy=AUTO

5 PartitionArchiverCheckTask - Checks whether partition archiver is working 
successfully.

# PartitionArchiverCheckTask is run every 12 hours 
whine.check.interval.PartitionArchiverCheckTask=43200

# Archiver Lag Warning Threshold 
dbcheck.oracle.archiver.warnthreshold=2
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6 PartitionCompressorCheckTask - Checks whether partition compressor is working 
successfully.

# PartitionCompressorCheckTask is run every 12 hours 
whine.check.interval.PartitionCompressorCheckTask=43200

7 PartitionManagerCheckTask - Checks whether enough reserve partitions are 
available.

# PartitionManagerCheckTask is run every 12 hours 
whine.check.interval.PartitionManagerCheckTask=43200

# Partition Manager Warning Threshold (# of available reserve partitions) 
dbcheck.oracle.manager.warnthreshold=5

# Partition Manager Error Threshold (# of available reserve partitions) 
dbcheck.oracle.manager.errorthreshold=2 
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Appendix D

The Logfu Utility

This appendix is divided into the following sections:

Logfu is an ArcSight utility that analyzes log files. It is indispensable for troubleshooting 
problems that would otherwise require poring over text logs. Logfu generates an HTML 
report (logfu.html) and, especially in SmartConnector mode, includes a powerful 
graphic view of time-based log data. Logfu pinpoints the time of the problem and often the 
cause as well.

Figure D-1 Logfu has two windows: the interactive Chart and the Plot/Event window.

“Running Logfu” on page 272

“Example” on page 274

“Troubleshooting” on page 274

“Menu” on page 276

“Typical Data Attributes” on page 276

“Intervals” on page 277
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Running Logfu
Logfu finds log files in the current directory. The –a or –m or –c switches tell it which file 
names to look for. The –m switch tells it to look for all three Manager logs—
server.std.log, server.log, and server.status.log—for example. 

To run Logfu, follow these steps:

1 Open a command window in <ARCSIGHT_HOME>\logs\default. This refers to the 
logs directory under the ArcSight installation directory. (Path separators are / for Unix 
and \ for Windows.) Logfu requires an X Windows server on Unix platforms.

2 Run logfu for the type of log you will analyze:

For Manager logs, run: ..\bin\arcsight logfu –m

For SmartConnector logs, run: ..\bin\arcsight agent logfu –a

3 Right-click in the grid and select Show Plot/Event Window from the context menu.

4 Check at least one attribute (such as Events Processed) to be displayed.

The initial display is always an empty grid. Loading very large log files can take a few 
minutes (a 100MB log might take 5 or 10 minutes). Once log files are scanned, the 
information gleaned from them is cached (in files named data.*) that will speed up loading 
the second time. If something about the log changes, however, you must manually delete 
the cache files to force logfu to reprocess the log.

Right-click the grid and choose Show Plot/Event Window from the context menu. 
Select what to show on the grid from the Plot/Event Window that appears.

The tree of possible things to display is divided into Plot—attributes that can be plotted 
over time, like events per second—and Event—one-time things, like exceptions, which are 
shown as vertical lines. Check as many things as you want to show. 

Because SmartConnectors can talk to multiple Managers and each can be configured to use 
multiple threads for events, the Plot hierarchy includes nodes for each SmartConnector and 
each Manager. Within the SmartConnector, threads are named E0, E1, and so on. Each 
SmartConnector has one heartbeat thread (H0) as well. Different types of SmartConnector 
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(firewall log SmartConnector, IDS SNMP SmartConnector, and so on) have different 
attributes to be plotted.

Figure D-2 The interactive Chart uses sliders to change the view. Hovering over a data point 
displays detailed information.

There are two horizontal sliders—one at the top of the grid, one underneath. The slider at 
the top indicates the time scale. Drag it to the right to zoom in, or widen the distance 
between time intervals (vertical lines). The slider at the bottom changes the interval 
between lines—anywhere from 1 second at the far left to 1 day at the far right. The time 
shown in the grid is listed below the bottom slider: 

Showing YY/MM/DD HH:MM:SS – YY/MM/DD HH:MM:SS (Interval= X)

Click anywhere in the grid area and drag a green rectangle to zoom in, changing both the 
vertical and horizontal scales at once. Hold the Ctrl key as you drag to pan the window in 
the vertical or horizontal direction, and hold both the Shift and Ctrl keys as you drag to 
constrain the pan to either vertical or horizontal movement. When you are panning, only 
sampled data is shown, but when you stop moving, the complete data will fill in. (You can 
change this by unchecking Enable reduced data point rendering in Preferences.)

Hover the mouse over a data point to see detailed information in a “tooltip” window, as 
shown in Figure D-2.

For each attribute being plotted, a colored, vertical slider appears on the right of the grid. 
This slider adjusts the vertical (value) scale of the thing being plotted. 

By default, data points are connected by lines. When data is missing, these lines can be 
misleading. To turn off lines, uncheck Connect dots in Preferences.

Once you have specified attributes of interest, scaled the values, centered and zoomed the 
display to show exactly the information of concern, select Save as JPG on the menu to 
create a snapshot of the grid display that you can print or e-mail. The size of the output 
image is the same as the grid window, so maximize the window to create a highly detailed 
snapshot, or reduce the window size to create a thumbnail.
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Example
Perhaps a particular SmartConnector starts by sending 10 events per second (EPS) to the 
Manager, but soon is sending 100, then 500, then 1000 EPS before dropping back down to 
10. Logfu lets you plot the SmartConnector’s EPS over time—the result is something like a 
mountain peak.

When you plot the Manager’s receipt of these events, you might see that it keeps up with 
the SmartConnector until 450 EPS or so. You notice that the Manager continues consuming 
450 EPS even as the SmartConnector’s EPS falls off. This is because the Manager is 
consuming events that were automatically cached.

By plotting the estimated cache size, you can see the whole story—the SmartConnector 
experienced a peak event volume and the cache stepped in to make sure that the Manager 
didn’t lose events, even when it couldn’t physically keep up with the SmartConnector.

Use the vertical sliders on the right to give each attribute a different scale to keep the peak 
EPS from the SmartConnector from obscuring the plot of the Manager’s EPS. 

Troubleshooting
Another real-world example involved a Check Point SmartConnector that was mysteriously 
down for almost seven days. Logfu plotted the event stream from the SmartConnector and 
it was clearly flat during the seven days, pinpointing the outage as well as the time that the 
event flow resumed. By overlaying Check Point Log Rotation events on the grid, it became 
clear that the event outage started with a Log Rotation and that event flow resumed 
coincident with a Log Rotation.

Further investigation revealed what had happened—the first Check Point Log Rotation 
failed due to lack of disk space, which shut down event flow from the device. When the 
disk space problem had been resolved, the customer completed the Log Rotation and 
event flow resumed.

If the Manager suddenly stops seeing events from a SmartConnector Logfu helps 
determine whether the SmartConnector is getting events from the device. Another 
common complaint is that not all events are getting through. Logfu has a plot attribute 
called ‘ZFilter’—zone filter—that indicates how many raw device events are being filtered by 
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the SmartConnector. Events processed (the number of events sent by the device) minus 
ZFilter should equal Sent (the number of events sent to the Manager).

Figure D-3 The HTML report for the log file shown in Figure 1.
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Menu

Typical Data Attributes
SmartConnector Specific

Menu Item Description

Show Plot/Event Window Presents the possible attributes to be 
displayed

Bring To Front

Send to Back

Undo Zoom Return to previous view

Zoom out

Auto Scale Fit all data on the grid

Save as JPG Save a snapshot of the current view on the 
grid

Go to Display the line of the log file which 
corresponds to a particular data point

Reset Clear all checked attributes and restore the 
normal startup view of an empty grid

Preferences Check:

Connect dots – draw lines between data 
points

Enable fast rendering

Enable reduced data point rendering

Menu Item Description

CommandResponses Processed Number of Get Status calls from the Manager

Current Max Rate

Events Processed

Events/Sec Averaged events per second

Events/Sec (Since Last Check) Events per second in last minute (unless check 
time is configured to a different interval)

Max Rate

contcachesize Contiguous Cache Size

maxrate Maximum Rate

maxsleeptime Maximum Sleep Time

randomizeratetime Randomize Rate Time

timefactor
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For Each SmartConnector Thread

Memory Usage

Events

Intervals
1 second

5 seconds

10 seconds

30 seconds

1 minute

5 minutes

10 minutes

30 minutes

1 hour

6 hours

12 hours

Menu Item Description

Average Batch Size Number of events per batch (typically ~100)

Average Cycle Time Duration of transport and Manager 
acknowledgement

Average Time Per Batch Should be under 1 minute

Menu Item Description

Total Total available memory

Used Memory used

Menu Item Description

SmartConnectors Initializing SmartConnector startup

com.arcsight.agent.transport.Tr
ansportException

com.arcsight.common.agent.Ser
verConnectionException

java.net.SocketException

Forcing disconnection Transport event—Manager disconnecting.
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1 day
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Creating Custom E-mails Using Velocity 
Templates

This appendix describes how to modify Velocity templates to customize e-mail messages 
you receive from the ArcSight notification system. 

This appendix is divided into the following sections:

A sample use case is presented to illustrate the concept. 

Overview
ArcSight supports the use of Velocity templates that are a means of specifying dynamic 
input to the underlying Java code. 

You can apply Velocity templates in a number of places in ArcSight. For a complete list of 
Velocity template applications in ArcSight, see the Console online Help. 

This section describes one such application—E-mail Notification Messages—in detail. You 
can use Velocity templates on your Manager to create custom e-mail messages to suit your 
needs. 

Notification Velocity templates
The <ARCSIGHT_HOME>\Manager\config\notifications directory contains the 
following two Velocity templates for customizing e-mail notifications:

Email.vm—The primary template file that calls secondary template files.

Informative.vm—The default secondary template file.

Commonly used elements in Email.vm and 
Informative.vm files

It is important to understand the commonly used Velocity programming elements in the 
Email.vm and Informative.vm files before editing these files.

The #if statement
The general format of the #if statement for string comparison is:

“Overview” on page 279

“Notification Velocity templates” on page 279
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#if ($introspector.getDisplayValue($event, ArcSight_Meta_Tag) 
Comparative_Operator Compared_Value)

The #if statement for integer comparison is:

#if ($introspector.getValue($event, 
ArcSight_Meta_Tag).intValue()Comparative_Operator Compared_Value)

You can specify ArcSight_Meta_Tag, Comparative_Operator, and 
Compared_Value to suit your needs. 

ArcSight_Meta_Tag is a string when using the #if statement for string comparison (for 
example, displayProduct) and is an integer for the #if statement for integer comparison 
(for example, severity). 

For a complete listing of ArcSight meta tags, see the Token Mappings topic in ArcSight 
FlexConnector Guide.

Comparative_Operator is == for string comparison; =, >, and < for integer 
comparison.

Compared_Value is a string or an integer. For string comparison, enclose the value in 
double quotes (“ ”).

Contents of Email.vm and Informative.vm
The default Email.vm template file contents are:

## This is a velocity macro file...

## The following fields are defined in the velocity macro.

## event == the event which needs to be sent.

## EVENT_URL == root of the event alert.

## NOTIFICATION_URL == URL of the notifications page in ArcSight 
Web

#parse ("Informative.vm")

This message can be acknowledged in any of the following ways:

1) Reply to this email. Make sure that the notification ID listed 
in this message is present in your reply)

2) Login to the ArcSight Console and click on the notification 
button on the status bar

3) Login to ArcSight Web at ${NOTIFICATION_URL}

To view the full alert please go to at ${EVENT_URL}

The default Informative.vm template file contents are:

=== Event Details ===

#foreach( $field in $introspector.fields )

#if( $introspector.getDisplayValue($event, $field).length() > 0 )
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${field.fieldDisplayName}: $introspector.getDisplayValue($event, 
$field)

#end

#end

How the Email.vm and Informative.vm Template Files 
Work

Email.vm calls the secondary template file Informative.vm (#parse 
(“Informative.vm”)). The Informative.vm file lists all the non-empty fields of an 
event in the format fieldName : fieldValue.

Understanding the Customization Process
If you want to customize the template files to suit your needs, ArcSight recommends that 
you create new secondary templates containing fields that provide information you want to 
see in an e-mail for a specific condition.

For example, if you want to see complete details for an event—Threat Details, Source 
Details, Target Details, and any other information—generated by all Snort devices in your 
network, create a secondary template file called Snort.vm in 
<ARCSIGHT_HOME>\config\notification, on your Manager, with the following lines:

=== Complete Event Details ===

Threat Details

Event: $introspector.getDisplayValue($event,"name")

Description:           
$introspector.getDisplayValue($event,"message")

Severity:              
$introspector.getDisplayValue($event,"severity")

------------------------------------------------------------------
--

Source Details

Source Address:     
$introspector.getDisplayValue($event,"attackerAddress")

Source Host Name:   
$introspector.getDisplayValue($event,"attackerHostName")

Source Port:           
$introspector.getDisplayValue($event,"sourcePort")

Source User Name:     
$introspector.getDisplayValue($event,"sourceUserName")

------------------------------------------------------------------
--

Target Details
ArcSight Confidential ArcSight ESM Administrator’s Guide 281



E Creating Custom E-mails Using Velocity Templates
Target Address: 
$introspector.getDisplayValue($event,"targetAddress")

Target Host Name: 
$introspector.getDisplayValue($event,"targetHostName")

Target Port: $introspector.getDisplayValue($event,"targetPort")

Target User Name:    
$introspector.getDisplayValue($event,"targetUserName")

------------------------------------------------------------------
--

Extra Information (where applicable)

Transport Protocol:    
$introspector.getDisplayValue($event,"transportProtocol")

Base Event Count:     
$introspector.getDisplayValue($event,"baseEventCount")

Template:           
/home/arcsight/arcsight/Manager/config/notifications/Infosec.vm

------------------------------------------------------------------
--

Once you have created the secondary templates, you can edit the Email.vm template to 
insert conditions that will call those templates. 

As shown in the example below, insert a condition to call Snort.vm if the 
deviceProduct in the generated event matches “Snort”. 

#if( $introspector.getDisplayValue($event, "deviceProduct") == 
"Snort" )

#parse("Snort.vm")

#else

#parse("Informative.vm")

#end

Customizing the template files
Follow these steps to customize the Email.vm and create any other secondary template 
files to receive customized e-mail notifications:

1 In <ARCSIGHT_HOME>\config\notifications, create a new secondary template 
file, as shown in the Snort.vm example in the previous section. 

2 Save the file.

3 Edit Email.vm to insert the conditions, as shown in the example in the previous 
section. 

4 Save Email.vm.
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Sample Output
If you use the Snort.vm template and modify Email.vm as explained in the previous 
section, here is the output these templates will generate:

Notification ID: fInjoQwBABCGMJkA-a8Z-Q== Escalation Level: 1

=== Complete Event Details ===

Threat Details 

Event:                 Internal to External Port Scanning

Description:           Internal to External Port Scanning Activity 
Detected; Investigate Business Need for Activity

Severity:              2

------------------------------------------------------------------
--

Source Details

Source Address:        10.129.26.37 

Source Host Name:      

Source Port:           0

Source User Name:      jdoe

------------------------------------------------------------------
--

Target Details

Target Address:        161.58.201.13

Target Host Name:      

Target Port:           20090

Target User Name:      

------------------------------------------------------------------
--

Extra Information (where applicable)

Transport Protocol:    TCP

Base Event Count:      1

Template:              
/home/arcsight/arcsight/Manager/config/notifications/Snort.vm

------------------------------------------------------------------
--

How to Respond

This message can be acknowledged in any of the following ways:
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1) Reply to this email. Make sure that the notification ID listed 
in this message is present in your reply)

2) Login to the ArcSight Console and click on the notification 
button on the status bar

3) Login to myArcSight and go to the My Notifications 
Acknowledgment page at 
https://mymanager.mycompany.com:9443/arcsight/app?service=page/Not
ifyHome

To view the full alert please go to at 
https://mymanager.mycompany.com:9443/arcsight/app?service=external/EventInspector&
sp=SfInjoQwBABCGMJkA-a8Z-Q%3D%3D&sp=F&sp=F
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Appendix F

The Archive Command Tool

This appendix is divided into the following sections:

You can use the archive command line tool to import and export resource information 
stored in the ArcSight Database. You can use this tool in managing configuration 
information, for example, importing asset information collected from throughout your 
enterprise. You can also use this tool to archive resource information stored in the ArcSight 
Database so that, for example, prior to installing new versions of ESM, you can simply 
restore all the resource information after completing the installation. 

When archiving information from the ArcSight Database, the archive command 
automatically creates the archive files you specify, saving resource objects in XML format. 
This documentation does not provide details on the structure of archive files and the XML 
schema used to store resource objects for re-import into ESM. If you have any special 
requirements for importing and exporting archive files, please contact your ArcSight 
representative.

Overview of the Archive Command Tool
The ArcSight archive command tool can be run in two basic modes, remote or 
standalone. In remote mode, you can perform resource import or export operations from 
either an ArcSight Manager or ArcSight Console installation and can perform archive 
operations while ArcSight Manager is running. In standalone mode, from the computer 
where ArcSight Manager is installed, you can connect directly to the ArcSight database to 

“Overview of the Archive Command Tool” on page 285

“Exporting Resources to an Archive” on page 286

“Importing Resources from an Archive” on page 287

“Syntax for Performing Common Archive Tasks” on page 290

 

Starting with ArcSight ESM v4.0, you can use the packages feature to archive 
resources from and import resource to your ArcSight Database. For more 
information about packages and how to use them, see the Managing 
Packages topic in ArcSight Console Online Help. For information about the 
packages command, see Appendix A of this guide.
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import or export resource information, however, ArcSight Manager must be shut down 
before you perform archive operations.

The basic syntax for the archive command is the following:

Remote archive Command Syntax:

arcsight archive -u Username -m Manager [-p Password] -f Filename

 [-i | -sort] [-q]  ...

Standalone archive Command Syntax:

arcsight archive -standalone -f Filename [-i | -sort] [-q] ...

See the description for the archive command in Appendix A‚ ‚ on page 201 for more 
information on this tool.

Exporting Resources to an Archive
1 Open a shell window or a Windows command box, on a computer where either 

ArcSight Console or ArcSight Manager is installed. 

This command adds a certificate to the Manager’s key store for secure SSL communication 
with the ArcSight Manager. 

2 From the <ARCSIGHT_HOME>\bin directory, enter the arcsight archive 
command along with any parameters you want to specify. For example (on Windows):

 

Do not run the archive tool in standalone mode against a database currently in 
use by an ArcSight Manager as it is possible to corrupt the database.

 

The cacerts file on the Manager host must trust the Manager's certificate. You 
may have to update cacerts if you are using demo certificates by running:

arcsight tempca –ac

You do not need to run the above command if you run the archive command 
from the Console.

 

Both remote and standalone archive commands support the same optional 
arguments.

If you are on the computer where ArcSight Manager is installed, and are 
running the archive command in remote mode for the first time, go to the 
<ARCSIGHT_HOME>\bin directory and type the following:

arcsight tempca –ac

 

From the <ARCSIGHT_HOME>\bin directory, you can enter the command, 
arcsight archive -h to get help. In that case, the command displays a list 
of parameters you can specify with the archive command.
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arcsight archive -u admin -p password -m hostname 
-f c:\archive\archive.xml

This command first logs into ArcSight Manager. It then displays a list of Resources available 
for archiving. 

3 Enter the number of the resource type to archive.

The archive command now displays a list of options that let you choose which 
resource or group of resources within the resource type that you want to archive. 

4 Choose the resource or group to archive.

After making your selection, you are prompted whether you want to add more 
resources to the archive.

5 You can continue adding additional resources to the archive list. When you’ve finished, 
answer no to the prompt

Would you like to add more values to the archive? (Y/N)

After it is finished writing the archive file, the archive command returns the command 
prompt, from which you can enter additional commands or exit.

Importing Resources from an Archive
1 Open a shell window or a Windows command box, on a computer where either 

ArcSight Console or ArcSight Manager is installed.

This command adds a certificate to the Manager’s key store for secure SSL 
communication with the ArcSight Manager. 

2 From the <ARCSIGHT_HOME>\bin directory, type arcsight archive with its 
parameters and attach -i for import.

3 Select one of the listed options if there is a conflict.

Importing is complete when the screen displays Import Complete.

 

If the ArcSight Manager is running, you must specify archive commands in 
remote mode, entering your user name, password, and Manager name to 
connect to ArcSight Manager. To run the archive command in standalone 
mode, accessing resources directly from the ArcSight Database, enter  
-standalone rather than -u <username> -p <password> -m <manager>.

 

If you are on the computer where ArcSight Manager is installed, and are 
running the archive command in remote mode for the first time, go to the 
<ARCSIGHT_HOME>\bin directory and type the following:

arcsight tempca -ac

 

If the ArcSight Manager is running, you must specify archive commands 
in remote mode, entering your user name, password, and Manager name 
to connect to ArcSight Manager. To run the archive command in 
standalone mode, accessing resources directly from the ArcSight 
Database, enter -standalone rather than -u <username> -p 
<password> -m <manager>.
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About Importing v3.x Content to a v4.x ESM System
If you import content to an ArcSight ESM v4.x system that was exported from a v3.x 
system, make sure you are aware of the following:

Do not import system content from an ArcSight ESM v3.x or earlier system to an ArcSight 
ESM v4.x system. If you do so, it can cause unpredictable consequences on the ArcSight 
Manager and associated Console clients. The Packages feature in v4.x does not prevent 
you from importing v3.x system content; therefore, you must be careful when importing 
content into your v4.x system. 

The above restriction does not apply to the custom content you may have created and 
archived from an ArcSight ESM v3.x system. You can import any custom content to a v4.x 
system if it does not reference any v3.x system content. 

To identify whether your archived files contain ArcSight ESM v3.x system content, do one 
of the following:

Read through the archive XML file to locate the system content URIs.

Use the arcsight archive command with the list option to see the system content 
URIs:

arcsight archive –action list –f <archive file name>

To remove/exclude system content from the archived file, run this command from 
<ARCSIGHT_HOME>\bin directory:

arcsight archivefilter -source <source_file_name> -xuri 
<system_content_URIs_to_exclude> -f <target_file_name>

Here is a complete list of system content URIs that must be excluded before importing 
custom content from an ArcSight ESM v3.x or earlier system to an ArcSight ESM v4.x 
system:

/All Active Channels

/ArcSight Solutions

/Site Active Channels

/System Active Channels

/All Field Sets

/ArcSight Solutions

/Site Field Sets

/System Field Sets

 

The predefined content with which ArcSight ships is referred to as system 
content. In ArcSight v3.x, system content was available in System 
Resource_Name sub-tree of each resource tree. Additional system content for 
a few resources was available in the ArcSight System Administration sub-
tree. For example, system content for the Rules resource was available in 
/All Rules/System Rules and system content for the Assets resource was 
available in /All Assets/ArcSight System Administration and /All 
Assets/System Assets. Refer to the complete list of system content URIs 
listed below at the end of this section.
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/All Active Lists

/ArcSight Solutions

/Site Active Lists

/System Active Lists

/All Agents

/ArcSight Administration

/All Assets

/ArcSight Solutions

/ArcSight System Administration

/Site Assets/Disallowed Servers

/All Zones

/System Zones

/All Networks

/System Networks/Global

/Site Networks/Local

/All Locations

/System Locations/ArcSight

/All Cases

/ArcSight Solutions

/System Cases

/All Dashboards

/ArcSight Solutions

/ArcSight System Administration

/Site Dashboards

/System Dashboards

/All Data Monitors

/ArcSight Solutions

/ArcSight System Administration

/Site Data Monitors

/System Data Monitors

/All Filters

/ArcSight Solutions
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/ArcSight System Administration

/Site Filters/Device Type Filters

/System Filters

/All Partitions/

/All Profiles

/ArcSight Solutions

/Site Profiles

/System Profiles

/All Reports

/ArcSight Solutions

/System Reports

/All Rules

/ArcSight Solutions

/Real-time Rules

/System Rules

/All Stages/

/All Users

/Administrators

/Default User Groups

Syntax for Performing Common Archive Tasks

For manual importing, run this command in <ARCSIGHT_HOME>\bin:

arcsight archive -i -format preferarchive -f <file name>

-u <user> -m <manager hostname>

Before performing the import operation, you are prompted for a password to log in to the 
ArcSight Manager. 

For exporting:

arcsight archive -f <file name>

-u <user> -m <manager hostname>

Before performing the import operation, you are prompted for a password to log in to the 
ArcSight Manager and use a series of text menus to pick which Resources will be archived.

 

Make sure you have read the topic “About Importing v3.x Content to a v4.x 
ESM System” on page 288 before you perform any of the tasks listed in this 
section.
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For scheduled/batch importing:

arcsight archive -i -q -format preferarchive

-f <file name> -u <user> 

-p <password> -m <manager hostname>

For scheduled/batch exporting:

arcsight archive -u admin -p password -m arcsightserver 

-f somefile.xml -uri “/All Filters/Geographic Zones/West 
Coast”

-uri “/All Filters/Geographic Zones/East Coast”

 

You can specify multiple URI resources with the URI parameter keyword by 
separating each resource with a space character, or you can repeat the URI 
keyword with each resource entry.
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Appendix G

TLS Configuration to Support FIPS 
Mode

This appendix covers the following sections:

FIPS 140-2 is a standard published by the National Institute of Standards and Technology 
(NIST) and is used to accredit cryptographic modules in software components. A 
cryptographic module is either a piece of hardware or a software or a combination of the 
two which is used to implement cryptographic logic. The US Federal government requires 
that all IT products dealing with Sensitive, but Unclassified (SBU) information should meet 
the FIPS 140-2 standard. 

Configuring a component to run in FIPS 140-2 mode, requires that you set up TLS 
configuration on the component. Since TLS is based on SSL 3.0, we recommend that you 

“NSS Tools Used to Configure Components in FIPS Mode” on page 294

“Types of Certificates Used in FIPS Mode” on page 294

“Using a Self-Signed Certificate” on page 294

“Using a Certificate Authority (CA) Signed Certificate” on page 295

“Some Often Used SSL-related Procedures” on page 310

“Setting up Server-Side Authentication” on page 316

“Setting up Client-Side Authentication” on page 316

“Changing the Password for NSS DB” on page 317

“Listing the Contents of the NSS DB” on page 318

“Veiwing the Contents of a Certificate” on page 319

“Setting the Expiration Date of a Certificate” on page 319

“Deleting an Existing Certificate from NSS DB” on page 319

“Replacing an Expired Certificate” on page 319

The commands and examples shown in this appendix are for a Windows 
system. Path separators are / for Unix and \ for Windows.

Not all ESM versions or ArcSight Express models support the FIPS mode.

PKCS #11 token support may not be available for all ESM versions and 
ArcSight Express models.
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have a good understanding of how SSL works. Please read the section “Understanding SSL 
Authentication” on page 20 for details on how SSL works. 

You have to perform some manual steps to set up the TLS configuration. This appendix 
serves as a reference for the manual procedures you will need to perform on ArcSight 
Manager, ArcSight Console, and ArcSight Web. 

NSS Tools Used to Configure Components in FIPS 
Mode

NSS is a cross-platform cryptographic C library and a collection of security tools. ArcSight 
ESM comes bundled with the following three basic NSS command line tools:

runcertutil - is a certificate and key management tool used to generate key pairs 
and import and export certificates.

runmodutil - is the NSS module configuration tool. It is used to enable or disable the 
FIPS module and change Keystore passwords.

runpk12util - is an import and export tool for PKCS #12 format key pairs (.pfx 
files). 

See Appendix A‚ ArcSight Commands‚ on page 201 for details on the above command line 
tools. You can also refer to the ‘NSS Security Tools’ page on the Mozilla website for more 
details on any of the above NSS tools (make sure to search for them as certutil, modutil, or 
pk12util).

For online help on any command, enter the following command from a 
component’s \bin directory:

arcsight <command_name> -H

Types of Certificates Used in FIPS Mode
You can use either a self-signed certificate or a CA-signed certificate when setting up SSL 
authentication on your ESM components.

Using a Self-Signed Certificate
The “Installing ArcSight ESM in FIPS Mode” appendix in the ArcSight ESM Installation and 
Configuration Guide walks you through the steps to generate and use a self-signed 
certificate when doing a fresh installation of ESM in FIPS mode.

To configure ArcSight SmartConnectors and ArcSight Logger, refer to their 
respective documentation.

Notes:

• The runcertutil tool currently has a limitation due to which it cannot 
import the certificate when the NSS DB is set to FIPS mode. In order 
to work around this issue, you have to disable FIPS mode in the NSS 
DB first, then import the certificate, and lastly re-enable FIPS mode.

• When generating a key pair on the Manager or ArcSight Web, it is 
mandatory to use “mykey” (without quotes) as the alias name for the 
key pair.
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Using a Certificate Authority (CA) Signed Certificate
In ESM, the Manager and ArcSight Web are both servers. You can use CA-signed 
certificates for both of them. To use a CA-signed certificate, you have to first obtain the 
signed certificate from the CA. The CA embeds the public key of the server and the CA’s 
signature in the certificate. So, the Manager’s CA-signed certificate will contain the public 
key of the Manager along with the CA’s signature, and the Web’s CA-signed certificate will 
contain the public key of the Web along with the CA’s signature.

To obtain the CA-signed certificate, you have to generate a Certificate Signing Request 
(CSR) on the server (Manager or the Web as the case may be). Next, you send the CSR to 
the CA. Using the CSR, the CA then creates a certificate for the server and sends it back to 
you. Once you receive the certificate from the CA, you have to import the certificate into 
the server’s NSS DB. 

You are also required to import the server’s certificate into any client that wishes to 
connect to the server. Doing this allows the client to trust the server.

Here are the detailed steps that you will need to perform on each component if you choose 
to use CA-signed certificates:

Steps Performed on the Manager
1 Install the Manager by running its executable file.

2 When you get to the first configuration screen shown below, leave the wizard running 
and open a command prompt window.

3 Generate a key pair on the Manager by running the following from the Manager’s 
\bin directory:

Notes:

• Make sure to use mykey as the alias.

• Make sure that the serial number in the -m option is unique within the 
nssdb.
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arcsight runcertutil -S -s "CN=<manager’s_hostname>" -n mykey  
-k rsa -x -t "C,C,C" -m 1234 -d 

C:\arcsight\Manager\config\jetty\nssdb

When prompted for password, enter “changeit” (without the quotes).

Enter random keyboard strokes when prompted to generate a random seed which will 
be used to generate your key.

4 Disable FIPS mode by running the following from the Manager’s \bin directory:

arcsight runmodutil -fips false -dbdir 
<ARCSIGHT_HOME>\config\jetty\nssdb

5 Generate a CSR by running the following from the Manager’s \bin directory:

For the -t option, be sure to use C,C,C protocols only and in the same 
order that it is shown above.
296 ArcSight ESM Administrator’s Guide ArcSight Confidential



G TLS Configuration to Support FIPS Mode
arcsight runcertutil -R -s "CN=<hostname_or_IP>, 
O=<Name_of_organization>, 
L=<City_where_the_organization_is_located>, 
ST=<State_where_organization_is_located>, C=<Country>" -a -o 
<absolute_path_to_filename.csr>  
-d <ARCSIGHT_HOME>\config\jetty\nssdb

Enter the password for the NSS DB when prompted. The default password is 
“changeit” (without the quotes).

Enter random keyboard strokes when prompted to generate a random seed which will 
be used to generate your key.

For the example shown in the screenshot above, the CSR file, 
ManagerCertRequest.csr, gets created in the C:\arcsight\Manager directory. 

6 Enable FIPS mode on the Manager by running the following:

If you do not specify the absolute path to where you want the .csr file to be 
placed (as shown in the example screen shot below), the .csr file gets placed 
in the Manager’s <ARCSIGHT_HOME>.
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arcsight runmodutil -fips true -dbdir 
C:\arcsight\Manager\config\jetty\nssdb

7 Go back to the installation wizard screen and choose No, do not upgrade. This is a 
new manager setup to create a new, clean installation and click Next. 

8 Next, you will see the following screen:
298 ArcSight ESM Administrator’s Guide ArcSight Confidential



G TLS Configuration to Support FIPS Mode
Select the Run manager in FIPS 140-2 mode radio button and click Next.

9 The configuration wizard will ask you to confirm that you have set up the NSS DB. 
Click Yes. 

10 You will be reminded that once you select the FIPS 140-2 mode, you will not be able to 
revert to the default mode. Click Yes.

11 Follow the prompts in the next few wizard screens to complete the Manager 
installation. Refer to “Installing ArcSight Manager” chapter in the ArcSight ESM 
Installation and Configuration Guide for details on any screen.

12 Send the .csr file to your Certificate Authority. 

The Certificate Authority will send you the signed Manager’s certificate which contains 
the CA’s signature and the Manager’s public key.

13 After you receive the signed certificate from the CA, import it into the Manager’s 
NSSDB by running these commands from the Manager’s \bin directory:

a Disable FIPS mode by running:

arcsight runmodutil -fips false -dbdir 
<ARCSIGHT_HOME>\config\jetty\nssdb

b Import the Manager’s CA-signed certificate that you received from your CA by 
running:
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arcsight runcertutil -A -n <provide_an_alias_for_the_cert>  
-t "CT,C,C" -d <ARCSIGHT_HOME>\config\jetty\nssdb -i 

<absolute_path_to_the_signed_certificate>

c Enable FIPS mode by running:

arcsight runmodutil -fips true -dbdir 
<ARCSIGHT_HOME>\config\jetty\nssdb

14 Start the Manager. You should see a message saying that the Manager is starting in 
FIPS mode, as shown in the screenshot below.

Steps Performed on the Web

ArcSight Web plays a dual role. On one hand, it acts as a client to the Manager to which it 
connects. On the other, it acts as a server to web browsers that connect to it. Therefore, 
the Web authenticates the Manager but has to authenticate itself to web browsers.

To authenticate the Manager, the Web’s NSS DB should contain the Manager’s certificate. 
At the same time, since the Web acts as a server to the web browsers that connect to it, 

For the -t option, be sure to use CT,C,C protocols only and in the same 
order that it is shown above.

Make sure that you have copied the Manager’s certificate to the machine on 
which you will be installing ArcSight Web.
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you should have a key pair and a certificate containing the Web’s public key in the Web’s 
NSS DB. This allows the Web to authenticate iteself to the web browsers. 

So, you will be required to import the Manager’s certificate into the Web’s webnssdb. To 
obtain a CA-signed certificate for the Web, you have to generate a key pair on the Web, 
generate a CSR on the Web, and send the CSR to the CA.  Lastly, after you receive the 
signed certificate from the CA, import it into the webnssdb.

To accomplish all of the above:

1 Install ArcSight Web by running its executable file.

2 When you get to the first configuration screen shown below, leave the wizard running 
and open a command prompt window.

3 Import the Manager’s certificate:

a Disable FIPS mode in the Web’s webnssdb. This is required in order to import 
certificates into the webnssdb.

arcsight runmodutil -fips false -dbdir 
<ARCSIGHT_HOME>\config\jetty\nssdb

b Import the Manager’s certificate into the webnssdb by running the following from 
the Web’s \bin directory.
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arcsight runcertutil -A -n <provide_an_alias_for_the_cert>  
-t "CT,C,C" -d <ARCSIGHT_HOME>\config\jetty\webnssdb -i 

<absolute_path_to_the_Manager’s_certificate>

This is required in order for the Web to be able to authenticate the Manager.

c Enable FIPS mode by running:

arcsight runmodutil -fips true -dbdir 
<ARCSIGHT_HOME>\config\jetty\nssdb

4 Generate a key pair on the Web by running:

arcsight runcertutil -S -s “CN=<hostname>” -n mykey -k rsa -x -

t “C,C,C” -m 2345 -d <ARCSIGHT_HOME>\config\jetty\webnssdb

For the -t option, be sure to use CT,C,C protocols only and in the 
same order that it is shown above.

For the -t option, be sure to use C,C,C protocols only and in the same 
order that it is shown above.
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2345 represents the serial number which has to be unique within the webnssdb and 
hostname is the name of the machine on which ArcSight Web is installed. 

Enter the password for webnssdb when prompted. The default password is ‘changeit’ 
without the quotes.

Enter random keyboard strokes when prompted to generate a random seed which will 
be used to generate your key.

5 Generate a CSR in the webnssdb which you have to send to the CA to obtain a CA-
signed certificate for the Web:

arcsight runcertutil -R -s "CN=<hostname_or_IP>, 
O=<company_name>, L=<Location_of_the_company>, 
ST=<State_where_company_is_located>, C=<country>" -a -o 
<absolute_path_to_the_filename.csr> -d 
<ARCSIGHT_HOME>\config\jetty\webnssdb

Notes:

• Make sure to use the alias mykey.

• Make sure that the serial number in the -m option is different from the 
serial number used when you generated the Manager’s key pair. Since 
the Manager’s certificate gets imported into the webnssdb, you need to 
make sure that the serial number for the Web’s key pair is different 
from the serial number used in the Manager’s key pair.

Notes:

• Make sure the CN is either the IP address of the machine on which 
ArcSight Web resides or its fully qualified domain name that will be 
used in the URL when you access ArcSight Web using a browser.

• If you do not specify the absolute path to where you want the .csr file 
to be placed, the .csr file gets placed in the Web’s 
<ARCSIGHT_HOME>.
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This will generate a CSR file which will be placed in the location that you had specified 
in the -o option in the command.

6 Go back to the wizard screen. Select No, I do not want to transfer the settings 
and click Next.

7 Select Run web in FIPS 140-2 mode in the following screen and click Next:
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8 You will see the following prompt asking you whether you configured your webnssdb. 
Click Yes.

9 You will see this warning message:

Click Yes.

10 When you get to the following screen, make sure that the Webserver Host name 
exactly matches the host name that you had entered for the webserver when installing 
the Manager. For example, if you had entered an IP address for the webserver in the 
Manager setup, make sure to enter the IP address in this screen too.

11 Follow the prompts in the next few wizard screens and complete the wizard.

12 Send the .csr file to your Certificate Authority. 

The Certificate Authority will send you the signed Web’s certificate which contains the 
CA’s signature and the Web’s public key.

13 After you receive the Web’s signed certificate from the CA, import it into the Web’s 
webnssdb. 
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a Disable FIPS mode on the webserver by running the following command from the 
Web’s \bin directory:

arcsight runmodutil -fips false -dbdir 
<ARCSIGHT_HOME>\config\jetty\webnssdb

b Import the Web’s CA-signed certificate by running:

arcsight runcertutil -A -n <provide_an_alias_for_the_cert>  
-t "CT,C,C" -d <ARCSIGHT_HOME>\config\jetty\webnssdb -i 
<absolute_path_to_the_web_certificate>

The web browsers that connect to the webserver use the Web’s certificate to 
authenticate the webserver.

c Enable FIPS mode by running the following from the Web’s \bin directory:

arcsight runmodutil -fips true -dbdir 
<ARCSIGHT_HOME>\config\jetty\webnssdb

14 Start ArcSight Web by running the following from its \bin directory:

arcsight webserver

You should see a message saying that the webserver is starting in FIPS mode, as show 
in the screenshot below.

Steps Performed on the Console
You are required to import the Manager’s certificate into the Console’s nssdb.client. 
This allows the Console to trust the Manager.

1 Install the Console by running its executable file.

For the -t option, be sure to use CT,C,C protocols only and in the 
same order that it is shown above.

Make sure that you have copied the Manager’s certificate to the machine on 
which you will be installing ArcSight Console.
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2 When you get to the first configuration screen shown below, leave the Console running 
and open a command prompt window.

3 Import the Manager’s certificate:

a Set the Console’s nssdb.client temporarily to non-FIPS 140-2 mode by 
running the following command from the Console’s 
<ARCSIGHT_HOME>\current\bin directory:

arcsight runmodutil -fips false -dbdir 
<ARCSIGHT_HOME>\current\config\nssdb.client

b Run the following command to import the Manager’s certificate:

arcsight runcertutil -A -n <provide_an_alias_for_the_cert>  
-t “CT,C,C” -d <ARCSIGHT_HOME>\current\config\nssdb.client -
i <path_to_the_Manager’s_certificate>

For the -t option, be sure to use CT,C,C protocols only and in the 
same order that it is shown above.
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c Run the following command to enable FIPS mode in nssdb.client:

arcsight runmodutil -fips true -dbdir 
<ARCSIGHT_HOME>\config\nssdb.client

4 Go back to the wizard and select No, I do not want to transfer the settings in the 
following screen and click Next:
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5 Next, you will see the following screen:

Select Run console in FIPS 140-2 mode and click Next.

6 The configuration wizard will remind you to set up the NSS DB. Click Yes.  

7 You will be reminded that once you select the FIPS 140-2 mode, you will not be able to 
revert to the default mode. Click Yes.

8 Follow the prompts in the next few wizard screens to complete the Console 
installation. Refer to” Installing ArcSight Console” chapter in the ArcSight ESM 
Installation and Configuration Guide for details on any screen.
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When you start the Console. You should see a message saying that the Console is starting 
in FIPS mode, as shown in the screenshot below.

Some Often Used SSL-related Procedures 
Here are some of the commonly used SSL-related procedures that are intended to serve as 
a reference when installing or setting up ESM components in FIPS mode.

Generating a Key Pair in a Component’s NSS DB

This section explains how to generate a key pair in a component’s NSS DB. A component 
that has to authenticate itself is required to have a key pair on it. For example, during 
server-side authentication, since the server needs to authenticate itself to a client, the 
server should have a key pair in its NSS DB and send its certificate which contains the 
server’s public key to the client requesting it. The same is true for client-side authentication 
where a key pair has to exist on the client. For self-signed certificate, the certificate gets 
generated when generating a key pair.

On the Manager
1 Run the following command from the Manager’s <ARCSIGHT_HOME>\bin directory to 

generate a key pair:

arcsight runcertutil -S -s “CN=<hostname>” -v 
<number_of_months_the_certificate_should_be_valid> -n mykey -k 

rsa -x -t “C,C,C” -m 1234 -d <ARCSIGHT_HOME>\config\jetty\nssdb

where the hostname is the name of the machine on which your Manager is installed 
and -v is the validity period of the certificate.

For example, if your hostname is myhost.arcsight.com, you would run:

When you import or generate a key pair in a component’s NSS DB, if there is 
a existing key pair/certificate that has the same CN as the one you create, 
the runcertutil utility will use the existing alias for the newly created key 
pair and ignore the alias you supplied in the runcertutil command line.

For the -t option, be sure to use C,C,C protocols only and in the same 
order that it is shown above.

• Make sure to use mykey as the alias.

• The -m serial number should be unique within nssdb.

• Using -v is optional. If you choose to use it, see “Setting the 
Expiration Date of a Certificate” on page 319 for details.
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arcsight runcertutil -S -s “CN=myhost.arcsight.com” -v 6 -n 
mykey -k rsa -x -t “C,C,C” -m 1234 -d 
<ARCSIGHT_HOME>\config\jetty\nssdb

This will generate a key pair and certificate with the alias mykey which is valid for 6 
months from the current date and time in the Manager’s nssdb.

2 Enter the password for NDSS DB when prompted. The default password is “changeit” 
(without the quotes).

3 Enter random keyboard strokes when prompted to generate a random seed which will 
be used to generate your key.

On the Console
To create a key pair on the Console:

1 Run the following command from the Console’s \bin directory:

arcsight runcertutil -S -s “CN=<External_ID_of_the_user>” -v 
<number_of_months_the_certificate_should_be_valid> -n mykey -k 
rsa -x -t “C,C,C” -m 4975 -d 
<ARCSIGHT_HOME>\current\config\nssdb.client

2 Enter the password for nssdb.client. The default password is ‘changeit’ without 
quotes.

3 Enter random keyboard strokes when prompted to generate a random seed which will 
be used to generate your key.

On ArcSight Web
To create a key pair on the Web server:

1 Run the following command from ArcSight Web’s bin directory:

arcsight runcertutil -S -s “CN=<hostname>” -v 
<number_of_months_the_certificate_should_be_valid> -n mykey -k 
rsa -x -t “C,C,C” -m 2345 -d 
<ARCSIGHT_HOME>\config\jetty\webnssdb

For the -t option, be sure to use C,C,C protocols only and in the same 
order that it is shown above.

• Make sure to use mykey as the alias.

• CN is the External ID of the user you created when running the 
Manager’s setup. 

• The -m serial number should be unique within nssdb.client.

• Using -v is optional. If you choose to use it, see “Setting the 
Expiration Date of a Certificate” on page 319 for details.

For the -t option, be sure to use C,C,C protocols only and in the same 
order that it is shown above.
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2345 represents the serial number which has to be unique within the webnssdb and 
hostname is the name of the machine on which ArcSight Web is installed. 

2 Enter the password for webnssdb. The default password is ‘changeit’ without the 
quotes.

3 Enter random keyboard strokes when prompted to generate a random seed which will 
be used to generate your key.

Verifying Whether the Key pPir Has Been Successfully Created
To verify whether the key pair has been successfully created in the nssdb, run the 
following from the component’s <ARCSIGHT_HOME>\bin directory:

arcsight runcertutil -L -d <path_to_the_component’s_NSS DB> 

Viewing the Contents of the Certificate
If you would like to check the contents of the certificate, you run this from the 
component’s \bin directory:

arcsight runcertutil -L -d <path_to_the_component’s_NSS DB> -n 
<key_alias>

Exporting a Certificate
This section explains how to export a certificate from a component’s NSS DB. During an 
SSL handshake, for server side authentication, you need to have the server’s certificate in 
the NSS DB of both the server and the client. So, you will need to export the server’s 
certificate from the server’s NSS DB in order to import it into the client that wishes to 
connect to the server.

Likewise, for client side authentication, you need to have the client’s certificate in the NSS 
DB of both the client and the server. So, you will need to export the client’s certificate from 
the client’s NSS DB in order to import it into the server that the client will be connecting to.

From the Manager
Run the following command from the Manager’s <ARCSIGHT_HOME>\bin directory: 

arcsight runcertutil -L -n <alias_for_exported_certificate> -r -d 
<ARCSIGHT_HOME>\config\jetty\nssdb -o 
<absolute_path_to_where_you_want_certificate_exported>

Notes:

• Make sure to use the alias mykey.

• Make sure that this serial number is different from the serial number 
used when you generated the Manager’s key pair. Since the 
Manager’s certificate gets imported into the webnssdb, you need to 
make sure that the serial number for the Web’s key pair is different 
from the serial number used when generating the Manager’s key pair.

• Using -v is optional. If you choose to use it, see “Setting the 
Expiration Date of a Certificate” on page 319 for details.

When you import or generate a key pair into nssdb, if there is a existing 
key pair/certificate that has the same CN as the one you create, the 
runcertutil utility will use the existing alias for the newly created key 
pair and ignore the alias you supplied in the runcertutil command line.
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For example:

arcsight runcertutil -L -n managercert -r -d 
<ARCSIGHT_HOME>\config\jetty\nssdb -o C:\ManagerCert.cer

This will export the Manager’s certificate into a file called ManagerCert.cer and place it in 
your C:\ directory. The alias for this file will be managercert. 

From the Console
To export the Console’s certificate run the following from the Console’s \bin directory:

arcsight runcertutil -L -n <alias_for_exported_certificate> -r -d 
<ARCSIGHT_HOME>\current\config\nssdb.client -o 

<absolute_path_to_where_you_want_certificate_exported>

From the Web
To export the Web’s certificate, run the following from the Web’s \bin directory:

arcsight runcertutil -L -n <alias_for_exported_certificate> -r -d 
<ARCSIGHT_HOME>\config\jetty\webnssdb -o 

<full_path_to_where_you_want_certificate_exported>

Importing a Certificate into NSS DB
This section explains how to import a certificate into a component’s NSS DB. For server 
side authentication, the server’s certificate needs to be imported into the client’s NSS DB. 
For client side authentication, the client’s certificate needs to be imported into the server’s 
NSS DB.

The NSS tool, certutil, is used to import a certificate into the NSS DB. The certutil 
tool currently has a limitation that it cannot import the certificate when the component is 
running in FIPS mode. In order to work around this issue, you have to disable FIPS mode 
on the component first, then import the certificate, and lastly re-enable FIPS mode.

On the Manager
If you use a CA-signed certificate, you will be required to import the Manager’s CA-signed 
certificate into the Manager’s nssdb. In addition, if you set up client side authentication, 
you will be required to import the client’s certificate into the Manager’s nssdb. To import a 
certificate into the Manager’s nssdb:

 If you do not specify the absolute path for the .cer file, it gets placed in the 
Manager’s <ARCSIGHT_HOME>.

 If you do not specify the absolute path for the .cer file, it gets placed in the 
Console’s <ARCSIGHT_HOME>.

 If you do not specify the absolute path for the .cer file, it gets placed in the 
Web’s <ARCSIGHT_HOME>.
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1 Disable FIPS mode by runing the following from the Manager’s 
<ARCSIGHT_HOME>\bin directory:

arcsight runmodutil -fips false -dbdir 
<ARCSIGHT_HOME>\config\jetty\nssdb

2 Run the following to import the certificate into the Manager’s nssdb:

arcsight runcertutil -A -n 
<provide_an_alias_for_the_certificate> -t “CT,C,C“ -d 
<ARCSIGHT_HOME>\config\jetty\nssdb -i 

<absolute_path_to_the_certificate_file>

3 Run the following command to re-enable the FIPS 140-2 mode:

arcsight runmodutil -fips true -dbdir 
<ARCSIGHT_HOME>\config\jetty\nssdb

On the Console
You are required to import the Manager’s certificate into the Console that will be 
connecting to the Manager. To import a certificate into the Console’s nssdb.client:

1 Set the nssdb temporarily to non-FIPS 140-2 mode by running the following from the 
Console’s <ARCSIGHT_HOME>\bin directory:

arcsight runmodutil -fips false -dbdir 
<ARCSIGHT_HOME>\current\config\nssdb.client

2 Run the following to import the certificate:

arcsight runcertutil -A -n <provide_an_alias_for_the_cert> -t 
“CT,C,C” -d <ARCSIGHT_HOME>\config\nssdb.client -i 
<absolute_path_to_certificate_file>

3 Run the following command to set the nssdb back to FIPS 140-2 mode:

arcsight runmodutil -fips true -dbdir 
<ARCSIGHT_HOME>\current\config\nssdb.client

On ArcSight Web
To import a certificate on ArcSight Web:

If you are importing the Console’s certificate to set up client-side 
authentication, make sure that you do NOT use the alias mykey for the 
Console’s certificate when importing it into the Manager’s nssdb because 
the nssdb already has the Manager’s certificate with the alias mykey in it. 
All aliases in the nssdb should be unique.

For the -t option, be sure to use CT,C,C protocols only and in the same 
order that it is shown above.

For the -t option, be sure to use CT,C,C protocols only and in the same 
order that it is shown above.
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1 Run the following from ArcSight Web’s <ARCSIGHT_HOME>\bin directory to 
temporarily disable the FIPS 140-2 mode in order to import the certificate:

arcsight runmodutil -fips false -dbdir 
<ARCSIGHT_HOME>\config\jetty\webnssdb

2 Run the following to import the Manager’s certificate into ArcSight Web’s webnssdb:

arcsight runcertutil -A -n <provide_an_alias_for_the_cert> -t 
“CT,C,C” -d <ARCSIGHT_HOME>\config\jetty\webnssdb -i 
<absolute_path_to_the_certificate_file>

3 Run the following to re-enable the FIPS 140-2 mode:

arcsight runmodutil -fips true -dbdir 
<ARCSIGHT_HOME>\config\jetty\webnssdb

Importing an Existing Key Pair into the NSS DB
If you already have an existing key pair, you can use it instead of generating a new key pair 
on a component. This procedure instructs you how to import an existing key pair into a 
component’s NSS DB.

1 Export the key pair using a tool, such as keytoolgui, and be sure to export the key 
pair with the name mykey.pfx. An alias is required in order to import the key pair 
into NSS DB.

2 Import the .pfx file into NSS DB using the pk12util tool. Make sure that the alias of 
the key pair being imported does not match the alias of a pre-existing key pair in the 
component’s NSS DB. If the key pair being imported has an alias that matches a pre-
existing key pair, the key pair will fail to import citing an error:

PKCS12 decode validate bags failed: The user pressed cancel.

Run the following command from the component’s \bin directory:

On the Manager:

arcsight runpk12util -i <absolute_path_to_mykey.pfx> -d 
<ARCSIGHT_HOME>\config\jetty\nssdb

On the Web:

arcsight runpk12util -i <absolute_path_to_mykey.pfx> -d 
<ARCSIGHT_HOME>\config\jetty\webnssdb

On the Console:

arcsight runpk12util -i <absolute_path_to_mykey.pfx> -d 
<ARCSIGHT_HOME>\current\confignssdb.client

3 Run the following from the component’s <ARCSIGHT_HOME>\bin directory to verify 
that the key pair has been imported correctly. Note that the alias of the key pair that 
you just imported in the NSS DB will be the same as the alias of that key pair in the 
.pfx file, in our example, mykey. 

On Manager:

For the -t option, be sure to use CT,C,C protocols only and in the same 
order that it is shown above.
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arcsight runcertutil -L -d <ARCSIGHT_HOME>\config\jetty\nssdb

On Web:

arcsight runcertutil -L -d 
<ARCSIGHT_HOME>\config\jetty\webnssdb

You should see the alias of the imported key pair in the output.

Setting up Server-Side Authentication
When you install a component in FIPS mode, you set it up for server-side authentication. 
Setting up client-side authentication is optional.

The ArcSight ESM Installation and Configuration Guide walks you through the steps for 
installing ESM with server-side authentication.

Setting up Client-Side Authentication
SSL 3.0 supports client-side authentication. TLS is based on SSL 3.0. ArcSight ESM uses 
TLS and supports client-side authentication. 

The client side authentication takes place after the initial handshake (after the Manager 
has authenticated itself to the Console). The Manager then requests the Console for its 
(Console’s) certificate. The Console in turn sends its certificate to the Manager. The 
Manager has to be configured to accept the Console’s certificate. In other words, the 
Console’s certificate must exist in the Manager's nssdb prior to the Manager authenticating 
the Console. With this high level overview in mind, here are the steps you need to perform 
to set up client-side authentication.

If you plan to use self-signed certificate for the Console:

1 Stop the Console if it is running.

2 Generate a key pair in the Console’s nssdb.client. Follow the steps in “Generating 
a Key Pair in a Component’s NSS DB” on page 310 (“On the Console” subsection). This 
will automatically generate a self-signed certificate on the Console’s NSS DB.

Alternatively, you can use an existing key pair which you have to import into the 
Console’s NSS DB. See “Importing an Existing Key Pair into the NSS DB” on page 315 
for details.

3 Export the Console’s certificate. See the section “Exporting a Certificate” on page 312 
(“From the Console” subsection) for detailed instructions.

4 Stop the Manager if it is running.

5 Import the Console’s certificate  into the Manager’s nssdb. See the section “Importing 
a Certificate into NSS DB” on page 313 (“On the Manager” subsection) for details.

6 Restart the Manager, then Console.

If you plan to use CA-signed certificate for the Console:

Make sure that you do NOT use the alias mykey for the certificate when 
importing it into the Manager’s nssdb because the nssdb already has the 
Manager’s certificate with the alias mykey in it. All aliases in the nssdb must be 
unique.
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1 Stop the Console if it is running.

2 Generate a key pair on the Console. See the “Generating a Key Pair in a Component’s 
NSS DB” on page 310 for details.

3 Generate a CSR on the Console by running the following from the Console’s \bin 
directory:

arcsight runcertutil -R -s "CN=<hostname_or_IP>, 
O=<Name_of_organization>, 
L=<City_where_the_organization_is_located>, 
ST=<State_where_organization_is_located>, C=<Country>" -a -o 
<absolute_path_to_filename.csr>  
-d <ARCSIGHT_HOME>\current\config\nssdb.client

4 Send the CSR file to your CA and obtain a signed certificate from your CA.

5 Import the CA-signed certificate into the Console’s nssdb.client. See “Importing a 
Certificate into NSS DB” on page 313 (subsection “On the Console”) for details.

6 Stop the Manager if it is running.

7 Import the Console’s CA-signed certificate into the Manager’s nssdb. See “Importing a 
Certificate into NSS DB” on page 313 (subsection “On the Manager”) for details.

Changing the Password for NSS DB
ESM ships with a default password for the NSS DB, “changeit” (without quotes). ArcSight 
recommends that you change the password on each component before moving to a 
production environment. To do so:

1 Disable the FIPS mode in NSS DB by running the following from the component’s 
\bin directory:

arcsight runmodutil -fips false -dbdir 
<absolute_path_to_the_component’s_NSS DB>

2 Run the following to list the NSS DB’s token name:

arcsight runmodutil -list -dbdir 
<absolute_path_to_the_component’s_NSS DB>

3 Change the token’s password by running the following from the component’s \bin 
directory:

arcsight runmodutil -changepw “<name_of_token>” -dbdir 
<absolute_path_to_the_component’s_NSS DB>

4 Enter the old password and a new password and confirm it when prompted.

5 Re-enable FIPS mode on the NSS DB:

arcsight runmodutil -fips true -dbdir 
<absolute_path_to_the_component’s_NSS DB>

6 Open the properties file:

If you do not specify the absolute path to where you want the .csr file to 
be placed, the .csr file gets placed in the Console’s <ARCSIGHT_HOME>.
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On the Manager: 

Located in: <ARCSIGHT_HOME>\config\server.properties.

Change

server.privatekey.password.encrypted=<encrypted_password>

to

server.privatekey.password=<new_unencrypted_password>

On the Console:

Located in <ARCSIGHT_HOME>\current\config\console.properties

Change

console.privatekey.password.encrypted=<encrypted_password>

to

console.privatekey.password=<new_unencrypted_password>

On the Web:

Located in <ARCSIGHT_HOME>\config\webserver.properties.

Change

webserver.privatekey.password.encrypted=<encrypted_password>

to

webserver.privatekey.password=<new_unencrypted_password>

7 Run the setup program from the component’s \bin directory:

Manager:

arcsight managersetup

Console:

arcsight consolesetup

Web:

arcsight webserversetup

and accept all the defaults in the wizard. This is required in order to obfuscate the 
password that you had entered in plain text.

Listing the Contents of the NSS DB
After you import a certificate or generate a key pair in a component’s NSS DB, you can 
verify that the certificate import was successful or the key pair has been successfully 
generated. You can do this by listing the contents of the NSS DB. To view the contents of a 
component’s NSS DB, run the following command from the component’s \bin directory:

arcsight runcertutil -L -d <absolute-path-to-the_component’s_NSS 
DB>
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You should see the alias of the certificate you just imported or the alias for the key pair you 
generated.

Veiwing the Contents of a Certificate
To view the contents of a certificate, run the following command from the component’s 
\bin directory:

arcsight runcertutil -L -d <absolute-path-to-the_component’s_NSS 
DB> -n <certificate_alias> 

Setting the Expiration Date of a Certificate
To set the expiry date of the certificate, you have to do so when generating the key pair. 
Once you have generated the key pair, you cannot change the expiration date on the 
certificate and the certificate will expire in three months by default. 

arcsight runcertutil -S -s “CN=<hostname>” -v 
<number_of_months_the_certificate_should_be_valid> -n mykey -k rsa 

-x -t “C,C,C” -m 1234 -d <component’s_NSS DB_path>

You specify the validity of the certificate with the -v <number_of_months> option. The 
value that you provide with -v will calculate the number of months that the certificate will 
be valid starting from the current time. You can use the -w <offset_months> along 
with -v to set the beginning time for the validity. The -w <offset_months> if used, will 
calculate the start time of the certificate validity and the offset will be calcualted from the 
current system time. If you do not use the -w option, the current time will be used as the 
start time for the certificate validity. See the subsection, “runcertutil” in Appendix A‚ 
ArcSight Commands‚ on page 201 for details on the -v and -w options.

Deleting an Existing Certificate from NSS DB
To delete a certificate from a component’s NSS DB:

1 Stop the component if it is running.

2  Run the following command from the component’s \bin directory:

arcsight runcertutil -D -n <certificate-alias> -d <absolute-
path-to-the_component’s_NSS DB> 

Replacing an Expired Certificate
When an existing certificate expires on a server (Manager or Web), you need to replace it 
with a new one. To replace the certificate:

1 Stop the server if it is running.

2 Delete the expired certificate from the server’s NSS DB. See “Deleting an Existing 
Certificate from NSS DB” on page 319 for details.

For the -t option, be sure to use C,C,C protocols only and in the same order 
that it is shown above.
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Since the common name (CN) for the new certificate is identical to the CN in the old 
certificate, you are not permitted to have both the expired as well as the new 
certificate co-exist in the NSS DB. 

3 In case of CA-signed certificate, replace the certificate by importing the new certificate 
into the server’s NSS DB. 

In case of self-signed certificate, you have to generate a key pair on the server. See 
“Generating a Key Pair in a Component’s NSS DB” on page 310 for details on how to 
do this. Generating the key pair automatically generates the certificate.

4 On every client that connects to the server, make sure to delete the old expired server 
certificate from the client’s NSS DB and import the server’s newly generated 
certificate.

 For example, if your Manager’s certificate has expired, you have to 

a Delete the expired certificate from the Manager’s nssdb.

b Generate a new key pair (which will automatically generate a new self-signed 
certificate).

c Export the newly generated certificate from the Manager.

d Delete the expired Manager’s certificate from the Console’s and Web’s NSS DB.

e Import the Manager’s new certificate into the Console’s and Web’s NSS DB.

Using the Certificate Revocation List (CRL)
Starting in v4.0 SP2, ArcSight ESM supports the use of CRL to revoke a CA-signed 
certificate which has been invalidated. The CA that issued the certificates also issues a CRL 
file which contains a signed list of certificates which it had previously issued that it now 
considers invalid. ArcSight Manager checks the client certificates against the list of 
certificates listed in the CRL and denies access to clients whose certificates appear in the 
CRL.

Before you use the CRL feature, make sure:

Your certificates are issued/signed by a valid Certificate Authority or an authority with 
an ability to revoke certificates.

The CA’s certificate is present in the Manager’s 
<ARCSIGHT_HOME>\config\jetty\nssdb directory

In the case of client-side authentication, the Manager validates the authenticity of the 
client certificate using the certificate of the signing CA.

You have a current CRL file provided by your CA. 

The CA updates the CRL file periodically as and when additional certificates get 
invalidated.

To use the CRL feature:

1 Make sure you are logged out of the Console.

2 Copy the CA-provided CRL file into your Manager’s 
<ARCSIGHT_HOME>\config\jetty\crls directory.

After adding the CRL file, it takes approximately a minute for the Manager to get 
updated.
320 ArcSight ESM Administrator’s Guide ArcSight Confidential



Appendix H

Advanced Configuration to Support 
Standard Content

This appendix contains instructions for configuring ArcSight components and standard 
resources to support the standard content that comes with ArcSight Express.   

Configure SmartConnectors to Send Connector Device 
Status Events for Critical Devices

The ArcSight Administration content includes resources that monitor the devices in your 
network and send a notification when one of your critical devices is down.

The content is based on internal events sent from your SmartConnectors to the ArcSight 
Manager called Connector Device Status events. These events include the timestamp of the 
last time the Connector received an event from one of its devices, the count of events sent 
by a device since the last internal check, and the total count of events sent by a device. 

The Connectors for your critical devices should be configured to send the "Connector 
Device Status" events to the ArcSight Manager periodically. To do this, configure the 
Connector to enable device status monitoring using the Connectors resource editor. 

1 In the Navigator panel, go to Connectors and navigate to the Connector you want to 
configure.

2 Right-click the Connector and select Configure. 

3 In the Connector editor in the Inspect/Edit panel, scroll down to the Processing 
section. In the Enable Device Status Monitoring (in milliseconds) field, enter how often 
you want the Connector to send Device Status Events. 

For example, if the value is set to 300000, the Connector will send status events 
for all its devices every 5 minutes (300000 milliseconds). 

If the value is set to -1, the Connector will send no Device Status events.

For more about enabling device status monitoring and configuring SmartConnectors, see 
“Managing SmartConnectors” on page 142.

“Configure SmartConnectors to Send Connector Device Status Events for Critical 
Devices” on page 321

“Configure Connector Up/Down Resources” on page 322

“Configure Critical Device Not Reporting Resources” on page 323
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Configure Connector Up/Down Resources
The ArcSight Express content provides the following resources that monitor the operational 
status of SmartConnectors configured on the ArcSight Express Manager. 

The rules Connector Up and Connector Down detect SmartConnectors that are started and 
reporting events and those that are shut down, and send a notification when Connectors 
have been down for a certain period of time (by default, 20 minutes). 

There may be situations in which you want to exclude certain Connectors from being 
evaluated by these rules, for example if: 

You have Connectors that you start and stop manually. For example, if you start a 
TestAlert connector to replay some events, then stop it when you are done, and you 
don’t want to get a notification saying that the connector is down every 20 minutes 
until you restart it.

After installing and configuring ArcSight, you get unwanted notifications about 
Connectors going down. You can opt to not receive Connector down notifications from 
those Connectors. 

You have a Connector scheduled to run once every week (such as a vulnerability 
scanner), and the Connector is otherwise down in the time in between. 

You are testing a new Connector and you will be starting and stopping it frequently 
during the set-up process. 

For these situations, the Connector Up and Connector Down rules also reference a filter, 
which points to the Black List - Connectors active list, as shown below. 

Resource Type Universal Resource Identifier (URI) Resource Name

Filter /All Filters/ArcSight 
Administration/Connectors/System 
Health/Custom/

Black List - 
Connectors

Rule /All Rules/ArcSight 
Administration/Connectors/System 
Health/

Connector Down

Rule /All Rules/ArcSight 
Administration/Connectors/System 
Health/

Connector Up

Active List /All Active Lists/ArcSight 
Administration/Connectors/System 
Health/Custom/

Black List - 
Connectors
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To exclude certain SmartConnectors from being evaluated by these rules, enter the 
SmartConnector’s URI and IP address in the Black List - Connectors active list. 

1 In the Navigator panel, go to Lists > Active Lists > All Active Lists > ArcSight 
Administration > Connectors > System Health > Custom.

2 Right-click the active list Black List - Connectors and select Edit Active List.

3 In the Active List Editor in the Inspect/Edit panel, click Add Entry.

4 In the ActiveList Entry Editor, enter the URI of the SmartConnector (starting with All 
Connectors) and the Connector’s IP address and click Add. For example: 

5 Repeat steps 3 and 4 for every SmartConnector you want to exclude from the 
Connector Up/Down rules. 

For more about working with active lists, see the topic Managing Active Lists in the 
ArcSight ESM User’s Guide. 

To populate Active Lists from an imported CSV file:

1 In the Navigator panel, navigate to the active list you want to configure (Lists > 
Active Lists). 

2 Generate a CSV file with the values with which you wish to populate the active list, and 
save it to a directory on the Console system.

3 Right-click the active list you wish to import the values into and select Import CSV 
File...

4 In the Open dialog box, navigate to and select the CSV file and click Open.

Configure Critical Device Not Reporting Resources
The ArcSight Administration content includes resources that monitor the devices in your 
network and send a notification when one of your critical devices is down. This content 
functions off the Device Status events sent by SmartConnectors that you configured in 
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“Configure SmartConnectors to Send Connector Device Status Events for Critical Devices” 

on page 321. 

The Device Reporting rules reference the White List filters for which devices to track and 
insert in the Reporting Devices active list. 

Configure White List Filters
The White List - Devices filter tells the Devices Reported rule which devices to track that 
send Device Status events to the Manager. By default, the condition in the filter is True, 
which means that all the devices that send Device Status events will be inserted in the 
Reporting Devices active list. 

Modify this filter to choose only the devices you want to insert in the Reporting Devices 
active list. Entries in this active list never expire. 

Resource Type Universal Resource Identifier (URI) Resource Name

Filter /All Filters/ArcSight 
Administration/Connectors/System 
Health/Custom/

White List - 
Devices

Filter /All Filters/ArcSight 
Administration/Connectors/System 
Health/Custom/

White List - Critical 
Devices

Rule /All Rules/ArcSight 
Administration/Connectors/System 
Health/

Device Reported

Rule /All Rules/ArcSight 
Administration/Connectors/System 
Health/Custom/

Critical Device 
Reported 

Rule /All Rules/ArcSight 
Administration/Connectors/System 
Health/Custom/

Critical Device Not 
Reporting 

Active List /All Active Lists/ArcSight 
Administration/Connectors/System 
Health/Custom/

Reporting Devices
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The White List - Critical Devices filter tells the Critical Device Reported rule which devices to 
track that send Device Status events and are also categorized as criticality High (All 
Asset Categories/System Asset Categories/Criticality/High). 

Modify this filter to choose the critical devices you want to monitor closely and about which 
you want to be notified when they are not reporting. 

The devices in Reporting Devices active list are likely to be a subset of the devices in the 
Reporting Device active list. By default, the filter will pick all the assets that are categorized 
as /All Asset Categories/System Asset Categories/Criticality/High. 
Create conditions that match your critical devices, and categorize your critical assets (or 
zones) as /All Asset Categories/System Asset 
Categories/Criticality/High.

To modify the filters to select only the devices you specify:

1 In the Navigator panel, navigate to the White List filters (/All 
Filters/ArcSight Administration/Connectors/System 
Health/Custom/) and double-click the one you want to modify to open it in the 
Inspect/Edit panel. 

2 In the Filter editor in the Inspect/Edit panel, select the Filter tab. 

White List - Devices filter: Delete the default condition True (select the 
condition and press Delete).

White List - Critical Devices filter: Leave the Attacker Asset ID and Attacker 
Zone conditions in place. These identify the asset as being categorized as 
criticality high.

3 Construct an expression that captures the devices you want the rule to evaluate.

White List - Devices filter: Select event1 and add an AND operator (click the 

AND icon ). Use the event fields grid to build the condition, or right-click 
event1 and select New Condition.

White List - Critical Devices filter: Select event1 and use the event fields 
grid to build the condition, or right-click event1 and select New Condition.  

Depending on the devices you want to capture, you can use device vendor/product, 
asset categories, and other conditions. 

• Use Device Custom strings. You can use Device Custom strings to 
express device vendor and device product fields. Device Custom 
String1 is the device vendor (such as Microsoft), Device Custom 
String2 is the device product (such as Microsoft Windows). For 
example: 

Device Custom String1 = Device Vendor ABC

Device Custom String2 = Device Product XYZ (this will select all 
the devices with that device vendor/product)

• Use Attacker fields. The attacker fields correspond to the deivce. 
Use these fields to specify an IP address, a zone or an asset category 
using the “Attacker” fields and the appropriate operator. For example:

Attacker Zone = /All Zones/... (This checks if the device is in a 
zone)

• Use Assets conditions. Use the Assets condition button to check if 
a device is in one or more asset categories. For example:

Attacker Asset ID inGroup /All Asset Categories/... 
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4 Click OK to apply changes and close the Filter editor. 

For more about working with the Common Conditions Editor, see the online Help topic 
Common Conditions Editor. 

Configure Critical Device Not Reporting Rule
The Critical Device Not Reporting rule is disabled by default. Enable the rule if you want to 
be notified when one of your critical devices is down. Enable the rule only after you 
modified the White List - Critical Devices filter. 

To enable the rule:

1 In the Navigator panel, go to Rules > All Rules > ArcSight Administration > 
Connectors > System Health > Custom. 

2 Right-click the rule Critical Device Not Reporting and select Enable Rule.

To enable the Create New Case action if a critical device goes down:

To also create a case when the rule conditions are met, edit the Create New Case action to 
give it an owner and enable the action. 

1 Select the Create New Case action and click Edit in the toolbar at the top of the 
Actions tab. 

2 In the Edit Action dialog box in the Owner drop-down menu, navigate to and select an 
appropriate ArcSight Express user. Click OK.

3 Select, then right-click the Create New Case action and select Enable. Click OK.
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